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Chapter 1. About this publication

This publication helps you with advanced configuration and daily
administration/operations for InfoPrint® Manager for the Windows® Operating
System, hereafter called InfoPrint Manager for Windows.

Who should read this publication
This publication is for the administrator who configures and manages an InfoPrint
Manager environment. You should have already performed the basic installation of
InfoPrint Manager by performing the steps described in the book InfoPrint Manager
for Windows: Getting Started, G550–1072.

Most recent information

For the most recent information about InfoPrint Manager, go to the InfoPrint
Solutions Company Web site at http://www.infoprint.com.
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Chapter 2. The InfoPrint publication library

For the most current information, see the InfoPrint Solutions Company Web site at
http://www.infoprint.com.

InfoPrint Manager common publication library

These publications are common to both InfoPrint Manager for AIX® and InfoPrint
Manager for Windows:
v InfoPrint Manager: SAP R/3 Planning and Configuration Guide, S550-1051. For print

administrators who need to create and configure both the SAP R/3 environment.
we recommend that users possess a detailed knowledge of a SAP R/3
environment, as well as administering and maintaining either AIX or Windows
operating systems. This publication describes how a business enterprise that
uses SAP R/3 can use either InfoPrint Manager for AIX or InfoPrint Manager for
Windows to manage its print environment.

v InfoPrint Manager: Reference, S550-1052. For print administrators, operators, and
application programmers with the need to do command-line functions. This
publication describes the commands, utilities, transforms, attributes, and
attribute values associated with InfoPrint.

v InfoPrint Manager: PSF and Server Messages, G550-1053. This publication lists the
PSF and Server messages and explanations from InfoPrint Manager.

v InfoPrint Manager Print-on-Demand Feature: Submit Express User’s Guide, S550-1054.
This publication is for the user who installs, configures, and uses Submit Express
on a Windows or Macintosh workstation. Although you can use this publication
for general guidance in using Submit Express, you should use the online Help to
find more detailed instructions.

v InfoPrint Job Ticketer: Job Ticketer User’s Guide, S550-1055. This publication is a
guide for using the InfoPrint Job Ticketer Web application. This guide provides
descriptions of tasks and procedures that an end-user needs to know to set up
their workstation to use the application, and then to create, layout, store, retrieve
print jobs, and submit the jobs to a print server for printing.

v InfoPrint Job Ticketer: Administrator’s Guide, S550-1056. This publication is a guide
for system administrators who are responsible for the InfoPrint Job Ticketer Web
application. This guide provides information about the Job Ticketer system
requirements, installation and configuration, system maintenance, security, and
problem determination.

InfoPrint Manager for AIX publication library

InfoPrint Manager for AIX includes publications in PDF format on a CD-ROM
supplied with the product.

The publications for InfoPrint Manager for AIX are:
v InfoPrint Manager for AIX: Introduction and Planning Guide, G550-1060. This

publication gives an overview of InfoPrint Manager for AIX, introduces the
concepts, and helps you prepare to use it. It addresses migration from previous
versions of the product. And it explains the differences between the AIX and
Windows versions of InfoPrint Manager.
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v InfoPrint Manager for AIX: Installation Instructions, G550-1059. This publication
describes how to install InfoPrint Manager for AIX 4.3. These instructions
explain the procedures for local and remote installations.

v InfoPrint Manager for AIX: Getting Started, G550-1061. This publication helps you
install and configure InfoPrint Manager for AIX. It focuses on the software
configuration of server and client system.

v InfoPrint Manager for AIX: Configuration and Tuning Guide, S550-1062. This
publication provides information about configuring and tuning the InfoPrint
Manager for AIX, Version 4.3. This book is designed for the InfoPrint Manager
administrator who needs to understand how to configure and tune an InfoPrint
Manager system. It helps administrators to evaluate, develop, and maintain both
a logical and hardware configuration for their environment.

v Guidelines for Installing InfoPrint Manager for AIX 4.2 in an HACMP Configuration,
G550-1063. This publication helps you install and configure HACMP™ with
InfoPrint Manager for AIX. It also describes how to use HACMP with InfoPrint
Manager for AIX.

v InfoPrint Manager for AIX: Using Generalized Fax, S550-1064. This publication
describes how to configure and use the Generalized Fax support that is included
with InfoPrint Manager for AIX. This publication includes information about
sending and receiving faxes from an InfoPrint Manager server.

v InfoPrint Manager for AIX: Procedures, G550-1066. This publication describes how
to set up an InfoPrint environment, to submit print jobs, to schedule jobs, and to
manage the print environment.

InfoPrint Manager for Windows publication library

InfoPrint Manager for Windows includes publications in PDF format on a
CD-ROM supplied with the product.

The publications for InfoPrint Manager for Windows are:
v InfoPrint Manager for Windows: Introduction and Planning Guide, G550-1071. This

publication gives an overview of InfoPrint Manager for Windows, introduces its
concepts, and helps you prepare to use it. It describes features of this product.
Finally, this publication explains the differences between the AIX and Windows
versions of InfoPrint.

v InfoPrint Manager for Windows: Getting Started, G550-1072. This publication helps
you install and configure InfoPrint Manager for Windows. It focuses primarily
on server and client system software configuration.

v InfoPrint Manager for Windows: Procedures, G550-1073. This publication describes
the primary tasks necessary for setting up an InfoPrint environment, submitting
print jobs, scheduling jobs, and managing the print environment.

Related publications

The related publications are:
v AFP Conversion and Indexing Facility User’s Guide, S550-0436.
v Page Printer Formatting Aid: User’s Guide, S550-0801.
v Using OpenType Fonts in an AFP System, G544-5876.
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Part 2. Administrative Procedures: Configuring InfoPrint
Manager
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Chapter 3. Using Multiple Network Adapter Cards

If you are concerned that your local area network (LAN) might not have enough
bandwidth to handle the additional traffic that installing additional printers can
create, you can create a secondary network that is essentially dedicated to driving
printers. To set up this configuration, the system that your InfoPrint Manager
server is installed on will have to have two network adapter cards installed in it,
one for each network. Print data comes into the InfoPrint Manager server over the
LAN and is transferred to the secondary network to be printed.

When you set up the secondary network, keep these points in mind:
v In the system that your InfoPrint Manager server is installed on, the primary

network adapter card should be the one that connects to your existing network.
v In the system that your InfoPrint Manager server is installed on, the secondary

network adapter card connects to a network that contains only printers. This
network is isolated; no IP forwarding is recommended.

v The IP addresses for printers on the secondary network must not be resolvable
on the primary network.
It is recommended that you use private IP addresses for your secondary
network card and your printers, for example, addresses that follow either of
these formats:
– Class A IP address: 10.xx.xxx.xxx
– Class B IP address: 192.168.xxx.xxx

v In the properties for the secondary network adapter card, you should not set a
Default Gateway, DNS, or WINS. If these fields are filled in when you configure
the card, clear the default values.

v On the printers that you connect to the secondary network, do not specify a
Default Gateway. If you must specify a Default Gateway, enter the IP address of
the secondary network adapter card.
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Chapter 4. Selecting a type of actual destination

Once you have decided how many logical destinations, queues, and actual
destinations you want to use and how to configure them, you need to determine
which kind of actual destinations to create. In InfoPrint Manager for Windows,
there are four basic types of actual destinations: PSF printers, Passthrough printers,
BSD printers, and IPP printers. The names of the destination types refer to the
destination support systems (DSSs) that process the print data and send it to the
printer.

Consult these tables to help you determine what kind of destinations to create
based on where your print jobs are coming from:
v PC-based applications or a host system using IP Printway
v Both PC-based applications and host systems (using MVS™ Download)

PC-based applications or a host system using IP Printway

Use this table to see which type of destination fits your needs.

Table 1. PC-based applications or a host system using IP Printway

If the data
stream that your
applications
send to
InfoPrint
Manager is:

PostScript, PCL or any non-IPDS data stream

and the data
stream that you
send to this
printer is:

the same that the application sends to InfoPrint
Manager

PCL, PPDS1,
IPDS™

and your jobs
are going to be
sent to a printer:

through a
Windows
defined port

using a
command such
as lpr

that is IPP
enabled

that is attached
to your InfoPrint
Manager system
in any of the
ways listed in
the PSF
Attachment
Types table

Create this kind
of actual
destination:

Passthrough2 BSD IPP PSF

Note:

1. You can only print PPDS on a non-Windows system, for example, by sending the PPDS
data stream to an AIX system.

2. If you are printing PCL data to an Windows-defined printer, and have therefore chosen
to create a Passthrough destination, you might want to consider creating a “PSF
attachment types” on page 13 destination instead. A Passthrough destination uses fewer
processing resources, but a PSF destination provides much more functions, such as
accounting and automatic data stream transforms.
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For example, an advertising firm is installing InfoPrint Manager for Windows to
manage printing for its 1,200 employees. The company has 450 PCL and
PostScript® printers that are between one and seven years old, and about 20
printers that are more than seven years old. They have recently purchased 5 PCL
printers that are also enabled to use the Internet Printing Protocol (IPP). Most of
the print jobs that users generate are from word processing, graphics, or desktop
publishing programs. These applications create mostly PCL and PostScript print
jobs, which don’t need to be transformed to another data stream to be printed on
the existing printers.

The print administrator decides to create three kinds of actual destinations.
v Passthrough printers will send jobs to the PostScript and PCL printers.
v IPP printers will send jobs to the new IPP-enabled printers.
v BSD printers will send jobs to the oldest of the printers (the ones that still

receive jobs using the lpr command).

MVS Download, DPF, or a combination of PC-based applications and
host systems

If you will be sending jobs to this destination from both PC-based applications and
host systems (using DPF or MVS Download), use this table to see which type of
destination fits your needs.

Table 2. MVS Download, DPF, or a combination of PC-based applications and host systems

If the data
stream that your
host system and
applications
send to
InfoPrint
Manager is:

AFP™, ASCII, DBCS ASCII, line
data, PCL, PostScript, PDF, IPDS
(via DPF)1

PCL only PS only

and the data
stream that you
send to this
printer is:

IPDS PCL or PPDS2 PCL PS

Create this type
of actual
destination:

PSF (TCP/IP) PSF (other driver
or command)

PSF (other driver
or command)
OR any of the
destination types
listed under
PC-based
applications

One of the
destination types
listed under
PC-based
applications

Note:

1. DPF can only submit jobs to PSF printers. MVS Download can submit jobs to any of
the printer types listed.

2. You can only print PPDS on a non-Windows system, for example, by sending the PPDS
data stream to an AIX system
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PSF attachment types

PSF destinations are further divided by attachment type. See this table for
information about choosing an attachment type.

Table 3. PSF attachment types

If you are sending
this data stream to
the printer:

IPDS PCL or PPDS PCL or PPDS

and you are going to
attach the printer to
the InfoPrint
Manager system in
this way:

over the TCP/IP
network

over the TCP/IP
network OR directly
attaching it through a
parallel or serial port

over the TCP/IP
network using a
command such as lpr
to submit jobs to it

select this
attachment type:

TCP/IP Other driver Command
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Chapter 5. Managed IPDS Dialog support

The Managed IPDS Dialog (MID) support enables additional sharing capabilities
for specific printers. Current sharing of a print device is based on the setting of an
inactivity timer. MID support overcomes these current limitations:
v Release for sharing requires physical intervention to disconnect the print device,

and the PSF host must re-acquire the TCP/IP connection to process additional
print requests. When the original connection is released, all downloaded
resources are generally lost. Furthermore, there is a possibility that another host
might acquire the TCP/IP connection and prevent the current host from
processing additional print requests.

v Release of the print device is controlled by a specific time value. This causes the
release of the printer even when there are no additional print requests pending.

With MID support, the printer can request that the PSF host release its control of
the print device (but not drop the TCP/IP connection), thus allowing the print
engine to print non-IPDS data streams when IPDS activity is minimal. MID
support also enables the sharing of the print mechanism with other non-IPDS data
streams.

This chapter includes the following sections:
v “Enabling MID support”
v “Considerations to activate MID support”

Enabling MID support

Set these parameters to enable MID support:
1. mid-support-enabled

a. Right-click the actual destination in the InfoPrint Manager GUI and click
Properties.

b. Click Tuning.
c. Enter Yes in the Enable MID Support field to activate MID. The default

value is No.
2. mid-release-timer

a. Right-click the actual destination in the InfoPrint Manager GUI and click
Properties.

b. Click Tuning.
c. Specify a numeric value for MID Release Timer from 1 to 9999. The default

value is 15.

Note: The value for the MID-release-timer must be less than the value for
the destination-release-timer-setting. The MID will never be enabled if the
destination-release-timer-setting value is less than the MID-release-timer
value.

Considerations to activate MID support

Consider these before you activate MID support for your print device:
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v Your print device must be capable of supporting MID. Contact your InfoPrint
representative if you are not sure of your print device capability.

v If you want incoming non-IPDS print requests to be intermingled with IPDS
print requests, it is suggested that you maintain control over the print
mechanism rather than activate MID.

v Jobs must be “stacked″ before the print mechanism is released. This might lead
to paper loss for the print device.

v Releasing the print mechanism might prevent the IPDS host from processing
subsequent print requests until the control is returned to the host (the time
depends on the capacity of each print device).

v The MID support does not allow for sharing of the print mechanism between
two IPDS hosts for InfoPrint printers.
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Chapter 6. Using the Internet Printing Protocol (IPP) with
InfoPrint Manager

The Internet Printing Protocol (IPP) is an application protocol that uses the
Hypertext Transfer Protocol (HTTP) to allow you to print your documents to any
IPP-enabled printer whose web address (or Uniform Resource Identifier-URI) you
know. You can use IPP to send print data over both LANs and the Internet so
users who are directly connected to your LAN as well as those who work remotely
have access to the same printers. InfoPrint Manager for Windows provides two
ways to configure your system to print using IPP.

Printing to an IPP-enabled printer

If you have an IPP-enabled printer, you can create an IPP printer just as you
would any other actual destination using the Create IPP Printer Wizard in the
InfoPrint Administration GUI. To print to the new destination, you can submit jobs
using a print command such as pdpr, or you can install InfoPrint Select on your
workstation and create a Select printer that uses that destination or any other job
submission method.

Printing through the IPP Gateway

The IPP gateway is a service in InfoPrint Manager that lets you print using IPP
even if you don’t have an IPP-enabled printer, as long as you (and your users)
have IPP client software installed on your workstation.

Note: Windows 2000/2003 systems come with IPP client software built in. Users
on other Windows platforms can download IPP client software. The Printer
Working Group, the organization that is leading the development of IPP, provides
a list of IPP client software that you can use to find an appropriate client at:
http://www.pwg.org/ipp/IPP-Products.html

Once you have an IPP client installed, to set up the gateway:
1. Enable the IPP Gateway using the InfoPrint Manager Management Console. For

more information about completing this task, see the Management Console
online help .
a. The IPP Gateway runs as a Windows service called InfoPrint Manager IPP

Gateway. On Windows 2000/2003 systems, the IPP Gateway is not set to
start automatically by default. For information about changing the default
settings, see the Management Console online help.

Note: Selecting this box does not start the IPP Gateway Service
immediately. You must either restart the system that the InfoPrint Manager
server is installed on or start the service from the Windows Control Panel.

b. To start the IPP Gateway service from the Windows Control Panel:
1) Navigate to the Control Panel and click Administrative Tools.
2) In Administrative Tools, click Services.
3) In Services, highlight InfoPrint Manager IPP Gateway, and then select

Action → Start.
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2. Verify that the gateway is working. Open your Internet browser and enter this
web address, replacing serverhostname with the DNS hostname of the system
that InfoPrint Manager is installed on:
http://serverhostname:631/printers

Note: If you don’t have a DNS name server running on your network, replace
serverhostname with the dotted-decimal IP address of the system that InfoPrint
Manager is installed on instead.
If the gateway is working correctly, you will see a list of the printers that are
available through the gateway. All of your InfoPrint destinations should be
listed. Find the address (URI) of the destination you want your users to print
to.

3. Refer your users to “Adding an Internet Printing Protocol (IPP) gateway
printer to your desktop” on page 306. This step varies depending on which IPP
client you are using; follow the instructions for adding a printer as provided by
the IPP client. For the printer address, have your users enter the address that
you found in step 2.
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Chapter 7. Using InfoPrint Manager notifications

InfoPrint Manager can detect events (such as job completed or destination needs
attention) as they occur, generate messages about those events, and deliver the
messages to users who need the information. For example, users can receive
messages about jobs they submit, operators can be notified about InfoPrint objects
that require their attention, and administrators can be notified if someone makes a
configuration change. With notifications, you don’t have to query for status of the
objects in your system—you just receive messages when specific events occur so
that you can take care of them.

You can tailor who receives these messages and how they are delivered based on
the notification profile that is set for a particular InfoPrint object.

Understanding notification profiles
Most InfoPrint objects (the server, actual destinations, logical destinations, queues,
jobs, and default jobs) have notification profiles associated with them. A
notification profile is composed of one or more notification profile entries. Each
notification profile entry has three main components:

Event Identifiers
Which events cause messages to be sent. See “Event identifiers” on page 20
for more information.

Delivery method
How the messages are delivered. See “Delivery method and delivery
address” on page 20 for more information.

Delivery address
Where the messages are sent. See “Delivery method and delivery address”
on page 20 for more information.

In addition, a notification profile entry can include a comment (text that InfoPrint
will add to the general message text) and a locale (to set the language that the
message will be sent in). Comments are optional. If you don’t specify a locale,
InfoPrint delivers messages using the locale (language) that the user is running.

Some objects need only one entry in their notification profiles. For example, when
a person submits a job, he is probably the only one who needs to receive
information about it, and he will probably be content to have all of the messages
about that job delivered the same way.

For other objects, there are very good reasons to have multiple entries. For
example:
v If operators manage printers from more than one workstation, you can create an

entry for each workstation. That way, all of the messages go to all of the
machines.

v If operators can address some messages (like destination-needs-attention), but
an administrator needs to address others (like object-deleted), you can create an
entry for each operator and one for the administrator. Messages are delivered to
the person who can handle them.
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v If an administrator likes to use InfoPrint Manager Notifications while he’s at
work, and wants to keep a more permanent record of how often some events
occur, he can set up two entries. One delivers messages to the InfoPrint Manager
Notifications client and one writes certain messages into a file that he can check
periodically.

Event identifiers
The event identifiers component lists the InfoPrint events that trigger notifications.
You can find a full list of InfoPrint notification events and their descriptions in the
InfoPrint Manager: Reference. In the descriptions, you will see what objects each
event supports. If you add an event to an object that it does not support, no
messages will ever be generated for that event. For example, you can add the
queue-backlogged event to a notification profile entry for an actual destination,
but queue-backlogged only supports the queue, job, and server objects. As a
result, the actual destination notification profile will not generate any messages
about that event.

That chapter also lists the InfoPrint Manager event classes, or groups of related
notification events. When you add event identifiers to a notification profile, you
can add individual events, event classes, or a combination of the two.

Each type of InfoPrint object has a default set of event identifiers. See “Default
notification profiles” on page 24 for a list of defaults for each object.

Delivery method and delivery address
The delivery method component shows how you want notification messages to be
delivered. The delivery method and delivery address components are strongly
related; the delivery method you choose determines the type of value you use for
the delivery address.

In addition, delivery method and delivery address are the keyed components in
notification profile entries; they are the two values that InfoPrint Manager checks
when you modify a notification profile. If the delivery method and delivery
address that you specify match the delivery method and delivery address of an
existing entry, InfoPrint Manager updates that entry. If both values don’t match
any of the existing entries, InfoPrint Manager adds a new entry to the profile.

There are various delivery methods defined for InfoPrint objects. All methods are
valid for all objects except for job-log; job-log is only valid for jobs. Table 4 on
page 21 lists the delivery methods, along with descriptions and how to set the
delivery address for each type. 1

1. Two other delivery methods, sapcb and sapconnect exist, but they are only used internally with the InfoPrint Manager SAP Print
Feature. You should never use either of those values in a notification profile entry.
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Table 4. InfoPrint notification delivery method characteristics

Delivery Method Description Delivery address

message

Message is the default
delivery method for all
objects.

Sends a message to the InfoPrint
Manager notification server,
where it waits for an InfoPrint
Manager Notifications client to
pick it up. Once a message is
picked up, it is deleted from the
notification server; there are no
further records of that message.

The delivery address listed in
the notification profile can be
whatever you want it to be– a
user id, office number, IP
address, driver’s license
number– as long as it is
unique. To receive messages
sent to that address, you must
set the delivery address listed
in the Settings dialog in the
InfoPrint Manager Notification
client to the same value. The
InfoPrint Manager
Notifications client will only
pick up messages that specify
an identical delivery address.

electronic-mail
(synonyms: e-mail,
email)

Sends an e-mail to the address
listed in the delivery address.

To use the e-mail delivery
method, you must also set the
smtp-server-host atttribute on
your InfoPrint Manager server to
the IP address or DNS hostname
of the system that your SMTP
mail server runs on.

The e-mail address that you
want notification messages to
be sent to. For example,
kjones@printerco.com.

exit Doesn’t actually send a message.
Instead, when the event
specified in the event identifier
occurs, InfoPrint Manager runs
an exit program or script. See
“Using the ’exit’ delivery
method” on page 24 for more
information.

The full path to the notification
exit program or script (with
hard-coded arguments, if any).

wireless Sends notifications to wireless
devices, such as pagers, cellular
phones, palm pilots, and laptop
computers.

Because wireless notifications
are delivered as e-mails, you
must set both the
smtp-server-host and the
smtp-server-port server
attributes on this InfoPrint
server.

If your InfoPrint server is
behind a firewall, you might
have to configure your SMTP
server.

file Writes the message in the file
you specify in the delivery
address. If the file doesn’t exist,
InfoPrint Manager will create it.
If the file does exist, InfoPrint
Manager will overwrite it the
first time it writes a message.
After that, messages are added
to the end of the file.

The directory path and name
of the file that you want to
write your notification
messages in. This file must be
on the same system as your
InfoPrint Manager server.
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Table 4. InfoPrint notification delivery method characteristics (continued)

Delivery Method Description Delivery address

file-add-to Adds the message to the end of
the file you specify in the
delivery address. If the file
doesn’t exist, InfoPrint Manager
will create it.

The directory path and name
of the file that you want to
write your notification
messages in. This file must be
on the same system as your
InfoPrint Manager server.

job-log

Valid only for jobs.

Writes messages into the job-log
attribute of the job. If the job is
deleted, the job log is also
deleted. To see the messages,
enter the pdls command for the
job-log attribute on the job you
want to know about; or, on the
InfoPrint Manager
Administration Interface, go to
Job → View Log.

No value needed.

none Does not send any notifications;
turns notification off.

No value needed.

Working with Select notifications

By default when you submit a job using InfoPrint Select, a notification profile is
sent with the job. If you have the Select message windows running when you
submit a print job using InfoPrint Select, notifications are requested. If the Select
message window is not running, notifications are not requested. When notifications
are requested, they are delivered by e-mail. InfoPrint Select does not use the
standard e-mail port for notifications to avoid conflict with other SMTP servers. If
you have a conflict with the port that Select is using for notification, you can select
another port by following: Start → Programs → InfoPrint Select → InfoPrint Select
Notification → InfoPrint Manager Message Port, and entering another port.

The InfoPrint Select Notification message window usually starts automatically
when Windows first loads, but to start the Notification message Window at
another time, go to Start → Programs → InfoPrint Select → InfoPrint Select
Notification.

To turn off the Notification message window, click X in the upper right corner of
the window and then click OK on the warning message.

Note: If you receive a communication error when using the Select Message
Window with Windows XP with Service Pack 2 or Windows 2003 with Service
Pack 1, you might have to include ipnotify.exe on the Exceptions tab of the
Windows Firewall dialog.

Setting up your own InfoPrint Select notification profile:

The Select notification profile overrides any notification settings that you configure
in a default job. If you do not want to use the Select notification profile, use the
appropriate procedure for your operating system:
v Windows XP

1. On the Windows system that InfoPrint Select is installed on, right-click My
Computer and select Properties.
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2. Select the Advanced tab, and click Environment Variables.
3. Click one of the variables listed under System Variables to signal that you

want to create a system variable. The variable and its value will appear in
the fields at the bottom of the dialog.

4. Clear the Variable and Value fields.
5. In the Variable field, type: pdnotify and in the Value field type:

override_select.
6. Click Set.
7. Verify that pdnotify appears in the list of System Variables and not in the

User Variables. If it appears in the list of User variables, delete it and start
again from step 3.

8. Click OK.
9. Restart your system to make the changes take effect.

v Windows 2000

1. On the Windows system that InfoPrint Select is installed on, right-click My
Computer and select Properties.

2. In the System Properties window, click Advanced.
3. On the Advanced tab, click Environment Variables.
4. In the System variables box on the Environment Variables dialog, click

New.
5. In the Variable Name field, type pdnotify and in the Variable Value field,

type override_select.
6. Click OK.
7. Verify that pdnotify appears in the list of System variables and not in the

User variables. If it appears in the list of User variables, delete it and start
again from step 4.

8. Click OK in the Environment Variables dialog.
9. Click OK in the System Properties window.

10. Restart your system to make the changes take effect.
v Windows Vista or Windows Server 2008

1. On the Windows system that InfoPrint Select is installed on, right-click My
Computer and select Properties.

2. In the System Properties window, click Advanced system settings.
3. On the Advanced tab, click Environment Variables.
4. In the System variables box on the Environment Variables dialog, click

New.
5. In the Variable Name field, type pdnotify and in the Variable Value field,

type override_select.
6. Click OK.
7. Verify that pdnotify appears in the list of System variables and not in the

User variables. If it appears in the list of User variables, delete it and start
again from step 4.

8. Click OK in the Environment Variables dialog.
9. Click OK in the System Properties window.

10. Restart your system to make the changes take effect.
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Using the ’exit’ delivery method
The exit delivery method lets you set up automatic responses to system events
beyond just sending a message. When you set the delivery method for a given
event to exit, you use the delivery address to specify the explicit path to a script or
program on your system. Whenever that event occurs, InfoPrint Manager runs the
script or program you specify.

For example, if the InfoPrint Manager server runs low on disk space, the
disk-space-low event generates a message for the system administrator. The
administrator then has to do something to clean up the disk so InfoPrint Manager
can continue to run effectively. However, using the exit delivery method can
automate that process by launching a ″disk clean up″ script. The administrator can
still receive the message, but will know that the script is already working on the
problem.

If you are using the Print Optimizer DSS, InfoPrint Manager provides a sample
script called poexitcleanup that you can use with the exit delivery method. The
script demonstrates one way that you can automate cleaning up disk space in the
Print Optimizer resource filesystem after the disk-space-low event occurs.

By default, when you use the exit delivery method, InfoPrint Manager only passes
two values along to the script or program: the message number of the event that
occurred and the text of the message. As a result, the command line that the exit
delivery method executes is composed of the path that you specified in the
delivery address, the last three digits of the message number, and the text of the
message.

Therefore, if you create a notification profile entry for the job-completed event,
setting the delivery method to exit and the delivery address to
c:\Infoprint\exits\myscript, when a job finishes printing, InfoPrint Manager will
generate and execute a command line similar to this one:
c:\Infoprint\exits\myscript 280 "5010-280 Finished processing job ofc,
Job 20 (3520800004)."

The scripts or programs you write might require other information, such as the
destination name or the printer model. To pass those values, you can include them
in the delivery address of the notification profile entry; they will be added to the
end of the command line when InfoPrint Manager creates it.

Note: The program run by a notification profile with the ″exit″ delivery method
runs under InfoPrint Manager, which is running as a Windows service and does
not have access to the desktop. Because of this, the notification method of ″exit″
does not allow a delivery address that requires a windowed program to be used,
such as notepad.exe.

Default notification profiles
By default, the person who creates an object (server, destination, queue, job)
receives the notification messages about that object. The default notification profile
settings provide information such as object status, error conditions, or
configuration changes. Some of these events require the person managing the
object to intervene; for example, someone might need to clear a paper jam.

By default, the events listed in this table generate messages for the corresponding
objects. These messages are delivered to the user who created the object: job
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submitters receive messages about their print jobs; the administrator receives
messages about destinations and servers that he or she created. The default
delivery method is message, so the notifications are sent to the InfoPrint Manager
Notification client on the system that the person used to create the object.

Table 5. Default notification profile settings

Object Events

Actual destination v destination-needs-administrator
v destination-needs-attention
v destination-needs-operator
v destination-timed-out
v object-cleaned
v object-deleted

Default Job No defaults set. See “Using notification
profiles with default jobs” on page 26 for
more information.

Job v destination-needs-attention
v destination-needs-operator
v destinations-not-ready-for-job
v document-aborted-by-destination
v document-aborted-by-server
v document-cancelled-at-destination
v job-aborted-by-server
v job-cancelled-by-operator
v job-cannot-be-scheduled
v job-completed
v past-discard-time

Logical destination v object-cleaned
v object-deleted

Queue v object-cleaned
v object-deleted
v queue-backlogged

Server v internal-server-error
v low-on-memory
v memory-exhausted
v object-cleaned
v object-deleted
v out-of-disk-space
v out-of-dpf-haids
v out-of-dpf-job-numbers
v out-of-dpf-raids
v sapcbd-down
v sapconnectd-down
v server-shutdown-complete

Determining how much notification administrators, operators, and job submitters
require takes some planning and, as you familiarize yourself with InfoPrint, you
should discover when you require more or less notification. You can start by using
the defaults and see how many and what kind of messages you receive. To send
more or less notification, to modify which users receive notifications, or to send
messages using a different delivery method, you can change the notification
profiles.
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Using notification profiles with default jobs
When someone submits a print job, InfoPrint Manager sends messages about that
job based on a default notification profile. As a result, the delivery method is
message, the delivery address is ″the user ID of the person who submitted the job
@ the address of the system the job was submitted from,″ and the event identifiers
are those listed in Table 5 on page 25. (If you submit jobs using InfoPrint Select, the
default notification profile is different. See “Working with Select notifications” on
page 22 for additional information.)

To change the settings in the default notification profile, you can create a
notification profile on a default job. There are several things to keep in mind when
you set up a notification profile on a default job:
v You can only set one default job on each logical destination. As a result, all of

the jobs will use the same notification profile.
v If you set a delivery address in the notification profile for the default job, all

messages will go to that address. However, if you leave the delivery address
blank, InfoPrint Manager will fill it in with the address that the job was
submitted from (you can’t specify this address; it is sent with the job). This
option only works with the message and e-mail delivery methods and is the
only time that the notification profiles are merged.

v If you submit a job with an explicit notification profile (for example, by
including the notification-profile attribute when you submit a job using pdpr),
that profile overrides the one set in the default job.

Note: If you submit jobs using InfoPrint Select, an explicit notification profile is
sent with every job. To use a notification profile on a default job with InfoPrint
Select, see“Working with Select notifications” on page 22 for information about
overriding Select notifications.

Changing notification profiles

For jobs, default jobs, servers, queues, and actual
destinations

You can use the properties notebooks in the InfoPrint Manager Administration GUI
to change notification profiles for jobs, default jobs, servers, queues, and actual
destinations. Open the properties notebook and click Notification for an actual
destination, a job, or a default job. For a server, click Other. On the page that
opens, you can see the notification profile entries that already exist, including:
v How messages about that object are delivered
v Who they are sent to
v What events generate messages
v Any comments that are included with the messages

Use the Add, Modify, and Delete buttons to make changes to the notification
profile. See the online help for the InfoPrint Manager Administration GUI for
additional information. You can also change notification for jobs in the InfoPrint
Manager Operations GUI.

Note: If you change the delivery method, make sure you change the delivery
address appropriately.
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For logical destinations

The only way to change a notification profile for a logical destination is to use the
pdset command. The procedures below provide examples of some common
modifications you might want to make. You can use these procedures to change
the notification profiles for other InfoPrint objects as well, but you might find it
easier to use the properties notebooks in the InfoPrint Manager Administration
GUI.

This procedure describes how to modify notification profiles by:
v “Adding or modifying events or users in a notification profile” on page 28
v “Removing users from a notification profile” on page 29
v “Changing the delivery method” on page 30

If you need to change other parts of a notification profile, see the InfoPrint
Manager: Reference for information on the pdset command and the
notification-profile attribute.

Important: When you modify a notification profile, InfoPrint Manager compares
the new delivery method and delivery address to the delivery methods and
delivery addresses in the existing entries and behaves accordingly:
v If you specify both of the values and both match the values in an existing entry,

the modification replaces that entry.
v If you only specify one of the values, InfoPrint Manager fills in the other value

with the default values. Then, it checks to see if any of the existing entries match
that combination. If they match, InfoPrint Manager replaces that entry. If they
don’t match, InfoPrint Manager creates a new entry.

v If you specify both values but only one matches, InfoPrint Manager creates a
new entry.

v If you specify both values and neither one matches, InfoPrint Manager creates a
new entry.

When you delete a notification profile entry, the delivery method and delivery
address in your command must match those in an existing entry exactly.

Viewing an existing notification profile

To see what values are set for a notification profile, follow these steps.
1. Open a DOS window on the computer that your InfoPrint Manager server is

installed on. On Windows NT® systems, click the Windows Start button and
select Programs → Command Prompt. On Windows 2000 systems, click the
Windows Start button and select Programs → Accessories → Command Prompt.

2. Type this command. Fill in the values for the italicized items as defined below.
pdls -c Type of InfoPrint object -r notification-profile Objectname

Type of InfoPrint object
What type of object you want to perform this command on, not the
specific object. For example, type destination not printer1-ld.

Objectname
The name of the destination or queue that this notification profile refers
to.

3. Press Enter.
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The notification profile will be displayed.

Note: If you have messages about a particular object sent to more than one person,
the notification profile will display multiple entries, one for each person.

Adding or modifying events or users in a notification profile

To add or remove events in the notification profile for a particular delivery
address, or to add another entry to the notification profile so that messages will be
sent to another address as well, do this procedure:
1. Open a DOS window on the computer that your InfoPrint Manager server is

installed on. On Windows NT systems, click the Windows Start button and
select Program —> Command Prompt. On Windows 2000 systems, click the
Windows Start button and select Program —> Accessories —> Command
Prompt.

2. Type the this command. Fill in the values for the italicized items as defined
below.
pdset -c Type of InfoPrint object-x “notification-profile+={event-
identifiers= event(s) delivery-method= method delivery-
address=”address“}” Objectname

Type of InfoPrint object
What type of object you want to perform this command on, not the
specific object. Type destination, queue, job, or server.

event-identifiers
The events that cause InfoPrint Manager to send a message. You can
have messages sent for any of the events that are listed in the
events-supported attribute for the server. See the InfoPrint Manager:
Reference, InfoPrint object attributes chapter, section Attributes for Servers:
events-supported, for a list of these values. Not all events support all
objects. See the Notification events and event classes chapter in the
InfoPrint Manager: Reference for lists of what objects each event supports.

Note: You must type all of the events for this object that you want the
user specified in the delivery address to receive, even if they already
appear in the notification profile. Any events that you do not type will
not be listed in the notification profile.

delivery-method
How you want messages to be sent. See Table 4 on page 21 for
information about the various delivery methods.

delivery-address
Where you want to have messages sent. See Table 4 on page 21 for
information about what kinds of delivery address value to use with
each delivery method. Enclose the value in double quotes.

Note: You cannot specify more than one delivery address here. If you
want another user to receive messages about the same (or different)
events, finish this procedure, then enter the command again with that
user’s delivery address.

Objectname
The name of the destination or queue that this notification profile refers
to.

3. Press Enter.
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4. Repeat the process for other users and objects.

Example

The default notification profile for queues is set to send you messages when the
queue-backlogged, object-cleaned, and object-deleted events occur. You need to
change the notification profile for the print queue printer1-q so that you receive
messages when the queue-no-longer-backlogged and queue-state-changed events
occur as well. Your backup person does not currently receive any messages about
queues, but needs to receive all of the same messages you do.

Issue this command to change your notification profile. Remember to list the
event-identifiers for all of the events that you want this user to receive
notifications about. This list of event-identifiers replaces the existing list entirely.

pdset -c queue -x “notification-profile+={event-identifiers=object-cleaned
object-deleted queue-backlogged queue-no-longer-backlogged
queue-state-changed delivery-address=”administrator@mydesk.office.com“}”
printer1-q

Then, enter this command to have the same queue messages sent to your backup
person.

pdset -c queue -x “notification-profile+={event-identifiers=object-cleaned
object-deleted queue-backlogged queue-no-longer-backlogged
queue-state-changed delivery-address=”backup@hisdesk.office.com“}”
printer1-q

Use the “Viewing an existing notification profile” on page 27 procedure to make
sure the changes took effect.

Removing users from a notification profile

To remove an entire entry from a notification profile, follow this procedure:
1. Open a DOS window on the computer that your InfoPrint Manager server is

installed on. On Windows NT systems, click the Windows Start button and
select Program —> Command Prompt. On Windows 2000 systems, click the
Windows Start button and select Program —> Accessories —> Command
Prompt.

2. Use the “Viewing an existing notification profile” on page 27 procedure to find
the entry you want to remove.

3. Type the following command. Type the correct delivery-method and the
delivery-address exactly as it is displayed for the entry that you want to
remove.
pdset -c Type of InfoPrint object -x "notification-profile-={delivery-
method=electronic-mail or message delivery-address=“address”}"Objectname

4. Press Enter.
5. Use the “Viewing an existing notification profile” on page 27 procedure to

verify that the entry has been removed.
6. Repeat the process for other entries.
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Example

You and two other people currently receive messages about the logical destination
printer1-ld. You don’t want to receive them any longer. You view the notification
profile, and see these three entries:
printer1-ld: notification-profile=

{event-identifiers = object-cleaned object-deleted delivery-method = message
delivery-address = “admin@desk1.office.com” locale = en_US}

{event-identifiers = object-cleaned object-deleted delivery-method = message
delivery-address = “helpdesk@desk2.office.com” locale = en_US}

{event-identifiers = object-cleaned object-deleted delivery-method = message
delivery-address = “backup@desk3.office.com” locale = en_US}

Enter this command to remove your entry from the notification profile.

pdset -c destination -x "notification-profile-={delivery-method=message
delivery-address = “admin@desk1.office.com”}" printer1-ld

Note: If you display the notification profile to verify that the entry has been
removed and find that it has not been removed, enter the command again, but this
time instead of only specifying the delivery-address, type the entire notification
profile exactly as it appears.

Changing the delivery method

You can choose to receive your notification messages in a variety of ways, as listed
in Table 4 on page 21. To change the delivery method from the default to another
value, follow this procedure:
1. Open a DOS window on the computer that your InfoPrint Manager server is

installed on. On Windows 2000 systems, click the Windows Start button and
select Program —> Accessories —> Command Prompt.

2. Use the “Viewing an existing notification profile” on page 27 procedure to find
the entry you want to change.

3. Type the following command. Fill in the values for the italicized items exactly
as they appear in the entry you want to change. Replace the delivery-method
and delivery-address values as specified in Table 4 on page 21.
pdset -c Type of InfoPrint object -x “notification-profile+={event-
identifiers=event(s) delivery-method=method delivery-address=”address“
locale=yourlocale}”Objectname

4. Press Enter.
5. Use the “Viewing an existing notification profile” on page 27 procedure to

verify that the entry was added.
6. Follow the procedure for “Removing users from a notification profile” on page

29 to remove the old entry.

Example

You want to receive your messages about printer1-q in your E-mail instead of
through InfoPrint Manager Notifications. You view the notification profile, and see
this entry:
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printer1-q: notification-profile={event-identifiers = object-cleaned
object-deleted queue-backlogged delivery-method = message delivery-address
= “admin@desk1.office.com” locale = en_US}

Enter this command to add another entry to the notification profile with a different
delivery method and delivery address.

pdset -c queue -x “notification-profile+={event-identifiers=object-cleaned
object-deleted queue-backlogged delivery-method=electronic-mail
delivery-address=”admin@mycompany.com“ locale=en_US}” printer1-q

Then view the notification profile again and see two entries:

printer1-q: notification-profile= {event-identifiers = object-cleaned
object-deleted queue-backlogged delivery-method = message delivery-address
= “admin@desk1.office.com” locale = en_US} {event-identifiers =
object-cleaned object-deleted queue-backlogged delivery-method =
electronic-mail delivery-address = “admin@mycompany.com” locale = en_US}

Follow the procedure for removing a user to delete the entry that would send
messages to InfoPrint Manager Notifications.

Getting help for notification messages

If you receive a notification message that you don’t understand, InfoPrint Manager
provides a way to get more information about the situation. In some cases, the
explanation even suggests some things you can do to resolve the problem.

To see the full text of an error message, open the Management Console and select
Help → Message Help. Type the message code in the fields at the top of the
Message Help dialog, and click OK.

Other notification methods

Notify-operator attribute

The notify-operator attribute is a scaled-down version of a notification profile. It
can only be set on InfoPrint Manager queues and actual destinations and can only
use the e-mail, message, exit and wireless delivery methods. In addition, it only
sends messages when one of these events occur.
1. A job is added to a queue.
2. An actual destination starts processing a job.
3. An actual destination finishes processing a job.

The syntax of the notify-operator attribute is:
delivery-method:delivery-address

Refer to Table 4 on page 21 for descriptions of the e-mail and message delivery
methods and their corresponding delivery addresses. By default, the
notify-operator attribute is set to message:your user ID@your node when you
create an actual destination or a queue. To change the value for an actual
destination, you can use the Notification tab of the properties notebook. To change
the value for a queue, use the pdset command.
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The messages that the notify-operator attribute delivers are not standard error
messages like the ones you receive when you use a full notification profile. Instead,
you write the messages that you want to send and specify them as attributes of
jobs when you submit them.

Note: You must either specify those attributes in the command when you submit
the job or set the text in the job and document defaults for the appropriate logical
destination.
The job attributes that you use to specify these messages are the following.
v job-message-to-operator

The message that InfoPrint Manager sends when it adds a job to the queue.
v job-start-message

The message that InfoPrint Manager sends when the job starts processing.
v job-end-message

The message that InfoPrint Manager sends when the job finishes processing.

You can type the text for all three of these messages in the appropriate field on the
Job Notification tab of the properties notebook for a job or a default job.

In addition, you can use the job-start-message attribute in conjunction with the
job-start-wait attribute. If you set the job-start-wait attribute on a job (or in a
default job) to true, the actual destination receives the job and sends the job-start
message. Then, it pauses the actual destination (whether or not a job is currently
being printed) until the operator intervenes. This function is useful when different
jobs need to be printed on different types of paper. Operators don’t need to
manually pause the actual destination to change paper between jobs; InfoPrint
Manager does it automatically. Once the printer is ready, the operator must resume
the actual destination and the job prints. This function should be set for the first in
a series of jobs, once you are certain that there are no jobs printing on the printer.
Because it compels InfoPrint Manager to pause the printer for every job with
job-start-wait=true, you should not specify this value on the default job.

To use the job-start-wait attribute, you must set it to yes on the job or default job.
You can specify the attribute in the command when you submit a print job or set it
on the Job Notification tab of the properties notebook for default jobs.
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Chapter 8. Managing security

InfoPrint Manager security is a feature that you administer through the InfoPrint
Manager Management Console. It lets you protect your printing system by
associating an Access Control List (ACL) with an InfoPrint object or operation. An
ACL is the list of users and groups who have permission to do something to or
with an object, and what type of permission that is.

Important: InfoPrint Manager Security references the login ID of the current user
to determine who is attempting to perform an action. Otherwise, the InfoPrint
Manager security system is entirely separate from any Windows security you have
set. For example, you cannot use groups that you create with the Windows User
Manager in InfoPrint Manager Security- you must create security groups using the
InfoPrint Manager Management Console.

If you do not want to use InfoPrint Manager Security, you can turn it off using the
server properties notebook in the InfoPrint Manager Administration GUI by setting
the Security level for your server to none.

Types of permission
In InfoPrint Manager, users can have three levels of permission: read, write, and
delete. The levels provide these types of access.
v Read- For operations, the user can perform the operation. For servers and

queues, the user can view the attributes. For destinations, the user can view
attributes and submit jobs to that destination.

v Write- For all objects, the user can modify attributes.
v Delete- For all objects, the user can delete the object.

Note: The levels of permission are not cumulative. If you give a user delete
permission only, he will not automatically have read and write permissions. Be
sure to mark all of the levels of permission that the user needs.

If you place user A on the ACL for the logical destination ″print2ld″ and give her
read permission, she can send her print jobs to it and can open the “print2ld”
object to see its properties. However, she cannot make changes to those properties.
If she tried to change any of them or tried to delete the destination, she would
receive an error message. If you decide that user A needs to be able to do more
and give her write permission as well, she will be able to change the properties of
“print2ld,” but still will not be able to delete it.

Important: If you protect a destination (logical or actual) so that only certain users
can modify or delete its properties, you might inadvertently prevent other users
from submitting print jobs to it. To be sure that all of your users can still print to
the destination, add the wildcard character (*) to the ACL as a user with read
permission.

You can also attach ACLs to the operations that you can perform on InfoPrint
objects. Allowing you to protect both operations and objects means that InfoPrint
Manager Security provides different levels of security: you can protect all objects
by using ACLs at the operation level or you can protect individual objects with
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ACLs applied only to them. Or you can do both: protect all objects by using
operation-level ACLs for some operations, and limit access to subsets of objects by
using object-level ACLs.

For operations, there is only one level of permission: read. If a user has read
permission, he can perform that action; if he does not, he cannot perform the
action. For example, user B is a printer operator and must be able to move jobs to
different positions in the print queue because some jobs need to be printed before
others. You can give user B read permission for the operation Reorder Job to allow
him to do his job. On the other hand, user C submits print jobs from his office
workstation and doesn’t like to wait for the jobs ahead of his in the queue to print.
To prevent him from moving jobs, don’t put him on the ACL for the Reorder Job
operation. When he tries to move his job to the top of the queue, the action will be
denied.

When you install InfoPrint Manager, many operations are already protected so that
only members of the admin and oper groups can perform them. You can see the
ACLs for operations in the Management Console by selecting the
Security-ACL-Operations item in the left pane. If you want users to be able to
perform those operations, you must either add those users to the individual ACLs
or to a group that has permission (either the existing admin and oper groups or a
new group that you create).

Note: If an object is protected, a user can only perform an operation on that object
if he has both read permission for the operation and the appropriate level of
permission for the object (for example, a job or a printer).
v If the object is not protected, any user with read permission on an operation can

perform that operation.
v If the object is protected, the permission needed depends on the operation. For

example: List requires read permission on the object, Set requires write
permission, and Delete requires delete permission.

By default, InfoPrint objects (destinations, queues, servers) are not protected,
members of the admin group have read permission on all operations, members of
the oper group have read permission on most operations, and all users have read
permission on five operations. Those five operations are:
v List/Query (all objects)
v Print

v Modify job

v Query job

v Remove job (delete job)

However, users who are not members of the admin and oper groups can only
modify and remove jobs that they submitted. In addition, if the ACL for the
Reorder job action is changed so that everyone can use it, users who are not
members of the admin and oper groups will only be able to reorder jobs that they
submitted. By default, members of the admin and oper groups can do all six of
those operations on all jobs.

Note: If you decide to protect your queues, all users will still be able to perform
the tasks listed above on their own jobs. Users who are on the ACL for a queue
will be able to perform those tasks on all jobs in that queue.
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Security groups
No matter what size organization you work in, manually adding every user to
every ACL can be a time-consuming process. To reduce some of the work, you can
create security groups, groups of users who need to have the same levels of
permission for the same objects. You use the name of the security group like a user
ID; instead of adding each user ID to an ACL, you add the group name. For
example, if you want all of your help desk operators to be able to perform the
same operations, create a group and name it helpdesk. Then, add helpdesk to the
appropriate ACLs.

Important: User IDs and group names are case-sensitive.

When you install InfoPrint Manager, three security groups are created by default:
v acl_admin- Users who have authority to manage security by changing access

control lists and groups. The default members are Administrator@* and the user
who was logged on when InfoPrint Manager was installed (for example,
myuserid@*).

v admin- Users who have administrator authority. The default members are
Administrator@* and the user who was logged on when InfoPrint Manager was
installed (for example, myuserid@*).

v oper- Users who have operator authority. The default member is
Administrator@*.

Note:

1. If you have installed InfoPrint Job Ticketer as part of the Print-on-Demand
feature, the Job Ticketer group is created. Unlike the other groups, there are
no default users created during installation. See InfoPrint Job Ticketer:
Administrator’s Guide for more information.

2. You can modify these groups as needed. In the example above, you could
have simply added the help desk operators to the default oper group and
modified any permissions that weren’t set to the level that you wanted them.

3. The default group members contain the wildcard character (*) for greater
flexibility. See below for more information about wildcarding. If you don’t
want the Administrator user on other systems to be able to administer
InfoPrint Manager, replace the * with the explicit address of the system that
the InfoPrint Manager server is installed on, for example
Administrator@serversystem.company.com.

You can add users to multiple groups, but you cannot make one group a member
of another group. For example, if you hire five new print operators, you might
create a group for them called trainees, since you only want them to have limited
permissions until they are finished with their training. When they finish their
training, you cannot add trainees as a member of the operators group. You will
have to add their user IDs to the operators group one at a time. In addition, you
will have to either delete the trainees group or delete the members from it—
otherwise those users will have conflicting levels of permission.

When users are members of more than one group and each group has a different
level of permission for a particular object, the most restrictive permission applies.
In the example above, if you forgot to remove the new employees from the
trainees group at the end of their training, they wouldn’t be able to perform the
tasks their job required- they would still be restricted.
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Identifying users and groups: wildcarding
When you add users to ACLs or Security groups, you identify them by their user
ID and the computer that they work on in this format: username@computername.
The permissions you assign will only apply when that person accesses InfoPrint
Manager from that workstation.

Note: The computername that you specify must be the fully qualified name of the
workstation, for example: joescomputer.infoprint.com

If, however, you or any of your users want to be able to work with InfoPrint
Manager objects from various workstations, you might not want to add multiple
user ID/computer name combinations for the same person— you can use
wildcarding instead. When you use wildcarding, you replace the computer name
or user ID with the wildcard character (*) when you add a member to an ACL or
Security Group. The wildcard character stands for “any computer” or “any user
ID.” So, if you create an ACL member called Administrator@*, no matter what
computer you log on to as Administrator, you have the same permissions. If you
use the wildcard character before the computer name, for example *@computer1,
any user who logs on to computer1 can perform the actions that the ACL member
has permission for.

Working with ACLs and groups

Use the InfoPrint Manager Management Console to manage the security of your
print system. Open the Security folder in the left pane of the Management Console
to display the Access Control Lists folder and Groups object. Open the Access
Control Lists folder to see the types of ACLs that exist. Click the type of ACL
(Operations, Destinations, Servers, or Queues) to display the ACLs that exist.
Click Groups to see the groups that currently exist and their members.

For more detailed information about using the Management Console to work with
groups and ACLs, see the online help (in the Management Console, click Help ->
Contents, and look on the Contents tab under Managing Security).
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Chapter 9. Customizing error logs in the InfoPrint Manager
Windows server

InfoPrint Manager provides three configuration files for various InfoPrint Manager
servers and processes:
1. spl_error.cfg for the InfoPrint Manager server error log.
2. notifyd_error.cfg for the Notification server error log.
3. sap_error.cfg for all the SAP Callback processes.

To customize error logs for one of these servers or processes to control their size,
whether they wrap, the severity level of messages written to the logs, and the
number of back-up logs that InfoPrint Manager saves, you must perform one of
the procedures in the next section.

Customizing an InfoPrint Manager server error log

By default, the InfoPrint Manager server error log starts when the InfoPrint
Manager server starts. Use this procedure to customize the InfoPrint Manager
server error log.
1. Find the spl_error.cfg file in the bin directory that is under the directory where

InfoPrint Manager is installed (the default is C:\Program Files\IBM\Infoprint
Manager).

2. Copy the spl_error.cfg file into the workspace_path directory.
The workspace_path is specified on the Workspace path field. From the InfoPrint
Manager Management Console, click Edit → Service Configuration path to
verify the setting of the Workspace path field. For these examples,
workspace_path signifies the fully qualified path where the error log is in, such
as C:\Program Files\IBM\Infoprint Manager\var\pd.

Note: If you already customize your server error logs, remember to change the
name or move the current spl_error.cfg file in workspace_path so that your
customization values can be copied over into the newer version of the file.

3. Open a copy of the spl_error.cfg file in the workspace_path directory and edit it
to specify the settings for the log attributes that you want (as shown in Figure 1
on page 38).
For example, you can modify the log-backup-number attribute, which lets you
specify the number of backup logs that InfoPrint saves, including the initial
error.log.BAK file. Before this attribute was added to the product, an unlimited
number of logs were saved.
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When you start the InfoPrint Manager server after a shutdown, it backs up the
first error log by creating an error.log.BAK file. With each successive restart, it
creates an additional .BAK file, adding a timestamp as a fourth qualifier. By
default, the log-backup-number attribute specifies a value of 10, meaning that
you can have nine back up files with timestamps and the initial .BAK file. You
can reduce this number as low as 1 or increase it as high as 999.
For a complete list of the error log attributes that you can customize, see the
InfoPrint Manager: Reference ″Attributes for logs″ topic in ″Chapter 3. InfoPrint
object attributes.″

4. Once you have finished defining your options, save and close the file.

Note: If you do not need the customization change to take effect immediately,
you can skip the final two steps and just wait until the next time the InfoPrint
Manager server is restarted.

5. To shut down the server from the Management Console, specify File → Stop
server.

6. To restart the server from the Management Console, specify File → Start server.

Customizing a Notification server error log

By default, the Notification server error log starts when the Notification server
starts. Use this procedure to customize the InfoPrint Notification server error log.
1. Find the notifyd_error.cfg file in the bin directory that is under the directory

where the file is installed.
2. Copy it to the workspace_path directory.

The workspace_path is specified on the Workspace path field. From the InfoPrint
Manager Management Console, click Edit → Service Configuration path to
verify the setting of the Workspace path field. For these examples,
workspace_path signifies the fully qualified path where the error log is in, such
as C:\Program Files\IBM\Infoprint Manager\var\pd.

Note: If you already customize your Notification server error log, remember to
change the name or move the current notifyd_error.cfg file in workspace_path so
that your customization values can be copied over into the newer version of
the file.

3. From the workspace_path directory, edit the notifyd_error.cfg file to specify the
settings for the log attributes that you want (as shown in Figure 2 on page 39).
For example, you can modify the log-backup-number attribute, which lets you
specify the number of backup logs that InfoPrint saves, including the initial
error.log.BAK file. Before the log-backup-number attribute was added,

#
# ErrorLog Configuration File
#
# Log size (units = KBytes)
log-size = 1024
# Wrap On?
log-wrap = true
# Severity?
log-severity = debug
# Number of backup log files
log-backup-number = 10

Figure 1. Sample spl_error.cfg file provided by InfoPrint Manager
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InfoPrint Manager for Windows only saved one backup error log.

When you start the InfoPrint Manager server after a shutdown, it backs up the
first error log by creating an error.log.BAK file. With each successive restart, it
creates an additional .BAK file, adding a timestamp as a fourth qualifier. By
default, the log-backup-number attribute specifies a value of 10, meaning that
you can have nine back up files with timestamps and the initial .BAK file. You
can reduce this number as low as 1 or increase it as high as 999.
For a complete list of the error log attributes that you can customize, see the
InfoPrint Manager: Reference ″Attributes for logs″ topic in ″Chapter 3. InfoPrint
object attributes.″

4. Once you have finished defining your options, save and close the file.

Note: If you do not need the customization change to take effect immediately,
you can skip the final two steps and just wait until the next time the InfoPrint
Manager server is restarted.

5. To stop the Notification server on an InfoPrint Windows server:
a. Click Start → Settings → Control Panel → Services.
b. Highlight InfoPrint Manager Notification and click Stop.

6. To restart the Notification server on an InfoPrint Windows server:
a. Click Start → Settings → Control Panel → Services.
b. Highlight InfoPrint Manager Notification and click Start.

#
# Error Log Configuration File
#
log-size = 1024
log-wrap = true
log-severity = debug
log-backup-number = 10

Figure 2. Sample notifyd_error.cfg file provided by InfoPrint Manager
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Chapter 10. Monitoring disk use

InfoPrint Manager includes support to help you monitor disk usage. The InfoPrint
Manager server polls critical disks at regularly scheduled intervals, and it increases
the polling as the usage increases. Initially, the disk is polled for usage every 16
minutes.

Here is the polling schedule:
80% Every 8 minutes
90% Every 4 minutes
95% Every 2 minutes
97.5% Every minute

If the usage for a disk goes above the InfoPrint Manager pre-defined threshold of
80%, InfoPrint Manager logs a message and generates a disk-space-low event. As
usage increases above the 80% threshold, more messages and disk-space-low
events are logged and generated.

Each time usages goes above the 80, 90, 95, and 97.5 percent usage levels, the
disk-space-low event is generated and logged. However, InfoPrint Manager only
issues one event for each usage level. Figure 3 illustrates the algorithm used to
monitor disk usage.

Note: The threshold is reset if the disk usage drops below the previous threshold;
for example, when the disk usage drops to 70% after an 80% disk-space-low event,
it is reset.

Figure 3. Disk usage algorithm
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Adjusting your server notification profile for disk usage
The InfoPrint Manager server notification profile uses the out-of-disk-space event
as the default, so that when your disk usage reaches 100%, this event is generated.
You can modify the server notification profile to add the disk-space-low event.
However, the messages from the disk usage monitoring are always logged;
regardless of the events in the server notification profile. It is recommended that
you include both the disk-space-low and out-of-disk-space events in your
notification profiles.

Disks monitored by InfoPrint Manager
InfoPrint Manager for Windows monitors these paths (as shown in the
Management Console → Service Configuration) that point to subdirectories where
InfoPrint Manager is installed:
v Install path

v Base namespace path

v Workspace path

v AFP support workspace path
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Chapter 11. Administering your InfoPrint Manager server
using a Windows Terminal Server client

While you can do most administrative tasks using the InfoPrint Manager
Administration GUI, there are a few that you must do using the Management
Console. However, since the Management Console must reside on the system that
your InfoPrint Manager server is installed on, performing those tasks can be
inconvenient. The only way to perform administrative tasks on the Management
Console on a different system is to use a Windows Terminal Server. If you use
Windows 2000, Terminal Server capabilities are included in Windows 2000 Server.
Therefore, you must install your InfoPrint Manager server on a Windows 2000
Server system, not a Windows 2000 Professional system.

Once you have InfoPrint Manager installed on the correct version of Windows, you
need to install the Terminal Server Client on any other systems that you want to be
able to access the Management Console from. You can install the client on one of
these systems:
v Windows 2000 Server SP4
v Windows Server 2003 Standard Edition
v Windows Server 2003 R2 Standard Edition SP2
v Windows Server 2003 Enterprise Edition SP2
v Windows Server 2003 R2 Enterprise Edition SP2
v Windows Server 2008 Standard Edition

Use the “Installing the Windows Terminal Server client” procedure to create
installation disks and install the client.

Installing the Windows Terminal Server client

To complete this procedure, you need two blank floppy disks.

For Windows 2000/2003 Server:

1. Log on to the system that your InfoPrint Manager server is installed on.
2. On Windows Server, click Start → Programs → Administrative Tools →

Terminal Services Client Creator.
3. Select Terminal Services for 32–bit x86 Windows and check the Format

disk(s) check box. Click OK.
4. Follow the instructions in the pop-up dialogs to create your Terminal Services

Client installation disks.

Note: Save these disks. You will need them if you ever need to uninstall the
client.

5. Close the dialog once the disks are created.
6. Log on to the machine that you want to install the Terminal Services Client

on.
7. Insert the first Terminal Services Client installation disk in the drive.
8. Navigate to that disk drive and double click Setup.exe to start the Terminal

Server/Services Client Setup wizard.
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9. Follow the instructions in the wizard to install the client.
When you finish the wizard, Terminal Server/Services Client will be added to
your Start menu.

10. Start the client by selecting Start → Programs → Terminal Services Client →
Terminal Services Client.

11. Find the name of the server that your InfoPrint Manager server is installed on
and connect to it.
Once you are connected, you can open the Management Console and use it
just as you would on the server system itself.
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Chapter 12. Changing the server hostname and IP address

Use this procedure to change the hostname of the system that your InfoPrint
Manager server runs on.

Note:

1. If you have changed the hostname/IP address on the system and already
restarted the system, the InfoPrint Manager service will not be able to start and
your InfoPrint GUIs will not function properly. Complete the “Changing the
server hostname and IP address” task to correct the problem.

2. If the system that your InfoPrint Manager server runs on is part of a domain,
remove it from the domain before you do this procedure. Complete the
“Changing the server hostname and IP address” task before you add the
system to the domain again.

3. For multi-server environments:

v If you are changing the hostname/IP address on the namespace system, you
must stop all of the non-namespace servers and un-map all of the network
drives that you have mapped to the namespace system before you start the
procedure below. After you complete the procedure below, re-map the
network drives. Then, use the Management Console (Edit → Service
Configuration) on each of the non-namespace servers to change the Base
namespace path and Remote namespace folder to the new hostname and
restart the non-namespace servers.

v If you are changing the hostname of a InfoPrint Manager non-namespace
server (running on Windows 2000 or 2003) that shares a namespace with
InfoPrint Manager for AIX (with the namespace on an AIX system), follow
the “Changing the hostname of a non-namespace server” on page 46
procedure.

Changing the server hostname and IP address
1. If your InfoPrint Manager server is running, stop it by selecting File → Stop

Server in the Management Console.

Notes: If you changed the hostname on the system and already restarted the
system, your InfoPrint Manager server will already be stopped.

2. If you use InfoPrint Manager Security and have changed the member names of
the acl_admin group so they include the hostname, follow these steps:
v In the left pane of the Management Console, open the Security folder and

click Groups.
v In the right pane, check to see if any of the member names in the acl_admin

group include the hostname.
v Edit any user IDs in the acl_admin group that contain the old hostname by

replacing the hostname with the wildcard character (*), so you will still be
able to administer InfoPrint Manager Security after the hostname is changed.

v Make note of the members that you change so you can replace the wildcard
with the new hostname once it is set.

3. Change the hostname/IP address using Windows interfaces. When the system
asks, choose not to restart the system.
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Note: If you have already changed the hostname/IP address of your system,
you do not have to change them again. Continue with step 4.

4. In the Management Console, click Edit → Changed Hostname.
5. In the Changed Hostname dialog, enter the new hostname. Names are

case-sensitive. Make sure the new hostname that you type exactly matches the
one on your Windows system and click OK.

6. When the system asks, restart the system so the changes take effect.
7. Update all of the client systems that communicated with the server using the

old hostname/IP address to use the new one, including:
v InfoPrint Select clients
v InfoPrint Manager Administration GUI
v InfoPrint Manager Operations GUI
v Windows gateway printers
v IPP Gateway clients
v InfoPrint Manager Notifications clients

8. Update any InfoPrint Manager Security ACLs or groups that reference IDs
using the old hostname. In addition, if you changed any members of the
acl_admin group in step 2, change the wildcard character to the new hostname.

Changing the hostname of a non-namespace server

Follow this procedure only if you are running both InfoPrint Manager for AIX and
InfoPrint Manager for Windows as interoperating print servers and need to change
the hostname of the system that InfoPrint Manager for Windows is running on.
1. Complete “Changing the server hostname and IP address” on page 45 on the

non-namespace server. At the end of the procedure, the InfoPrint Manager for
Windows server should be stopped and can no longer access the namespace
on the AIX machine.

2. On the system that InfoPrint Manager for Windows runs on, disconnect the
network drive that was mapped to the namespace on the AIX machine.

3. Log on to AIX server machine as root.
4. Follow this path: Smitty → InfoPrint Printing System → InfoPrint Utilities →

Configure Secondary Servers (NFS) → Link from Primary Server to
Secondary Server

5. In the dialog that appears:
a. Type the new hostname in the Secondary Server Host Name field.
b. Type the new server IP address in the Secondary Server IP Address field.
c. For Is /ipdata used for job ticketing? answer:
v Yes if you use /ipdata with InfoPrint Submit.
v No if you do not.

d. For Retain secondary servers previously defined? answer Yes.
6. On the Windows server machine, remap the network drive to the

\\aixserver\var\pddir\default_cell filesystem using the same drive letter that
you used for the network drive that you disconnected in step 2. Map the
drive using the same user id and password that you used during the initial
multiserver environment setup.

7. Log on to the AIX server machine as root.
8. Stop the InfoPrint Manager for AIX server.
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9. Clear the namespace by issuing the clrfstns /var/pddir/default_cell
command.

10. Create the shared namespace by issuing the crtfstns /var/pddir/default_cell
command.

11. Start the InfoPrint Manager for AIX server.
12. Start the InfoPrint Manager for Windows non-namespace server.

Changing only the server IP address

If you are only changing the IP address and you have updated your system name
resolution so that the old name resolves to the new IP address, InfoPrint Manager
will be reset to use the new IP address with the old hostname when you restart the
system. If any of your InfoPrint clients refer to InfoPrint Manager using the IP
address, you must update them so they use the new IP address.
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Chapter 13. Setting up your InfoPrint Manager server to use
resources on a different Windows system

Sometimes, users choose to store printing resources (such as pagedefs, formdefs,
and fonts) on systems other than the one that their InfoPrint Manager server runs
on. If you choose that setup, you must first make sure that InfoPrint Manager has
access to the resources, then tell InfoPrint Manager where the resources are located.
Use these procedures to complete these tasks.
1. “Giving InfoPrint Manager access to remote resources”
2. “Telling InfoPrint Manager where your remote resources are located” on page

51

Giving InfoPrint Manager access to remote resources

Follow “Using Windows 2000/2003” to set up access to remote resources.

Note: Both of your systems must be running on the same operating system. You
cannot mix Windows operating systems in this environment. The systems should
also operate in the same domain.

Using Windows 2000/2003
1. Set up a domain user account that your InfoPrint Manager server will run

under.

a. Log on to the domain that your InfoPrint Manager servers operate in as a
domain administrator.

b. Click the Windows Start button and select Programs → Administrative
Tools → Active Directory Users and Computers.

c. In the left pane of the Active Directory Users and Computers window, find
the Users directory.

d. Right-click the Users directory and select New → User from the pop-up
menu.

e. In the first dialog of the New Object – User wizard, type a name for this
user in the Full name and the User logon name fields.

Note: You do not have to fill in the other name fields.
f. Click Next.
g. In the second dialog of the New Object – User wizard, enter a password for

this user. Clear all of the check boxes, then select Password never expires
(so you don’t have to change the password and update all of your servers
on a regular basis).

h. Click Next to verify the settings for the user and complete the wizard.
i. Once you have created the user, right-click the user in the right pane of the

Active Directory Users and Computers window and select Add members to
a group from the pop-up menu.

j. In the Select Group dialog, find and select the Domain Administrators (or
Domain Admins) group. Click OK to add your user to the group.

Note: You can leave the Name field blank.
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2. Grant the appropriate user rights to the new domain user on the system that
your InfoPrint Manager server runs on.

a. Log on to the system as a user who is a member of the Domain
Administrators group.

b. Click the Windows Start button and select Settings → Control Panel.
c. In the Control Panel window, double-click Administrative Tools.
d. In the Administrative Tools window, double-click Local Security Policy.
e. In the right pane of the Local Security Settings window, double-click Local

policies.
f. Double-click User Rights Assignment in the right pane.
g. In the list of user rights, select Act as part of the operating system and

double-click it.
h. In the Local Security Policy Setting dialog, click Add.
i. In the Select Users or Groups dialog, click the arrow on the drop-down list

box and select the domain that your InfoPrint Manager servers exist in.
j. Find and select the domain user you created and click Add.
k. Click OK in the Select Users or Groups dialog.
l. Click OK in the Local Security Policy Setting dialog.
m. Repeat from step 2g for two other user rights: Create permanent shared

objects and Log on as a service.
3. Set up the InfoPrint Manager server to use the new user account.

a. Click the Windows Start button and select Programs → InfoPrint Manager →
Management Console.

b. Stop the InfoPrint Manager server by selecting File → Stop Server.

Note: If you are not able to stop the server because you are not authorized
for that action, check the InfoPrint Manager Access Control List (ACL) for
the Shutdown operation. Log off and log back on as a user who is on the
access control list.

c. Select Edit → Service Account/Domain.
d. Enter the name of the domain that the InfoPrint Manager server is installed

in and the user name and password from step 1 on page 49
e. Click OK.

4. On the machine where the AFP resources reside, share the directory that the
resources reside in so the domain user has access to it.

a. Log on to the system that your resources reside on as a user who is a
member of the Administrators group.

b. Open Windows Explorer and navigate to the directory that your resources
are stored in.

c. Right-click the folder and select Properties from the pop-up menu.
d. In the Properties dialog, click Security.
e. If Domain Admins is not in the Name list, click Add.
f. In the Select Users, Computers, or Groups dialog, select the correct domain

from the Look in drop-down list.
g. Select Domain Admins in the Name list and click Add. You might also

want to add the local administrators group as well.
h. Click OK.
i. In the Properties dialog, make sure that Full Control is allowed for Domain

Admins in the Permissions box.
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Note: You might want change the access level for the Everyone group as
well.

j. Click Sharing.
k. Select Share this folder. Verify the name of the folder in the Share name

field and type a descriptive comment in the Comment field.
l. Click OK.
m. Return to the Management Console on the system that InfoPrint Manager

is installed on and click File → Start Server to restart the InfoPrint Manager
server.

Preparing for shared resources with MVS Download

If you are running InfoPrint Manager on Windows 2000, 2003, or XP and will be
using MVS Download multiple data set support, you must perform an additional
task to share resources on a network drive:
1. Click the Windows Start button and select Settings → Control Panel →

Administrative Tools → Services.

2. Select InfoPrint Manager MVS Download.
3. On the InfoPrint Manager MVS Download Properties (Local Computer)

dialog, click Log On, and click This account.
4. Enter the account information for the same user you authorized in step 1 on

page 49.
5. Click OK.

Note: This procedure uses screen captures from Windows 2000. The screens are
very similar to this on Windows 2003 and XP.

Telling InfoPrint Manager where your remote resources are located

Once you have made the resources available, you have to make sure the InfoPrint
Manager destinations that will be using them know where they are. To complete
this configuration:
1. On the system that InfoPrint Manager runs on, map a network drive to the

directory that your resources reside in.
a. Open Windows Explorer.
b. Click Tools → Map Network Drive.
c. Specify the user and password to use.

Windows 2000

1) In the Map Network Drive dialog, select a drive letter that you are not
currently using from the drop-down menu in the Drive field.

2) In the Folder field, type the Universal Naming Convention (UNC) name
of the directory you shared on the system that your resources are stored
on server in this format: \\resourcesystem\sharename.

3) Select Reconnect at logon.
4) Click Connect using a different user name.
5) In the Connect As dialog, type the user name and password that you

created in step 1 on page 49.
6) Click OK in the Connect As dialog.
7) Click Finish in the Map Network Drive dialog.
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2. Start the InfoPrint Administration GUI.
3. Select one of the printers that needs to access these resources and right-click it.
4. Select Properties from the pop-up menu.
5. In the Properties notebook for this printer, click AFP Resources.
6. Find the correct field for your situation. For example, if your directory only

holds fonts, find the Location of fonts field; if it holds only overlays, find the
Location of overlays field. However, if the directory holds a variety of
resources, find the Location of resources field.

7. In the correct field, type the letter of the drive you mapped in step 1c on page
51 and the share name of the directory that contains the resources. For example:
x:\afpresources.

8. Click OK to close the properties notebook and make the settings take effect.
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Chapter 14. Working with SNMP printers

About SNMP communication
For network printers that work with Simple Network Management Protocol
(SNMP) and the standard printer management information block (MIB) RFC 1759,
the InfoPrint Manager server can use SNMP to automatically:
v Set the default of several InfoPrint Manager actual destination attributes in the

printer to the values returned in the standard printer MIB. The actual
destination attributes pertain to trays, media, bins, plexes, and sides. This
process is called smart–defaulting the attributes.

v Detect, report, and recover from printer problems for several conditions, even if
no jobs are currently being printed.

v Assess device specific information directly.
v Execute device commands directly on the device.

Smart-defaulting actual destination attributes

The InfoPrint Manager server can automatically smart-default an actual destination
attribute for an SNMP printer only if an InfoPrint Manager user does one of these:
v Does not explicitly set the attribute when creating or modifying the actual

destination
v Resets the attribute to the InfoPrint Manager default

Before you create the actual destination and let the server smart-default one or
more actual destination attributes for a printer, IBM® recommends that you:
1. Turn the printer on.
2. Make sure the printer is connected to the network.

The actual destination attributes that the server can smart-default are:
v destination-model

v input-trays-medium (also smart-defaults the attributes input-trays-supported
and media-ready)

v media-ready

v media-supported

v output-bin-numbers (also smart-defaults the attribute output-bins-supported)
v plexes-supported

v psf-tray-characteristics (also smart-defaults the attributes input-trays-supported
and media-ready)

v sides-supported

For media, smart-defaulting only detects the size of the medium. If you have
different media that are the same size (for example, three different letter-size
preprinted forms) and you need to differentiate between them in the attributes,
you must explicitly set the attributes instead of using smart–defaulting.
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Detecting, reporting, and recovering from printer problems
The InfoPrint Manager server can automatically detect, report, and recover from
printer problems for several needs key operator and needs attention conditions as
it periodically queries an SNMP printer, even if no jobs are currently being printed.
(To turn off automatic recovery, a key operator can manually disable the actual
destination.)

For example, the server detects that a printer is out of toner, disables the actual
destination, requeues the jobs, and sets the actual destination state to needs
attention or needs key operator. Then, when a key operator replaces the toner, the
server detects that the printer is running again, sets the actual destination state to
idle, and re-enables the actual destination.

Besides automatically managing the state of the actual destination, the InfoPrint
Manager server also updates its problem-message, warning-message, and
snmp-device-conditions attributes and sends out printer-needs-attention and
printer-needs-key-operator notifications. The actual destination’s state, which
message attribute is updated, and what type of notification is sent depends on the
severity of the condition reported by the printer, such as error, warning, or report.

This is the list of SNMP printer conditions that InfoPrint Manager reports:
v Cover open
v Input tray empty
v Interlock open
v Media empty
v Media missing
v Offline
v Paper jam
v Power off
v Service requested
v Fuser over temp
v Input tray missing
v Marker supply empty
v Marker supply missing
v Marker waste full
v Output bin full
v Output bin missing
v Fuser under temp
v Marker supply low
v Marker waste almost full
v Media low
v Moving offline
v Moving online
v Output bin near full
v Warmup

Note: Not all printers report all these conditions. For example, most printers do
not report the Warning conditions.

The same condition can be reported with a different severity depending on the
situation. For example, a printer might report an input tray empty condition as an
error or a warning. It could be a warning if the printer had multiple input trays
linked together with the same media and only one of them is empty. If a condition
is reported as an error, InfoPrint Manager reports these conditions as
needs-key-operator as opposed to needs-attention:
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v fuser-over-temp
v fuser-under-temp
v marker-supply-empty
v marker-supply-low
v marker-supply-missing
v marker-waste-full
v marker-waste-almost-full
v media-missing
v output-bin-missing
v service-requested
v warmup

Regardless of the severity, InfoPrint Manager lists all conditions on the
snmp-device-conditions attribute.

Accessing device information

You can use the InfoPrint Manager Administration GUI or the pdls command to
access information about SNMP devices.

Besides providing information about the actual destination object, InfoPrint
Manager allows you to access information directly from the printer. InfoPrint
Manager uses device-specific attributes to provide this function. While
device-specific actual destination attributes are accessed through an actual
destination, the information comes from the physical printer. The device-specific
attributes are not returned when you ask for all the actual destination’s attributes.
You have to request the device-specific attributes specifically or you can use -r
all-device to query all the device-specific attributes.

This is the list of non-settable device-specific actual destination attributes:
v device-description
v device-input-trays
v device-ip-address
v device-manufacturer
v device-marker-supplies
v device-media-supported
v device-model
v device-op-panel-locked
v device-output-bins
v device-printer-name
v device-ready-media
v device-serial-number
v device-state
v device-version

This is the list of settable device-specific actual destination attributes:
v device-contact
v device-location

Note:

1. Not all printers report all these attributes.
2. The information returned is not translated.

The InfoPrint Manager Administration Interface can launch a Status window that
displays information returned from SNMP. The window lets you see a detailed
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view of the status of an SNMP printer. It includes a graphic representation of the
printer and its current status, such as whether it has a paper jam or a door open.

To see the Status window from the InfoPrint Manager Administration Interface:
1. Select an SNMP printer.
2. Click Check Status.
3. Click More Information.

You can use the pdls command to access SNMP device information with the -r
flag, such as output-bins, like this:
pdls -c destination -r device-output-bins prt5-ad

Note: You can filter for specific device information with the -f flag.

You can also use the pdls command to access all the information for an SNMP
device by specifying the -r flag with the all-device value.

For more information about the pdls command, see the “InfoPrint Manager Tools”
chapter in the InfoPrint Manager: Reference.

Changing device information

You can use the InfoPrint Manager Administration GUI, the pddeviceop command,
and the pdset command to change information for SNMP devices.

The value of the snmp-active actual destination attribute must be true and the
printer device associated with the actual destination must support the operation.
You must have write permission to the actual destination, and
smnp-write-community-name actual destination attribute must be set properly for
the pddeviceop command or GUI commands to work.

From the Device Information window in the InfoPrint Manager Administration
GUI, you can reset the specific device, take it offline, or put it online. You can also
change the contact or location information.

You use the pddeviceop command to reset a specific device, take it offline, put it
online, as well as lock and unlock the operation panel for the specific device.

You can use the pdset command or the InfoPrint Manager Administration GUI to
change the contact or location information for SNMP devices.

Note: You cannot combine setting device-specific and actual destination attrributes
in the same pdset command.

For more information about the pddeviceop and pdset commands, see the
“InfoPrint Manager Tools” in the InfoPrint Manager: Reference.

Setting up and using SNMP

To set up and use SNMP with InfoPrint Manager, you must check and set the
appropriate InfoPrint Manager attributes when you create or modify the physical
printer in InfoPrint Manager.

This section explains:
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v Determining if a printer works with SNMP
v Using the InfoPrint Manager Administration Interface
v Procedures

Determining if a printer works with SNMP

Not all printers work with SNMP and the standard MIB. In addition, only printers
that are attached to a network can work with SNMP. Printers that are
parallel-attached or channel-attached cannot use SNMP.

To determine if a printer works with SNMP:
1. Set the actual destination attribute destination-tcpip-internet-address to the IP

address of the printer to indicate that InfoPrint Manager should try to
communicate with the printer using SNMP. The server sets the actual
destination attribute use-snmp to “true”.

Note: For PSF TCP-IP attached printers, a destination TCP-IP port number of
5002 must be used when driving the second engine in an InfoPrint 4000 or
InfoPrint 4100 dual simplex configuration for SNMP support to work. If 5002 is
used for a printer other than one using SNMP, the actual destination for that
printer will not work. The server will set the actual destination attribute
use-snmp to ″false″.

2. If the server cannot communicate with the printer using SNMP, it pings the
printer. If the ping command:
v Works, the server concludes that the printer is not an SNMP printer. It sets

use-snmp to “false”.
v Does not work, the server concludes that the printer is turned off or is not

currently connected to the network. It leaves use-snmp set to “true” and
continues trying to establish an SNMP connection with the printer.

3. Check the actual destination attribute snmp-active. If it is “true”, the printer
works with SNMP.

Using the InfoPrint Manager Administration Interface

To use the InfoPrint Manager Administration Interface to check and set the
attributes:
1. From the menu bar, select Printer or Server, as appropriate.
2. Select Properties. You see the printer properties or server properties notebook.
3. Select the SNMP tab.
4. Check and set the appropriate attributes on the SNMP tab as explained in

“Procedures.”

Procedures

Do these steps to check and set the attributes:
1. Check these actual destination attributes:
v snmp-community-name

Indicates the name of the SNMP community that the printer belongs to. The
default is “public”. The field on the SNMP tab is Community name”.

v snmp-write-community-name
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Indicates the name of the SNMP write community that the printer belongs
to. There is no default. The field on the SNMP tab is Write community
name”.
When the snmp-write-community-name attribute is set properly and you
have write permission to the actual destination, you can set the contact and
location information and execute device commands on the printer associated
with an actual destination.

v snmp-retry-count

Indicates the number of times the server should retry an SNMP request if it
fails. The higher the number, the more network traffic. Using a lower number
can improve performance. The default is “2”. The field on the SNMP tab is
“Number of times to retry”.

v snmp-timeout

Indicates the number of seconds the server should wait for the printer to
respond to an SNMP request. Using a lower number can improve
performance. The default is “5”. The field on the SNMP tab is “Timeout”.

v use-snmp

Indicates whether the server should try to use SNMP to communicate with
the printer. The default is “true”. The field on the SNMP tab is “Use SNMP”.

2. If the defaults in Step 1 on page 57 in this section are correct, set this actual
destination attribute:
v destination-tcpip-internet-address

Indicates the IP address of the SNMP printer. The field on the tab is “TCP/IP
address”.

3. Check this actual destination attribute:
v snmp-active

Indicates whether the server has been able to establish an SNMP session with
the printer. The field on the SNMP tab is “SNMP is active”.

4. Set these server attributes:
v snmp-discovery-during-startup

Indicates whether the server queries the printer MIB when InfoPrint Manager
starts, or whether the server gets the printer status when it periodically polls
the printer. The default is “true”, but you might want to set it to “false” if
you have several SNMP printers and you want to make the server start
faster. The field on the SNMP tab is “Discover printers at startup”.

v snmp-normal-poll-interval

Indicates the number of seconds that the server should wait after
sequentially polling all the SNMP printers without known problems.
Increasing the polling interval causes the server to use less CPU and network
resources for SNMP polling, but it makes the currently shown printer status
(for printers that are not currently printing) less accurate. The field on the
SNMP tab is “Normal poll interval”.

v snmp-problem-poll-interval

Indicates the number of seconds that the server should wait after
sequentially polling all the SNMP printers with known problems. Increasing
the polling interval causes the server to use less CPU and network resources
for SNMP polling, but it makes the currently shown printer status (for
printers that are not currently printing) less accurate. The field on the SNMP
tab is “Problem poll interval”.
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For more information about the SNMP actual destination attributes, see the
“InfoPrint Object attributes” chapter in the InfoPrint Manager: Reference.

Effects on performance with SNMP
The performance areas that SNMP can influence are:
v Server start-up
v Actual destination queries
v SNMP polling
v Number of SNMP printers on a server

Server start-up
If you set snmp-discovery-during-startup to “true”, the server start-up might be
slow because the server queries the printer MIB for each SNMP enabled actual
destination for the most current information. Setting this attribute to “false” can
improve startup performance. However, the initial actual destination status is not
current and won’t be until because the server polls the printer next.

Actual destination queries

On an SNMP printer, when you query an actual destination attribute that might be
affected by the printer MIB (for example, destination-state), the default is that the
server uses SNMP at the same time to get the relevant information from the
printer. If the printer is turned off or not connected to the network, it might take a
long time before the printer times out, which delays the response to your query.

If this is a problem, you can use the pdls command with the when=now attribute
to return the current information instead of querying the printer MIB. Using this
attribute can improve performance.

SNMP polling
The server periodically polls the SNMP printers to get their latest status. If a
printer condition changes while the server is polling a printer (for example, a user
closes an open cover), the server might temporarily miss one of the changes.
However, during the next polling cycle, the server automatically picks up any
changes that it missed.

If the server cannot discover an SNMP printer when InfoPrint Manager starts, it
shows the printer status from the last time the server was shut down.

Increasing the polling interval causes the server to use less CPU and network
resources for SNMP polling, but it makes the currently shown printer status (for
printers that are not currently printing) less accurate.

Chapter 14. Working with SNMP printers 59



60 InfoPrint Manager for Windows: Procedures



Chapter 15. Creating and managing resource-context objects

Resource-context objects identify the locations of different types of Advanced
Function Presentation™ (AFP) resources that jobs sent to PSF physical printers can
reference. Resource-context objects let you encapsulate the directory path name in
one place. Then you specify the resource-context object name rather than directory
names with documents and actual destinations when specifying where to find
resources. Later, if the location of a resource changes, you only need to modify the
path name specified in the corresponding resource-context object.

The different types of AFP resources are:

Color management resources (CMRs)
CMRs are the foundation of color management in AFP print systems. They
provide all the color management information, such as ICC profiles and
halftones, that an AFP system needs to process a print job and maintain
consistent color from one device to another.

Notes:
1. CMRs are stored in resource libraries that use resource access tables

(RATs). When you update an existing CMR or add a new CMR to a
resource library, the RAT is updated. You must restart PSF so the
changes take effect.

2. CMRs are considered data objects for accounting purposes.
3. For retention of resources across print jobs, CMRs are counted as part

of the maximum-presentation-object-containers-to-keep.

Data object font resources
A data object font resource can be an OpenType font collection, an
OpenType set of linked fonts, or OpenType fonts that are installed in one
or more directories on your InfoPrint Manager server. Data object font
resources are the only fonts registered through a RAT that are located in
the same directory as the fonts. For more information about using data
object font resources with InfoPrint Manager, see “Using OpenType Fonts”
on page 229.

Data objects
Data objects can be IOCA files or types of files natively supported by a
particular model of printer (for example, an EPS file on an InfoPrint Color
130 Plus). In addition, if you use the transforms that come with InfoPrint
Manager to convert objects into AFP first, these non-native types of files
can be used as data objects. In InfoPrint Manager, data objects are grouped
with BCOCA™ and GOCA objects, and they are collectively known as
presentation object containers.

Note: Data objects are stored in resource libraries that use RATs. When
you update an existing data object or add a new data object to a resource
library, the RAT is updated. You must restart PSF so the changes take
effect.

Fonts A font is a single size and typeface in a particular type family, including
letters, numerals, punctuation marks, special characters, and ligatures.

Form definitions
Form definitions provide instructions on how output devices position data
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on the page. Form definitions can specify overlays, a paper source for
cut-sheet printer devices, duplexed printing, text suppression, data
position, and the number and modifications of pages.

Page definitions
Page definitions contain the formatting controls for line data. Page
definitions can include controls for the number of lines per logical page,
font selection, print direction, and the mapping of individual fields to
positions on the logical page.

Page segments
Page segments contain text and images that you can include at any
addressable point on a page or an electronic overlay.

Overlays
Overlays are collections of predefined data such as lines, shading, text
boxes, or logos, that can merge with variable data on a page or a form
during printing or transmission.

You use the pdcreate command to identify the directory or directories where the
AFP resources reside and provide a name for the resource-context object. You use
the AFP Resources tab of the actual destination and default document attributes
notebooks in the InfoPrint Manager Administration GUI, or the Command Prompt
window from an InfoPrint Manager for Windows server, to identify the
resource-context object name or which paths you want to associate with that object.
Jobs can also reference resource-context objects through their contained documents.
See “The search order for AFP resources” for the search order InfoPrint uses to
locate resource-context objects for a job. Both the actual destination and the
resource-context objects that are referenced must reside in the same InfoPrint
server.

You can also purchase additional resources or even create your own custom
resources. To create page definitions and form definitions, you can purchase the
Page Printer Formatting Aid (PPFA) for Windows, which is an optional feature of
InfoPrint Manager for Windows.

The search order for AFP resources
This section describes the order and the conditions on which InfoPrint searches for
AFP resources:
1. For fonts, paths specified by the -osrchfontlib keyword on the enq, lp, qprt, or

lprafp command
2. Paths specified by the -oreslib keyword on the enq, lp, qprt, or lprafp

command
3. The path specified by the resource-context-user document attribute.
4. The paths specified by one of these document attributes, depending on the type

of resource:
v resource-context-font

v resource-context-form-definition

v resource-context-overlay

v resource-context-page-definition

v resource-context-page-segment
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Note: When one of these document attributes contains a value, InfoPrint
ignores any location specified by the same attribute of a default document
object if one is used with the job.

5. The path specified by the resource-context document attribute.
6. The path specified by the PSFPATH environment variable.

If you are using OpenType Fonts, you must allow the Infoprint® Fonts product
to install its resource access table for keeping track of these fonts in the default
directory. On an InfoPrint Manager Windows server, if you change the location
of this table from the folder where it was installed, you can update the global
search path on your Windows system with the global resource path for these
fonts.

7. The paths specified by the resource-context attributes of the actual destination.
8. For fonts, the directory where your fonts are installed.

Once a resource is located, the search ends, and the located resource is used to
process the job, as long as the user can access the resource. If InfoPrint Manager
ultimately cannot find a required resource, it prints an error message advising you
of the missing resource. InfoPrint Manager reports that the job completed
successfully.

If the only AFP resources you use are the AFP resources that shipped with
InfoPrint Manager, there is no need to use resource-context objects. All of your
resources are located automatically because these resources reside in the reslib,
fontlib, and font directories described above. If, on the other hand, you have
custom AFP resources, make sure that you do not store them in the reslib, fontlib,
or font directories listed. Any custom resources stored in these locations might be
corrupted by installing, uninstalling, or servicing the software. Store any custom
AFP resources in a directory outside these locations and use resource-context
objects to provide access to them.

When InfoPrint Manager puts together the total of all resource contexts for a
particular resource type, InfoPrint Manager tries this list of extensions in order
while searching each directory for a particular resource. For example, InfoPrint
Manager is searching for a 300–pel raster font named C0H20000 and these
conditions are true:
v Document attributes are set to resource-context-font=\myfonts

v resource-context=\all_resources

v The $PSFPATH environment variable has not been set.
v The resource-context-font actual destination attribute has not been set.

A list of files similar to this would be checked in sequence:
1. x:\myfonts\C0H20000.300

2. x:\myfonts\C0H20000.FONT300

3. x:\myfonts\C0H20000

4. x:\all_resources\C0H20000.300

5. x:\all_resources\C0H20000.FONT300

6. x:\all_resources\C0H20000

7. With InfoPrint Manager for Windows:
a. c:install_path\reslib\C0H20000.300

b. c:install_path\reslib\C0H20000.FONT300

c. c:install_path\reslib\C0H20000
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d. c:\font_install_path\afpfonts\C0H20000.300

e. c:\font_install_path\afpfonts\C0H20000.FONT300

f. c:\font_install_path\afpfonts\C0H20000

g. c:\font_install_path\psf\fontlib\C0H20000.300

h. c:\font_install_path\psf\fontlib\C0H20000.FONT300

i. c:\font_install_path\psf\fontlib\C0H20000

Once InfoPrint Manager finds a matching file, the search ends.

If InfoPrint Manager cannot find the resource in any of the paths, it stops the job
and prints an error message at the end of the job.

CMRs and data objects search order
The search order for CMRs and data objects is different from the order used for
other AFP resources.

CMRs and data objects must reside in the same directory as the RAT where the
resources are identified. That is, the CMR RAT and the data object RAT can be
located in different directories, but the resources that are associated with the
specific RAT must reside in the same directory as the RAT.

The InfoPrint 5000 printer Models AS1 and AD1/2 and InfoPrint 4100 printers
support CMRs and data objects.

The search order for CMRs
InfoPrint Manager searches for CMRs in different locations and in a different order
than it uses for other AFP resources.

InfoPrint Manager searches for CMRs in these locations in this order:
1. Inline objects
2. The path specified by the resource-context-presentation-object-container

document attribute
3. The path specified by the resource-context document attribute
4. The path specified by the PSFPATH environment variable
5. The path specified by the resource-context-presentation-object-container actual

destination attribute
6. The path specified by the resource-context actual destination attribute
7. The system dependant library:

For Windows, $$ENV_PDRESLIB

Notes:

1. InfoPrint searches for CMRs using the UTF-16 name provided in the data
stream.

2. If a CMR changes after a job prints, recycle the actual destination by disabling
and enabling the connection.

The search order for data objects
InfoPrint Manager searches for data objects in different locations and in a different
order than it uses for other AFP resources.

InfoPrint Manager searches for data objects in these locations in this order:
1. Inline objects
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2. The path specified by the resource-context-page-segment document attribute if
object is IOCA that is not installed in a data object RAT

3. The path specified by the resource-context-presentation-object-container
document attribute

4. The path specified by the resource-context document attribute
5. The path specified by the PSFPATH environment variable
6. The path specified by the resource-context-presentation-object-container actual

destination attribute
7. The path specified by the resource-context actual destination attribute
8. The system dependant library:

For Windows,$$ENV_PDRESLIB

Notes:

1. InfoPrint Manager searches for data objects using the UTF-16 name and the
eight-character name provided in the data stream. The search process is
different from previous versions. InfoPrint Manager now searches items one
through four by UTF-16 name and then search items one through four by eight
byte name. Then, InfoPrint Manager searches items five through eight by
UTF-16 name and then by eight byte name.

2. If a data object changes after a job prints, recycle the actual destination by
disabling and enabling the connection.

Reuse of CMRs and data objects across printer jobs
Using CMRs and data objects in more than one print job can improve printer
performance. InfoPrint Manager includes two actual destination attributes that you
can use to specify reuse: maximum-presentation-object-containers-to-keep and
capture-inline-cmr-resources.

If you use the same resources (such as company logos) in different print jobs, you
can improve print performance by storing those resources on the printer.

Use the maximum-presentation-object-containers-to-keep actual destination
attribute to specify the maximum number of CMRs and data objects to store in the
memory of the printer device between jobs. The default value is 100 objects. Both
CMRs and data objects are included in this count.

The printers control the actual retention of resources based on the value of the
maximum-presentation-object-containers-to-keep actual destination attribute and
the available resources downloaded to the printer.

Note: If the printer is reset, the printer memory is cleared.

If you include CMRs inline with your print jobs, you can use the
capture-inline-cmr-resources actual destination attribute to indicate whether inline
CMRs can be captured and reused by PSF TCP/IP printers. Capturing a CMR
means the resource is downloaded to the printer and remains resident in the
printer memory for future reuse. The default for this attribute is false (not active).
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File extensions for resources

This table contains file extensions for specific types of resources and lists the order
that the extensions are tried by InfoPrint when searching for that resource.

Table 6. File extensions for resources

Type of Resource File Extensions Searched (see note)

BCOCA (bar code) objects 1. No file extension

2. OBJ

3. OBJECT

Code pages 1. ECP

2. No file extension

3. FONT3820

4. FONT38PP

5. CDP

6. FONT300

Coded fonts 1. No file extension

2. FONT3820

3. FONT38PP

4. CFT

5. FONT300

Font character sets, 240-pel resolution 1. No file extension

2. 240

3. FONT3820

4. FONT38PP

5. CFT

6. CDP

Font character sets, 300-pel resolution 1. No file extension

2. 300

3. FONT300

4. CFT

5. CDP

Outline fonts 1. No file extension

2. OLN

3. FONTOLN

4. CFT

5. CDP

TrueType and OpenType fonts, CMRs, and
data object resources

Entire file name, including extension; comes
from the Resources Access Tables (RATs)
creaetd by the AFP Resource Installer. If a
CMR or a data object RAT is altered, PSF
must be restarted for the changes to take
effect.
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Table 6. File extensions for resources (continued)

Type of Resource File Extensions Searched (see note)

Form definitions 1. No file extension

2. FDEF3820

3. FDEF38PP

4. FDE

5. FIL

GOCA (graphics) objects 1. No file extension

2. OBJ

3. OBJECT

IOCA (IO image) objects 1. No file extension

2. OBJ

3. OBJECT

MO:DCA™ Objects 1. No file extension

2. OBJ

3. OBJECT

Overlays 1. No file extension

2. OVLY3820

3. OVLY38PP

4. OVL

5. OLY

6. OVR

Page definitions 1. No file extension

2. PDEF3820

3. PDEF38PP

4. PDE

Page segments 1. No file extension

2. PSEG3820

3. PSEG38PP

4. PSG

5. PSE

Color mapping table 1. No file extension

2. SETUP

3. SET

Presentation object container

For data object resources not installed in a
Resource Access Table (RAT).

1. No file extension

2. DOR

Setup data 1. No file extension

2. SETUP

3. SET

4. COMSETUP

Note: All file extensions must be in uppercase.
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Processing resources installed with Resource Access Tables

A RAT maps a resource name specified in the MO:DCA-P data stream to
information used to find and process the resource. The resources that are installed
with a RAT include:
v TrueType and OpenType fonts
v Color management resources (CMRs)
v Data object resources

In order for line2afp to process resources installed with a RAT, you must:
1. Use the InfoPrint AFP Resource Installer or a similar product to install the

resources and create RATs in the appropriate resource directories on your
system.

2. When invoking line2afp, use these parameters on AIX and Windows systems
to specify the path names where the RATs and resources are installed in:

Parameter Resource Type

FONTPATH TrueType and OpenType fonts

OBJCONDDD, RESLIB, and USERLIB Object containers and CMRs

USERPATH Any RAT-installed resource

3. Modify your application to include the RAT-installed resources in a page
definition, form definition, or Map Data Resource (MDR) structured field. See
InfoPrint Page Printer Formatting Aid for Windows: User’s Guide, S550-0801, for
more information about including resources. You can use the RESTYPE
parameter with line2afp to control what type of resources are included in the
resource type.

Creating a new resource-context object

You create resource-context objects from the Command prompt window; you
cannot create them through the InfoPrint Manager Administration GUI.

To create a new resource-context object from the command line, type a pdcreate
command using -c resource-context and typing:
1. The context-address

2. The server name
3. The resource-context object name

For example, to create a resource-context object named Resfont1 contained in
server Server1 that identifies x:\resource\fonts\group1 as the context-address or
directory containing AFP font resources, enter the command:
pdcreate -c resource-context -x "context-address=x:\resource\fonts\group1"

Server1:Resfont1

Notes:

1. Specify a name that uniquely describes the resource-context object in the server.
All resource-context objects in a server appear in the selection lists for the fields
in the PSF Resource tab of the Printer Properties window. Two servers can
each contain a resource-context object with the same name, but possibly with
different values for their attributes.

68 InfoPrint Manager for Windows: Procedures



2. InfoPrint uses resource-context object names as values for the lists associated
with the fields in the actual destination attributes notebook (Printer Properties
window) or as valid values you can enter in the fields of the default document
attributes notebook. Job submitters can also use them as values for attributes of
a document in a job.

For more information about the attributes used in creating resource-context objects,
see ″Attributes for Resource Contexts″ in the InfoPrint Manager: Reference.

Changing a directory path for a resource-context object

To change the path to a resource-context object, use the pdset command.

For example, to change the path for the resource-context object named Resfont1
contained in server Server1 to x:\resource\fonts\group2 as the directory
containing AFP font resources, enter the command:
pdset -c resource-context -x "context-address=x:\resource\fonts\group2"

Server1:Resfont1
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Chapter 16. Using PSF DSS user-exit programs

This section describes the sample PSF DSS user-exit programs supplied with
InfoPrint Manager and shows how you can create your own PSF DSS user-exit
programs. These user-exit programs apply to printers connected to InfoPrint
Manager through the PSF device support subsystem (DSS).

This chapter contains these topics:
v “Supported types of PSF DSS user-exits”
v “Sample PSF DSS user-exit programs” on page 72
v “Creating and using your own PSF DSS user-exit programs” on page 74
v “Compiling and installing the user-exit program” on page 74
v “The header page and trailer page user-exit programs” on page 79
v “Accounting, post-print accounting, and audit user-exit program inputs and

outputs” on page 80
v “Input data user-exit program inputs and outputs” on page 83
v “Ouput data user-exit program inputs and outputs” on page 85
v “Structure of a user-exit program” on page 86
v “User-exit programs for the line data transform” on page 86
v “Attributes of the line data input file” on page 93
v “Using the uconv command to convert coded character sets” on page 94

Supported types of PSF DSS user-exits
InfoPrint Manager supports dynamically loaded user-exit programs. These
programs are loaded with InfoPrint Manager during initialization and are called at
various points during job processing.

InfoPrint Manager allows eight different types of PSF DSS user exits. InfoPrint
Manager calls the exits in this order:
v Header (Start) page user exit
v Separator page user exit
v Input data user exit
v Output data user exit
v Accounting user exit
v Audit user exit
v Trailer (End) page user exit
v Post-print accounting user exit
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Sample PSF DSS user-exit programs

InfoPrint Manager supplies sample PSF DSS user-exit programs for the header,
separator, and trailer pages, for accounting and audit data, and for post-print
accounting data. The sample header, separator, and trailer page user-exit programs
generate Advanced Function Presentation (AFP) data stream pages. The sample
accounting and audit user-exit programs generate ASCII data in a report file
format or write to a log file. The sample post-print accounting user-exit program
only writes to a log file. InfoPrint Manager also supplies sample user-exit
programs for input data and output data; however, these user-exit programs do
not perform any function. You can use all of these sample programs as they are or
you can modify them.

If you choose to modify the existing user-exit programs, the source code for each
one is located in the install_path\exits\psf directory. The install_path is the
directory that InfoPrint Manager is installed in. If you don’t know the install path,
you can find it in the Management Console. Open the Management Console, click
Edit → Change Service Configuration and find the Install path field.

Table 1 lists the sample user exit programs supplied with InfoPrint Manager.

Table 7. Sample user-exit programs

Type of user exit File Name Description

Header Page ainuxhdr.c Generates brief style start
sheet.

ainuxhdr2.c Generates full style start
sheet.

ainuxhdrp.c Generates start sheet with
job ticket information.

ainuxhdrx.c Generates start sheet without
vertical lines.

pduxblkh.c Generates a blank start sheet.

Start
sheet

Separator
sheet

Send job
to printer

Accounting Audit
End
sheet

Start

Job Post-print
accounting

(Trailer)(Header)

Inp Data User Exit

Output Data User Exit

ut

Job

Stacked

Other job
processing

Figure 4. InfoPrint Manager user-exit program order at the printer
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Table 7. Sample user-exit programs (continued)

Type of user exit File Name Description

Separator Page ainuxsep.c Generates brief style
separator sheet

ainuxsep2.c Generates full style separator
sheet.

ainuxsepp.c Generates separator sheet
with job ticket information.

ainuxsepx.c Generates separator sheet
without vertical lines.

pduxblks.c Generates a blank separator
sheet.

Trailer Page ainuxtlr.c Generates brief style end
sheet.

ainuxtlr2.c Generates full style end
sheet.

ainuxtlrp.c Generates start sheet with
job ticket information.

ainuxtlrx.c Generates end sheet without
vertical lines.

pduxblkt.c Generates a blank end sheet.

Accounting ainuxacc.c Generates brief style
accounting sheet.

ainuxacc2.c Generates full style
accounting sheet.

ainacclog.c Generates accounting log
information.

ainuxaccp.c Generates accounting sheet
log with job ticket
information.

Post-print Accounting ainuxjobcompletion.c Generates accounting log
information about printed
(″stacked″) sheets

Audit ainuxaud.c Generates brief style audit
sheet.

ainuxaud2.c Generates full style audit
sheet.

ainuxaudp.c Generates audit sheet with
job ticket information.

ainaudlog.c Generates audit log
information.

Input Data ainuxind.c Provides template for writing
your own user-exit program.

Output Data ainuxout.c Provides template for writing
your own user-exit program.

Note: For sample user-exit programs used with the line data transform, see
“User-exit programs for the line data transform” on page 86.
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Creating and using your own PSF DSS user-exit programs

You can create your own PSF DSS user-exit program at any time; however, you
must perform additional tasks to produce a PSF DSS user-exit executable program.
You must have the Microsoft® Visual Studio 2005 Program installed on your
InfoPrint Windows server to compile and build user-exit programs. Be sure to
apply the latest service available.

You can create your own user-exit program in one of these ways:
v Copy one of the sample user-exit programs, rename it, and modify it using the

Microsoft Visual Studio 2005 Program.
v Write your own user-exit program. You can include the variable data shown in

these sections, for example, USERID; but InfoPrint cannot process variable data
that is not shown in this section.

ICONV:

If you have written any user-exit programs that use ICONV, you must alter them
to use UCONV instead. For more information, see the InfoPrint Manager: Reference.

Compiling and installing the user-exit program

You can only specify one user-exit program for each function name provided by
InfoPrint per actual destination.

The function name of the user exit must be one of these (in uppercase), because
that is the entry point in the module:
v ACCOUNTING
v AUDIT
v JOBCOMPLETION
v HEADER
v SEPARATOR
v TRAILER
v INDATA
v OUTDATA

Activating the user-exit program

Before you can use the new user-exit program, you must activate the program.

To perform this task from the command line, click the Windows Start button and
select Programs → Command Prompt and complete these steps:
1. Enter this command: pdls -c aux -r all servername:, where servername refers

to the name of the server you are using.
This command displays the attributes for all current auxiliary sheet objects
available on the server. You can also view attributes for a specific auxiliary
sheet object. For example, to view attributes for the accounting log, enter this
command: pdls -c aux -r all servername:accounting-log

2. Use the pdset command to change the values of any of the auxiliary sheet
objects, as necessary.
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From the InfoPrint Manager Administration GUI, you must select the printer that
you want to associate with an auxiliary sheet (in this case, prt1) and then use the
Printer → Properties menu to access the Printer Properties notebook. To complete
this task, see the online help topic Using auxiliary-sheet objects in the InfoPrint
Manager Administration GUI.

To do this task from the command line, complete these steps.
1. To create a new auxiliary-sheet object, type:

pdcreate -c aux-sh -x psf-exit-prog-name=fullpath\exit_name
server1:auxiliary_sheet_name

2. Shut down the actual destination (in this case, prt1). pdshutdown -cp prt1

3. Associate this new auxiliary-sheet object (in this case, an audit exit) with the
actual destination. pdset -cp -x dest -x audit-exit=auxiliary_sheet_name
prt1

Note: For the post-print accounting exit, instead of this step you will set the
attribute in the accounting auxiliary sheet object for the actual destination,
using this command: pdset —c auxiliary-sheet —x psf-post-print-
accounting-program-name=fullpath\exit_name servername: accounting-log

By default, the accounting-log auxiliary sheet object is available for all
destinations. This object can point to any combination of the accounting and
post-print accounting exits. For example, you can set either one, both, or
neither of these attributes at the same time:
psf-exit-program-name=name of accounting exit
psf-post-print-accounting-program-name=name of post-print accounting exit

If you want some printers to have different accounting configurations than
others, you must create a new auxiliary sheet object for each configuration.

4. Enable the actual destination (in this case, prt1).
pdenable prt1

User-exit program structures
All input and output variables used in InfoPrint Manager user-exits are defined
through either of these two files:
v The install_path\psf\exits\ainuexit.h file
v The install_path\psf\exits\ainurpt.h file

The ainuexit.h file contains definitions for the header, trailer, separator, accounting,
audit, and post-print accounting exits, while the ainuprt.h file formats data for
these executable reporting utilities that apply to the accounting, audit, and
post-print accounting exits:
v Accounting Log

– ainurpt1

– ainurpt2

– ainurpt3

v Audit Log
– ainurpt4

– ainurpt5

– ainurpt6

v Post-print Accounting Log
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– ainurpt7

– ainurpt8

– ainurpt9

These user-exit program structure files are written in the C programming language.
The declarations and statements in these files show the structure of the InfoPrint
Manager user-exit programs, which are imbedded as part of the user-exit program.

Common input and output fields
These fields can be found in the user-exit programs. For a detailed list of input and
output fields according to user-exit, see the install_path\psf\exits\ainuexit.h file.
This information can be specified from:
v Migrated jobs
v MVS Download jobs
v Fields set in the InfoPrint Manager Administration Interface Job and Document

Defaults notebook

UserID
Identifies the system user ID of the person who submitted the job.

The Userid field value can be any null-terminated (X’00’) character string.
You should limit the string to 10 or less characters.

NodeID
Identifies the name of the system (host). The backend program sets the
NodeID.

The Nodeid field value can be any null-terminated (X’00’) character string.
You should limit the string to 10 or less characters.

Jobname or Name
Identifies the name of the job. This is the same as the file name in the job.

Job submitters can also specify the job name with the InfoPrint Manager
job attribute job-name=name or name=name when they submit a job. If the
job name is not specified for files defined as PCL, PostScript, line data,
unformatted ASCII, double-byte character set (DBCS) ASCII, or PDF, when
the job is submitted, InfoPrint creates a temporary file for the transform
output. InfoPrint uses the temporary file name for the job name.

This field value can be any null-terminated (X’00’) character string. You
should limit the string to 24 or less characters.

SpoolID
Identifies the PSF job ID, which is an integer. InfoPrint Manager sets the
SpoolID.

PrinterName
Identifies the first eight characters of the InfoPrint Manager destination
name.

hab This function is not used.

Date Identifies the date the job is printed in MM/DD/YY format.

Time Identifies the time the job is printed in HH:MM:SS format.

Distribution
Identifies the distribution information provided when the job is submitted.
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PagePointer
Points to a buffer containing the header page or trailer page data produced
by the exit.

PageSize
Indicates the size of the header page or trailer page data returned by the
exit. This field is initially set to 0 before the exit is called. If no data is
generated by the exit, this field remains set at 0.

PageType
Indicates the type of header or trailer page data (if any) that the exit
generates. The field is initially set to 0 (AFP data stream) before the exit is
called. Valid values are:

0 AFP data stream

1 ASCII data

Job Completion
Indicates the status returned by the exit. This field is initially set to 0
before the exit is called. Valid return codes are:

0 Good completion, all done, accept resultant page.

-1 Bad completion, non-fatal error, no page generated.

-5 Bad completion, fatal error. The exit is disabled until you shut
down the actual destination.

-8 Bad completion, terminate the current job.

-12 Bad completion: terminate the job and put it in pending state. In
addition, InfoPrint disables the actual destination.

Account
Identifies the account information provided when the job is submitted. The
Account field value can be any null-terminated (X’00’) character string. You
should limit the string to 20 characters or less. Job submitters can specify
this same information through the account-text document attribute.

Address1
Identifies the first line of address information provided when the job is
submitted.

The Address1 field value can be any null-terminated (X’00’) character
string. You should limit the string to 57 or less characters.

Address2
Identifies the second line of address information provided when the job is
submitted.

The Address2 field value can be any null-terminated (X’00’) character
string. You should limit the string to 57 or less characters.

Address3
Identifies the third line of address information provided when the job is
submitted.

The Address3 field value can be any null-terminated (X’00’) character
string. You should limit the string to 57 or less characters.

Address4
Identifies the fourth line of address information provided when the job is
submitted.
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The Address4 field value can be any null-terminated (X’00’) character
string. You should limit the string to 57 or less characters.

Account
Identifies the account information provided when the job is submitted.

The Account field value can be any null-terminated (X’00’) character string.
You should limit the string to 20 or less characters.

Building
Identifies the building information provided when the job is submitted.

The Building field value can be any null-terminated (X’00’) character
string. You should limit the string to 24 or less characters. You can specify
this same information through the building-text document attribute.

Department
Identifies the department information provided when the job is submitted.

The Department field value can be any null-terminated (X’00’) character
string. You should limit the string to 24 or less characters. You can specify
this same information through the department-text document attribute.

Passthru
Identifies any other information provided when the job is submitted that
will be passed through the user-exit to the backend program.

These Passthru flags are supported:

class Identifies the one-character class attribute.

destination
Identifies the one-to eight-character destination attribute.

forms Identifies the one-to eight-character forms attribute.

segmentid
Identifies the one-to ten-character segmentation identifier.

ServerJobID
Identifies the job identifier.

The Passthru field value can be any null-terminated (X’00’) character string
no greater than 1,024 characters.

Programmer
Identifies the programmer information provided when the job is submitted.

The Programmer field value can be any null-terminated (X’00’) character
string. You should limit the string to 24 or less characters. You can specify
this same information through the programmer-text document attribute.

Room Identifies the room information provided when the job is submitted.

The Room field value can be any null-terminated (X’00’) character string.
You should limit the string to 24 or less characters. You can specify this
same information through the room-text InfoPrint document attribute.

Title Identifies the title information provided when the job is submitted.

The Title field value can be any null-terminated (X’00’) character string.
You should limit the string to 24 or less characters. You can specify this
same information through the title-text document attribute.

LongPrinterName
The full name of the InfoPrint destination.
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Note: Because InfoPrint Manager only allows eight character names,
PrinterName and LongPrinterName are the same.

The header page and trailer page user-exit programs

Because the InfoPrint Manager start page and trailer page user-exit programs
require the same inputs and produce the same outputs, the program descriptions
are similar.

The source code (in the C programming language) for the sample header page
user-exit programs and trailer page user-exit programs listed in “Sample PSF DSS
user-exit programs” on page 72 are located in the install_path\exits\psf directory.
These sample programs generate an AFP data stream page.

The data structures for the header and trailer page user-exit programs are included
with the source code in the install_path\exits\psf\ainuexit.h file. The code for
these structures is shown in “User-exit program structures” on page 75.

The declaration of these exits is:
void HEADER (HEADER_EXITDATA *exitdata)
void TRAILER (TRAILER_EXITDATA *exitdata)

The HEADER_EXITDATA and the TRAILER_EXITDATA input/output parameters contain
all of the input and output data needed to communicate between InfoPrint
Manager and the user-exit programs.

See “Common input and output fields” on page 76 and the ainuexit.h file for
explanations of the function and structure of the various components of this
user-exit.

After you create your header page or trailer page user-exit program, you must use
the AIX make command to compile the code (see “Compiling and installing the
user-exit program” on page 74).

The separator page user-exit program

The InfoPrint Manager separator page user-exit program is called before copies of
a job (including the very first copy) print. This exit is also called before the error
messages and the trailer page ( Figure 4 on page 72).

The source code (in the C programming language) for the sample separator page
user-exit programs listed on page 72 are located in the install_path\exits\psf
directory. These sample programs generate an AFP data stream page.

The data structures for the separator page user-exit program are included with the
source code in the install_path\exits\psf\ainuexit.h file. The code for these
structures is shown in “User-exit program structures” on page 75.

The declaration of this exit is:
void SEPARATOR (SEPARATOR_EXITDATA *exitdata)

The SEPARATOR_EXITDATA input/output parameter contains all the input and output
data needed to communicate between InfoPrint Manager and the user-exit
program.
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See “Common input and output fields” on page 76 and the ainuexit.h file for
explanations of the function and structure of the various components of this
user-exit.

This field is also found in the separator page user-exit program and provides
output information:

Copy Indicates which copy is associated with this call to the exit. Initially set to
1, it increments by one each time the exit is called. The sample separator
page user-exit program generates one separator page for the first copy and
all subsequent copies of the job.

After you create your separator page user-exit program, you must use the AIX
make command to compile the code (see “Compiling and installing the user-exit
program” on page 74).

Accounting, post-print accounting, and audit user-exit program inputs
and outputs

The InfoPrint Manager accounting and audit user-exit programs require the same
inputs and produce the same outputs so the program descriptions are the same.
The post-print accounting user-exit program requires more inputs and produces
more outputs.

The source code (in the C programming language) for the sample separator page
user-exit programs listed in “Supported types of PSF DSS user-exits” on page 71
are located in the install_path\exits directory.

The sample programs store the data into a file you can access with these
executable reporting utilities:

ainurpt1
Provides accounting data for the actual destinations defined, based upon
the destination ID.

ainurpt2
Provides accounting data for the actual destinations defined, based upon
the userid.

ainurpt3
Provides detailed accounting data for the destinations defined, based upon
the particular userid supplied.

ainurpt4
Provides audit data for the actual destinations defined, based upon the
destination ID.

ainurpt5
Provides audit data for the actual destinations defined, based upon the
userid.

ainurpt6
Provides detailed audit data for the actual destinations defined, based
upon the particular userid supplied.

ainurpt7
Provides post-print accounting data stored in jobcompletion.log, sorted by
actual destination.
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ainurpt8
Provides summary post-print accounting data stored in jobcompletion.log,
sorted by job submitter.

ainurpt9
Provides detailed entries of times and pages printed for a specific job
submitter in jobcompletion.log.

The source code for these reporting utilities is also located in the
install_path\exits\psf directory.

These executable reporting utilities are located in the install_path\bin folder. By
specifying these executable reporting utilities at the DOS command line, you can
display data by either destination ID or userid. For example, to report on print
requests submitted by a specific user to a actual destination for which the
accounting user exit has been activated, you can specify ainurpt3 and then provide
the userid to the program.

Note: You must activate these exits to generate the log files used by these report
programs. For more information about activating these exits, see “Activating the
user-exit program” on page 74.

The data structures for the accounting, audit, and post-print accounting user-exit
programs are included with the source code in the install_path\exits\psf\ainuexit.h
and install_path\exits\paf\ainurpt.h files. The code for these structures is shown in
“Structure of a user-exit program” on page 86.

The declarations of these exits are:
void ACCOUNTING (ACCOUNTING_EXITDATA *exitdata)
void AUDIT (AUDIT_EXITDATA *exitdata)
void JOBCOMPLETION (JOBCOMPLETION_EXITDATA *exitdata)

The ACCOUNTING_EXITDATA, AUDIT_EXITDATA, and
JOBCOMPLETION_EXITDATA input and output parameters contain all the input
and output data needed to communicate between InfoPrint and the user-exit
programs.

The ACCOUNTING_EXITDATA, AUDIT_EXITDATA, and
JOBCOMPLETION_EXITDATA structures include these fields.

To build the executable program, you must use the Microsoft Visual Studio 2005
Program, pull-down menu.

Fields that provide information for accounting, audit, and
post-print accounting user-exit programs

These fields are also found in the accounting, audit, and post-print accounting
user-exit programs.

Pages Printed (accounting and audit user-exit only)
Shows the total number of impressions processed for this job.

Bin One Sheets Processed (accounting and audit user-exit only)
Shows the total number of processed sheets that were selected from the
primary bin.
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Bin Two Sheets Processed (accounting and audit user-exit only)
Shows the total number of processed sheets that were selected from bins
other than the primary bin.

User Pages Stacked by Bin (post-print accounting user-exit only)
Shows the total number of stacked pages in the user print file. It does not
include system pages, such as the header page, in the count.

User Sheets Stacked by Bin (post-print accounting user-exit only)
Shows the total number of stacked sheets in the user print file. It does not
include system pages, such as the header page, in the count.

Pages Stacked by Bin (post-print accounting user-exit only)
Shows the total number of pages stacked for this job by bin.

Sheets Stacked by Bin (post-print accounting user-exit only)
Shows the total number of sheets stacked for this job by bin.

Data Object Resources
Shows the total number of Data Object Resources, which can consist of
PDF pages, IOCA images, and Encapsulated PostScript (EPS) files, used in
this job. Data Object Resources are also known as presentation-object
containers (for more information, see the presentation-object-container
attributes in the InfoPrint Manager: Reference).

Note: The counters do not include resources contained in the input file.
The counters only include resources used before the accounting or audit
user-exit is called. Therefore, the resources required for printing error
messages and the trailer page do not appear in the resource totals.

Job Copies Requested (post-print accounting user-exit only)
Shows the total number of results-profile job copies requested in the job.

Fonts used
Shows the total number of fonts used in this job.

Note: The counters do not include resources contained in the input file.
The counters only include resources used before the accounting or audit
user-exit is called. Therefore, the resources required for printing error
messages and the trailer page do not appear in the resource totals.

Overlays used
Shows the total number of overlays used in this job.

Note: The counters do not include resources contained in the input file.
The counters only include resources used before the accounting or audit
user-exit is called. Therefore, the resources required for printing error
messages and the trailer page are not included in the resource totals.

Segments used
Shows the total number of page segments used in this job.

Note: The counters do not include resources contained in the input file.
The counters only include resources used before the accounting or audit
user-exit is called. Therefore, the resources required for printing error
messages and the trailer page are not included in the resource totals.

ExtStart Date
Identifies the date the job started processing.
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Start Date
The date the job started processing.

Start Time
The time the job started processing.

ExtStop Date
The date the job finished processing.

Stop Date
The date the job finished processing.

Stop Time
The time the job finished processing.

Completion Date (post-print accounting user-exit only)
The date all pages in the job printed and stacked.

Note: If errors or operator commands affect the job so that all pages are
not sent to the printer, this field indicates the time when all pages sent are
printed and stacked.

Completion Time (post-print accounting user-exit only)
The time all pages in the job printed and stacked.

Note: If errors or operator commands affect the job so that all pages are
not sent to the printer, this field indicates the time when all pages sent are
printed and stacked.

DORU
The data object resources used (DORU) by the exit.

DOFU The data object fonts used (DOFU) by the exit.

Input data user-exit program inputs and outputs
The InfoPrint Manager input data user-exit program can be used to:
v Monitor the incoming print data stream to InfoPrint Manager
v Discard an input record before it is processed
v Replace an existing input record with one or more records (which might include

the original record or a modified version of the original record)
v Continue processing with the input record unchanged

This exit can be called for all parts of the job (see Figure 4 on page 72).

Note: The input data user-exit program only processes MO:DCA data.

If you are using the exit to insert extra input records, the original input record that
is passed to the exit can be processed before or after the extra input records. This
means that the extra input records can be inserted before or after the current
structured field depending on where the current structured field is placed in the
list of structured fields to insert.

Important considerations
v Code processing becomes an integral part of PSF and can affect performance and

reliability.
v User exits should be coded by experienced programmers who are aware of

overall system implications.
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v Any delays caused by this exit will translate into a PSF processing delay and
could affect printer performance.

v This exit is not passed any structured fields that are contained in resources that
are processed. This includes: form definitions, overlays, page segments, fonts,
data object resources, internal medium maps, and data object fonts.

v Code processing must be able to handle PSF repositioning.

Repositioning might occur as a result of errors or operator commands. PSF might
reposition items forward into the print job, skip structured fields, or reposition
items back into previously processed data. If PSF repositions back into the print
file, it is the responsibility of the exit to return the same data in the same sequence
to PSF, just as it did when the structured field was originally passed to the exit.

Because of the constraints outlined above, you should first consider using the
transform subsystem to process data, because the transform subsystem does not
have these limitations. For example, a transform object would have access to all of
the input data (no restrictions) and could add, delete, and modify both resources
and pages. In addition, the transform subsystem processing is performed before
printing begins, so it would have no impact on printer performance or behavior.

The Input Data User Exit is not capable of identifying individual document
boundaries in a data stream. For example, your job might have 5 separate
documents that each contain 10 pages of data. This is viewed by the exit as 50
pages of data, not 5 units of 10. The transform subsystem does not have this
limitation.

The PSF Input Record Exit is responsible for managing any memory it allocates. It
can reuse the memory across calls through the use of a work area pointer provided
in ainuexit.h. PSF does not free any memory that might be pointed to by fields in
either the INDATA_EXITDATA structure or the PSFINSERTRECS structure. The exit can
point to memory that it has defined or allocated. The exit can reuse allocated
memory or free memory when it is appropriate. PSF might run out of memory if
the PSF Input Record Exit mismanages memory.

The source code (in the C programming language) for the sample input data
user-exit program listed on page “Sample PSF DSS user-exit programs” on page 72
is in the install_path\exits\psf\ainuxind.c. This sample program consists of a
return code and performs no function.

The data structures for the input data user-exit program are included with the
source code in the install_path\exits\psf directory.

The declaration of this exit is:
void INDATA (INDATA_EXITDATA *exitdata)

The INDATA_EXITDATA input/output parameter contains all of the input and
output data needed to communicate between InfoPrint Manager and the user-exit
program.

The INDATA_EXITDATA structure includes these fields. These fields provide
input information:

version
This variable was formerly called reserved1. It is designed for use as a
migration aid for future variants of this exit. It contains a version identifier
for this structure:
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v X’00’= previous version (before August, 2005)
v X’01’= August, 2005 version adding support for deletion and insertion of

input records

Copy Indicates which copy is associated with this call to the exit. Initially set to
1, it increments by one each time the exit is called.

DataSize
Contains the length of the input data record

DataPointer
Points to the input data record to be processed.

DataType
Always set to 0 (AFP; MO:DCA data only).

Note: If the exit is being called to indicate end of job processing:
v DataSize is set to 0,
v DataPointer is set to NULL
v DataType is set to 0 — no record is passed in at that time

The PSFINSERTRECS structure contains information about a structured field that
is to be inserted at the request of the Input Data Exit. The PSFINSERTRECS
structure contains these fields:

version
Version identifies to PSF the version of the PSFINSERTRECS structure that
is being supplied. The exit must supply a value of 0x01 or the record
(including the next_p pointer) is ignored.

next_p
Contains the pointer to the next record to insert.

record_p
Contains the pointer to the MO:DCA (AFP) structured field to be inserted.

Important

See more data definitions and comments in the ainuexit.h source file located in
install_path\exits\psf.

Note: The input information fields used by some of the sample programs are
available through the alternate sample user exits. InfoPrint Manager does not
provide an alternate Input Data User Exit.

Ouput data user-exit program inputs and outputs
The InfoPrint output data user-exit program is used to monitor the outgoing print
data stream from InfoPrint. This exit is called at the end of the job before the error
messages and the trailer page. The input and output data exits are one-directional,
that is, it can read the data but cannot alter it.

The source code (in the C programming language) for the sample input data
user-exit program listed in “Supported types of PSF DSS user-exits” on page 71 is
in the install_path\exits\psf\ainuxout.c file. This sample program consists of a
return code and performs no function.
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The data structures for the output data user-exit program are included with the
source code in the install_path\exits\psf\ ainuexit.h file. The code for these
structures is shown in “Structure of a user-exit program.”

The declaration of this exit is: void OUTDATA (OUTDATA_EXITDATA \exitdata)

The OUTDATA_EXITDATA input/output parameter contains all the input and
output data needed to communicate between InfoPrint and the user-exit program.

To build the executable program, you must use the Microsoft Visual Studio 2005
Program pull-down menu.

These fields are also found in the output data user-exit program:

Copy Indicates which copy is associated with this call to the exit. Initially set to
1, it increments by one each time the exit is called.

DataSize
Indicates the number of bytes in the buffer.

DataPointer
Points to a buffer containing the outgoing print data stream.

Structure of a user-exit program
All input and output variables used in InfoPrint user exits are defined through
either of these two files:
v install_path\exits\psf\ainuexit.h or
v install_path\exits\psf\ainurpt.h

The ainuexit.h file contains definitions for the header, trailer, separator, accounting,
audit, and post-print accounting exits, while the ainurpt.h file formats data for
these executable reporting utilities:
v Accounting Log – (ainurpt1; ainurpt2; ainurpt3)
v Audit Log – (ainurpt4; ainurpt5; ainurpt6)
v Post-print Accounting Log – (ainurpt7; ainurpt8; ainurpt9)

These user-exit program structure files are written in the C programming language.
The declarations and statements in these files show the structure of the InfoPrint
PSF user-exit programs, which are imbedded as part of the user-exit program.

User-exit programs for the line data transform

InfoPrint provides several sample user-exit programs for the line-data transform.
Use of the user exits is optional. You specify the names of the exit programs with
the inpexit, indxexit, outexit, and resexit keywords.

InfoPrint provides these sample programs:

install_path\exits\acif\apkinp.c
Input-record user exit

install_path\exits\acif\apkout.c
Output-record user exit

install_path\exits\acif\apkres.c
Resource exit
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In addition, InfoPrint provides these input-record user exits programs to translate
input data streams:
v apka2e
v asciinp
v asciinpe

apka2e
install_path\exits\acif\apka2e.c

Converts ASCII stream data to EBCDIC stream data.

The apka2e input-record exit program translates data that is encoded in one code
character set (CCSID) to another. You should use this exit when your job uses fonts
such as GT12, which has code points that are different from your data file. The
default translation is from ASCII (code set 00850) to EBCDIC (code set 00037) if the
INPCCSID and OUTCCSID parameters are not specified on the line2afp
command. INPCCSID specifies the input code page, and OUTCCSID specifies the
output code page.

To execute the apka2e input record exit program, set these keywords and values in
your line-data transform keyword file. The line2afp parmdd keyword identifies
the keyword file.
inpexit=install_path\bin\apka2e.dll
cc=yes
cctype=z

asciinp.c
install_path\exits\acif\asciinp.c

Converts unformatted ASCII data that contains carriage returns and form
feeds into a record format that contains an American National Standards
Institute (ANSI) carriage control character. This exit encodes the ANSI
carriage control character in byte 0 of every record.

The asciinp input-record exit program transforms an ASCII data stream into a
record format that contains a carriage control character in byte 0 of every record. If
byte 0 of the input record is an ASCII carriage return (X’0D’), byte 0 is transformed
into an ASCII space (X’20’) that causes a data stream to return and advance one
line; no character is inserted. If byte 0 of the input record is an ASCII form feed
character (X’0C’), byte 0 is transformed into an ANSI skip to channel 1 command
(X’31’) that serves as a form feed in the carriage-control byte.

To execute the asciinp input record exit program, set these keywords in your
line-data transform keyword file. The line2afp parmdd keyword identifies the
keyword file:
inpexit=install_path\bin\asciinp.dll
cc=yes
cctype=z

asciinpe.c
install_path\exits\acif\asciinpe.c

Converts unformatted ASCII data into a record format just as asciinp.c
does, and then converts the ASCII stream data to EBCDIC stream data.
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The asciinpe input-record exit program combines both of the user input-record
exits described above. To execute, specify inpexit=install_path\bin\asciinpe.dll
as the exit program in the keyword file and follow the directions specified for both
apka2e and asciinp.

The asciinpe.c input-record exit program translates data that is encoded in one
code character set (CCSID) to another. You should use this exit when your job uses
fonts such as GT12, which has code points that are different from your data file.
The default translation is from ASCII (code set 00850) to EBCDIC (code set 00037)
if the INPCCSID and OUTCCSID parameters are not specified on the line2afp
command. INPCCSID specifies the input code page, and OUTCCSID specifies the
output code page.

While the asciinp and asciinpe input-record exits do not recognize other ASCII
printer commands, you can modify these exits to account for these:
v backspacing (X’08’)
v horizontal tabs (X’09’)
v vertical tabs (X’0B’)

In addition to the information above, see the prolog of the asciinp.c source file that
is provided with InfoPrint Manager in the install_path\exits\acif directory for more
information about using and modifying these programs.

The C language header file for all ACIF exit programs is provided in
install_path\exits\acif\apkexits.h along with the build rules for the ACIF user exits
in install_path\exits\acif\Makefile.

To build the executable program, you must use the Microsoft Visual Studio 2005
Program, pull-down menu.

Input record exit
The line-data transform provides an exit that enables you to add, delete, or modify
records in the line-data input file. The program invoked at this exit is defined by
the value of the inpexit keyword of the line2afp command.

This exit is called after each record is read from the input file. The exit can request
that the record be discarded, processed, or processed with control returned to the
exit for the next input record. The largest record that InfoPrint Manager can
process is 32756 bytes. This exit is not called when the line-data transform is
processing resources from directories.

This example provides a sample C language header that describes the control block
that is passed to the exit program:
/*********************************************************************/
/* INPEXIT STRUCTURE */
/*********************************************************************/
typedef struct _INPEXIT_PARMS /* Parameters for input record exit */
{

char *work; /* Address of 16-byte static work area */
PFATTR *pfattr; /* Address of print file attribute info*/
char *record; /* Address of the input record */
unsigned short in_CCSID; /* input CCSID for translating @06a*/
unsigned short out_CCSID; /* output CCSID for translating @06a*/
unsigned short recordln; /* Length of the input record */
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unsigned short reserved2; /* Reserved for future use */
char request; /* Add, delete, or process the record */
char eof; /* EOF indicator */

} INPEXIT_PARMS;

The address of the control block containing these parameters is passed to the input
record exit:

work (Bytes 1–4)
A pointer to a static, 16-byte memory block. The exit program can use this
parameter to save information across calls (for example, pointers to work
areas). The 16-byte work area is aligned on a full word boundary and is
initialized to binary zeros before the first call. The user-written exit
program must provide the code required to manage this work area.

pfattr (Bytes 5–8)
A pointer to the print file attribute data structure. For more information
about the format of this data structure and the information it contains, see
“Attributes of the line data input file” on page 93.

record (Bytes 9–12)
A pointer to the first byte of the input record including the carriage control
character. The record is in a buffer that is located in a storage allocated by
the line-data transform but the exit program is allowed to modify the input
record.

in_CCSID (Bytes 13-14)
The value from the INPCCSID parameter on the line2afp command.

out_CCSID (Bytes 15-16)
The value from the OUTCCSID parameter on the line2afp command.

recordln (Bytes 17–18)
Specifies the number of bytes (length) of the input record. If the input
record is modified, this parameter must also be updated to reflect the
actual length of the record.

reserved2 (Bytes 19–20)
These bytes are reserved for future use.

request (Byte 21)
Specifies how the line-data transform processes the record. On entry to the
exit program, this parameter is X’00’. When the exit program returns
control to line-data transform, this parameter must have the value X’00’,
X’01’, or X’02’, where:

X’00’ Specifies that the line-data transform should process the record.

X’01’ Specifies that the line-data transform should not process the record.

X’02’ Specifies that the line-data transform should process the record and
then return control to the exit program to allow it to insert the next
record. The exit program can set this value to save the current
record, insert a record, and then supply the saved record at the
next call. After the exit inserts the last record, the exit program
must reset the request byte to X’00’.

A value of X’00’ on entry to the exit program specifies that the record be
processed. To ignore the record, change the request byte value to X’01’. If
you want the record to be processed, and you want to insert an additional
record, change the request byte value to X’02’. Any value greater than X’02’
is interpreted as X’00’, and the exit processes the record.
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Note: Only one record can reside in the buffer at any time.

eof (Byte 22)
An end-of-file (eof) indicator. This indicator is a one-byte character code
that specifies whether an eof condition has been encountered.

When eof is signaled (eof value=’Y’), the last record has already been
presented to the input exit, and the input file has been closed. The pointer
record is no longer valid. Records cannot be inserted when eof is signaled.
These are the only valid values for this parameter:

Y Specifies that eof has been encountered.

N Specifies that eof has not been encountered.

This end-of-file indicator allows the exit program to perform some additional
processing at the end of the file. The exit program cannot change this parameter.

Output record exit
Using the output-record exit, you can modify or ignore the records the line-data
transform writes into the output file. The program invoked at this exit is defined
by the outexit keyword of the line2afp command.

The exit receives control before a record (structured field) is written to the output
document file. The exit can request that the record be ignored or processed. The
largest record that the exit can process is 32752 bytes, not including the record
descriptor word. The exit is not called when the line-data transform is processing
resources.

This example contains a sample C language header that describes the control block
passed to the exit program:
typedef struct _OUTEXIT_PARMS /* Parameters for resource record exit */
{

char *work; /* Address of 16-byte static work area */
PFATTR *pfattr; /* Address of print file attribute information */
char *record; /* Address of the record to written */
unsigned short recordln; /* Length of the output record */
char request; /* Delete or process the record */
char eof; /* Last call indicator */

}OUTEXIT_PARMS;

The address of the control block containing these parameters is passed to the
output record exit:

work (Bytes 1–4)
A pointer to a static, 16-byte memory block. The exit program can use this
parameter to save information across calls (for example, pointers to work
areas). The 16-byte work area is aligned on a full word boundary and is
initialized to binary zeros before the first call. A user-written exit program
must provide the code required to manage this work area.

pfattr (Bytes 5–8)
A pointer to the print file attribute data structure. For more information
about the format of this data structure and the information it contains, see
“Attributes of the line data input file” on page 93.

record (Bytes 9–12)
A pointer to the first byte of the output record. The record is in a 32KB
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(where KB equals 1024 bytes) buffer. The buffer is located in storage
allocated by the line-data transform, but the exit program is allowed to
modify the output record.

recordln (Bytes 13–14)
Specifies the length, in bytes, of the output record. If the output record is
modified, this parameter must also be updated to reflect the actual length
of the record.

request (Byte 15)
Specifies how the line-data transform processes the record. On entry to the
exit program, this parameter is X’00’. When the exit program returns
control to the line-data transform, this parameter must have the value X’00’
or X’01’, where:

X’00’ Specifies that the line-data transform should process the record.

X’01’ Specifies that the line-data transform should not process the record.

A value of X’00’ on entry to the exit program specifies that the
record be processed. To ignore the record, change the request byte
value to X’01’. Any value greater than X’01’ is interpreted as X’00’;
the exit processes the record.

Note: Only one record can reside in the buffer at any time.

eof(Byte 16)
An end-of-file (eof) indicator. This indicator is a one-byte character code
that signals when the line-data transform has finished writing the output
file.

When eof is signaled (eof value=’Y’), the last record has already been
presented to the output exit. The pointer record is no longer valid. Records
cannot be inserted after eof is signaled. These are the only valid values for
this parameter:

Y Specifies that the last record has been written.

N Specifies that the last record has not been written.

This end-of-file flag, used as a last-call indicator, allows the exit program to
return control to the line-data transform. The exit program cannot change
this parameter.

Resource exit
The line-data transform provides an exit that enables you to filter (exclude)
resources. This exit is useful in controlling resources at the file-name level. For
example, assume you only wanted to use those fonts that are not shipped with
InfoPrint Manager. You could code this exit program to contain a table of all fonts
shipped with InfoPrint and filter those from the resource file. Security is another
consideration for using this exit because you could prevent certain named
resources from being included. The program invoked at this exit is defined by the
resexit keyword of the line2afp command.

This exit receives control before a resource is read from a directory. The exit
program can request that the resource be processed or ignored (skipped), but it
cannot substitute another resource name in place of the requested one. If the exit
requests that any overlay be ignored, the line-data transform automatically ignores
any resources the overlay might have referenced (that is, fonts and page segments).
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This example contains a sample C language header that describes the control block
passed to the exit program:
/*********************************************************************/
/* RESEXIT STRUCTURE */
/*********************************************************************/
typedef struct _RESEXIT_PARMS /* Parameters for resource record exit */
{

char *work; /* Address of 16-byte static work area */
PFATTR *pfattr; /* Address of print file attribute info*/
char resname[8]; /* Name of requested resource (8 byte) */
char restype; /* Type of resource */
char request; /* Ignore or process the resource */
char eof; /* Last call indicator */
unsigned short resnamel; /* Length of resource name @05A*/
char pad1[3]; /* padding byte @05A*/
char resnamf[250]; /* Rsrc name if more than 8 bytes@05A*/

} RESEXIT_PARMS;

The address of the control block containing these parameters is passed to the
resource record exit:

work (Bytes 1–4)
A pointer to a static, 16-byte memory block. The exit program can use this
parameter to save information across calls (for example, pointers to work
areas). The 16-byte work area is aligned on a full word boundary and is
initialized to binary zeros before the first call. A user-written exit program
must provide the code required to manage this work area.

pfattr (Bytes 5–8)
A pointer to the print file attribute data structure. For more information
about the format of this data structure and the information presented, see
“Attributes of the line data input file” on page 93.

resname (Bytes 9–16)
Specifies the name of the requested resource. The exit program cannot
modify or change this value.

restype (Byte 17)
Specifies the type of resource the name refers to. This is a one-byte
hexadecimal value where:

X’03’ Specifies a GOCA (graphics) object.

X’05’ Specifies a BCOCA (barcode) object.

X’06’ Specifies an IOCA (IO image) objec.t

X’40’ Specifies a font character set.

X’41’ Specifies a code page.

X’FB’ Specifies a page segment.

X’FC’ Specifies an overlay.

The line-data transform does not call this exit for these resource types:

Page definition
The page definition (pagedef keyword) is a required resource for
transforming a line-data file.

Form definition
The form definition (formdef keyword) is a required resource for
printing a transformed line-data file.
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Coded fonts
The line-data transform must process coded fonts to determine the
names of the code pages and font character sets they reference.
This is necessary in creating Map Coded Font-2 (MCF-2) structured
fields.

request (Byte 18)
Specifies how the line-data transform processes the resource. On entry to
the exit program, this parameter is X’00’. When the exit program returns
control to the line-data transform, this parameter must have the value X’00’
or X’01’ where:

X’00’ Specifies that the line-data transform should process the resource.

X’01’ Specifies that the line-data transform should ignore the resource.

A value of X’00’ on entry to the exit program specifies that the resource be
processed. To ignore the resource, change the request byte value to X’01’.
Any value greater than X’01’ is interpreted as X’00’and the resource is
processed.

eof (Byte 19)
An end-of-file (eof) indicator. This indicator is a one-byte character code
that signals when the line-data transform has written the last record.

When eof is signaled (eof value = ’Y’), the last record has already been
presented to the resource exit. The pointer record is no longer valid.
Records cannot be inserted after eof is signaled. These are the only valid
values for this parameter:

Y Specifies that the last record has been written.

N Specifies that the last record has not been written.

This end-of-file flag, used as a last-call indicator, returns control to the
line-data transform. The exit program cannot change this parameter.

resnamel
The length of the meaningful characters in field resnamf. In resnamel, the
last character is the letter l.

pad1 A padding byte to place resnamf on a word boundary.

resnamf
An actual name of the resource if it is greater than 8 characters. If the
name is 8 characters or less, it is stored in field resname instead.

Non-zero return codes
If the line-data transform receives a non-zero return code from any exit program,
the line-data transform issues message 0425-412 and terminates processing.

Attributes of the line data input file

Note: This data structure is provided for informational purposes only.

The line-data transform provides information about the attributes of the line-data
input file in a data structure available to the line-data transform user exits. This
example shows the format of this data structure.
typedef struct_PFATTTR /* Print File Attributes */
{

char cc[3]; /*Carriage controls? — “YES” or “NO” */
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char cctype[1]; /*Carriage control type - A(ANSI), M (Machine), Z (ASCII) */
char chars[20]; /*CHARS values, including commas (eg.. GT12,GT15) */
char formdef[8]; /*Form Definition (FORMDEF) */
char pagedef[8]; /*Page Definition (PAGEDEF) */
char prmode[8]; /*Processing mode */
char trc[3]; /*Table Reference Characters — “YES” or “NO” */

} PFATTR;

The address of the control block containing these parameters is passed to the user
exits:

cc (Bytes 1–3)
The value of the cc keyword as specified with the line2afp command. The
line-data transform uses the default value (yes) if this keyword is not
explicitly specified.

cctype (Byte 4)
The value of the cctype keyword as specified with the line2afp command.
The line-data transform uses the default value (z) for ANSI carriage-control
characters that are encoded in ASCII, if this keyword is not explicitly
specified.

chars (Bytes 5–24)
The value of the chars keyword as specified with the line2afp command,
including any commas that separate multiple font specifications. Because
the chars keyword has no default value, this field contains blanks if no
values are specified.

formdef (Bytes 25–32)
The value of the formdef keyword as specified with the line2afp
command. Because the formdef keyword has no default value, this field
contains blanks if no value is specified.

pagedef (Bytes 33–40)
The value of the pagedef keyword as specified with the line2afp
command. Because the pagedef keyword has no default value, this field
contains blanks if no value is specified.

prmode (Bytes 41–48)
The value of the prmode keyword as specified with the line2afp
command. Because the prmode keyword has no default value, this field
contains blanks if no value is specified.

trc (Bytes 49–51)
The value of the trc keyword as specified with the line2afp command. The
line-data transform uses the default value (no) if this keyword is not
explicitly specified.

Using the uconv command to convert coded character sets

InfoPrint Manager for Windows, Version 2 Release 2, replaced iconv with uconv
and uconv is used for Version 2 Release 3 as well for translating text strings. uconv
also lets you use UTF16 characters for translation.

iconv:

If you have written any line-data user-exit programs that use iconv, you need to
alter them to use uconv instead.
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From a Command Prompt window, you can invoke the uconv command to
convert the encoding of characters read from either standard input or the specified
file from one code character set (CCSID) to another and then write the results to
standard output (for example to convert ASCII to EBCDIC). This command is
useful when the line data coded character sets must be changed so they match the
coded character sets for the available font resources for a job. These are often
applied for job resources (such as page definitions and form definitions) that have
been created on either an AIX or an z/OS® operating system and sent to Windows.

For more information about the uconv command, see InfoPrint Manager: Reference.
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Chapter 17. Creating and managing auxiliary sheets and PSF
DSS user-exit programs

Besides logical destinations, queues, and actual destinations, the InfoPrint
Windows server also controls auxiliary-sheet objects. This section contains
information and procedures for creating and configuring these objects.

This section contains these topics:
v “Preparing to work with auxiliary sheets”
v “Creating and configuring auxiliary sheet objects” on page 105
v “Using Interrupt Message Pages” on page 107

Preparing to work with auxiliary sheets
These topics describe auxiliary-sheet terms, default auxiliary sheets, and PSF DSS
user-exit programs supplied by InfoPrint Manager, and provides examples of
printed auxiliary sheets:
v “Terms relating to auxiliary sheets”
v “InfoPrint default auxiliary-sheet objects” on page 98
v “Sequence of user-exit programs” on page 103
v “Directory locations of user-exit programs supplied with InfoPrint Manager” on

page 103

Terms relating to auxiliary sheets
To understand auxiliary sheets and how InfoPrint Manager generates the
information that appears on them, you need to understand these terms:

Auxiliary sheet
Represents a particular sheet of paper, blank or otherwise, that can precede
a job, separate copies of a job, or follow a job. PSF printers print auxiliary
sheets. Both Internet Print Protocol (IPP) and Passthrough printers also
print auxiliary sheets, but they do not use auxiliary sheet objects to activate
this support.

Auxiliary-sheet object
Represents a single user-exit program that you can specify for InfoPrint
PSF printers. User-exit programs process information that can be printed
on an auxiliary sheet or recorded in an accounting or audit log. Both the
actual destination (PSF printer) and the auxiliary-sheet objects must reside
in the same InfoPrint server.

Some auxiliary sheet objects supplied with InfoPrint Manager generate a
file that you can use with an executable reporting utility to view job
statistics. see Chapter 18, “Gathering accounting and audit data about print
jobs,” on page 111 for more information about viewing statistics.

Auxiliary-sheet object name
Identifies the auxiliary sheet object. The names of some of the default
auxiliary sheets indicate the style of the auxiliary sheet: brief, full, or
blank.

User exit
A point during print processing when you can tell InfoPrint Manager to
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run a user-exit program, then return control of processing to InfoPrint
Manager after the user-exit program ends. InfoPrint Manager provides data
at each exit point that can serve as input to the user-exit program.
InfoPrint Manager can use the output from the user-exit program for
InfoPrint Manager processing; for example, a user-exit program can pass
instructions about how to format a start sheet to InfoPrint Manager.
InfoPrint Manager provides user exits for these types of auxiliary sheets:
v Start sheet
v End sheet
v Separator sheet
v Accounting log
v Accounting sheet
v Audit log
v Audit sheet
v Input data stream
v Output data stream
v Post-print accounting (log file only)

User-exit program
Defines the data that prints and creates the format of the auxiliary sheet
style. InfoPrint Manager extends its function by providing user-exit
programs that you can use to format start, end, or separator sheets for the
job. Also, InfoPrint Manager user-exit programs allow you to track
accounting and audit information, as well as extract information about the
incoming and outgoing job data streams.

Form definition
Defines the characteristics of the form or printed media, which include:
overlays used, the paper source (for cut-sheet printers), duplex printing,
text suppression, and the position of composed-text data on the form.

For more information about both form definitions, see the InfoPrint
Manager: Reference.

Edge marks
Marks that print at the edges of auxiliary sheets and help to identify job
boundaries in printed output.

Interrupt Message Pages
Interrupt Message Pages (IMPs) are pages that are similar to the message
pages that print at the end of a print job, but IMPs are printed at the point
of an error where a possible data loss has occurred. See “Using Interrupt
Message Pages” on page 107 for more information.

InfoPrint default auxiliary-sheet objects
InfoPrint Manager provides default auxiliary-sheet objects, which it creates when
you first create a server. InfoPrint Manager automatically identifies these as
supported values for PSF actual destinations. The default auxiliary-sheet objects
with their associated user-exit programs and form definitions are shown in Table 8
on page 99.
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Table 8. Default auxiliary sheet objects

Auxiliary
sheet object

Form
definition

Description User exit
program

Additional Information

none n/a InfoPrint
generates no
auxiliary
sheet.

n/a n/a

brief F1A10110 Start sheet ainuxhdr

Separator
sheet

ainuxsep

End sheet ainuxtlr

Accounting
exit

ainuxacc

Audit exit ainuxaud

full F1A10110 Start sheet ainuxhdr2

Separator
sheet

ainuxsep2

End sheet ainuxtlr2

Accounting
exit

ainuxacc2

Audit exit ainuxaud2

blank F1A10110 Start sheet pduxblkh Blank sheet of paper

Separator
sheet

pduxblks

End sheet pduxblkt

accounting-
log

n/a Accounting
exit

ainacclog Writes accounting information to
the install_path \var\psf\
accounting.log file. Does not
produce a printed sheet.

Audit exit ainaudlog Writes audit information to the
install_path \var\psf\ audit.log
file. Does not produce a printed
sheet.

Post-print
accounting
exit

ainuxjob
completion

Writes post-print accounting
information to the install_path
\var\psf\ jobcompletion.log file
if the auxiliary sheet object’s
psf-post-print-accounting-program-
name is set to ainuxjobcompletion.
Does not produce a printed sheet.

job-ticket n/a Start sheet ainuxhdrp

Separator
sheet

ainuxsepp

End sheet ainuxtlrp

Accounting
exit

ainuxaccp Writes accounting information to
the install_path \var\psf\
podaccount.log Does not produce
a printed sheet.

Audit exit ainuxaudp
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Table 8. Default auxiliary sheet objects (continued)

Auxiliary
sheet object

Form
definition

Description User exit
program

Additional Information

64xx F1A10110 Start sheet ainuxhdrx

Separator
sheet

ainuxsepx

End sheet ainuxtlrx

You can create your own auxiliary-sheet objects using the InfoPrint pdcreate
command from a Command Prompt window. see “Creating new auxiliary-sheet
objects using the pdcreate command” on page 105.

Examples of Brief-Style and Full-Style Auxiliary Sheets
These examples of auxiliary-sheet printouts were produced using the InfoPrint
brief and full default auxiliary-sheet objects.

Start Sheet Examples: In Figure 5, the user-exit program ainuxhdr generated the
brief style of the start sheet and user-exit program ainuxhdr2 generated the full
style of the start sheet.

Separator Sheet Examples: In Figure 6 on page 101, the user-exit program
ainuxsep generated the brief style of the separator sheet and user-exit program
ainuxsep2 generated the full style of the separator sheet.
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Figure 5. Brief and Full Styles of Start Sheets
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End Sheet Examples: In Figure 7, the user-exit program ainuxtlr generated the
brief style of the end sheet and user-exit program ainuxtlr2 generated the full style
of the end sheet.

Accounting Sheet Examples: In Figure 8 on page 102, the user-exit program
ainuxacc generated the brief style of the accounting-log sheet and user-exit
program ainuxacc2 generated the full style of the accounting-log sheet.

IP
R

W
A

U
X

S
P

Figure 6. Brief and Full Styles of Separator Sheets
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Figure 7. Brief and Full Styles of End Sheets
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Audit Sheet Examples: In Figure 9 on page 103, the user-exit program ainuxaud
generated the brief style of the audit sheet and the user-exit program ainuxaud2
generated the full style of the audit sheet.
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Figure 8. Brief and Full Styles of Accounting-Log Sheets
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Sequence of user-exit programs
This figure shows the order in which InfoPrint calls the user-exit programs during
job processing on a printer. You cannot change this order.

Note: Separator sheets are printed only between copies of a job, not between
documents in a job.

Directory locations of user-exit programs supplied with
InfoPrint Manager

When you create the auxiliary-sheet object, you specify the name of the user-exit
program and other options, such as the form definition and whether the program
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Figure 9. Brief and Full Styles of Audit Sheets
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Figure 10. InfoPrint Manager user-exit program order at the printer
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produces printed output. You identify which auxiliary-sheet objects you want
associated with each actual destination using the GUI attributes notebook for each
actual destination. InfoPrint Manager runs the referenced user-exit programs when
you submit a job to that printer.

Table 9. Locations of InfoPrint Manager user exits

Program Description

Start Sheets

install_path\bin\pduxblkh.dll Prints a blank start sheet.

install_path\bin\ainuxhdr.dll Prints a brief-style start sheet.

install_path\bin\ainuxhdr2.dll Prints a full-style start sheet.

install_path\bin\ainuxhdrp.dll Prints job ticket information about the start
sheet.

install_path\lpp\psf\bin\ainuxhdrx.dll Prints a start sheet without vertical lines for
InfoPrint 6400 and 6500 model printers.

Separator Sheets

install_path\bin\pduxblks.dll Prints a blank separator sheet.

install_path\bin\ainuxsep.dll Prints a brief-style separator sheet.

install_path\bin\ainuxsep2.dll Prints a full-style separator sheet.

install_path\bin\ainuxsepp.dll Prints job ticket information on the
separator sheet.

install_path\lpp\psf\bin\ainuxsepx.dll Prints a separator sheet without vertical
lines for InfoPrint 6400 and 6500 model
printers.

End Sheets

install_path\bin\pduxblks.dll Prints a blank end sheet.

install_path\bin\ainuxtlr.dll Prints a brief-style end sheet.

install_path\bin\ainuxtlr2.dll Prints a full-style end sheet.

install_path\bin\ainuxtlrp.dll Prints job ticket information on the end
sheet.

install_path\lpp\psf\bin\ainuxtlrx.dll Prints an end sheet without vertical lines for
InfoPrint 6400 and 6500 model printers.

Accounting

install_path\bin\ainuxacc.dll Prints a brief-style accounting sheet.

install_path\bin\ainuxacc2.dll Prints a full-style accounting sheet.

install_path\bin\ainuxaccp.dll Writes accounting information to
install_path\var\psf\podaccount.log.

install_path\bin\ainacclog.dll Writes accounting information to
install_path\var\psf\accounting.log.

Post-print Accounting

install_path\bin\ainuxjobcompletion.dll Writes accounting information to
install_path\var\psf\jobcompletion.log

Audit

install_path\bin\ainuxaud.dll Prints a brief-style audit sheet.

install_path\bin\ainuxaud2.dll Prints a full-style audit sheet.

install_path\bin\ainuxaudp.dll Prints job ticket information on the audit
sheet.
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Table 9. Locations of InfoPrint Manager user exits (continued)

Program Description

install_path\bin\ainaudlog.dll Writes audit information to
install_path\var\psf\audit.log.

Input Data

install_path\bin\ainuxind.dll Performs no tasks; use it as a model for
writing your own user-exit program.

Output Data

install_path\bin\ainuxout.dll Performs no tasks; use it as a model for
writing your own user-exit program.

In addition, you can use the source code of the sample user-exit programs to write
your own user-exit programs. InfoPrint Manager provides the source code for all
of these exits in the install_path\exits\psf directory.

Creating and configuring auxiliary sheet objects

When you first create a server, InfoPrint creates the default auxiliary-sheet objects
described in “InfoPrint default auxiliary-sheet objects” on page 98.

These topics describe how you can create and configure auxiliary-sheet objects:
v “Creating new auxiliary-sheet objects using the pdcreate command”
v “Associating auxiliary-sheet objects with PSF printers” on page 106
v “Activating auxiliary sheets for accounting or audit information” on page 106
v “Associating the post-print accounting user-exit program with an actual

destination” on page 106
v “Associating an input data user-exit program with an actual destination” on

page 107
v “Associating an output data user-exit program with an actual destination” on

page 107

Creating new auxiliary-sheet objects using the pdcreate
command

You create auxiliary-sheet objects from the Command Prompt window; you cannot
create them through the InfoPrint administrator’s GUI. Use the pdcreate command
with the -c auxiliary-sheet flag and specify the server name and an auxiliary-sheet
object name to create a new auxiliary-sheet object. Specify a name that uniquely
identifies the auxiliary-sheet object in the server. Different servers can contain a
auxiliary-sheet objects with the same name, but possibly with different values for
their attributes.

You also specify the psf-exit-form-definition, psf-exit-page-mark, and
psf-exit-program-name attributes with the command to specify the form definition,
whether edge marks print, and the user-exit program used.

For example, to create an auxiliary-sheet object named custom-start contained in
Server1 that specifies the ainuxhdr user-exit program, the F1A10110 form
definition, and includes edge marks, enter the command:
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pdcreate -c auxiliary-sheet -x "psf-exit-program-name=ainuxhdr
psf-exit-form-definition=F1A10110 psf-exit-page-mark=true"
Server1:custom-start

Associating auxiliary-sheet objects with PSF printers

Use the InfoPrint Manager Administration GUI to associate auxiliary sheet objects
with PSF printers. Start the GUI and select the printer that you want to associate
with an auxiliary sheet. Then, click Printer → Properties to open the Printer
Properties notebook. To complete this task, see the online help in the InfoPrint
Manager Administration GUI, starting with the topic Using auxiliary-sheet objects.

Activating auxiliary sheets for accounting or audit information

You can use the InfoPrint Manager Administration GUI to specify auxiliary sheet
objects to collect accounting and audit information about jobs processed (as
opposed to printed) by a selected PSF printer. Start the GUI and select the printer
that you want to associate with an auxiliary sheet. Then, click Printer → Properties
to open the Printer Properties notebook. To complete this task, see the online help
in the InfoPrint Manager Administration GUI, starting with the topic Using
auxiliary-sheet objects.

To activate the accounting user-exit program , specify one of the accounting
user-exit programs names as the value for the psf-exit-program-name (for example,
psf-exit-program-name=ainacclog) in the auxiliary sheet object associated with the
destination. To activate the audit user-exit program, specify one of the audit
user-exit program names as the value for the psf-exit-program-name (for example,
psf-exit-program-name=ainaudlog) in the auxiliary sheet object associated with the
destination.

Each PSF actual destination can have one, both, or neither or the two accounting
methods (accounting and post-print accounting) active. If the accounting setup is
intended to be the same for all PSF printers, this can all be done with one auxiliary
sheet object, which can either be one you have created or the default
accounting-log auxiliary sheet object supplied by InfoPrint.

Associating the post-print accounting user-exit program with
an actual destination

Use the InfoPrint Manager Administration GUI to specify auxiliary sheets to
collect post-print accounting information about jobs processed by a selected PSF
printer. Start the GUI and select the printer that you want to associate with an
auxiliary sheet. Then, click Printer → Properties to open the Printer Properties
notebook. To complete this task, see the online help in the InfoPrint Manager
Administration GUI, starting with the topic Using auxiliary-sheet objects. Then set
the attribute of the auxiliary sheet object using the command shown in “Activating
the user-exit program” on page 74.

To activate the post-print accounting exit program, specify psf-post-print-
accounting-program-name=ainuxjobcompletion in the auxiliary sheet object
associated with the destination.

Each PSF printer actual destination can have one, both, or neither of the two
accounting methods (accounting and post-print accounting) active. If the
accounting setup is intended to be the same for all PSF printers, this can all be
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done with one auxiliary sheet object, which can either be one you have created or
the default accounting-log auxiliary sheet object supplied by InfoPrint.

Associating an input data user-exit program with an actual
destination

You can use the input data user-exit program to monitor the contents of the data
stream coming into InfoPrint Manager from the InfoPrint Manager
Administration GUI. Start the GUI and select the printer that you want to
associate with an auxiliary sheet. Then, click Printer → Properties to open the
Printer Properties notebook. To complete this task, see the online help in the
InfoPrint Manager Administration GUI, starting with the topic Using
auxiliary-sheet objects.

Associating an output data user-exit program with an actual
destination

You can use the output data user-exit program to monitor the contents of the data
stream created by InfoPrint from the InfoPrint Manager Administration GUI.
Start the GUI and select the printer that you want to associate with an auxiliary
sheet. Then, click Printer → Properties to open the Printer Properties notebook. To
complete this task, see the online help in the InfoPrint Manager Administration
GUI, starting with the topic Using auxiliary-sheet objects.

Using Interrupt Message Pages
Interrupt Message Pages (IMPs) provide a way for printer operators to find the
cause and location of a printing problem. IMPs are pages that are similar to the
message pages that print at the end of a print job, but IMPs are printed at the
point of an error where a possible data loss has occurred. This allows the operators
to make sure that no data is missing or to compensate for issues during the
post-processing phase of the print job.

IMPs are for use with PSF TCP/IP. They are associated with an Actual Destination
(AD), and cannot be changed for each job.

IMPs and finishing processes are incompatible and we do not recommend
combining these functions.

Scenario/Condition Produce interrupt message page?

Pause job Yes

Resume job Yes

Pause printer No

Resume printer No

AD shutdown - Synchronous (same as pause job) Yes

AD shutdown - Now (stop as soon as possible) No

NACKs 1 On an action code basis
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Scenario/Condition Produce interrupt message page?

Forward Spacing
– Normal in-job forward space

- before NPRO 2

- after NPRO
– Forward space with no pages committed
– Forward past the end of the job

- before NPRO
- after NPRO

Yes
No
Yes
No
Yes
No
Yes

Back Spacing
– Normal in job back space

- before NPRO
- after NPRO

– Back space with no pages committed
– Back space to the beginning

- before NPRO
- after NPRO

Yes
No
Yes
No
Yes
No
Yes

Print a page range No

Cancel job
- pdrm/pddelete
- cancel button on printer

Yes
Covered under NACK

Communication lost No

Stop button on the printer No - on ready/not ready
(other conditions fall under NACKs)

Add new IMP messages to the final message page Yes

Add messages to the IMP Yes

Print messages in currently supported NLS language Yes
1 negative acknowledgement2 non-process run out

Activating IMPs

Follow this procedure to enable a printer to produce IMPs:
1. Open the InfoPrint Manager Administration GUI.

2. Right-click on the printer that you want to enable and select Properties. The
properties notebook will open for that printer.

3. Click Auxiliary/Separator Sheets.
4. Click Yes next to Activate interrupt message page.
5. To use a form definition that is different than the default, enter the name of the

definition in the Interrupt message page form definition entry field.
6. To use page marks, click Yes next to Interrupt message page mark form. The

Interrupt message page mark form setting prints a mark on the edge of the
forms so that the mark is visible in a stack of paper when viewed from the
side. Continuous forms printers that are folding the forms will print the mark
where the fold in the pages occurs.

IMPs have a default message page form definition that is already assigned and is
designed to print on all paper sizes. This form definition is named F1MG0110, and
has these default settings:
v One copy
v No overlay

108 InfoPrint Manager for Windows: Procedures



v Use paper from bin 1

There is also a new form definition named F1MGIMP that is identical to the default
form definition, except that it specifies offset stacking.

You can create your own form definition, but be aware that doing so might alter
the ability of your form definition to print on all paper sizes. To create a form
definition, you must use the InfoPrint Page Printer Formatting Aid (PPFA) feature.
See the InfoPrint Page Printer Formatting Aid: User’s Guide, S544–5284, and the
InfoPrint Page Printer Formatting Aid: Command Quick Reference, G544–3701, for more
information.

If you are creating your own form definition and wish to use offset stacking, you
can use PPFA and specify JOG YES in the form definition.

Chapter 17. Creating and managing auxiliary sheets and PSF DSS user-exit programs 109



110 InfoPrint Manager for Windows: Procedures



Chapter 18. Gathering accounting and audit data about print
jobs

InfoPrint Manager for Windows lets you gather accounting information about print
jobs from two sources:
v The InfoPrint Manager server (applies to all destination support systems (DSSs)).

For more information, see Working with InfoPrint Manager Accounting
Information.
You should use accounting information from the InfoPrint Manager if you:
– need to track accounting information for all types of InfoPrint DSSs.
– want to take advantage of the pdaccount command to summarize data in a

spread sheet program.
v The PSF audit, accounting, and post-print accounting user-exit programs (applies

only to the PSF DSSs). For more information, see Working with PSF Accounting
and Audit User-Exit Programs.
You should use information from these PSF audit and accounting user-exit
programs if you:
– use only PSF attached printers.
– need more detailed information than that provided by the pdaccount

command.

Working with InfoPrint Manager server accounting information
While all DSSs can store accounting information about the jobs processed, the
information from some DSSs is more accurate than the information from others. All
actual destination accounting logs are enabled through the server and actual
destination log-accounting-data attribute. When you specify log-accounting-
data=true, InfoPrint stores data into server accounting logs (one for each
destination), which you can either view directly through your editor of choice
(such as Notepad) from the command-line or by specifying the pdaccount
command. The pdaccount command lets you obtain summary information in a
comma-delimited format (Printer1,12997,1989787763). This information can be
saved in a file, which can be imported into a spread sheet to calculate the cost of
consumables, the usage rate of printers, or the cost of printing by individual user.
The summary information includes both the total pages and total octets (the
number of bytes) printed, either by destination or by user as requested for a
specified time period. You can also obtain the complete accounting records
(information for all print jobs) for a specified time period, instead of the summary
data.

How does the pdaccount command collect InfoPrint Manager
accounting information?

To activate InfoPrint Manager account log support, you must change the
log-accounting-data value. By default, the InfoPrint Manager value is
log-accounting-data=false, and the actual destination default is to use the server
setting. As a result, you must log-accounting-data attribute as follows:
v To activate accounting for all destinations on a server:

set the server’s log-accounting-data attribute to True (if an actual destination
hasn’t specified this attribute, the server’s log-accounting-data attribute is used).
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v To activate accounting for a specific actual destination:
set the log-accounting-data attribute to True for that specific actual destination.
If you have not set an actual destination, the value of the log-accounting-data
attribute for the server is used.

v To deactivate accounting for all destinations on a server, :
set the log-accounting-data attribute to False . If an actual destination hasn’t
specified this attribute, the server’s log-accounting-data attribute is used.

v To deactivate accounting for a specific actual destination:
set the log-accounting-data attribute to False for that specific actual destination.
If an actual destination hasn’t specified this attribute, the server’s
log-accounting-data attribute is used.

You can change the log-accounting-data attribute with either a pdset command or
the InfoPrint Manager Administration GUI. For more information about the
InfoPrint Manager Administration GUI, see: ″Using the InfoPrint Interfaces″ in the
InfoPrint Manager for Windows: Getting Started.

The pdaccount command obtains these accounting information from one or more
InfoPrint Manager servers:
v actual destination name

v job owner

v global job-id

v submission time

v completion time

v pages-completed

v octets-completed

v data stream

v job name

Note: You only get all these accounting options if you specify pdaccount —t all on
the command line.

To request summary information grouped by destinations on an InfoPrint Manager
server named Server1 from 8 AM 9/20/99 to 8 AM 9/27/99, specify this from
either the Windows Command prompt or MS-DOS prompt window:
pdaccount -t destination -s '08:00:00 09/20/99' -e '08:00:00 09/27/99'
Server1

InfoPrint displays the information in a format similar to this:
Destination Name,Pages Completed,Octets Completed
Printer1,12997,1989787763
Printer2,2455,17676836
Printer3,86673,189808083

where Printer1 specifies the actual destination, 12997 indicates the pages
completed, and 1989787763 indicates the octets completed within the specified start
and end times (in this example, one week).

For more information about using the pdaccount command, see InfoPrint Manager:
Reference.
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How do you manage the InfoPrint Manager accounting logs?

Once you specify log-accounting-data=true on either an InfoPrint Manager server
or an actual destination, these accounting logs start growing without bound. As
part of your scheduled system maintenance, the accounting logs should be
managed carefully to avoid potential performance problems. Periodically, the log
files must be either deleted or moved to a different folder. If you do not do either
of these tasks, your server will run out of space on the disk drive, preventing you
from printing any more jobs.

The Windows accounting logs are in a subfolder of the server’s folder. This
describes the subdirectory where the files are located in:
install_path\var\pd\accounting.logs

InfoPrint Manager for Windows provides one accounting log for each destination,
named actual_destination_name .accounting.log.v1, where actual_destination_name
specifies the actual destination where the job is processed.

To save a record of InfoPrint Manager server accounting data, you need to move
the existing log files to a new drive. Be sure that these logs are not being written
to, then use this procedure:
1. Create a new directory in the location where you want to archive the existing

(prt1.accounting.log.v1 ) log file by moving to that location on your system
(from the command line prompt, specify E:, then cd \ntserver).
To create the new directory, type: mkdir 3qrt2001logs

2. Go back to your C drive to the folder where the log file is located in. Then
access that location, for example prt1.accounting.log.v1 on server1, by
specifying:
cd install_path\var\pd\accounting.logs

3. Copy the prt1.accounting.log.v1 file to a new directory on a different drive (E
for this example) named 3qrt2001 by specifying:
copy prt1.accounting.log.v1 E:\ntserver\3qrt2001logs\

This command copies the existing file to the new directory.
4. Remove the original prt1.accounting.log.v1 file from the install_path\var\pd\

accounting.logs folder:
del prt1.accounting.log.v1

When the next job is processed on prt1, InfoPrint creates a new
prt1.accounting.log.v1 file.

We recommend that you move the data to another disk drive rather than deleting
it from the system. This lets you store accounting data and delete it from the
system when you no longer need to refer to it. To delete the prt1.accounting.log.v1
file,
1. Specify cd install_path\var\pd\accounting.logs

This command moves you into the correct path.
2. Enter

del prt1.accounting.log.v1

When the MS-DOS command-line prompt returns, you know that the
prt1.accounting.log.v1 file has been deleted from the system.

3. Enter
dir
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This command displays the contents of your directory for you to verify that the
file has been deleted. When the next job is submitted for printing to that actual
destination, InfoPrint creates a new prt1.accounting.log.v1 file and writes the
data into that file.

The pdaccount command only finds and processes the information in the log files
in the original location. Once you move or rename the files, you cannot use the
pdaccount command to summarize the data. You might want to use the pdaccount
command to find and process the information and summarize it, store the
summaries in a different location, and then delete the logs.

Attention: Requesting information for all accounting records can consume a lot
of the server’s memory since all the data is read into memory to be sent to you. If
you have a lot of data to retrieve, you should consider requesting it for smaller
time periods and concatenating the returned data.

For example, to retrieve all the accounting records for a one month period, you
could issue four pdaccount commands like this:
v pdaccount -t all -s '00:00:00 03/01/00' -e '00:00:00 03/08/00' Server A

>March1.accting.data

v pdaccount -t all -s '00:00:00 03/08/00' -e '00:00:00 03/15/00' Server A
>March2.accting.data

v pdaccount -t all -s '00:00:00 03/15/00' -e '00:00:00 03/22/00' Server A
>March3.accting.data

v pdaccount -t all -s '00:00:00 03/22/00' -e '00:00:00 03/31/00' Server A
>March4.accting.data

Usage considerations by DSS for accounting information
This section contains more information about server accounting information by
DSS. It also gives suggestions for working with the various DSSs when using the
accounting information in InfoPrint Manager.

In general, InfoPrint Manager logs jobs that complete or are paused, cancelled, or
are cleaned while being processed by the actual destination. InfoPrint Manager
does not log jobs that are not completed but are put back into the queue because
the printer is shutdown when a printer problem is encountered.

PSF DSS with TCP/IP attachment type

v On jobs that complete successfully, the page count shown in the
accounting log is the number of AFP pages stacked on the printer,
including start pages, separator pages, and end pages.

Note: For n-up documents, up to n pages are counted for each
sheet-side that prints.

v Limitations:

– When printing a multiple-document job in which all the documents
are ASCII, the accounting log only shows pages for the last document
printed.

– If a job is paused or cancelled, the page count shown in the
accounting log might not be accurate.

– On paused jobs, the octet count is always zero (0).
– The number of Intelligent Printer Data Stream™ (IPDS) pages printed

is based upon the number of begin-page and end-page structured
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field pairs in the data. As a result, a 2–up document printed duplex
could provide a page count of four for a single sheet of paper.

PSF DSS with Other-Driver attachment type

v If you are using the IBM TCP/IP Port Monitor or the InfoPrint TCP/IP
Network Port Monitor and the job completes successfully, then the page
count shown in the accounting log is the number pages stacked at the
printer. For example, a three-page document printed simplex records
three pages in the accounting log and three pages stacked; a four-page
document printed duplex reports four pages in the accounting log even
through only 2 sheets are stacked.
A duplexed four-page job with a header sheet provides a page count of
four, because the auxiliary sheets are not included in the count, but both
sides of each page are counted.

v If you are not using the IBM TCP/IP Port Monitor or the InfoPrint
TCP/IP Network Port Monitor, the page count is not based on the
number of pages stacked on the printer. Instead, the page count
recorded in the accounting log is the number of pages PSF reports it has
sent to the printer driver, including start pages, separator pages, and end
pages.

v If you have set the document-formats-ripped-at-destination actual
destination attribute for a PSF DSS with Other-Driver attachment type
actual destination, the accounting is handled as if it had been submitted
to a Passthrough DSS actual destination.

v Limitations: The page count and octet count reported in the accounting
log for cancelled and paused jobs is not accurate.

PSF DSS with Command attachment type
The page count recorded in the accounting log for destinations using the
command is the number of pages PSF generates and sends to the printer. It
is not based on the number of pages received or printed by the printer.
The page count does include start pages, separator pages, and end pages.

BSD DSS
The page count recorded in the accounting log for destinations using the
BSD DSS is based on the these criteria:
v If the user specifies a job-page-count job attribute or a page-count

document attribute with the print job, InfoPrint Manager records that
number in the accounting log.

v If the user has not specified job-page-count or page-count, and the data
being printed is PCL or PostScript, InfoPrint Manager attempts to
calculate the page count and records the calculated page count in the
accounting log.

Internet Printing Protocol (IPP) DSS
The page count recorded in the accounting log for destinations using the
IPP DSS is based on these criteria:
v Depending upon the capabilities of the your particular IPP printer, if the

printer reports pages completed information through the Internet
Printing Protocol and the job completes successfully, that information is
used. The auxiliary sheet is not added to the count.

v If the user specifies a job-page-count job attribute or a page-count
document attribute with the print job, InfoPrint Manager records that
number in the accounting log. The auxiliary sheet is not added to the
count.
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v If the user has not specified job-page-count or page-count, and the data
being printed is PCL or PostScript, InfoPrint Manager retrieves the page
count from the printer, if the particular printer supports that function.
The auxiliary sheet is not included in the count.

v Limitations: Because all information is obtained through the Internet
Printer Protocol, the attributes required for pages-completed might not
be supported by a particular printer model.

Note: For accurate results with this DSS, make sure that you set the sides
default (whether simplex or duplex) in the printer to match the value on
the sides actual destination attribute.

Passthrough DSS
The page count recorded in the accounting log for destinations using the
Windows DSS is based on these criteria:
v If you are using the IBM TCP/IP Port Monitor or the InfoPrint TCP/IP

Network Port Monitor and the job completes successfully, then the page
count shown in the accounting log is the number pages stacked at the
printer. For example, a three-page document printed simplex records
three pages in the accounting log and three pages stacked; a four-page
document printed duplex reports four pages in the accounting log even
through only 2 sheets are stacked. Auxiliary sheets are not included in
the count

v If you are using the IBM TCP/IP Port Monitor or the or the InfoPrint
TCP/IP Network Port Monitor and the job does not complete
successfully, or if you are not using the IBM TCP/IP Port Monitor or the
InfoPrint TCP/IP Network Port Monitor and the user specifies a
job-page-count job attribute or a page-count document attribute with
the print job, InfoPrint Manager records that number in the accounting
log.
A duplexed four-page job with a header sheet provides a page count of
four, because neither the auxiliary sheets nor the back sides of each page
are included in the count.

v If the user has not specified job-page-count or page-count, and the data
being printed is PCL or PostScript, InfoPrint Manager attempts to
calculate the page count and records the calculated page count in the
accounting log. The auxiliary sheet is not included in the count.

Note: For accurate results with this DSS, make sure that you set the sides
default (whether simplex or duplex) in the printer to match the value on
the sides actual destination attribute.

Working with PSF accounting, post-print accounting, and audit data
about the job

The accounting, post-print accounting, and audit PSF DSS user-exit programs
record data about jobs. For each job printed, InfoPrint Manager activates the PSF
DSS accounting and audit user-exit programs before processing the print job’s
trailer page. InfoPrint Manager activates the PSF DSS post-print accounting
user-exit program when the job stacks. More than one InfoPrint actual destination
can use the same user-exit program to write into the same log file.

This section contains these topics:
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v “What do the accounting, post-print accounting, and audit PSF DSS user exits
provide?”

v “How do you format accounting, post-print accounting, and audit data for
viewing?” on page 119

v “How do you manage the contents of the data files?” on page 119

What do the accounting, post-print accounting, and audit PSF
DSS user exits provide?

The accounting and audit PSF DSS user-exit programs record statistical data on
jobs processed by InfoPrint Manager actual destinations. This table shows the most
common accounting and audit user-exit programs, the files where they record data,
and the types of data that they record.

Program Log File Records

install_path\ bin\ainuxaccp install_path \var\psf\
podaccount.log

Job submitter, job ID, actual destination,
submission machine (nodeid), pages
processed (projected), sheets from bin 1,
sheets from bin 2, end time, start date,
start time, copies per job

install_path\ bin\ainacclog install_path \var\psf\accounting.log Job submitter, job name, actual
destination, submission machine
(nodeid), pages processed (projected),
sheets from bin 1, sheets from bin 2,
end time, start date, start time, fonts,
resident fonts, overlays

install_path\ bin\
ainuxjobcompletion

install_path \var\psf\
jobcompletion.log

Job submitter, job ID, job name, spool
ID, actual destination, global ID, user
pages stacked by tray, user sheets
stacked by tray, actual pages stacked by
tray, actual sheets stacked by tray,
copies requested, fonts and resident
fonts used, overlays used, hard and soft
segments used, processing start and
stop date/time, job completion
date/time, file date/time, extended
user ID, extended job ID, address,
account, building, department,
programmer, room, title, job ticket
name

install_path\ bin\ainaudlog install_path \var\psf\audit.log Job submitter, job name, actual
destination, pages per job, pages per
actual destination, jobs per output bin,
start date, start time, fonts, resident
fonts, overlays

Bothinstall_path\ bin\ainacclogand install_path\ bin\ainaudlog record the same
information in different files. This information is specified in flat ASCII format,
with a single line for each job that is processed. You can use this information to
determine billing procedures, to assess the workload of different output devices, or
to determine how resources are used at your installation.

The ainuxjobcompletion exit is called when the printer reports back to InfoPrint
Manager that all of the pages for a job have printed. This includes a partial job
(due to a data stream error or because the job was paused/cancelled or
forward-spaced) and also any extra pages produced as a result of a backspace or
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other recovery. For the last job that prints on a continuous forms printer, the exit is
not called until an NPRO (non-print run out) is done, either by an operator or
automatically by InfoPrint Manager.

Only one record is written for a job that prints, unless a job is paused. In this case,
a record is written for the part of the job that was printed up to the pause point;
later, if the job is resumed, another record is written for the rest of the job.

Note: If InfoPrint Manager does not receive feedback from the printer that all
pages have stacked, such as when the printer is shut down in the middle of a job
or when an error such as a server failure occurs, no record is written.

A new procedure has been added to the InfoPrint Manager Administration GUI to
show you how to activate the default PSF ainuxjobcompletion accounting logs.
The ainuxjobcompletion accounting exit interface can be used for PSF-driven IPDS
printers. It provides actual (versus projected) accounting data and provides
additional information about completed print jobs.

Customers who migrate from an existing InfoPrint Manager Version, such as 1.1, to
InfoPrint Manager V2.2 will continue to find the previous accounting exit interface
intact. Accounting programs that count on the previous accounting interface, which
includes the IBM supplied samples, will function without modification.

Customers installing a InfoPrint Manager V2.2 server for the first time will see the
post-print accounting exit activated and the accounting data will be written to
install_path\var\psf\jobcompletion.log.

The intent is to minimize migration issues for existing customers, but to start new
customers out with the preferred accounting exit. The default installation for new
machines will not activate both accounting exits. However, when V2.2 is installed,
both new and migrated customers can choose to have the old, preferred, or both
accounting exits active.

If a migrating installation wants to activate the preferred (new) exit, the
administrator must set the psf-post-print-accounting-program-name auxiliary
sheet attribute in the appropriate auxiliary sheet object to provide the name of
either the IBM supplied sample exit or a custom version of the preferred exit. The
administrator can also choose to deactivate the old exit by resetting the value of
the psf-exit-program-name auxiliary attribute in the appropriate auxiliary sheet
object to <not set>.

If a new installation wants to deactivate the preferred exit and instead run the old
exit, the administrator must reset the psf-post-print-accounting-program-name
auxiliary sheet attribute in the appropriate auxiliary sheet object to <not set>. The
administrator can also choose to activate the old exit by setting the value of the
psf-post-print-accounting-program-name auxiliary sheet attribute in the
appropriate sheet object to the name of either the IBM supplied sample exit or a
custom version of the old exit.

In both cases, the administrator can also choose to have both exits active by setting
the psf-exit-program-name and the psf-post-print-accounting-program-name
auxiliary sheet attributes to the names of the two accounting programs (old and
preferred). The administrator can also choose to deactivate both exits by leaving
both attributes unset.
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How do you format accounting, post-print accounting, and
audit data for viewing?

To view this data, you can use one of these executable reporting utilities that are
provided with InfoPrint Manager. These reporting utilities only work if you open a
Command Prompt window, navigate to the install_path\bin directory, and run the
program from the command line.
v Accounting utilities

ainupod1
Reports accounting data stored in podaccount.log in a summary format
(one line per user), sorted by customer ID.

ainupod2
Reports accounting data stored in podaccount.log, sorted by job ID.

ainupod3
Reports detailed entries of times and pages printed for each job by the
customer ID from podaccount.log.

ainurpt1
Reports accounting data stored in accounting.log, sorted by actual
destination.

ainurpt2
Reports summary accounting data (one line per job submitted) stored in
accounting.log, sorted by job submitter.

ainurpt3
Reports detailed entries of times and pages printed for a specific job
submitter from accounting.log.

v Audit utilities

ainurpt4
Reports audit data stored in audit.log, sorted by actual destination.

ainurpt5
Reports summary audit data stored in audit.log, sorted by job submitter.

ainurpt6
Reports detailed entries of times and pages printed for a specific job
submitter from audit.log.

v Post-print accounting utilities

ainurpt7
Reports post-print accounting data stored in jobcompletion.log, sorted
by actual destination.

ainurpt8
Reports summary post-print accounting data stored in
jobcompletion.log, sorted by job submitter.

ainurpt9
Reports detailed entries of times and pages printed for a specific job
submitter in jobcompletion.log.

How do you manage the contents of the data files?

An installation with a regular schedule of printing jobs will accumulate accounting,
post-print accounting, and audit data that must be managed carefully to avoid
potential performance problems. Periodically, the log files must be either purged or
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moved to a different folder. If you do not do either of these tasks, your installation
might run out of space on the file system, preventing you from printing any more
jobs. To avoid this problem, you should purge or move the accounting and audit
logs as part of your system maintenance.

We recommend that you move the data to another file system rather than deleting
it from the system. That way, you can store accounting data and delete it from the
system when you no longer need to refer to it. This procedure describes one way
to copy the data to a new location.
1. On your InfoPrint Manager server system, open the Management Console and

click Edit → Service Configuration.
2. Make note of the directory that is listed in the Install path field.
3. Open Windows Explorer and navigate to the install path\bin directory.
4. In that directory, find the log file that you need to move, for example,

jobcompletion.log and select it.
5. With the file selected, click Edit → Copy.
6. Navigate to the directory that you want to archive the log file in and select

the directory.

Note: This directory might be on a different Windows system than the one
you are currently working on.

7. With the directory selected, click Edit → Paste.
8. Verify that the log file appears in the new directory.
9. Navigate back to the install path\bin directory.

10. In that directory, find the log file that you need to move, for example,
jobcompletion.log and select it.

11. With the file selected, click File → Delete.

To delete the jobcompletion.log file without storing the data in another folder, use
the procedure above, skipping steps five through ten.

When the next job is submitted for printing, InfoPrint creates a new
jobcompletion.log file and writes the data into that file.
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Chapter 19. Using the InfoPrint Manager line printer daemon
(LPD)

The InfoPrint Manager Line Printer Daemon (LPD) is a utility that lets you submit
print jobs from other operating systems using a Line Printer (LPR) client. The
InfoPrint Manager LPD replaces the LPD that is supplied with the Windows
operating system (TCP/IP Print Services); however, it submits the files it receives
directly to an InfoPrint destination, not to a Windows printer. It also supports the
-o options that are available with some LPR clients (-o options allow you to specify
advanced InfoPrint print options, such as formdefs and pagedefs).

Only one LPD can run on your InfoPrint Manager server system at a time. If you
have TCP/IP Print Services installed, InfoPrint Manager will disable it and enable
the InfoPrint Manager LPD. If you would prefer to use TCP/IP Print Services, use
the Management Console to change the service configuration. See the Management
Console help for further instructions.

Important: If you have a different LPD installed, InfoPrint Manager will not
disable it, but will install and start the InfoPrint Manager LPD. You must stop one
of the LPDs before you try to submit a print job using an LPR client.

To submit print jobs to the InfoPrint Manager LPD, you can use any LPR client.
However, to be able to specify advanced InfoPrint options on the –o flag, you
should use the lprafp sample code package. lprafp is an LPR client that is
available as a free download from the InfoPrint Solutions Company Web site. The
package includes executable forms of the lprafp client for the Windows and AIX
(version 4.3.3 and later) platforms. You can compile this code to use it on other
platforms as well. InfoPrint Solutions Company does not provide support for the
package.

For information about downloading, configuring, and using the lprafp sample code
package, see “Submitting print jobs through the InfoPrint Manager LPD” on page
308.
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Chapter 20. Using the InfoPrint Manager System Migration
(ismu) Utility

You use the InfoPrint System Migration (ismu) utility for backing up, restoring, or
migrating your InfoPrint Manager environment. This utility is based on the
existing server archive functionality, and it backs up your current configuration
from a specific level of InfoPrint Manager and restores it on the same or different
InfoPrint Manager environment.

Using this utility, you can back up any level of your InfoPrint Manager
environment.

When using this utility for restoring purposes, we recommended having the
InfoPrint Manager and the backup archive at the same level. If they are not at the
same level and you proceed with the restoring or migration process, two warning
messages will prompt you that you are not on the same level and the results might
be unpredictable. This still enables you to have the backup or restore process ran
at slightly different levels (for example x.2.0.255 versus x.2.0.256).

If you need to perform a migration between different levels of InfoPrint Manager,
follow these steps:
v Make sure that InfoPrint Manager is at the same level on the backup and target

environments
v Perform the backup and restore required operations, as documented in InfoPrint

Manager: Reference.

v If necessary, upgrade InfoPrint Manager to the required level.

Note:

v The ismu utility must not be used to perform crossover migrations, such as
migrating the AIX environment to the Windows environment and backwards.
Use this command to backup and restore only similar operating system
environments.

v For the Version 2 Release 2 customers convenience, we are delivering the
InfoPrint Manager System Migration Utility on the server CDs starting with the
next update for Release 2.

Supported operating environments

The ismu utility can run on any of these operating systems:
v Windows 2000 Server SP4
v Windows 2000 Professional SP4
v Windows XP Professional SP2
v Windows Server 2003 Standard Edition SP1
v Windows Server 2003 R2 Standard Edition Service Pack 2
v Windows Server 2003 Enterprise Edition SP2
v Windows Server 2003 R2 Enterprise Edition SP2
v Windows Vista Business
v Windows Vista Enterprise
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v Windows Server 2008 Standard Edition SP1

InfoPrint System Migration Utility requires that the minimum level of InfoPrint
Manager is Version 2 Release 2. The utility does not support Version 2 Release
1migrations. The tool will not limit the migration from Version 2 Release 1 but the
results might be unpredictable.

Prerequisites

Before using the ismu utility, make sure you are aware of these recommendations:
v To run this utility, you must have administrative rights on the system InfoPrint

Manager is running.
v The InfoPrint Manager server(s) must be installed and running at all times.
v The InfoPrint Manager target server(s) must not contain any objects.
v To run the ismu utility, these programs must be installed on your machine:

zip and unzip

v The ismu utility also requires IBM Java™ Runtime Environment 1.4.1 or later to
be installed on your machine.

Note: You can only run the ismu utility locally. This utility does not have network
functionality.

Migrating your InfoPrint Manager settings

Before migrating your InfoPrint Manager settings and objects, read the following
sections to find out more about what files are automatically backed up and what
files are not automatically backed up. For the files and settings that are not
automatically backed up, you should use the manual back up procedure.

Automatic process

This section lists the files that will be automatically backed up and restored by the
ismu utility.

Table 10. Files that the ismu utility automatically backs up and restores

Files automatically backed up and restored

Custom notification and PSF exits

FST security settings

PSF Direct configuration

Custom or modified halftones.

Transform configuration files.

Server Admin/Operator GUI configuration/customization.

Custom 64xx GRID mapping tables.

Custom ICU tables.

Custom auxilliary-sheets.

Custom LPD parameters mapping tables.
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Automatic tasks during migration

This section details all sections of InfoPrint Manager that are automatically backed
up during the migration process.

Custom notification and PSF exits

The program automatically backs up and restores any custom exits and/or PSF
exits it founds including these two server exits:

lower-memory-usage-exit

upper-memory-usage-exit

FST security settings

The ismu utility automatically backs up and/or restores all the files within the
<install_path>\var\pddir\acl directory.

PSF Direct configuration

The ismu utility copies all the <install_path>\var\psf\psfdirect\*.profile files from
source to the target server.

Custom or modified halftones

The ismu utility backs up and/or restores all files from the <install_path>\psf\
config\custom directory.

Transform configuration files

By default, InfoPrint Manager comes with this transforms: gif2afp, img2afp,
jpeg2afp, pcl2afp, ps2afp, tiff2afp and xml2afp. There are two other transforms that
are installed separately: afp2pdf and sap2afp. The configuration files for all the
transforms are located in <install_path>\InfoPrint Manager\
<transform_name_directory>, and if you had modified them, then the modified files
will be copied onto the new server.

Server Admin/Operator GUI configuration/customization

Copy all the ipgui_*.cfg files from <install_path>\ipgui directory on the new
server.

Custom 64xx GRID mapping tables

Copy all the customized *.grd files from <install_path>\var\psf\<printer_name>.

Custom ICU tables

Copy all the customized .cnv files from <install_path>\unicode\data\mappings..

By default it contains 6 cnv files:
v icudt24b_ibm-1388-sap2afp.cnv
v icudt24b_ibm-933-sap2afp.cnv
v icudt24b_ibm-937-sap2afp.cnv
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v icudt24b_ibm-939-sap2afp.cnv
v icudt24b_ibm-1399-sap2afp.cnv
v icudt24b_IBM-943C.cnv

If exist, the tool will copy and/or restore all the files from <install_path>\usr\lpp\
psf\afp2pdf\cnv.

Custom auxilliary-sheets

If the output shows more than the default sheets that come with InfoPrint Manager
(64xx, accounting-log, blank, brief, full, job-ticket and none) then the program
automatically copies the customized sheets to the new server. Also, the customized
user-exits from <install_path>\usr\lpp\psf\exits\psf are copied, too.

Manual process
The following list contains parts that the ismu utility will not automatically back
up and restore.
v Third party applications
v Fast Connect/SAMBA software and configuration for IPDATA and

interoperating
v IPPGW configuration
v Channel configuration
v Associated installed products and/or InfoPrintManager features
v IJT and Web Server
v Halftone Management System
v Port monitors
v Registry data about psfin
v Custom fonts paths
v Multi-server environment and credentials (user/password)
v Registries
v MMC ″Edit->Service Configuration″ checkboxes
v ″Communication Ports″ MMC registry
v Gateway printer definitions
v DPF and MVS Download settings
v Custom exits for ACIF and MVS Download

Specific tasks during migration
During the migration process, it is very important to make sure that all objects are
correctly backed up and your initial configuration is correctly restored. Therefore,
these sections list all important areas where you should take additional steps for
an accurate migration process.

Fast Connect/SAMBA software and configuration for IPDATA and
interoperating

If the source pdserver that must be migrated is inter-operated with another server,
you must set up the interoperating environment on the new server.

To find more information about this procedure, follow the instructions from
InfoPrint Manager for AIX: Procedures: (G550-1066), Chapter 23 ″Configuring InfoPrint
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systems for interoperability″ and InfoPrint Manager for Windows: Procedures:
(G550-1073) Chapter 22 ″Setting up interoperating environments″.

If job ticketing is used, you must configure the IPDATA folder. The documentation
for this task is found in ″InfoPrint Job Ticketer: Administrator’s Guide: (S550-1056)″,
Chapter 3 ″Installation and Configuration″ - ″Setting up shared file support″.

Channel configuration

The channel configuration is no longer supported. The printers will be created, but
they won’t start.

Associated installed products and/or InfoPrint Manager features

PPFA

If you have this feature installed, you must install it from the InfoPrint PPFA
Feature CD on the new server. If you have customized PPFA source files, you need
to copy them to the new server for later processing.

AFP Resource Installer

This is an independent Windows application. You need to make sure that the
resources used by the InfoPrint Manager objects are available on the new system.

InfoPrint Job Ticketer and Web Server

If you have InfoPrint Job Ticketer installed on your machine, follow these steps:
1. On the new server, install the InfoPrint Print-on-Demand Feature with Job

Ticketer.
2. Copy the \var\pdjt\JobLibrary directory from the old server to the new one

and also copy the database from \var\db\ibmdb
3. Open the Job Ticketer application in the browser and select ″Preferences″ from

the left panel.
4. Make sure that the same settings on the new server (measurement units,

submitted jobs to retain and file sharing folder) exist.
5. Click ″Print Devices″ in the menu and make a list with the print servers, port

numbers, and active/inactive status.
6. Add these print servers in InfoPrint Job Ticketer on the new server.

IPPGW configuration

Make sure that the service is started by following these steps:
1. Go to Control Panel -> Administrative Tools -> Services.
2. If the service ″InfoPrint Manager IPP Gateway″ is started, start it on the new

server also.

To do this you need to perform these steps:
1. From the Management Console, select Edit > Service Configuration.
2. Check the ″Automatically start IPP gateway..″ box.
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3. To verify that the gateway is working open the Internet browser and enter the
following web address, replacing serverhostname with the DNS hostname of
the system where the IPP gateway daemon is running: http://
serverhostname:631/printers

Note: IPPGW can be ran only with default port which is 631.

Halftone Management System

If you have Print-on-Demand feature installed then you have Halftone
Management System server running.

Start the Halftone Management System server on the target InfoPrint Manager
machine. The configuration does not need to be migrated. The halftones are
handled automatically.

Note: If you have HMS on R1, you need to buy the POD licenses, due to the fact
that HMS has been moved to the POD feature.

Custom exits for ACIF and MVS Download..

If there are any ACIF exits, you need to copy and restore all the MVS Download
exits located in \bin\mvsdsubm.exe and \exits\mvsd (source files and objects) to the
right location on the target server. Also, you need to copy all the ACIF exits
located in \bin\ (apk*.dll, asciinp*.dll and dbblank.dll) and the source files
located in \exits\acif\ directory.

Windows port monitors

To check if there are Windows port monitors, enter this command:

# pdls -c destination -r attachment-type -U <server_name>:

If there is a destination with attachment-type=other-driver, you need to do the
following migration steps for the port monitor:
1. Enter this pdls command:

# pdls -c destination -r device-name -U <server_name>:<ADname>

2. The output will show the name of the port where this DSS sends the data.
3. From Windows Printers and Faxes, right click one of the printers, select

Properties, and then select the Ports tab.
4. From the list of ports, you need to locate the one that was returned by the

previous pdls command. Select it and press the Configure Port button. This
will provide all the details of the port monitor used (port monitor type, IP
address, etc).

5. Install the same port monitor on the target machine and create a port with the
same properties identified in Step 4.

Registry data about psfin
1. Open the Management Console.
2. Go to Options -> Customize Input Manager.
3. Check if these values are the default ones:
v Directory for segmet lists: \var\psf\seglist
v Directory for segmets and percent usage threshold: \var\psf\segments 90
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v Workspace management: automatic
v Default segment size: 5000
v Percentage of workspace for retained segments: 5
v Enable trace: unchecked

4. If the values match the default ones, no work needs to be done; otherwise, you
need to modify the defaults on the new server also to match the ones from the
source server.

Custom fonts paths

If you use other fonts than the ones shipped with the product, you have to migrate
them.

In order to do this, complete these steps:
1. Open the Management Console
2. Go to Edit -> Service Configuration .
3. Locate the Default font search path filed.

If it has a value different than the default one (\fontlib), make sure that the
same path is set on the new server, that it exists, and that it contains the same
fonts as the one on the original server.

4. If you have set the resource-context or resource-context-font attributes for any
actual destination to point to a custom path, you have to migrate the custom
path.

5. If the you have set the above attributes for a default document object, you need
to have the path and fonts on the new server, too.

6. To check the values of these attributes, use the following pdls commands:
#pdls -c destination -r resource-context <server_name>

#pdls -c initial-value-document -r resource-context <server_name>

#pdls -c destination -r resource-context-font <server_name>

#pdls -c initial-value-document -r resource-context-font <server_name>

7. Copy the font folders pointed to by the attributes listed above to the new
server. Also, set the Default font search path field in the Management Console
to match the one from the original server.

Multi-server environment and credentials (user/password)

The Management Console Registry can be seen by opening the Management
Console and selecting Edit->Service Configuration. There are 8 paths listed there.
The defaults values for them are:
v Install path: C:\Program Files\IBM\InfoPrint Manager
v Base namespace path: C:\Program Files\IBM\InfoPrint Manager\var\pddir
v Remote namespace folder: none

v Workspace path: C:\Program Files\IBM\InfoPrint Manager\var\pd
v AFP support workspace path: C:\Program Files\IBM\InfoPrint

Manager\var\psf
v Default fonts search path: C:\Program Files\IBM\InfoPrint Manager\fontlib
v Default resource search path: C:\Program Files\IBM\InfoPrint Manager\reslib
v Shared client path: none
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If you have modified any of these paths, you need to make the same modifications
on the target serve:
1. On the new installation, stop the pdserver and open the Service Configuration

dialog.
2. Change the paths that were customized to match the ones from the original

server.
3. Copy the contents of the font and resource folder from the original server to

the new one.
4. Start the pdserver.

Management Console “Edit->Service Configuration” checkboxes
1. Open the Management Console.
2. Go to Edit->Service Configuration.
3. Check if the following checkboxes have these default values:
v Automatically start server during system startup = checked
v Automatically start IPP gateway during system startup = not checked
v Confirm object delete = checked
v Run notification server on this system = checked
v Run InfoPrint Manager LPD service = checked

4. If any of these are not as above, open the Service Configuration dialog on the
new server and check the same checkboxes as on the original server.

“Communication Ports” Management Console registry
1. Open the Management Console.
2. Go to Edit->Service Configuration.
3. Check if the following fields have these default values:
v Server interface port numbers: 6880 through 6889
v Client interface port numbers 6874 through 6877

4. If any of these are not as above, open the Service Configuration dialog on the
new server and make the same modifications as on the original server.

Windows Gateway printer definitions

Check if Windows Gateway printers are installed on the source system:
1. Open the Management Console and select Objects -> Windows Gateway

Printers.
2. If there are printers defined, then you need to migrate them:
v In the Management Console, look at these Gateway Printer normal settings

(share name, target destination, Windows driver name, poll interval, etc) and
the Advanced settings and write them down.

v On the target system, install the printer driver used by each gateway printer
and then go to the Management Console and create the gateway printer with
the same settings from the first step.

.

DPF and MVS Download settings

If there are folders in \var\pd\dpf\receivers directory, these folders must be
copied to the new server. Each of these folders represents one DPF Host Receiver.
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After that, check if the receivers configuration was customized:
1. Open the Management Console.
2. Go to Options-->Preferences.
3. Check these default values:
v The field ″MVS Download receivers view interval″ is by default 0.
v The field ″DPF Host receivers view interval″ is 30.
v ″DPF Resources view interval″ is 0.
v The ″Disk Usage for Jobs/Resources directory″ is unchecked.
v All three checkboxes for ″Optional DPF Resource columns to display″ are

checked.
4. If the existing values are different than the defaults listed above, make the same

modifications on the target server also.
5. For every receiver from the Management Console > MVS Download

Receivers, complete these steps:
v Double click on each of the receivers and write down the settings of the

receiver.
v On the new server, recreate each receiver from the Management Console ->

MVS Download Receivers by right clicking it and selecting New.
v Use the same settings that were previously written down.
v Additionally, for each receiver you check the file from the “Destination

Control File” field. The default file should be \var\pd\mvsd\mvsdmap.txt).
If this is not the default or if the this file has been customized it, copy it to
the same location on the new server.

v For each receiver in the Advanced properties window, check if the field “Exit
Program Name” points to a file; if it does, copy this file at the same location
on the new server.
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Chapter 21. Setting up interoperating environments

This section describes this interoperating information:
v “Understanding interoperating environments”
v “Setting up a print environment with multiple Windows servers” on page 135
v “Configuring for interoperability between an InfoPrint AIX server and an

InfoPrint Windows server” on page 138

Understanding interoperating environments
When you install an InfoPrint Manager server, the install process creates a
namespace for that server. The namespace is a directory structure where InfoPrint
Manager stores the location information of all of your InfoPrint objects, including
the server itself, queues and destinations, and the Access Control Lists (ACLs) used
by InfoPrint Manager Security. On a Windows system, the namespace is located by
default at <install path>\var\pddir, where <install path> is the directory that
you installed InfoPrint Manager in.

If you install a second InfoPrint Manager server on another system on your
network, that server will create its own namespace and the two servers will
operate entirely independent of each other. In some cases, however, you might
want your servers to be able to work together. To make InfoPrint Manager servers
work together, you set up an interoperating environment in which two or more
InfoPrint Manager servers share the same namespace. The namespace is on one of
the servers and the other servers are granted permissions that allow them to use
that directory.

In InfoPrint Manager for Windows, Version 2, Release 2, you should only set up
two or three servers to interoperate (not four or more). Those servers can all be
installed on Windows 2000 systems, on Windows 2003 systems, on Windows XP
systems, or on a combination of Windows systems. In addition, if you have
InfoPrint Manager for AIX, it can be one of the three interoperating servers as well.

When configuring InfoPrint Manager servers to support interoperability, make sure
that these rules are followed:
1. Each InfoPrint Manager server must be accessible by all other InfoPrint

Manager servers using the same IP address.
For example, if Server1 is an InfoPrint Manager AIX server with an IP address
of 9.99.155.122, then all other InfoPrint Manager servers must use
9.99.155.122 to access Server1.

2. The IP address for each InfoPrint Manager server must be the address that is
identified for the first (or primary) network card that is defined to that server.

Reasons for setting up an interoperating environment
Not every printing system needs multiple InfoPrint servers. In fact, in many
environments one InfoPrint server is adequate. However, in print environments
that do very high volume printing or that print in remote locations (for example, a
main office with branch offices in different parts of the city), interoperating
InfoPrint servers can provide important benefits:
v Interoperating servers are much more scalable than single servers.
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– If your print volume increases and you find that you need more processing
power or memory to be able to meet the demand, you can add a second
server. However, by making the servers interoperate, you still only have one
printing system to administer.

– If your business expands and you add another office, you can add another
server to the namespace. You’ll have to define any new printers that you add
to the network, but you won’t have to redefine existing printers or move
resources again to be able to use them from the new location.

v Interoperating servers allow you to distribute print server functions across
systems.
Remote locations can have their own local servers, but you can administer them
from a central location.

Multiserver configuration examples
There are various ways to set up multiple InfoPrint Manager servers and have
them work together. Below are some example configurations and the benefits they
provide.
v Install two InfoPrint Manager servers in the same physical location.

One of the servers contains all of the InfoPrint print queues and logical
destinations, and the other contains all of the actual destinations. In this setup,
you balance processing between the two systems by spooling and scheduling on
one system and transforming and printing on the other.

v Install one InfoPrint Manager server in the main office and one in each
branch office.

The namespace is located on the InfoPrint Manager server in the main office,
and the other two servers are set up to share it. All three servers have logical
destinations, queues, and actual destinations defined in them, and the users
submit their print jobs to their local server. About 90% of the time, the servers
handle local print jobs, so it makes sense for each location to have its own
server. However, several times each week, the main office generates reports that
are needed at the branches. Instead of printing the reports and sending them
across town or faxing several hundred pages to each office, they simply send the
print job to printers at the branch offices. If necessary, the branch offices can do
the same thing.
In addition, because of the common namespace, the system administrator can
monitor all of the servers from a central location; if there’s a problem at one of
the branches, he can investigate it from the main office.

Important issues in interoperating environments
Before you set up an interoperating environment, consider these issues.
v Which system should contain the namespace?

The namespace does not contain large volumes of data (so it doesn’t have to
reside on the system with the most disk space) and it doesn’t move a lot of data
across the network. However, because all of the other servers will rely on the
namespace server, it must be available and reliable. Put the namespace on the
system that is the most available (always running) and most reliable (doesn’t
have to be rebooted often).

v InfoPrint Manager Security

All of the information that InfoPrint Manager Security uses to protect your
printing system (groups and Access Control Lists (ACLs)) is stored in the
namespace. When you share the namespace, the groups and ACLs that you set
on the namespace server apply to all of the servers; the groups and ACLs that
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you set on the other servers before they joined the common namespace
disappear. As a result, you should wait until you have the interoperating
environment set up before you set up any security on the systems.

v Printer drivers

If you are setting up an interoperating environment with mixed operating
systems (for example, two Windows 2000 systems and one Windows 2003
system), make sure that the printer drivers you choose work correctly in both
environments.

Setting up a print environment with multiple Windows servers

Some print environments require more than one InfoPrint Manager server to
handle their print management. If you are installing and configuring more than
one InfoPrint Manager for Windows server in your print environment, this section
will tell you what you need to do to make those servers work together.

When you install InfoPrint Manager, the install process creates a namespace for
that server. The namespace is a directory structure where InfoPrint Manager stores
the location information of all of your InfoPrint objects, including the server itself,
queues and destinations, and the Access Control Lists (ACLs) used by InfoPrint
Manager Security. On a Windows system, the namespace is located by default at
<install path>\var\pddir, where <install path> is the directory that you
installed InfoPrint Manager in.

If you install a second InfoPrint Manager server on another system on your
network, that server will create its own namespace and the two servers will
operate entirely independent of each other. In some cases, however, you might
want your servers to be able to work together. To make InfoPrint Manager servers
work together, you set up an interoperating environment in which two or more
InfoPrint Manager servers share the same namespace. The namespace is on one of
the servers (the namespace server) and the other servers (the non-namespace servers)
are granted permissions that allow them to use that directory.

With InfoPrint Manager for Windows, Version 2, Release 2, you should only set up
two or three servers to interoperate (not four or more). Those two or three servers
can all be installed on Windows systems, or on a combination of Windows
systems. In addition, if you have InfoPrint Manager for AIX, it can be one of the
three interoperating servers as well.

If you want InfoPrint Manager for Windows and InfoPrint Manager for AIX
servers to work together, see “Configuring for interoperability between an
InfoPrint AIX server and an InfoPrint Windows server” on page 138.

Notes:

1. You can only install one InfoPrint Manager server on a given Windows
workstation or server.

2. For your InfoPrint Manager servers to work together, they must all operate in
the same domain.

3. If your users will be submitting jobs directly to actual destinations, the actual
destination and the associated queue and logical destination must be on the
same server.

4. Once you have your multi-server system running, if the system that one of
your non-namespace servers is installed on shuts down or is restarted, that
InfoPrint Manager server will not restart automatically when the system
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restarts, even if you have that option selected in the Management Console. You
must open the Management Console for that server and start it manually.

5. You must set up each of your InfoPrint Manager servers so that all of the other
InfoPrint Manager servers can access them using the same IP address. For
example, Ipserv1 sometimes uses the IP address 9.99.155.122 and other times
uses 9.89.214.162, depending upon the machine that is trying to connect to it.
Ipserv2 and Ipserv3 must be able to access Ipserv1 through the same one of
those addresses; if Ipserv2 uses 9.99.155.122 to access Ipserv1, Ipserv3 must use
9.99.155.122 as well.

6. If you have more than one network adapter card in the system that InfoPrint
Manager runs on, the other InfoPrint Manager systems must be able to access
the system through the IP address that corresponds to the first (or primary)
network card in the system.

Configuration example

The recommended way to set up interoperating Windows servers is to create one
domain user account and let all of the InfoPrint Manager services use it as their
login account. The steps below describes how to set up this type of configuration.

Note: It is possible to configure your system so that each InfoPrint Manager
service has its own domain user account. If you want set up this alternate
configuration, you can follow the same basic instructions. However, in step 4, you
would create a domain user for each server. Then, when you assign user rights and
set up sharing in subsequent steps, you must make sure you use the same user
and password consistently on each system.

To have your InfoPrint Manager services share a namespace and a log in account.
1. Install all of your InfoPrint Manager servers.

Follow the installation instructions in InfoPrint Manager for Windows: Getting
Started. When you are finished, your servers will be operating independently.

2. Stop all of your InfoPrint Manager servers.

On each system that an InfoPrint Manager server runs on, open the InfoPrint
Manager Management Console and click File → Stop Server.

Note: If you are using the SAP Print Feature with an OMS configuration, you
must stop the SAP Service from the Control Panel. Click the Windows Start
button and select Settings → Control Panel. Go to SAP Service Properties and
select to stop the service. For more details on this and other considerations for
SAP systems, see the SAP R/3 Configuration and Printing Guide available on the
InfoPrint Solutions Company Web site.

3. Decide which server you want to use as the namespace server.

It is highly recommended that you choose your most reliable server to be the
namespace server since any disruption of service in the namespace server has
an impact on all of the servers in the configuration.

4. Set up the common domain user account that the servers will run under.

Windows 2000/2003

a. Log on to the domain that your InfoPrint Manager servers operate in as a
domain administrator.

b. Click the Windows Start button and select Programs → Administrative
Tools → Active Directory Users and Computers.
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c. In the left pane of the Active Directory Users and Computers window, find
the Users item.

d. Right-click the Users directory and click New → User from the pop-up
menu.

e. In the first dialog of the New Object – User wizard, type a name for this
user in the Full name and the User logon name fields.

Note: You do not have to fill in the other name fields.
f. Click Next.
g. In the second dialog of the New Object – User wizard, enter a password

for this user. It is recommended that you select the Password never expires
check box so you do not have to change the password and update all of
your servers on a regular basis, and clear all of the others.

h. Click Next to verify the settings for the user and complete the wizard.
i. Once you have created the user, right-click the user in the right pane of the

Active Directory Users and Computers window and select Add members to
a group from the pop-up menu.

j. In the Select Group dialog, find and select the Domain Administrators (or
Domain Admins) group. Click OK to add your user to the group.

Note: You can leave the Name field blank.
5. Grant the appropriate user rights to the new domain user on all of the systems

that InfoPrint Manager is installed on.

Windows 2000

a. Log on to one of the systems as a user who is a member of the Domain
Administrators group.

b. Click the Windows Start button and select Settings → Control Panel.
c. In the Control Panel window, double–click Administrative Tools.
d. In the Administrative Tools window, double–click Local Security Policy.
e. In the right pane of the Local Security Settings Window, double-click Local

policies.
f. Double-click User Rights Assignment in the right pane.
g. In the list of user rights, select Act as part of the operating system and

double-click it.
h. In the Local Security Policy Setting dialog, click Add.
i. In the Select Users or Groups dialog, click the arrow on the drop-down list

box and select the domain that your InfoPrint Manager servers exist in.
j. Find and select the domain user you created, and click Add.
k. Click OK in the Select Users or Groups dialog.
l. Click OK in the Local Security Policy Setting dialog.
m. Repeat from step 5g for two other user rights: Create permanent shared

objects and Log on as a service.
6. Set up sharing for the namespace directory on the namespace server.

a. Log on to the namespace server.
b. Open the InfoPrint Manager Management Console and select Edit → Service

Configuration.
c. Make note of the directory listed in the Base namespace path field. The

path will be <install path>\var\pddir.
d. Open Windows Explorer and navigate to that directory.
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e. Right–click the folder for that directory and select Sharing from the pop–up
menu.

Configuring for interoperability between an InfoPrint AIX server and an
InfoPrint Windows server

By performing this set of procedures on both an InfoPrint AIX server and an
InfoPrint Windows workstation, you can configure InfoPrint Manager to support
interoperability between InfoPrint AIX servers and InfoPrint Windows servers.

Note: If you are interested in configuring two or more InfoPrint AIX servers for
interoperability, refer to ″Installing secondary InfoPrint servers″ in InfoPrint
Manager for AIX: Getting Started.

When configuring InfoPrint Manager AIX and Windows servers to support
interoperability, make sure that these rules are followed:
1. Each InfoPrint Manager server must be accessible by all other InfoPrint

Manager servers using the same IP address.
For example, if Server1 is an InfoPrint Manager AIX server with an IP address
of 9.99.155.122, then all other InfoPrint Manager servers must use
9.99.155.122 to access Server1.

2. The IP address for each InfoPrint Manager server must be the address that is
identified for the first (or primary) network card that is defined to that server.

3. All printer objects (whether logical destination, actual destination, or queue)
must have unique names if they are used by interoperating InfoPrint servers.
If the printer objects do not possess unique names, you might have trouble
viewing them through the InfoPrint Manager Interface from a non-namespace
server.

LPD service for AIX can be used however, by submitting jobs with the lpr
command to actual destinations on the AIX server. The lpr command can also still
be used as before with Windows printer destinations (just not InfoPrint Manager
printers).

Setting up the InfoPrint AIX server for interoperability

Perform these procedures on your InfoPrint AIX server to prepare for
interoperability with an InfoPrint Windows server. This presumes that you have
installed InfoPrint Manager for AIX Version 4 Release 3 on your AIX server and
have logged onto the server as root.

Starting NFS and connecting the AIX secondary server
1. Open a dtterm window and type: /etc/rc.nfs to either start the NFS daemon

or make sure that it has been started.
2. Open a dtterm window, type smit.
3. From this panel, specify the InfoPrint Printing System → InfoPrint Utilities →

Configure Secondary Servers (NFS) → Link from Primary Server to Secondary
Server path.

4. Specify both the host name and the IP address of the InfoPrint Windows server
with which you intend to interoperate for the Secondary Server Host Name
and the Secondary Server IP Address fields respectively. For example, wserv1
and 9.99.193.120 represent the InfoPrint Windows server in the pop-up panel
displayed below:
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You should specify no for the Is /ipdata used for job ticketing? field, unless
you are using this AIX InfoPrint Manager server with AIX Fast Connect to
allow for file sharing with an InfoPrint Submit Express Windows client for
preflighting jobs and saving RIPped files.
You should also allow the Retain secondary server previously defined? field to
default to yes if you have more than one InfoPrint server functioning as a
secondary server.

5. Once verified, click OK, and then click Done.
6. Return to the first SMIT panel described in step 2 on page 138.

Adding users to and modifying permissions for FST security
groups
1. Set up the FST Security groups on your AIX server by taking the InfoPrint

Printing System → Security → Groups → Show Group path. From the
single-select list pop-up dialog, you should see these three groups: acl_admin,
admin, and oper.

2. Once you have verified the existence of these two groups, you should make
sure that users in the admin group can issue all the InfoPrint pd* commands.
From SMIT, take the InfoPrint Printing System → Security → Access Control →
Access Control for Operations → Show Access Control List path.

3. Once complete, return to the first SMIT panel described in step 2 on page 138.
4. Take the InfoPrint Printing System → Security → Groups → Add Users to a

Group path. Then specify acl_admin for the Group Name field. Enter the name
of the Windows administrative user you normally log in to the InfoPrint
Manager for Windows server machine as for the User or Users to Add field.
For the remainder of this procedure we will refer to this Windows
administrative user as ipwinadmin*. Note that ipwinadmin must be followed by
an asterisk (*) to account for the fully qualified host name. (For example,
ipwinadmin@ipwinservermachine.infoprint.com.)
From the Add Users to a Group panel, specify admin for the Group Name
field. Enter the name of the Windows administrative user you normally log in
to the InfoPrint Manager for Windows server machine as for the User or Users
to Add field. Note that you do not have to do this step for the oper group.

5. Once complete, click OK to make sure the changes take effect and return to the
first SMIT panel described in step 2 on page 138.

Now you can proceed to “Setting up the ipwinadmin id on a Windows 2000/2003
domain controller.”

Setting up the ipwinadmin id on a Windows 2000/2003 domain
controller

On the Windows 2000/2003 domain controller server for the domain where your
servers are located in, you must do this task to make sure that the InfoPrint
Manager Windows servers can access the namespace.
1. Log on to the Primary Domain Controller for the domain that your InfoPrint

Manager servers operate in as a domain administrator.
2. From the Start menu, access the Programs → Administrative Tools →

Computer Management path.
3. From the Computer Management window, click the plus (+) sign next to the

Local Users and Groups list.
4. Click the Users folder and select New User from the Action pull down menu

at the top.
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5. In the User name field type ipwinadmin. In the Password and Confirm
Password fields type a password value.
We recommend that you select Password never expires so you don’t have to
change the password and update all of your servers on a regular basis.

6. Click Create and close the dialog (it will be prompting you to add another
user’s information).

7. From the User window, open the ipwinadmin that you just finished creating
by double-clicking on the list item.

8. Click Member Of, click Add, then double-click Administrators.
9. Click OK.

10. Click OK a second time to finish.

Creating the ’ntuser’ ID on the InfoPrint AIX server

This procedure creates the example ntuser ID that the InfoPrint Windows server
will use to share and manage namespace directories and files that reside on the
InfoPrint AIX server.
1. Specify SMIT and take the Security & Users → Users → Add a User path.
2. On the Add a User panel, specify ntuser as the User NAME field value,

specify printq for the Primary GROUP field, printq,system as the Group SET
field, and /home/ntuser for the HOME directory field.
Change the File Creation UMASK field value to 003

Make sure the Login AUTHENTICATING Grammar field is either blank or
specifies compat (if SMIT will not process the command without an entry in this
field).
Make sure the Password REGISTRY field value specifies files

and take the default for all other fields.
3. Click OK to save the changes and exit the SMIT interface.
4. Login to the server as root and set the initial password.
5. Login as ntuser with the initial password, then change the password for

ntuser. Remember this password, as you will need it later for other procedures.

Ensuring correct AIX file permissions for interoperability
1. Log on to the server as root.
2. From a dtterm window, type cd /var/pddir/default_cell.
3. Make sure that all the files residing in this directory have the correct

permissions to be read by the InfoPrint Windows server by typing chmod -R
774 * .

4. Make sure that all the files residing in this directory belong to the correct group
by typing chgrp -R printq * .
If these last two steps have been performed correctly, entering an ls -l at the
command line should display these permissions and group values:

drwxrwxr-- 3 root printq 512 .... acl
drwxrwxr-- 3 root printq 512 .... printers
drwxrwxr-- 2 root printq 512 .... queues
drwxrwxr-- 2 root printq 512 .... servers
-rwxrwxr-- 1 root printq 4 .... version

5. Complete your preparations on the InfoPrint AIX server by logging in as
ntuser.
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Once you have completed these steps, the InfoPrint AIX server is ready for
interoperability.

Configure Windows servers for interoperability

Some print environments require more than one InfoPrint Manager server to
handle their print management. If you are adding one or more InfoPrint Manager
for Windows servers to your print environment, this section will tell you what you
need to do to make those servers work with the InfoPrint Manager AIX Version 4.3
server.

Notes:

1. In an interoperating environment that includes an AIX server and Windows
servers, the namespace will reside on the AIX server.

2. You can only install one InfoPrint Manager server on a given Windows
workstation or server.

3. If your users will be submitting jobs directly to actual destinations, the actual
destination and the associated queue and logical destination must be on the
same server.

4. Once you have your multi-server system running, if one of your Windows
servers shuts down or is restarted, InfoPrint Manager server will not restart
automatically when the system restarts. You must open the Management
Console for that server and start it manually.

Installing MS Services for UNIX on the InfoPrint Windows
servers

You must do this task on each Windows server:
1. Using the CD-ROM, install Microsoft Windows Services for UNIX® from the

″Add-on Pack for Microsoft Windows Workstation and Server 4.0″ at Version
1.0 or higher.

2. Reboot each InfoPrint Windows server.

Setting up the common account for InfoPrint Windows servers
on a 2000/2003 domain controller

On the Windows 2000/2003 domain controller server for the domain where your
servers reside, you must create the domain account that all the InfoPrint Windows
servers will run under. Do this task to make sure that the InfoPrint Manager
Windows servers can access the namespace.
1. Log on to the Primary Domain Controller for the domain that your InfoPrint

Manager servers operate in as a domain administrator.
2. From the Start menu, access the Programs → Administrative Tools →

Computer Management path.
3. From the Computer Management window, click the plus (+) sign next to the

Local Users and Groups list.
4. Click the Users folder and select New User from the Action pull down menu

at the top.
5. In the User name field type ntuser. In the Password and Confirm Password

fields, type the ntuser password from step 5 on page 140.
We recommend that you select Password never expires so you do not have to
change the password and update all of your servers on a regular basis.
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6. Click Create and close the dialog (it will be prompting you to add another
user’s information).

7. From the User window, open the ntuser that you just finished creating by
double-clicking on the list item.

8. Click Member Of, click Add, then double-click Administrators.
9. Click OK.

10. Click OK a second time to finish.

Grant appropriate user rights to the domain user on all InfoPrint
Manager Windows 2000/2003 servers

To make sure that the Windows 2000/2003 InfoPrint Manager servers can run as a
Windows service using the domain userid ntuser, you must make sure that this
userid has the proper level of authority on each Windows 2000/2003 InfoPrint
Manager server system.
1. Log on to one of the systems as a user who is a member of the Domain

Administrators group.
2. Click the Windows Start button and select Settings → Control Panel.
3. In the Control Panel window, double-click Administrative Tools.
4. In the Administrative Tools window, double-click Local Security Policy.
5. In the right pane of the Local Security Settings Window, double-click Local

policies.
6. Double-click User Rights Assignment in the right pane.
7. In the list of user rights, select Act as part of the operating system and

double-click it.
8. In the Local Security Policy Setting dialog, click Add.
9. In the Select Users or Groups dialog, click the arrow on the drop-down list

box and select the domain that your InfoPrint Manager servers exist in.
Find and select the domain user you created, and click Add.

10. Click OK in the Select Users or Groups dialog.
11. Click OK in the Local Security Policy Setting dialog.
12. Repeat from step 7 for two other user rights: Create permanent shared

objects and Log on as a service.

Configuring the NFS client to access the namespace

This NFS client configuration will need to be done on each InfoPrint Manager for
Windows server that will access the namespace on the AIX InfoPrint Manager
server machine.
1. Log on to the Windows InfoPrint Manager server as the domain user ntuser

who was created in the Setting Up the Common Account for InfoPrint
Windows Servers on the Domain Controller procedure above.

2. From the Start menu, access the Settings → Control Panel path, and
double-click Client for NFS to configure the NFS client to access the
namespace.

3. Click Authentication:
a. Enter ntuser in the User Name field.
b. Enter the InfoPrint AIX password for ntuser from step 5 on page 140) in the

Password field.
c. Click PCNFSD Server and type in the name of an InfoPrint Manager AIX

server.
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4. Click Filenames and set values as follows:

Preserve Case (no conversion) check
Generate Unique Names for Existing Files
with Mixed Case Filenames

uncheck

Match Filenames Exactly check
Match Filenames Ignoring Case uncheck

5. Click OK.
6. When you receive the pop-up dialog box that says NFS Login Successful, click

YES.
If you do not receive this message, go back to the Authentication tab and make
sure that the ID and password match those set up in step 5 on page 140.

7. Log off the Windows InfoPrint Manager server as the domain user ntuser and
log on to the Windows InfoPrint Manager server as the ipwinadmin user.

8. Repeat steps 2 through 6 from above.

Verifying access to the AIX namespace that allows
interoperability on Windows 2000/2003

From each InfoPrint Windows 2000/2003 server, you must verify that you have
access to the namespace on the InfoPrint AIX server. You can do this by mapping a
network drive (as ntuser with the ntuser password from step 5 on page 140) from
the Windows 2000/2003 server to the shared namespace on the InfoPrint AIX
server.
1. From the main Windows view, right-click My Network Places, select Map

Network Drive. In the dialog, use the Folder field to specify:
\\aix_servername\var\pddir\default_cell

where aix_servername is the name of the InfoPrint AIX server.
2. Check Reconnect at Login.
3. Click Connect Using Different User Name.
4. A dialog box will open asking for a username and password associated with

ntuser. Specify the ntuser password from step 5 on page 140 in the Password
field.

5. Click OK and the NFS Client window opens.
6. Click OK again. A small notification window should appear that says NFS

Login Successful.
Since the NFS Client was set up in the section Configuring the NFS Client to
Access the Namespace, click OK.

7. Click Yes to accept the current login and Finish to map the drive.
If the drive mapped correctly, a new window should open to the mapped
drive’s contents, and the NFS Client and Map Network Drive windows
should be gone.

Configuring the ’ntuser’ ID for interoperability on the InfoPrint
Windows servers

Make sure that you complete this procedure on all InfoPrint Windows servers.

Note: Once this procedure is completed, make sure that you do all namespace
administration from the Management Console on the InfoPrint Windows server,
not the InfoPrint AIX server.
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On all Windows servers:
1. Log on as user ipwinadmin .
2. From the Start menu, click Programs → InfoPrint Manager → Management

Console.
3. Stop the server by either clicking Stop or clicking File → Stop Server.
4. Access the Edit → Service Account/Domain path.
5. Specify the domain name in the Domain field, the account you created during

step 4 on page 141 in the User account field, and the password in the
Password field.

6. Click OK.
Note: A notification server was installed with each of your InfoPrint Manager
servers. However, now that the namespace is shared, you only need to run
one of them . The notification server must be run on the namespace server.
Disable all but one of the InfoPrint Manager Notification servers.

7. Click Edit → Service Configuration.
8. In the Settings group box, clear both the Run notification server on this

system and Run InfoPrint Manager LPD service check boxes.
9. Clear the Base namespace path field and type the drive letter that you want

to use to link to the namespace followed by a colon (for example, type x:).
Use the same drive letter that you used when mapping the network drive in
step 4 on page 141.

10. In the Remote namespace folder field, enter the Universal Naming
Convention (UNC) name of the shared directory on the namespace server in
this format: \\namespaceserver\sharename. The sharename of the namesapce on
an AIX server is default_cell. For this example, \\prince\var\pddir\
default_cell .

11. Click OK.
12. Restart all of the InfoPrint Manager servers by selecting File → Start Server

on each Management Console.
13. Verify that all of the servers are now sharing the namespace.

v Log on to any one of the machines that holds an InfoPrint Manager server,
open a command prompt.

v Start the InfoPrint Manager Administration Interface.
v Click Server → Show All Servers.
You should see a list of all of the servers that are using the namespace. If any
of them do not appear, stop the servers and check the settings that you
changed in step 7 for that server.

Verifying the authority of the ipwinadmin ID

Use this procedure to verify that the ipwinadmin id has permission to both modify
security groups and issue all the InfoPrint pd* commands.
1. Verify that the InfoPrint servers are interoperating by performing step 13 of

“Configuring the ’ntuser’ ID for interoperability on the InfoPrint Windows
servers” on page 143.

2. Make sure that you created a user named ipwinadmin in the domain in
“Setting up the ipwinadmin id on a Windows 2000/2003 domain controller”
on page 139.

3. Log on to the InfoPrint Windows server as user ipwinadmin.
4. From the Start menu, click Programs → InfoPrint Manager → Management

Console.
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5. From the left pane, click Security.
6. Double-click Groups.
7. From the Groups view in the right pane, highlight the acl_admin item and

select open from the drop-down menu.
8. Click Add.
9. In the Add Member to Group dialog, type ipwinadmin* in the field provided.

In the Groups view, you should be able to see ipwinadmin listed in the
Members column for the admin group.

10. From the Groups view in the right pane, highlight the admin item and select
open from the drop-down menu.

11. Click on the Add... button.
12. In the Add Member to Group dialog, type ipwinadmin* in the field provided.

In the Groups view, you should be able to see ipwinadmin listed in the
Members column for the admin group.

13. Log on to the InfoPrint Windows server as ipwinadmin.
You should be able to create and modify security groups and issue all the
InfoPrint pd* commands.
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Part 3. Administrative Procedures: Configuring for Host
Printing
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Chapter 22. Setting up to use MVS Download

Configuring MVS Download

The MVS Download feature of InfoPrint Manager uses a Destination Control File
(DCF) to map Job Control Language (JCL) parameters to InfoPrint Manager
submission parameters. A default DCF called mvsdmap.txt is provided with
InfoPrint Manager; it is installed in the <install path>\var\pd\mvsd directory,
where <install path> is the directory that you installed InfoPrint Manager in.
MVS Download receives JCL parameters from the host system, applies the DCF to
it, and generates a corresponding list of InfoPrint parameters. The list of InfoPrint
parameters is then passed to the MVS Download Exit Program (or Exit) so
InfoPrint Manager can process the job.

The MVS Download feature of InfoPrint Manager also invokes an Exit for every
file received. This Exit is responsible for performing some action on the received
file. One Exit is provided with InfoPrint Manager: Microsoft Visual Studio 2005.
The Exit submits the file to InfoPrint Manager using pdpr and logs any errors. The
exit also stops the MVS Download receiver if the pdpr fails. Microsoft Visual
Studio 2005 supports AFP Download Plus and multiple data set functions.

You must do these tasks to be able to print using the MVS Download feature of
InfoPrint Manager:
1. Create the InfoPrint destination or destinations that you want to submit your

print jobs to.
2. Make the AFP resources that you need to use for your print jobs available to

InfoPrint Manager.
3. [Optional]Modify the DCF.
4. [Optional]Modify the Exit Program.
5. Create an MVS Download receiver that will accept print jobs from the host and

tie all of the other elements together.

All printing configurations must complete steps 1, 2, and 5. For information about
creating destinations, see the InfoPrint Manager for Windows: Getting Started. See
“Making your AFP resources available to InfoPrint Manager” on page 166 for
information about completing step 2. If you can use the sample DCF and Exit that
are provided with InfoPrint Manager (the default configuration), you do not have
to do steps 3 and 4. See “Setting up a default MVS Download configuration” on
page 150 for instructions on completing step 5 for the default configuration. You
can use the default configuration if all of these conditions apply:
1. On jobs that are sent to this MVS Download receiver, the DEST listed on the

job when it is received from the host (converted to lowercase) identifies the
InfoPrint actual or logical destination that the job should be submitted to
OR

Jobs with no DEST specified will be submitted to the InfoPrint actual or logical
destination that you set as the default for this receiver.

2. You do not use InfoPrint job scheduling functions based on media type.
3. When submission of a print job fails (for example, because the server is

stopped or because the DEST requested does not exist), you will accept the
default action that the receiver automatically stops.
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4. You will not use the multiple data set function of MVS Download.

If you do not meet all of the criteria, you will need to modify the DCF, the Exit, or
both. Some of the reasons that you would need to modify the DCF are:
1. You want to use alternate attributes or no attributes for some mvs_keywords.
2. You do not want the DCF to change the DEST value it receives to lowercase.
3. You want to use InfoPrint job scheduling based on media type.
4. You see that some of the MVS to InfoPrint mappings in the sample DCF are not

what you want.
5. You want to identify MVS job defaults that are not communicated from MVS

(for example PAGEDEF).
6. You want to identify InfoPrint submission parameters to use on all jobs (for

example, the font resource directory on your Windows system).
7. You use the multiple data set function of MVS Download.

See these sections for instructions on modifying your DCF and Exit, and creating
an MVS Download receiver:
v “Understanding and using the MVS Download destination control file” on page

151
v “Understanding the MVS Download Exit Program” on page 161
v “Creating an MVS Download Receiver” on page 163

Setting up a default MVS Download configuration

Once you have made your resources available, the only tasks you need to do on
your Windows system to set up a Default configuration are:
v Create an InfoPrint destination.

For information about creating destinations, see the InfoPrint Manager for
Windows: Getting Started.

v Create and configure an MVS Download receiver that uses the default DCF and
Exit to send print jobs to that destination.
For instructions, see “Creating an MVS Download Receiver for a default
configuration.”

Creating an MVS Download Receiver for a default configuration

Before you can begin sending jobs from the MVS JES spool to InfoPrint Manager
through the MVS Download feature, follow this procedure to set up an MVS
Download Receiver:
1. Open the InfoPrint Manager Management Console.
2. Left-click the MVS Download Receiver item in the left pane to select it.
3. Right-click the MVS Download Receiver item in the left pane to open a

pop-up menu.
4. In the menu that pops up, select New.

The Add MVS Receiver dialog opens.
5. Fill in the fields according to these specifications. For more information about

the dialog and the fields it contains, see the Management Console online help.
v Port Number: Enter the port number that you want this receiver to use when

it communicates with the host system. This number must match the port
number that is specified in the Routing Control File used by the MVS
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Download FSA for this computer’s IP address or the PORTNO in the
PRINTDEV for the AFP Download Plus FSA.

v Target Destination: Select the default InfoPrint destination that you want this
receiver to submit jobs to from the drop-down list. InfoPrint Manager will
only submit a job to this destination if the jobs does not have a DEST
specified when it comes from the host system.

v Destination Control File: Do not change this path.
v In the Processing Options group box, both options are selected by default

and can be left that way.

Note: When the Retain command files check box is selected, InfoPrint
Manager saves the control files for any MVS Download print jobs that failed
in print submission. Therefore, when you want to resubmit those jobs, you
do not have to download them from the host system again; the files are still
on your InfoPrint server. You can deselect this box, but any jobs that fail in
processing will need to be resubmitted from the host to be printed.

Operators should evaluate any processing failures, correct the problems that
caused the failures, and resubmit the jobs either from the host system (if this
box is deselected) or from the receiver (if this box is selected).

For more information, see “Deleting orphan files and resubmitting jobs to
MVS Download” on page 304.

6. In the Error Processing Options group box, neither option is selected by
default and can be left that way.

7. In the Mapping Options group box, none of the options are selected by default
and can be left that way.

8. Click OK.
One or more pop-up informational messages might appear; read them and click
OK to dismiss them.

9. Select the MVS Download Receivers item in the left pane of the Management
Console.
You should see the receiver you just created in the right pane. The receiver
status might be STOPPED, but it should start momentarily. Click Refresh View
on the toolbar until the status changes to RUNNING.

Once the receiver is running, it is ready to receive print jobs from the host system.

Understanding and using the MVS Download destination
control file

The MVS Download Destination Control File (DCF) is a flat text file that consists
of Control Statements, blank lines, and comments. Each line has a maximum
length of 1023 bytes. Tabs are treated as blank spaces.

Note: If you change the DCF, the changes will not become active until you stop
and restart the receivers that use that DCF.

The DCF maps the MVS keywords and parameters it receives from the host to the
pdpr –x and –p attributes and parameters. The supplied MVS Download Exit uses
pdpr to submit jobs to the target destination. To modify any of the other pdpr
options, you must change the Exit Routine.
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The sample DCF that comes with InfoPrint Manager is set to perform the
mappings listed in Table 11.

Note: This table only lists the Mapping statements in the sample DCF. It does not
reflect the Default statements and Global statements that are set.

Table 11. Mappings in the Sample DCF

mvs_definition InfoPrint Attribute and Value for MVS
Download

InfoPrint Attribute and Value for AFP
Download Plus

ACCOUNT account-text account-text

ADDRESS1 address1-text address1-text

ADDRESS2 address2-text address2-text

ADDRESS3 address3-text address3-text

ADDRESS4 address4-text address4-text

BUILDING building-text building-text

CC=NO carriage-control-type=none ignored

CC=YES ignored ignored

CCTYPE=ANSI carriage-control-type=ansi-ebcdic ignored

CCTYPE=MACHINE carriage-control-type=machine ignored

CCTYPE=ASCII carriage-control-type=ansi-ascii ignored

CHARS chars ignored

CLASS printer-pass-through=-opa=class printer-pass-through=-opa=class

COPIES copy-count results-profile

DATACK=UNBLOCK data-fidelity-problem-reported=all data-fidelity-problem-reported=all

DATACK=BLOCK data-fidelity-problem-reported=none data-fidelity-problem-reported=none

DATACK=BLKPOS data-fidelity-problem-
reported=character

data-fidelity-problem-
reported=character

DATACK=BLKCHAR data-fidelity-problem-
reported=position

data-fidelity-problem-
reported=position

DATATYPE=AFP Not applicable document-format=modca-p

DATATYPE=LINE document-format=line-data Not applicable

DEPT department-text department-text

DEST target-destination-name and target-destination-name and

printer-pass-through=-opa=destination printer-pass-through=-opa=destination

DUPLEX=NO sides=1 sides=1

DUPLEX=NO plex=simplex plex=simplex

DUPLEX=NORMAL sides=2 sides=2

DUPLEX=NORMAL plex=simplex plex=simplex

DUPLEX=TUMBLE sides=2 sides=2

DUPLEX=TUMBLE plex=tumble plex=tumble

FCB page-definition ignored

FILEFORMAT=RECORD new-line-option=counted-4-octet-
aligned

ignored

FILEFORMAT=STREAM new-line-option=lf or cr-and-lf ignored

FILETYPE ignored ignored
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Table 11. Mappings in the Sample DCF (continued)

FORMDEF form-definition form-definition

FORMLENGTH form-length=nnnn.nnn form-length=nnnn.nnn

FORMS printer-pass-through=-opa=forms printer-pass-through=-opa=forms

INTRAY printer-pass-through=-obin printer-pass-through=-obin

IPADDR printer-pass-through=-opa=ipaddr printer-pass-through=-opa=ipaddr

JOBID printer-pass-through=-opa=jobid printer-pass-through=-opa=jobid

JOBNAME job-name and job-name and

job-owner job-owner

NAME name-text name-text

NODEID node-id-text node-id-text

OFFSETXB x-image-shift-back x-image-shift-back

OFFSETXF x-image-shift x-image-shift

OFFSETYB y-image-shift-back y-image-shift-back

OFFSETYF y-image-shift y-image-shift

OUTBIN output-bin output-bin

OVERLAYB overlay-back overlay-back

OVERLAYF overlay-front overlay-front

PAGECNT job-page-count job-page-count

PAGEDEF page-definition ignored

PRMODE=SOSI1 shift-out-shift-in=one ignored

PRMODE=SOSI2 shift-out-shift-in=two ignored

PRMODE=SOSI3 shift-out-shift-in=three ignored

PRMODE=[anything else] ignored ignored

PROGRAMMER programmer-text programmer-text

PRTQUEUE printer-pass-through=-oprtqueue printer-pass-through=-oprtqueue

RESFMT=P240 font-resolution=P240 font-resolution=P240

RESFMT=P300 font-resolution=P300 font-resolution=P300

ROOM room-text room-text

SEGMENTID printer-pass-through=-opa=segmentid printer-pass-through=-opa=segmentid

SHEETCNT ignored ignored

SYSOUT printer-pass-through=-opa=class printer-pass-through=-opa=class

TITLE title-text title-text

TRC table-characters-reference ignored

UCS chars ignored

USERID user-id-text user-id-text

Types of control statements
There are three kinds of Control Statements in a DCF:
1. Default statements identify a default parameter for an mvs_keyword when one

is not received from MVS. They consist of only an mvs_definition.
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Note: If you include multiple Default statements that use the same
mvs_keyword, InfoPrint only uses the last one.

2. Global statements identify an InfoPrint parameter that should be used on all
data set submissions. This statement uses GLOBAL as the mvs_definition value.

Note: If you include multiple Global statements that use the same
infoprint_attribute, InfoPrint only uses the last one.

3. Mapping statements match mvs_keyword with their InfoPrint equivalents.
These statements must contain both an mvs_keyword and a control. If there is
no Mapping statement listed in the DCF for one or more of the mvs_keywords
and parameters that are received, InfoPrint adds those mvs_keywords and
parameters as unchanged printer-pass-through attributes.

Notes:

a. If you include multiple Mapping statements that use the same
mvs_definition but map to different infoprint_attributes, all of them will be
honored.

b. If you include multiple Mapping statements that use the same
mvs_keyword and map to the same infoprint_attribute, the last one mapped
will be used.

c. If you define a Mapping statement that maps to an infoprint_attribute that
is also used in a Global statement, and the Mapping statement is used due
to the MVS keywords in a received file, the Mapping statement will
override the Global statement.

d. If no matching Mapping statement is found for a received mvs_keyword
and parameter, it will automatically be added to the printer-pass-through
parameter. A null Mapping statement can be used to throw the
mvs_keyword away entirely. A null Mapping statement contains an
mvs_definition and a control, but no infoprint_definition.

Syntax of control statements
Each Control Statement consists of three parts as described below. The entire
statement must reside on a single line (it can’t contain a carriage return until it is
complete) and it must follow this syntax:

mvs_definition [control [infoprint_definition]]

mvs_definition: The mvs_definition identifies a keyword that is generated by the
host and, for Default and some Mapping statements, its associated parameter. It
follows this format:

mvs_keyword[=mvs_parameter]

Note: In Control Statements, mvs_definitions, controls, and infoprint_definitions
themselves cannot contain any white space (spaces or tabs). The first occurrence of
white space separates the mvs_definition from the control and the second separates
the control from the infoprint_definition. As a result, if the elements contain white
spaces, the DCF will not complete the mapping correctly.

These values are described below.

mvs_keyword: The mvs_keyword represents the string that InfoPrint Manager
receives from an MVS system. It is what the MVS system uses to refer to
information about a print job (for example, whether it should be duplexed or what
overlay it uses, if any). The keywords identified in Table 11 on page 152 are the
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standard set of mvs_keywords that are available for you to use. The keywords that
MVS uses to refer to these job characteristics are not the same as the InfoPrint
attribute names that do the same things.

mvs_parameter: The optional mvs_parameter is a case-sensitive free-format field.
The purpose of an mvs_parameter depends upon what type of Control Statement
it is used with.
v Default Statement

The mvs_parameter value is required. This value identifies the default value of
the mvs_keyword when the mvs_keyword has not been sent by the host system
with a job. For example, in the Defaults section of the mvsdmap.txt file,
CHARS=GT13 is identified. Therefore, GT13 is the mvs_parameter default font
value, and will be used whenever InfoPrint Manager does not receive a font
value from the host system.

v Global Statement

The mvs_parameter value is ignored.
v Mapping Statement

The mvs_parameter value is optional. If an mvs_parameter value is specified for
an mvs_keyword on a Mapping statement, the mvs_keyword is not always
mapped to the infoprint_definition specified. The mvs_keyword is only mapped
to the infoprint_definition when the mvs_keyword and the mvs_parameter
combination that comes from the host system matches the mvs_keyword and
mvs_parameter combination specified on the Mapping statement.
For example, these four lines appear in the Mapping section of the mvsdmap.txt
file:
CCTYPE :: carriage-control-type=none

CCTYPE=ANSI :: carriage-control-type=ansi-ebcdic

CCTYPE=MACHINE :: carriage-control-type=machine

CCTYPE=ASCII :: carriage-control-type=ansi-ascii

If InfoPrint Manager receives a job from the host system with the mvs_keyword
CCTYPE=ANSI specified, InfoPrint Manager will map that keyword to the InfoPrint
attribute carriage-control-type and set its parameter to ansi-ebcdic. If the
next job comes with the mvs_keyword CCTYPE=MACHINE specified, InfoPrint
Manager will map that keyword to the InfoPrint attribute carriage-control-
type and set its parameter to machine instead. But, if InfoPrint Manager receives
a job with the mvs_keyword CCTYPE set to anything besides ANSI, MACHINE,
or ASCII, it will map that keyword to the InfoPrint attribute
carriage-control-type and set its parameter to none.

For certain mvs_keywords, special mvs_parameters are recognized. These
keywords are listed in Table 12.

Table 12. Special mvs_parameters

mvs_keyword mvs_parameters

CC YES NO

CCTYPE ANSI MACHINE ASCII

DATACK BLOCK UNBLOCK BLKPOS BLKCHAR

DATATYPE LINE AFP

DUPLEX NO NORMAL TUMBLE

FILEFORMAT RECORD STREAM
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Table 12. Special mvs_parameters (continued)

mvs_keyword mvs_parameters

RESFMT P240 P300

TRC YES NO

control: A control is a symbol that is used for delineation and which can also tell
the MVS Download receiver what it has to do to the mvs_keyword if it converts
the mvs_keyword to an InfoPrint keyword. Every Mapping statement contains a
control. Some of the controls listed below are used in the mvsdmap.txt file.

:: Don’t do any special processing. (Standard delineation)

:+ Change all of the characters in the mvs_parameter into uppercase when
converting it to an infoprint_parameter.

:- Change all of the characters in the mvs_parameter into lowercase when
converting it to an infoprint_parameter.

:! Do not convert this mvs_parameter into an infoprint_parameter. This control
is only necessary if no infoprint_parameter is specified on this statement.

Note: In Control Statements, mvs_definitions, controls, and infoprint_definitions
themselves cannot contain any white space (spaces or tabs). The first occurrence of
white space separates the mvs_definition from the control and the second separates
the control from the infoprint_definition. As a result, if the elements contain white
spaces, the DCF will not complete the mapping correctly.

Controls behave differently in the different types of Control statements.
v In Default statements, you cannot specify a control.
v In Global statements, you must specify a control, but the operator is only

recognized as a delineator; no matter what operator you use, it acts like the ::
control.

v In Mapping statements, you must specify a control.

infoprint_definition: The infoprint_definition identifies the attribute and parameter
that will be specified on the pdpr command when InfoPrint Manager sends the job
to the printer. The infoprint_definition identifies an InfoPrint attribute and
(optionally) the value that it should be set to. infoprint_definitions follow this
syntax:
infoprint_attribute[=infoprint_parameter]

Note: In Control Statements, mvs_definitions, controls, and infoprint_definitions
themselves cannot contain any white space (spaces or tabs). The first occurrence of
white space separates the mvs_definition from the control and the second separates
the control from the infoprint_definition. As a result, if the elements contain white
spaces, the DCF will not complete the mapping correctly.

The infoprint_attribute is the InfoPrint attribute name as it is listed in the
InfoPrint Manager: Reference under –x options, plus the specially recognized
target-destination-name, which is used to identify the –p option of the pdpr
command. The infoprint_parameter is the value that is assigned to that attribute.

infoprint_definitions work differently in each kind of control statement.
v In Default statements, you cannot specify an infoprint_definition.
v In Global statements, you must specify an infoprint_definition.
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v In Mapping statements, you should specify an infoprint_definition to map the
mvs_definition to. However, if you specify an infoprint_attribute, you do not
have to specify an infoprint_parameter with it. If you only list an
infoprint_attribute, the mvs_parameter value from the mvs_keyword becomes
the infoprint_attribute value.

Notes:

1. If you do not provide an infoprint_definition in a Mapping statement, the
information contained in that mvs_keyword will be discarded.

2. If you provide multiple Mapping statements that lead to the same attribute
only one will be used, but it is impossible to predict which one that will be.

v To identify an infoprint_attribute that you want to use on the -x option of the
pdpr command, omit the -x, for example: media-id.

v To identify an infoprint_attribute that you want to use on the
printer-pass-through attribute of the pdpr command, prefix the
infoprint_attribute with an -o flag for example, -ojobid. All generated—o
attributes will be collected and added to a single printer-pass-through
attribute.

v To identify an infoprint_attribute that you want to use on the -opa option of the
printer-pass-through attribute of the pdpr command, prefix the
infoprint_attribute with an -opa, for example, -opa:class. All generated—opa
attributes will be collected and added to a single -opa keyword on the
printer-pass-through attribute.

v To identify that the mvs_definition is to map to the name of the target
destination for submission, specify target-destination-name, which is a
specially-recognized infoprint_attribute that overrides the third parameter that is
passed to the sample MVS Download Exit.

v To handle complex, multi-valued infoprint_attributes, begin the
infoprint_parameter with as many colons (:) as necessary to move the parameter
into the correct position. For example, the results-profile attribute follows this
syntax:
-x "results-profile=name@node:method:number:'message text':bin"

In use, the attribute would look like this:
-x "results-profile=nr645@bld25:pickup:2:'Please read this'"

So, if you wanted to map the COPIES value to the ’number’ parameter of
results-profile, you would enter two colons (::) in the mapping statement. The
two colons indicate that the program should skip over the first two parameters
in the results-profile (name@node and method), and insert the value in the third
position (number). The mapping statement would look like this:
COPIES :: results-profile=::

You can include a hard-coded infoprint_parameter in the statement, but you do
not have to. If you do not include one, the normal rules for determining the
resulting infoprint_parameter apply.

Changing the sample DCF

Copying the sample DCF:

To create a copy of the sample DCF provided with InfoPrint Manager:
1. Open the file <install path>\var\pd\mvsdmap.txt, (where <install path> is

the directory where InfoPrint Manager is installed) in a text editor such as
Notepad.
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2. Click File → Save as, and save the file into a directory outside of the <install
path> directory. Make note of the directory and file name for reference later.

Notes:

a. You can change the file name if you like, but do not need to.
b. If you do not save the file to another directory outside the <install path>

directory, it could be overwritten or deleted if you ever need to reinstall,
apply service, or upgrade InfoPrint Manager.

c. This step creates a copy of the sample/default file and leaves the original,
unedited version in the directory listed above so you can use it to create
another customized DCF later if you need to.

Editing the DCF:

See this section to edit either the sample DCF provided with InfoPrint Manager or
an existing DCF.
1. Open the file you want to edit in a text editor.

Notice that most of the lines begin with a *. Every line that begins with a * is a
line that is commented out, so InfoPrint Manager ignores it during processing.
When you need to comment out a line, insert a * at the beginning of the line; to
uncomment a line, delete the * at the beginning of the line.

2. Read the notes and instructions in the file before you make any changes to it.
3. Change the Control Statements as you need to.
v In the Defaults section, you can set the defaults as you need them to be.
v In the Globals section, the only value that is set is carriage-control-type

attribute value.
The statements that are commented out are examples of how to specify
alternate resource search orders.
– The first example specifies a location that InfoPrint Manager will search

for all fonts (resource-context-font=C:\fonts\reslib).
– The second example specifies a location and search order for page

definitions (resource-context-pagedef=C:\joeski\pagedefs;c:\bills\
pdefs).

You should put any other pdpr parameters to be specified on the –x option
on all jobs here.

v In the Mapping section, there are two sections: Commonly changed mappings
and Less commonly changed mappings. Follow the instructions provided in the
text file to make your changes, keeping these additional considerations in
mind:
– If you plan to send print jobs to different logical destinations based upon

the media type of the job, you should uncomment the FORMS ::
default-medium mapping.

– The default mapping uses the MVS JCL keyword DEST to specify the
target destination (printer) that the downloaded jobs are sent to. If you
comment out this mapping or remove the target-destination-name from
the right side, all jobs are submitted to the target destination that you
specify in the Target destination field when you set up your MVS
Download Receiver.

– If your host MVS system uses the newer PRTQUEUE JCL keyword to
identify the target-destination, comment out the DEST ::
target-destination-name mapping and uncomment the lines:
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PRTQUEUE :: target-destination-name
DEST ::

Debugging your changed DCF:

The sample DCF contains a DEBUG statement that is commented out. To use this
statement to check your DCF:
1. Uncomment the DEBUG statement in the DCF that you changed.
2. Save the file.
3. Stop the MVS Download receiver that uses this DCF.
4. Restart the MVS Download receiver that uses this DCF.
5. Submit a job from MVS that runs through this MVS Download receiver.

Information will be written into the server log. You can view the server log by
clicking the Server Log item in the left pane of the Management Console.

6. Once you are satisfied with the results, open the DCF and comment the
DEBUG statement out again.

7. Save the file.
8. Stop the MVS Download receiver that uses this DCF.
9. Restart the MVS Download receiver that uses this DCF.

Changing the sample DCF advanced information
If you use MVS Exit 15, understand that the predefined mvs_keywords are internally
converted using Table 13 on page 160.To add lines to the DCF you will need to be
aware of these internal mappings and what additional information your lines need
to contain.

For example, the sample DCF contains the line:
DATACK=BLKPOS :: data-fidelity-problem-reported=character

But, because in Table 13 on page 160 DATACK maps to -odatac, this line would
produce the same results:
-odatac=blkpos :: data-fidelity-problem-reported=character

When the MVS host actually sends -odatac=blkpos, this mapping statement is
used. For information about the actual keywords that the MVS host sends, see the
Print Services Facility™ for z/OS;:MVS Download, (S544-5624) publication, which
you can download from the InfoPrint Solutions Company Web site at
http://www.infoprint.com.

Note: The mvs_definition (all of the information to the left of the control) is
case-sensitive and must exactly match the information that comes from the host
system for the mapping to be made.

Some parameter information is received from the MVS host as -o keywords and
other information is received as sub-keywords of the -opa keyword. For example,
CLASS information is received as -opa=class=xxx.

When the DCF is processed by an MVS Download receiver, the receiver looks at
each mvs_keyword to determine if it will be received from MVS as a keyword or
as a sub-keyword of the -opa keyword. The receiver tries to convert the specified
mvs_keyword according to Table 13 on page 160. If the receiver doesn’t find a
mapping conversion for the specified mvs_keyword, the mvs_keyword is left
unchanged. If the result of the conversion begins with -o, the receiver assumes that
the mvs_keyword will be received as a keyword. If the result of the conversion
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does not begin with -o, the receiver assumes that the mvs_keyword will be
received as a sub-keyword of the -opa keyword.

For example, the mvs_keyword SYSOUT is internally converted (according to
Table 13) to class. Since class does not begin with -o, the receiver assumes that
class is a sub-keyword of the -opa keyword.

Table 13. MVS keyword internal conversions

mvs_keyword MVS Values Passed to InfoPrint

ACCOUNT -AC

ADDRESS1 -oaddress1

ADDRESS2 -oaddress2

ADDRESS3 -oaddress3

ADDRESS4 -oaddress4

BUILDING -obu

CC -occ

CCTYPE -occtype

CHARS -ochars

CLASS class

COPIES -ocop

DATACK -odatac

DATATYPE -odatat

DEPT -ode

DEST destination

DUPLEX -odu

FCB -opagedef

FILEFORMAT -ofileformat

FILETYPE -ofiletype

FORMDEF -of

FORMLEN -oformlength

FORMS forms

INTRAY -oin

IPADDR -oipdest

JOBID jobid

JOBNAME -ojobn

NAME -ona

NODEID -ono

OFFSETXB -ooffxb

OFFSETXF -ooffxf

OFFSETYB -ooffyb

OFFSETYF -ooffyf

OUTBIN -ooutbin

OVERLAYB -oovlyb

OVERLAYF -oovlyf
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Table 13. MVS keyword internal conversions (continued)

PAGECNT -opagecount

PAGEDEF -opagedef

PRMODE -oprmode

PROGRAMMER -opr

PRTQUEUE -oprtqueue

RESFMT -ore

ROOM -oro

SEGMENTID segmentid

SHEETCNT -osheetcount

SYSOUT class

TITLE -oti

TRC -otrc

UCS -ochars

USERID -ous

MVS Exit 15 lets users add sub-keywords to the -opa keyword only. The
mvs_keyword that would be used in the DCF is the (case-sensitive) sub-keyword
only. For example, if an MVS Exit 15 added OUTGRP=n, where n was the number of
the dataset in the job, and you wanted to map this value to the
printer-pass-through=-opa=segmentid parameter (instead of the supplied
mapping), you would replace the existing DCF mapping statement of:
SEGMENTID :: -opa:segmentid

with
OUTGRP :: -opa:segmentid

To add multiple sub-keywords to the —opa keyword using MVS Exit 15, each
keyword/parameter pair must be delineated with a comma. It is highly
recommended that you not use any blank spaces or tabs around the comma or
around the ″=″ sign that you place between your generated sub-keyword and the
parameter.

For more information, see the Print Services Facility for z/OSMVS Download, or
Print Services Facility for z/OS: AFP Download Plus publication, which you can
download from the InfoPrint Solutions Company Web site at http://
www.infoprint.com.

Understanding the MVS Download Exit Program
The MVS Download Exit Program (or Exit) takes the InfoPrint Manager submission
parameters generated by the DCF and uses them to process the print job
appropriately. The Exit is invoked once per file received from MVS.

A sample exit routine is provided with InfoPrint Manager: written in Microsoft
Visual Studio 2005. The Visual Studio file set includes: mvsdsubm.dsp and
mvsdsubm.opt (project files), mvsdsubm.dsw (a workspace file), and mvsdsubm.c (a
source file). They are installed in the <install path>\exits\mvsd directory, where
<install path> is the directory that you installed InfoPrint Manager in.
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Using the sample MVS Download exit program
In the sample mvsdsubm files, the Exit performs these operations using the eight
parameters that are passed to it.
1. Issues a pdpr print command to submit the file (parameter #1) to the specified

target destination (parameter #3), with the indicated InfoPrint print parameters
(parameter #5).

2. If the job prints successfully, the Exit will erase the print job file (parameter #1).
3. If the job does not print, the Exit will log an error in the MVS Download error

file and terminate the receiver.

Parameters Definition

#1 The name of the file that contains data received from the MVS JES spool

#2 MVS JES destination control parameters

#3 InfoPrint target destination (printer) where the job is submitted

#4 MVS Download receiver name

#5 InfoPrint print parameters

#6 The port number used by this receiver

#7 Additional exit parameter specified when the receiver was created

#8 Indicator that indicates whether trace is on. A value of zero indicates trace is
off. Any other value indicates trace is on.

In addition, the Visual Studio exit has support for the multiple data set function in
MVS Download and AFP Download Plus.

Customizing the sample exit program
You can customize the mvsdsubm.c to allow the Exit to perform differently. For
example, you might want to modify the Exit so that it ignores the InfoPrint
Manager print parameters (parameter #5) and processes only the MVS JES
destination control parameters themselves (parameter #2). Or, you could remove
the pdpr call and change it to any applicable program or OS command call. For
instance, you could have the Exit copy or archive the data file (parameter #1).

Note: If you specify a DCF that contains no statements, InfoPrint will pass
parameter #5 as a null string.

Copying the sample exit:

To customize the sample Exit, you should not change the sample itself, because if
you ever need to reinstall InfoPrint Manager, all of your changes will be lost.
Instead, copy the fileset into a directory outside of the directory that you have
InfoPrint Manager installed in and make your changes to that version.

Note: You must have access to Microsoft Visual Studio 2005 to customize the Exit.

To complete the process:
1. Log on to the system that your InfoPrint Manager server is installed on.
2. Decide which directory you would like to store your new exit in or create a

new one for it.
3. Navigate to the <install path>\exits\mvsd directory, where <install path> is

the directory that you installed InfoPrint Manager in, using Windows Explorer
or the My Computer icon.
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You will see four files.
4. Copy these files you want to modify into the directory you selected or created

in step two.
5. Open the copy of the project and make your changes.
6. Save and compile the Exit.

Note: By default, the sample Exit builds a Debug compile version of the Exit.
The pre-installed executable version of the sample (mvsdsubm.exe) is a Release
version. You can change the Active Configuration of the mvsdsubm project to
build the Release version of the Exit.

Changes to custom scripts/exits are only required if any of these new functions are
desired:
v AFP Download Plus multiple data set
v Support for the pdpr retry count and retry interval
v Displaying the AFP Download Plus page count on the Admin/Operator GUI
v Printing/discarding AFP Download Plus failed jobs
v Using inline resources with MVS Download multiple data set
v Support for separator pages with AFP Download Plus multiple data set
v Using any of the Error Processing Options

If none of these functions are used, the existing custom scripts can be used.

See the current sample script/exit provided and the sample script/exit that your
custom script/exit is based on to determine the changes. From this, you will
identify the proper approach for updating and testing your custom script/exit.

Creating an MVS Download Receiver

Before you can begin sending jobs from the MVS JES spool to InfoPrint Manager
through MVS Download, follow this procedure to set up an MVS Download
Receiver.
1. Open the InfoPrint Manager Management Console.
2. On the menu bar, click Edit → New → MVS Download Receiver.

The Add MVS Download Receiver dialog opens.
3. Fill in the fields according to these specifications. For more information about

the dialog and the fields it contains, see the Management Console online help.
v Port Number: Enter the port number that you want this receiver to use when

it communicates with the host system. This number must match the port
number that is specified in the Routing Control File used by the for MVS
Download FSA for this computer’s IP address or the PORTNO in the
PRINTDEV for the AFP Download Plus FSA.

v Target Destination: Select the InfoPrint destination that you want this
receiver to submit jobs to from the drop-down list. InfoPrint Manager will
only submit a job to this destination when the job does not have a
target-destination-name value assigned to it after its mvs_keywords have
been processed against the DCF.

v Destination Control File: Click Browse and locate the destination control file
that you want to use with this receiver. Select the file and click Save.

v In the Processing Options group box, both of the options are selected by
default.
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– When the Retain command files check box is selected, InfoPrint Manager
saves all of the files that pertain to MVS Download jobs that fail in
processing. When MVS Download print jobs are processed successfully,
these files are cleaned up regardless of what you select here. If you need
to resubmit failed jobs, you do not have to download them from the host
system again; the files are still on your InfoPrint server. If you deselect
this box, you will have to download any jobs that fail in processing from
the host again to print them.

Note: You can diagnose errors by clicking the Server Log item in the left
pane of the Management Console.
Operators should evaluate any processing failures, correct the problems
that caused the failures, and resubmit the jobs.
For more information, see “Deleting orphan files and resubmitting jobs to
MVS Download” on page 304.

– When the Enable parallel processing check box is selected, this MVS
receiver will process multiple jobs simultaneously. When it is cleared, the
receiver will wait until the Exit for one print job completes before it starts
to process the next job.
This option is normally left selected unless a custom Exit has been written
that requires only one instance of the exit to run at a time and in the order
the files are received.
This option must be unchecked if the multiple data set function of MVS
Download or AFP Download Plus is used.

v In the Error Processing Options group box, neither of the options are
selected by default:
– When the Provide Extended Error Information to AFP Download Plus

check box is selected, internal errors or exit errors are reported to the host
for assistance in problem determination if requested by AFP Download
Plus. When the check box is cleared, neither internal errors nor exit errors
are reported to the host for assistance in problem determination. To report
internal error messages, you must check this box to report internal error
messages. In addition, you must also check the Provide Exit Program
Errors to z/OS check box to report exit messages. For all new and existing
view receivers, the default status of the box is cleared.

– When the Provide Exit Program Errors to z/OS check box is selected, the
success of the exit is monitored by the receiver. A zero return code from
the exit causes the receiver to indicate success to the mainframe. A
non-zero return code from the exit causes the receiver to indicate failure to
the mainframe. When this check box is selected and the exit reports an
error on a file in an multiple data set job, the mainframe might retry the
file. In addition, any error messages generated by the exit are provided to
the mainframe when you check this box if the Provide Exit Program
Errors to z/OS check box is also checked. When you do not check this
box, the success of the exit is not monitored by the receiver. For all new
and existing view receivers, the default status of the box is cleared.

v In the Mapping Options group box, neither of the options are selected by
default:
– Select Basic, to use a limited hard-coded conversion table.
– Select Custom, to specify the Host Code Page and, optionally, the Local

Code Page for conversion.
- Host Code Page: Enter the name of the code page from where your JCL

is submitted.
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- (Optional)Local Code Page: Enter the name of the local code page that
you want to use. If this field is left empty, the receiver queries the
system code page and uses it instead.

4. (Optional) Click Advanced to open the Add MVS Download Receiver
Advanced dialog. In this dialog, you can specify these options. For more
information about the dialog and the fields it contains, see the Management
Console online help.
v Select Standard Exit Program Options, to specify the Print AFP Download

Plus Jobs with Errors on z/OS, the Server Submission Retry Count, and the
Server Submission Retry Interval.

Note: These options are only functional if you are using the new InfoPrint
Manager provided exit. If you are using an older InfoPrint Manager
provided exit, these options will be ignored. If you are using a custom exit,
consult the writer of the exit.
– If you select the Print AFP Download Plus Jobs with Errors on z/OS

check box, and AFP Download Plus detects an error in any file in the job,
the job is printed including the error messages provided by AFP
Download Plus. The error messages provided by AFP Download Plus are
printed where the file would normally be printed in the job. If you clear
this check box and AFP Download Plus detects an error in any file in the
job, the entire job is discarded. For all new and existing view receivers, the
default status of the box is cleared.

– Server Submission Retry Count: Enter the number of times the pdpr
should be tried. If no value, or a value of 0 is entered, the pdpr is retried.

– Server Submission Retry Interval: Enter the time interval in seconds
between the pdpr retries. The value entered must be a integer from 0 to
32767. If no value or a value of 0 is entered, the pdpr is retried
immediately.

v Select the Custom Exit Program Options check box, if you are using custom
exits. Consult with the person responsible for the custom exits to determine
whether this box should be selected.
– Exit Program Name: Enter the path and filename of the custom Exit

Program that you want this receiver to use. Consult with the person
responsible for the custom exit program to determine the name of the exit.

– Additional Exit Program Parameters: Consult with the person responsible
for the custom exit program to determine the Additional Exit Parameters.

v Click OK to close the Add MVS Download Receiver Advanced dialog.
5. On the Add MVS Download Receiver dialog, click OK.

One or more pop-up informational messages might appear; read them and click
OK to dismiss them.

6. Select the MVS Download Receivers item in the left pane of the Management
Console.
You should see the receiver you just created in the right pane. The receiver
status might be STOPPED but it should start momentarily. Click Refresh View
on the toolbar until the status changes to RUNNING.
If the receiver does not start within a few minutes, select Edit → MVS
Download Manager and manually start the receiver by selecting it and clicking
Start.
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Note: Receivers that will not start more than likely have destination control file
errors. You can diagnose errors by clicking the Server Log item in the left pane
of the Management Console.

Making your AFP resources available to InfoPrint Manager
When the MVS Download feature of PSF for z/OS is used with MVS Download,
the AFP resources you use for your printing jobs must be available to InfoPrint
Manager, so the jobs can process correctly. When the AFP Download Plus feature
of PSF for z/OS is used with MVS Download, the resources are usually sent with
the print jobs and the AFP resources do not need to be available to InfoPrint
Manager, and this section can be skipped. However, AFP Download Plus can be
configured to not send all AFP resource types to InfoPrint Manager. If this
configuration is used, the resource types not sent must be made available to
InfoPrint Manager as described in this section. This section assumes that these
resources currently reside on your host system in AFP format, and that you (or
someone) can locate them.

Note: If you currently use the Distributed Print Function (DPF) of PSF for OS/2,
the resource files you use are in Intelligent Printer Data Stream (IPDS) format.
However, the Advanced Function Presentation (AFP) versions of those files exist
on your host system as well. Make sure that you use the AFP versions with MVS
Download.

There are several ways that you can make your resources available to InfoPrint
Manager; three of them are described below. Read through the options and decide
which is best for your configuration.

Manually transfer the resources from the host to your Windows
system

You can move your resources directly from your host system using any method
you like, though the most common is ftp. If you decide to ftp your files, make sure
that you transfer the files as binary data, not as text. In general, the steps you
should follow are:
1. Create a directory on your Windows system that will receive your resources.
2. ftp your resources to that directory as binary data.
3. Identify that directory to InfoPrint Manager.

You can either identify the directory using a resource context object or by
changing the default resource search path in the Management Console. For
information about changing the default resource search path, consult the online
help for the Management Console under Service Configuration.

This method is effective and relatively easy to implement. However, every time
you change your AFP resources, you will have to ftp them to the correct directory
on your Windows system. If you do not change your resources often, this method
might work well for you. If you change your AFP resources often, you might want
to consider a different option.

Store your resources in a central location
Another option is to store your AFP resources on any machine in your network
(including the host system that they currently reside on), and NFS mount a
directory on the Windows system that your InfoPrint Manager server is installed
on to that machine. Then, identify that directory to InfoPrint Manager just as in the
option above (either by using a resource context object or by changing the default
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resource search path). To implement this option, you will need to install NFS
server and client software, which is available from a variety of vendors.

The main drawback to this solution is that it generates a significant amount of
network traffic as the system retrieves the resources. The increase in traffic and
time needed to retrieve the resources when needed could cause printer clutching.

Move the resources using MVS Download
A third option is to move your AFP resources using the MVS Download feature of
InfoPrint Manager itself. You can achieve this by setting up a MVS Download
receiver that receives jobs and copies them into a particular directory without
printing them. You would only use this receiver to move your resources. Setting
up this configuration is different depending on your environment. Each time you
modify a resource, you submit a job that sends the modified resource to each
system that you are running an InfoPrint Manager server on. To accomplish this
task, you might need to customize the JES inish deck, the Host MVS Download
routing control data set, the Destination Control File (DCF), and the Exit Program.
The modifications needed will depend on your existing MVS Download
configuration used for sending jobs, although the process of getting the AFP
resources to the InfoPrint Manager computer is the same in all cases:
1. Place the resource on the spool for MVS Download to process with

identification that it is an AFP resource, the resource name, and the desired
target path. (Target path is optional)

2. Set up the routing control data set to send the AFP resources to unique MVS
Download receivers on the InfoPrint Manager system. (Optional)

3. Set up the routing control data set to not prefix each record with a record
length field for AFP resources.

4. Set up the DCF to map the desired resource path/name to the
target-destination-name. (Optional)

5. Modify the supplied Exit to copy the received AFP resource into the proper
resource directory with the provided resource name. The full functions of this
Exit would depend on the options chosen above. For example:
a. If the target path was not supplied, the Exit would either need to have it

hardcoded or determine it using other means.
b. If both AFP resources and print jobs are being sent to the same receiver, the

exit would need to distinguish between the two by some mechanism and
take the proper action for each.

c. If the DCF does not map the resource path/name to the
target-destination-name, it will either need to parse it from the other
parameters or determine it using other means.

This option is more difficult to set up than the other two, but is less time
consuming once you have it implemented, because every time you change your
AFP resources all you have to do is resubmit a job for transmission to your
Windows systems. If you have multiple Windows systems to update or can further
automate this process, this method might work well for you. One possible
configuration example follows.

Example: Assume that JES is configured to schedule all jobs with DEST=NTPRT1 to
an MVS Download FSA that downloads them to an InfoPrint Manager system that
then uses the default supplied DCF and Exit to submit the jobs to an IPDS printer,
ntprt1. The MVS Download FSA uses a routing control data set that contains this
statement:
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DEST=NTPRT1
IPADDR=dept01.myststem
PORTNUM=5002
RETRYNUM=3
RETRYINTV=60

We have decided this about the configuration:
v Leave the existing MVS Download receiver (on our Windows system) alone.
v Create a new receiver to processes the AFP resources, but continue using the

existing MVS Download FSA.
v Pass only the AFP resource name, not the directory path for it to be stored in.
v Use the FORMS keyword to identify the job as an AFP resource since the Routing

Control Statements can use FORMS to direct files to different receivers.
v Use the NAME JCL keyword to identify the AFP resource name.

In the JCL job for putting modified AFP resources on the spool, we have an
OUTPUT statement with:
OUTPUT DEST=NTPRT1,FORMS=AFPRES,NAME='C0MYFNT.300',....

No changes to the JES inish deck are required since the MVS Download FSA
already receives jobs with DEST=NTPRT1.

We change the routing control file as follows to send this job to a separate receiver
and to prefix these resources with no length field. Jobs that do not have
FORMS=AFPRES would continue to be sent to the existing receiver.
DEST=NTPRT1
FORMS=AFPRES
IPADDR=dept01.mysystem
PORTNUM=5003
SEND_REC_LENGTH=NO
RETRYNUM=3
RETRYINTV=60
DEST=NTPRT1
IPADDR=dept01.myststem
PORTNUM=5002
RETRYNUM=3
RETRYINTV=60

Now we need to define a new receiver on the dept01.mysystem machine. The new
receiver will use port number 5003 (as identified in the routing control statement),
a modified DCF, and a user-written Exit.

We make a copy of the supplied DCF and modify it to change the mapping of the
NAME keyword from MVS. The existing statement:
NAME :: name-text

would be changed to:
NAME :: target-destination-name

Also, the existing statement that maps DEST to target-destination-name would be
commented out as follows:
* DEST :: target-destination-name

Due to this change in the DCF, the Exit will now receive the AFP resource name as
the third passed parameter.
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Next, we make a copy of the supplied Exit. We modify the Exit so it copies the
received file instead of submitting it to InfoPrint Manager using pdpr. The Exit
must use the first passed parameter as the name of the resource file and the third
passed parameter to derive the target resource file name, because the DCF mapped
it that way. Since we did not pass the desired resource directory name in the JCL,
the Exit needs to determine the drive and directory and pre-pend it to the target
resource file name. Since this Exit will only be used on a receiver that receives AFP
resources, it doesn’t need to identify the file as an AFP resource and have a paths
for both copying resources and submitting non-resources to InfoPrint Manager to
be printed. The Exit can also be coded to detect and react to error situations as
appropriate.

Lastly, we use the Management Console to create the receiver that will use the
DCF and Exit that we created. In this example, the Target Destination that we
specify when we create the receiver is irrelevant and will only be passed to the
Exit if no NAME is specified in the JCL that submitted the resource.

Submitting multiple data set jobs
MVS Download and AFP Download Plus send each JES SYSOUT data set
separately to the MVS Download receiver on Windows. By default, the receiver
spools each data set as a separate file. On MVS, a job can contain multiple data
sets. Use this procedure to customize your installation for MVS Download multiple
data set job support, so that the data sets in a job sent to InfoPrint Manager
through MVS Download print in sequence, with no intervening files, no NPRO
processing between files, and only one header and trailer page for the set.

InfoPrint Manager now enables multiple data sets to be received, individually
transformed by ACIF into MO:DCA-P, and then combined into a single file and
spooled. InfoPrint Manager uses the medium maps (copy groups) from the form
definition that is associated with each data set to build a comprehensive inline
form definition that it inserts at the beginning of the combined file.

Use these procedures to install and configure MVS Download support for printing
multiple data set jobs.
v “Requirements to use multiple data set support”
v “Installing multiple data set support with MVS Download” on page 170
v “Limitations of multiple data set support” on page 171
v “Technical description of multiple data set support” on page 172

Requirements to use multiple data set support

To support the printing of multiple data sets in a job as a single unit using MVS
Download, you must:
v Install a special MVS Download user exit 15 program on MVS.
v Create a MVS Download Receiver on your InfoPrint Manager system with

parallel processing turned off.

To support the printing of multiple data sets in a job as a single unit using AFP
Download Plus, you must:
v Install AFP Download Plus with APAR OA15317.
v Set the dataset-grouping parameter in the control statement data set to Yes.
v Create an MVS Download Receiver on your InfoPrint Manager system with

parallel processing turned off.
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The sample user exit 15 program (apsux15m) provided with MVS Download, adds
a parameter that identifies data sets that belong to multiple data set jobs and
indicates whether the data set is first, next, or last in a job.

Turning off parallel processing ensures that the MVS Download receiver receives
the data sets in the correct sequence by creating only one child process. If parallel
processing is turned on, MVS Download can create more than one child process,
and thus can receive more than one data set from a multiple data set job at the
same time. Data sets could be received out of order and might not print correctly.

Note: Make sure you have set up your shared resources so thatMVS Download
can find them.

Installing multiple data set support with MVS Download

Use this procedure to install the MVS Download multiple data set support.
1. Install the MVS Download user exit 15 program, apsux15m, on MVS. The

program must be assembled and linked into a data set referenced in the
STEPLIB of your MVS Download startup PROC.

2. Run MVS Download on MVS using SEND_REC_LENGTH=YES either by specifying it
explicitly in the MVS Download Routing Control data set on MVS or by
allowing it to default. If you specify SEND_REC_LENGTH=NO, ACIF might be unable
to process some variable length line mode data. In these cases, ACIF issues a
message that it cannot read the input file with a return code of 310.

3. Make sure that ACIF can locate your resources. It looks in the directories
specified in the Service Configuration dialog of the Management Console. If
you specify resource directories using any of these attributes, you must specify
those same directories in the Default resource search path field in the Service
Configuration dialog of the Management Console:
v resource-context

v resource-context-font

v resource-context-overlay

v resource-context-page-segment

v resource-context-page-definition

v resource-context-form-definition

You must delimit each directory using a semicolon (;), not a colon (:).
4. Do not specify these attributes either directly or in Initial Value Job or Initial

Value Document objects:
v transform-message-file-name

v resource-context-page-definition

v You can use the resource-context attribute instead of the
resource-context-page-definition attribute.

5. Make sure that all of the receivers you plan to use have parallel processing
turned off. If parallel processing is enabled, you cannot use those receivers with
multiple data set jobs. To see the status of parallel processing:
a. Open the Management Console and click the MVS Download Receivers

item in the left pane.
A list of receivers appears in the right pane.

b. Double-click each receiver to open the Viewing dialog.
c. In the Processing Options box, see if Parallel Processing is enabled. If it is

enabled, you cannot use that receiver with multiple data set jobs.
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Installing multiple data set support with AFP Download Plus

Use this procedure to install the AFP Download Plus multiple data set support.
1. Install AFP Download Plus with APAR OA15317. To enable the multiple data

set function, set the dataset-grouping parameter in the control statement data
set to Yes. For more information about installing AFP Download Plus, see the
″Installing AFP Download Plus″ chapter in Print Service Facility for z/OS: AFP
Download Plus, S550-0433. Using the MVS Download exit 15 program to enable
multiple data set on AFP Download Plus is not supported.

2. Do not specify these attributes either directly or in Initial Value Job or Initial
Value Document objects:
v transform-message-file-name

v resource-context-page-definition

You can use the resource-context attribute instead of the resource-context-page-
definition attribute.

3. Make sure that all of the MVS Download receivers that you plan to use have
parallel processing turned off. If parallel processing is enabled, you cannot use
those receivers with multiple data set jobs. To see the status of parallel
processing:
a. Open the Management Console and click the MVS Download Receivers

item in the left pane. A list of receivers appears in the right pane.
b. Double-click each receiver to open the Viewing dialog.
c. In the Processing Options box, see if Parallel Processing is enabled. If it is

enabled, you cannot use that receiver with multiple data sets.

Limitations of multiple data set support
This support has these limitations:
1. You cannot use custom MVS Download exits on Windows with this function—

you must use the sample exit that comes with InfoPrint Manager.
2. This solution applies only to line mode, mixed mode, or MO:DCA-P data sets.
3. You cannot have inline resources with the same name and different content in

the same job, except for page definitions and form definitions.
4. The job-page-count attribute includes the separator pages when the host

separator page is enabled, but the separator pages are not included in the
job-page-count for any other jobs.

5. When the separator page support is enabled in the host but the data set does
not contain the separator page, the receiver will print the job with InfoPrint
Manager separators. In order to suppress the InfoPrint Manager separators, you
can perform one of the following options:
v Change the scripts/exits to set the auxiliary-sheet-selection job attribute to

none permanently.
v Set the printer-start-sheet, printer-separator-sheet, and printer-end-sheet job

attributes to none for the actual destination.
v Set the auxiliary-sheet-selection job attribute to none for the logical

destination.
6. You must disable parallel processing when you create the MVS Download

Receiver, so that it only receives one data set at a time. You cannot change
processing options on existing receivers. As a result, you will have to delete
and re-create any receivers that have parallel processing enabled.
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7. You must have enough disk space on the Windows system to receive and
transform all of the data sets in a multiple data set job. If you do not use this
solution, data sets might be received and transformed individually, so less
space might be required.

8. This solution does not create three types of form definition (FORMDEF)
statements in the generation of a comprehensive inline form definition:
v MSU (Map Suppression)
v PFC (Presentation Fidelity Control)
v MFC (Medium Finishing Control)
v PEC (Presentation Environment Control)
v MDR (Map Data Resource)

Note: If you enable multiple data set support using MVS Download, and you need
to configure multiple MVS Download FSA’s, you must have one receiver for each
Download FSA that is submitting jobs to the InfoPrint Manager server. If you don’t
do this and two MVS Download FSA systems send jobs at the same time, the job
data sets can become intermingled and errors or incorrect output can result. This
restriction does not apply to AFP Download Plus. Multiple AFP Download Plus
FSAs can be enabled for multiple data set and use one receiver.

Technical description of multiple data set support
This describes the sequence of the multiple data set support.
1. The MVS Download receiver receives a data set into a file.
2. The MVS Download receiver invokes the InfoPrint Manager sample exit to

spool the file. (You associated the sample exit with this receiver when you
created it.)

3. If MVS user exit 15 or AFP Download Plus marked the file as part of a
multiple data set job, the sample exit does not immediately spool the file.
Instead, the sample exit calls a second program, which invokes ACIF to
transform the file into MO:DCA-P if it is from MVS Download.

4. After the last file in a multiple data set job is received and transformed to
MO:DCA-P for MVS Download, the sample exit invokes the afpconcat program
to create one file with a comprehensive inline form definition and all the
MO:DCA-P documents. The afpconcat program can combine the multiple
MO:DCA-P files received from MVS Download into a single MO:DCA-P file.
The comprehensive inline form definition contains medium maps (copy groups)
from all of the form definitions associated with the individual data sets. The
formdefs requested for each input file are merged into a single combined
formdef that is placed inline in the output MO:DCA-P document.

5. If medium map names collide, the afpconcat program assigns unique names
and updates references in the MO:DCA-P documents.

6. The afpconcat program merges the inline resource group, discarding page
definitions and the original form definitions. Resources with matching resource
names and types are compared to verify that they are identical.

7. The sample exit spools the combined MO:DCA-P file.

Displaying the page count for your MVS Download jobs
To be able to see the page count for your MVS Download jobs listed in the
InfoPrint Manager GUI, you must install the multiple data set support as described
in “Submitting multiple data set jobs” on page 169. All of the requirements and
limitations apply, even if you do not plan to use multiple data set support.
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To be able to see the page count for your AFP Download Plus jobs listed in the
InfoPrint Manager GUI, you can either turn on multiple data set support, or you
can turn on page-accounting-support in AFP Download Plus.

Performance considerations with the Direct Download method

The performance of the download receiver/daemon on the InfoPrint Manager
server decreases when using the Direct download function. The Direct download
support can be enabled or disabled from the host (see AFP Download Plus guide
for further reference).

Note: When enabled, there is an impact upon the throughput of the file from the
beginning of file reception across TCP/IP until first page is printed. Also, the CPU
and disk usage may increase during the operation.

The memory usage is not expected to be affected.

Using Direct download causes additional temporary files in the download
working directory. You must ensure that you have sufficient space in the file
system where the download working directories reside. No additional file system
space is required.

Chapter 22. Setting up to use MVS Download 173

|

|
|
|
|

|
|
|

|

|
|
|
|



174 InfoPrint Manager for Windows: Procedures



Chapter 23. Using the Distributed Print Facility (DPF)

See these sources for information about using DPF to manage and control printing
from the host console:
v ″Planning to print from host systems″ in the InfoPrint Manager for Windows:

Introduction and Planning Guide.
v ″Preparing InfoPrint Manager to connect to your host system″ in InfoPrint

Manager for Windows: Getting Started.
v ″Create/change/view DPF Host Receiver″ topic in the online Help for the InfoPrint

Manager Management Console.
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Part 4. Administrative Procedures: Customizing for Special
Jobs
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Chapter 24. Working with transforms

InfoPrint Manager provides transform programs for these data streams:
v Printer control language (PCL)
v PostScript
v Portable document format (PDF)
v Tag image file format (TIFF)
v Joint photographic experts group (JPEG)
v Graphic interchange format (GIF)
v Line (ASCII, both formatted and unformatted)
v Double Byte text stream
v Personalized Print Markup Language (PPML)
v Extensible Markup Language (XML)

These transforms also support color management:
v ps2afp
v jpeg2afp
v tiff2afp
v gif2afp

The transforms convert the incoming data stream into the Advanced Function
Presentation (AFP) format.

When a job in any of these formats is submitted to print on a PSF printer, InfoPrint
Manager automatically invokes the appropriate transform. You can also run the
transforms from the Command Prompt window without printing the generated
output. You might find this useful if you intend to print the job later. You can also
use these transforms in transform objects and transform-sequences associated with
actual destinations. For more information about this function, see “Configuring
transforms” on page 211. Jobs print more quickly if they have already been
transformed.

Most transforms have flags or option keywords that you can use to specify
processing information. For a list of the flags or options and values for each
transform, see the InfoPrint Manager: Reference. Configuration files, environment
variables, and user-exit programs allow you to specify processing information for
InfoPrint Manager to use when it invokes the transform automatically. You can
also use configuration files and environment variables instead of typing flags on
the command line whenever you run a transform.

This section consists of these:
v “Customizing the PCL, PostScript, and PDF transforms” on page 180
v “Customizing the img2afp transform” on page 186
v “Customizing the TIFF, JPEG, and GIF transforms” on page 189
v “Working with the transform for line data” on page 190
v “Working with the transform for double byte text streams” on page 195
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Note: For information about the fonts used with the double-byte (db2afp)
transform, see Chapter 27, “Working with fonts,” on page 227.

v “Working with the InfoPrint PPML transform program” on page 197
v “Working with the XML transforms” on page 199
v “Color management resource transform support” on page 206

Customizing the PCL, PostScript, and PDF transforms
You can customize the transforms for PCL, PostScript, and PDF data by specifying
values in the transform configuration files. Table 14 shows the default
configuration files that InfoPrint Manager provides.

In the table, install_path is the directory that InfoPrint Manager is installed in. If
you don’t know the install path, you can find it in the Management Console.
Open the Management Console, click Edit -> Change Service Configuration and
find the Install path field.

You can either modify these files or create your own.

Table 14. InfoPrint Manager transforms and configuration files

Data Stream Transform Configuration File Daemon
Configuration File

PCL pcl2afp install_path
\pcl2afp\pcl2afp.cfg

install_path
\pcl2afp\
pcl2afpd.cfg

PostScript ps2afp install_path
\ps2afp\ps2afp.cfg

install_path
\ps2afp\ps2afpd.cfg

PDF pdf2afp install_path
\ps2afp\ps2afp.cfg

install_path\
ps2afp\ps2afpd.cfg

The PostScript and PDF transforms use the same default configuration files.

Sample configuration file

This is an example of a configuration file for the PostScript and PDF transforms.
The configuration file for the PCL transform is similar.
# ps2afp configuration file
# KEYWORD ps2afp FLAG PURPOSE
########### ############## ##################
port = 8251 # -P which TCP\IP port to use
server = 127.0.0.1 # -S server to connect with
ps_job_timeout = 20 # -j maximum number of minutes

# to process PostScript job
ps_server_timeout = 20 # -s maximum number of minutes

# server waits between jobs
ps_width = 8.5i # -w width of generated image
ps_length = 11i # -l length of generated image
ps_x_offset = 0i # -x left and right margins
ps_y_offset = 0i # -y top and bottom margins
ps_resolution = 600 # -r resolution of printer
ps_output_type = IO1_G4 # -a type of AFP image to

# generate

The configuration file uses keyword equivalents of the transform flags. For the
keywords and values that you can specify in the configuration file, see InfoPrint
Manager: Reference.

180 InfoPrint Manager for Windows: Procedures



Daemon configuration files
The PCL, PostScript, and PDF transforms all require a daemon to be running
before you can use them. The pcl2afpd daemon manages the PCL interpreter
portion of the pcl2afp transform. The ps2afpd daemon manages the PostScript
interpreter portion of the ps2afp and pdf2afp transforms. For more information
about these daemons, see InfoPrint Manager: Reference.

Each daemon, like the corresponding transform, uses a configuration file. The
daemon configuration file can contain the same keywords as the transform
configuration file (except server), plus some keywords that control the operation of
the daemon. For the daemon keywords, see the InfoPrint Manager: Reference.

Hierarchy of transform options
InfoPrint Manager assigns a hierarchy to its use of flags and configuration file
information when it runs the PCL, PostScript, or PDF transform program. This lists
the order in which InfoPrint Manager uses flags and information specified in
configuration files:
1. Any values you specify on the command line, including values in the

configuration file you specify with the -C flag.
InfoPrint commands process flags from left to right. If you enter the same flag
more than once, InfoPrint Manager uses the last occurrence of the flag to
determine the value to use. For example, if you enter this command:
ps2afp -Cconfig.file -r240 -r300 myfile.ps

the ps2afp command transforms the file using 300-pel resolution. InfoPrint
Manager ignores the resolution value specified in the configuration file
config.file as well as the first -r240 flag and value.

2. Values specified in the pcl2afp.cfg or ps2afp.cfg configuration file in the
current directory, if one exists and if you enter the transform command directly.
InfoPrint Manager ignores values in the current directory if you invoke the
transform command indirectly by submitting a job to print.

3. Values specified in the pcl2afp.cfg or ps2afp.cfg configuration file in your
home directory, if one exists.

4. Values specified in the default transform command configuration file named in
“Sample configuration file” on page 180.

5. Values specified in a customized configuration file identified with the -C flag of
the pcl2afpd or ps2afpd command when the transform daemon started.

6. Values specified in the default transform daemon configuration file named in
“Sample configuration file” on page 180.

7. Default values that are built into InfoPrint Manager. These are the same as the
transform defaults except that the default PostScript or PDF output type is an
IM1 uncompressed image.

Stapling and punch options available from the ps2afp transform
You can use the ps2afp transform to specify both staple and punch finishing
options. To use this support, you must:
1. Make sure that the IPDS (Intelligent Printer Data Stream) capable printer

supports either staple or punch finishing options.
2. Make sure that the PostScript input file contains either staple or punch

information.
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3. Make sure that the keyword finishing is assigned to the device_controls
option in the ps2afpd.cfg configuration file, as shown in the bold-faced
example in Figure 11 on page 183.

4. Make sure that the application or driver that generated the PostScript supports
the subset of staple or punch operations enabled in the ps2afp transform. See
“Staple and punch operations supported by the ps2afp transform” on page 183
for a list of these staple and punch options.

If you are interested in using this finishing support, the PostScript drivers available
with these printers contain this support. You can specify these InfoPrint printers as
TCP/IP:
v InfoPrint 2085
v InfoPrint 2105
v InfoPrint 2060ES
v InfoPrint 2075ES
v InfoPrint 2090ES
v InfoPrint 2105ES

Specifying finishing in the ps2afpd.cfg file
This shows how you can specify finishing values in the ps2afp data stream
transform:
1. From a command line, access the ps2afpd.cfg file that is in either the

/usr/lpp/psf/ps2afp/ directory on an AIX server or the install_path\ps2afp folder
on a Windows server.

2. Using your editor of choice, edit the file.
3. Find the heading #ENABLING STAPLING OR PUNCH FINISHING

OPTIONS THROUGH THE TRANSFORM and remove the hash mark (#) that
comments out this line:
device_controls=finishing

4. Save and close the file.

Notes:

1. The device_controls option also accepts bin numbers and plex key words.
2. If you omit plex, the ps2afp transform creates duplex output.
3. If you omit bin numbers, the ps2afp transform creates output that indicates

that the first input tray should be used.
4. Not all printers support using the staple and punch options that the ps2afp

transform generates. If you send a document with staple or punch operations
to an IPDS printer that does not support the request, InfoPrint Manager issues
a message and completes the job, without either staples or punch holes. Refer
to your printer documentation to determine which (if any) staple or punch
operations are available.

For further examples, see the ps2fpd.cfg file shipped with the latest version of
InfoPrint Manager, which includes the device_controls option.
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Staple and punch operations supported by the ps2afp
transform

These tables list the subset of PostScript information transformed to Advanced
Function Presentation (AFP) MO:DCA-P structured fields and triplets to support
staple and punch operations. The changes described below should only be
performed by someone with extensive knowledge of the PostScript language, such
as someone writing their own PostScript driver.

The << /Staple 3 information below is a particular example drawn from Table 15
on page 184 and Table 16 on page 184. Both tables contain pertinent information
for adding stapling operations to your PostScript data stream.
{ << /Staple 3 /StapleDetails << /Type 17 /Position 17 >> >> setpagedevice }
{ << /Staple 3 /StapleDetails << /Type 17 /Position 18 >> >> setpagedevice }

This example indicates that the printer will place two staples at the top of a page,
whether the page has either a Portrait or a Landscape orientation.

/Staple 3
The key that introduces the StapleDetails Dictionary.

/Type 17
A required key reserved for future use.

# ps2afpd configuration file
# KEYWORD EQUIVALENT ps2afp FLAG PURPOSE
###################################################################

port = 8251 # which TCP/IP port to use

work_directory = /var/psf/ps2afp
# directory to put work files into

log_file = /var/psf/ps2afp/ps2afpd.log
# where to write log messages

notify = root # who to notify if problems encountered
mail_command = /usr/bin/mail

# program used to send notifications
ps_program = /usr/lpp/psf/bin/ps2afpi

# name of PostScript interpreter program
ps_init_file = /usr/lpp/psf/ps2afp/ps2afpe.ps

# name of PostScript interpreter
# initialization file

ps_files_path = /usr/lpp/psf/ps2afp :\
/usr/lpp/psf/config

# path to search for jobInit files
:
:
:
######################################################################

# ENABLING STAPLING OR PUNCH FINISHING OPTIONS THROUGH THE TRANSFORM
# If you want to use the stapling or punch finishing options and have
# ensured that your PostScript driver supports these options,
# use the following options:

device_controls=finishing

Figure 11. Sample PostScript Daemon configuration file sections with staple and punch
options
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/Position
A key that indicates the placement of the staples, using the settings
displayed in Table 16.

The << /Punch 4 information below is a particular example drawn from Table 17
on page 185, Table 18 on page 185, and Table 19 on page 186. All three tables
contain pertinent information for adding stapling operations to your PostScript
data stream.

{ << /Punch 4 /PunchDetails << /Type 7 /HoleType 0 /Pattern 0 /Position 1 >> >> setpagedevice }
{ << /Punch 4 /PunchDetails << /Type 7 /HoleType 0 /Pattern 0 /Position 5 >> >> setpagedevice }

This example indicates that the printer will place a punch on the left side of a
page, whether the page has either a Portrait or a Landscape orientation.

/Punch 4
The key that introduces the PunchDetails Dictionary.

/Type 7
A required key reserved for future use.

/Pattern 0
A key that indicates the default punch setting, using the settings displayed
in Table 19 on page 186.

Note: Most PostScript drivers use /Pattern 0 because Finishers tend to
have one particular setting. /Pattern 0 works with all Finishers. If you
specify /Pattern 6 in the PostScript driver and your Finisher only
supports two-hole punch, InfoPrint Manager will print the job and
generate an error message without performing the finishing.

/Position
A key that indicates the placement of the staples, using the settings
displayed in Table 18 on page 185.

Table 15. Default staple locations

Staple Key name PostScript Staple

Do not staple None /Staple 0

Staple Not supported /Staple 3

Table 16. Additional PostScript staple details

Staple details Key name PostScript staple details

Do not staple None Portrait:
/Position 0

Landscape:
/Position 0

Single left diagonal LeftDiagonal Portrait:
/Position 1

Landscape:
/Position 5

Single left
horizontal

LeftHorizontal Portrait:
/Position 3

Landscape:
/Position 7
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Table 16. Additional PostScript staple details (continued)

Single left vertical LeftVertical Portrait:
/Position 2

Landscape:
/Position 6

Single right
diagonal

RightDiagonal Portrait:
/Position 9

Landscape:
/Position 13

Single right
horizontal

RightHorizontal Portrait:
/Position 11

Landscape:
/Position 15

Single right vertical RightVertical Portrait:
/Position 10

Landscape:
/Position 14

Double left DoubleLeft Portrait:
/Position 4

Landscape:
/Position 8

Double right DoubleRight Portrait:
/Position 12

Landscape:
/Position 16

Double top DoubleTop Portrait:
/Position 17

Landscape:
/Position 18

Booklet Booklet Portrait:
/Position 20

Landscape:
/Position 20

Table 17. Default punch locations

Punch Key name PostScript Punch

Do not punch None /Punch 0

Punch Not supported /Punch 4

Table 18. Additional PostScript punch details

Punch details Key name PostScript punch details

Do not punch None Portrait:
/Position 0

Landscape:
/Position 0

Left PunchLeft Portrait:
/Position 1

Landscape:
/Position 5
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Table 18. Additional PostScript punch details (continued)

Top PunchTop Portrait:
/Position 3

Landscape:
/Position 7

Right PunchRight Portrait:
/Position 2

Landscape:
/Position 6

Bottom PunchButtom Portrait:
/Position 4

Landscape:
/Position 8

Table 19. Punch Setting for the /Pattern value

Punch Key Name PostScript Punch
Details

Default Punch* /Pattern 0

2–holes Punch*2 /Pattern 6

3–holes Punch*3 /Pattern 5

4–holes Punch*4 /Pattern 7

Customizing the img2afp transform
The img2afp transform can be used to transform color (FS45) images into
monochrome bilevel (FS10) images for printing. This transform is valuable for
transforming color images so that they print well in black-and-white. You can
customize the img2afp transform only by specifying options on the command line.
Unlike other transforms shipped with the InfoPrint Manager, this transform is not
invoked automatically. Instead, you must specify it at the command line to
preprocess the data before printing. For specific information about the syntax and
use of this command, see InfoPrint Manager: Reference.

While you can create an img2afp.cfg file, InfoPrint Manager supplies a series of
img2afp.cfg configuration files that are based on the printer model. For example,
the img2afp.4000–708cfg file on an InfoPrint Manager for AIX server contains these
settings:
#img2afp InfoPrint 4000-708 configuration file

a=fs10
respath=.:/usr/lpp/psf/config
thresh=4000-708.ibm106lpi.ta.ps
gcorr=4000-708.ibm106lpi.tf.dt.ps
pagetype=page
v=yes
r=600

On an InfoPrint Manager for Windows server, the respath value should be set to
the path where the img2afp configuration files is located in: install_path\config

where install_path is the fully qualified path where InfoPrint Manager for Windows
is installed on your system.

In each device-specific configuration file, only the thresh and gcorr values change
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img2afp.cfg files observe these basic rules:

Note:

1. Any item specified in a configuration file can be overridden on the command
line.

2. Configuration file syntax is attribute = value.
3. A hash mark (#) indicates a comment to the end of the line.
4. All attribute names are the same as the command-line names.
5. For options that do not take values, you must type yes in the configuration file

(as shown below).
#sample img2afp configuration file

v = yes #equivalent to -v flag
a = fs10 #bilevel output

To invoke the transform from the command line, you must specify at least:
v -a fs10 to indicate bilevel output .
v -thresh {name} to specify the PostScript level 3 halftone dictionary that you are

using.
When you install some printers with InfoPrint Manager, the product makes
PostScript level 3 halftone dictionaries available on your server. For example, on
a Windows server an InfoPrint HD1-HD2, HD3-HD4, HD5-HD6, HS1, HS3,
MD1-MD2, MS1. PS-1, or PD1-PD2 4100 printer provides these:
– /usr/lpp/psf/config/4100.ibm71lpi.ta.ps

– /usr/lpp/psf/config/4100.ibm71lpirot90.ta.ps

– /usr/lpp/psf/config/4100.ibm85lpi.ta.ps

– /usr/lpp/psf/config/4100.ibm85lpirot90.ta.ps

– /usr/lpp/psf/config/4100.ibm106lpi.ta.ps

– /usr/lpp/psf/config/4100.ibm106lpirot90.ta.ps

– /usr/lpp/psf/config/4100.ibm141lpi.ta.ps

– /usr/lpp/psf/config/4100.ibm141lpirot90.ta.ps

v -gcorr filename to specify grayscale mapping tables to halftone the grayscale and
color images to bilevel for output.
When you install particular printers with InfoPrint Manager, you also install
these grayscale mapping tables for each type of PostScript level 3 halftone
dictionary option.
For example, on a Windows server an InfoPrint HD3-HD4, HD5-HD6, HS3,
MD1-2 MS1, PD1-PD2, or PS1 4100 printer provides these:
– /usr/lpp/psf/config/4100.ibm71lpi.tf.ap.ps for dark halftones
– /usr/lpp/psf/config/4100.ibm71lpi.tf.dt.ps for midtone halftones
– /usr/lpp/psf/config/4100.ibm71lpi.tf.lr.ps for standard halftones
– /usr/lpp/psf/config/4100.ibm71lpi.tf.ls.ps for accutone halftones
– /usr/lpp/psf/config/4100.ibm71lpi.tf.oc.ps for dark2 halftones
– /usr/lpp/psf/config/4100.ibm85lpi.tf.ap.ps for dark halftones
– /usr/lpp/psf/config/4100.ibm85lpi.tf.dt.ps for midtone halftones
– /usr/lpp/psf/config/4100.ibm85lpi.tf.lr.ps for standard halftones
– /usr/lpp/psf/config/4100.ibm85lpi.tf.ls.ps for accutone halftones
– /usr/lpp/psf/config/4100.ibm85lpi.tf.oc.ps for dark2 halftones
– /usr/lpp/psf/config/4100.ibm106lpi.tf.ap.ps for dark halftones
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– /usr/lpp/psf/config/4100.ibm106lpi.tf.dt.ps for midtone halftones
– /usr/lpp/psf/config/4100.ibm106lpi.tf.lr.ps for standard halftones
– /usr/lpp/psf/config/4100.ibm106lpi.tf.ls.ps for accutone halftones
– /usr/lpp/psf/config/4100.ibm106lpi.tf.oc.ps for dark2 halftones
– /usr/lpp/psf/config/4100.ibm141lpi.tf.ap.ps for dark halftones
– /usr/lpp/psf/config/4100.ibm141lpi.tf.dt.ps for midtone halftones
– /usr/lpp/psf/config/4100.ibm141lpi.tf.lr.ps for standard halftones
– /usr/lpp/psf/config/4100.ibm141lpi.tf.ls.ps for accutone halftones
– /usr/lpp/psf/config/4100.ibm141lpi.tf.oc.ps for dark2 halftones

and -gcorr and -thresh must be used to select an appropriate halftone.

Limitations of the img2afp transform
When using the img2afp transform, be aware of these limitations:
v Only jobs that contain either pure IOCA data or IOCA overlaid by other

bilevel-compatible OCAs print correctly.
v img2afp does not support one bit per spot CMYK data (FS42) data conversions.

Examples
For each of these examples, the user has an AFP input file of an FS45 image that
they are converting to an FS10 file for printing on a black-and-white printer. To
obtain their FS45 input file, they might have used either the tiff2afp, gif2afp,
jpeg2afp, pdf2afp, or ps2afp transform to convert an image file from one of those
formats

To convert an FS45 image (sampleFS45.afp) to an FS10 image (outFS10.afp) from
an InfoPrint command line for printing on an InfoPrint 21 printer, type this on the
command line:

img2afp -a fs10 -thresh 4322.ibm106lpi.ta.ps -gcorr 4322.ibm106lpi.tf.dt.ps sampleFS45.afp \
-o outFS10.afp

To print the resulting FS10 image (outFS10.afp) on an InfoPrint 21 printer, type
this on the command line:

pdpr -p ip21-ld outFS10.afp

To convert an FS45 image (DSC011FS45.afp) to an FS10 image (DSC011FS10.afp)
with standard halftones from an InfoPrint command line for printing on an
InfoPrint 4100–HD3/HD4 Advanced Function Printing™ System printer, type this
on the command line:

img2afp -a fs10 -thresh 4100-HD3-HD4.ibm106lpi.ta.ps -gcorr 4100-HD3-HD4.ibm106lpi.tf.lr.ps \
DSC011FS45.afp -o DSC011FS10.afp

To print the resulting FS10 image (DSC011FS11.afp) on an InfoPrint
4100–HD3/HD4 Advanced Function Printing System printer, type this on the
command line:

pdpr -p silver-ld DSC011FS10.afp

To convert an FS45 image (DSC015FS45.afp) to an FS10 image (DSC011FS15.afp)
with dark halftones from an InfoPrint command line for printing on an InfoPrint
4000 Advanced Function Printing System printer, type this on the command line:

img2afp -a fs10 -thresh 4000.ibm106lpi.ta.ps -gcorr 4000.ibm106lpi.tf.ap.ps \
DSC015FS45.afp -o DSC015FS10.afp
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To print the resulting FS10 image (DSC011FS15.afp) on an InfoPrint 4000 Advanced
Function Printing System printer, type this on the command line:

pdpr -p ip40001-ld DSC015FS10.afp

Customizing the TIFF, JPEG, and GIF transforms
You can customize the transforms for TIFF, JPEG, and GIF data by specifying
values in the transform configuration files. Table 20 shows the default
configuration files that InfoPrint Manager provides. You can either modify these
files or create your own.

Table 20. Default TIFF, JPEG, and GIF Transform Configuration Files

Data Stream Transform Configuration Files

TIFF tiff2afp install_path\tiff2afp\tiff2afp.cfg

install_path\tiff2afp\tiff2afp.3160cfg

install_path\tiff2afp\tiff2afp.3900cfg

JPEG jpeg2afp install_path\jpeg2afp\jpeg2afp.cfg

install_path\jpeg2afp\jpeg2afp.3160cfg

install_path\jpeg2afp\jpeg2afp.3900cfg

GIF gif2afp install_path\gif2afp\gif2afp.cfg

install_path\gif2afp\gif2afp.3160cfg

install_path\gif2afp\gif2afp.3900cfg

InfoPrint uses the .3160cfg and .3900cfg configuration files to transform documents
that have been submitted to print on an InfoPrint 60 printer or InfoPrint 4000 laser
printer respectively.

Sample configuration file

This is an example of a configuration file for the TIFF transform. The configuration
files for the JPEG and GIF transforms are similar.
a=ioca10
choice=full
cmp=g4
ms=5120
msf=0.01
nosniff=yes
noterm=yes
v=yes
pagetype=page
r=600
x=0
y=0

The configuration file uses options in the same format as the transform options
that you specify on the command line, except that command line options begin
with a dash (–). For the options and values that you can specify in the
configuration file, see the InfoPrint Manager: Reference.
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Hierarchy of transform options
InfoPrint Manager assigns a hierarchy to its use of options and configuration-file
information when it runs the TIFF, JPEG, or GIF transform program. This lists the
order in which InfoPrint uses command–line options and information specified in
configuration files:
1. Any values you specify on the command line, including values in the

configuration files you specify with the -C option.
InfoPrint Manager commands process options from left to right. If you enter
the same option more than once, InfoPrint Manager uses the last occurrence of
the flag to determine the value to use. For example, if you specify this
command:
tiff2afp -Cconfig.file -r240 -r300 myfile.tif

the tiff2afp command transforms the file using 300-pel resolution. InfoPrint
Manager ignores the resolution value specified in the configuration file
config.file and the first -r240 flag and value.

2. Values specified in the default transform command configuration file named in
Table 20 on page 189.

3. Default values that are built into InfoPrint Manager. These are the same as the
transform defaults.

Working with the transform for line data
InfoPrint Manager includes a line-data transform program that transforms line data
into the Advanced Function Presentation (AFP) data stream. Converting the line
data lets you print it on high-speed AFP printer devices.

The line2afp command and its keywords are a subset of the AFP Conversion and
Indexing Facility (ACIF) acif command. When you use this transform and if errors
occur, you might receive some error messages that make references to ACIF.

This section describes these:
v “What is line data?”
v “What are ANSI and machine carriage controls?” on page 191
v “What are variable-length and fixed-length files?” on page 192
v “How does the imageout keyword affect processing?” on page 193
v “Customizing the line data transform” on page 194

What is line data?
Line data is simply unformatted data; data with few or no embedded control
characters to create font changes, page breaks, and so on. The term line data can
cover a variety of data streams, such as:
v Traditional line printer format, also called 1403 format

v Unformatted ASCII files without escape sequences
v DBCS (double-byte character set) ASCII files generated for an IBM 5577 or 5587.

Notes:

1. The line2afp transform does not handle DBCS ASCII files. For this type of
input, use the db2afp transform.
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2. ACIF accepts EBCDIC DBCS line data files that use SOSI (shift-out/shift-in)
characters. ACIF must be coded with the PRMODE control statement set to
SOSI1, SOSI2 or SOSI3, as documented in the ACIF User’s Guide.

Line data is typically created by an application program. For example, an
application might produce a bank statement that has line data indicating an
account’s daily balance.

The InfoPrint line-data transform lets you format these kinds of data with a page
definition and form definition for printing on InfoPrint-managed printer devices:
v S\370 line-mode data

This type of line data was originally designed for a 1403 printer, is typically
generated on a S\370 host processor, and is usually EBCDIC characters with
embedded control characters (carriage control, table reference characters, and so
on). This type of line data can have double-byte code points and shift in\shift
out controls.

v Mixed-mode data
S\370 line-mode data embedded with certain AFP structured fields (for example,
Include Page Segment)

v Single-byte ASCII data with no embedded control characters except for newlines.
v Single-byte ASCII data that contains ANSI carriage-control characters,

table-reference characters, or both.
v Single-byte ASCII data that contains carriage returns and form feed controls, if

you specify the asciinp or asciinpe user-exit program.

When you transform the line-data job, you must specify a page definition and a
form definition. For more information about the page definitions and form
definitions available to you, see the InfoPrint Manager: Reference. For more
information about associating page definitions and form definitions with jobs, see
the online help in the InfoPrint Manager Administration GUI.

Notes:

1. You cannot use the line-data transform when printing files containing
Proprinter ASCII.

2. When the line2afp command processes any unrecognized or unsupported
keyword, line2afp issues a message, ignores the keyword, and continues
processing any remaining keywords. The line2afp command then stops
processing.

3. InfoPrint Manager also lets you transform and print DBCS ASCII data and
DBCS EUC data without a page definition. For more information, see the
db2afp command in the InfoPrint Manager: Reference.

What are ANSI and machine carriage controls?
In many environments (including IBM mainframes and most minicomputers),
printable data normally contains a carriage control character. The carriage control
character acts as a vertical tab command to position the paper at the start of a new
page, at a specified line on the page, or to control skipping to the next line. The
characters can be one of two types: ANSI carriage control or machine carriage
control.

ANSI carriage control characters
The most universal carriage control is ANSI, which consists of a single character
that is a prefix for the print line. The standard ANSI characters are listed in
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Table 21.

Table 21. ANSI carriage controls

ANSI Action

space Single space the line and print.

0 Double space the line and print.

- Triple space the line and print.

+ Do not space line and print.

1-9 Skip to a vertical position on the page as defined by a vertical tab record (
which is either printer- or system-dependent) or by a Page Definition.

A,B,C Skip to a vertical position on the page as defined by a vertical tab record (
which is either printer- or system-dependent) or by a Page Definition.

All ANSI control characters perform the required spacing before the line prints.
Using line2afp command keywords and values, ANSI controls might be encoded
in EBCDIC (cctype=a) or in ASCII (cctype=z).

Machine carriage control characters
Machine carriage controls were originally the actual hardware control commands
for printers, and are often used on other systems. Machine controls are binary
values, not symbols. They are not represented as characters in any encoding and,
therefore, machine controls cannot be translated. Some typical machine controls are
listed in Table 22.

Table 22. Machine carriage control characters

Machine Action

X’09’ Print the line and single space

X’11’ Print the line and double space

X’19’ Print the line and triple space

X’01’ Print the line (do not space)

X’0B’ Space one line immediately (do not print)

X’89’ Print the line, then skip to channel 1 (top of form)

X’8B’ Skip to channel 1 immediately (do not print)

Machine controls print before performing any required spacing. There are many
more machine control commands than ANSI.

Carriage controls can be present in a file, but to use carriage controls at all, every
record in the file must contain a carriage control. If the file contains carriage
controls but the line2afp command keyword and value cc=no is specified, the
carriage controls are treated as printing characters. If no carriage controls are
specified, the file prints as though it were single spaced.

What are variable-length and fixed-length files?
The line-data transform program needs to know two things about a file to
transform it:
v The length of each print record
v The kind of carriage control used

192 InfoPrint Manager for Windows: Procedures



Some files contain information in each record that describes the record length;
these are called variable-length files. Other files require an external definition of
length; these are called fixed-length files.

MO:DCA structured fields are treated as a special case. All such structured fields
are self-identifying and contain their own length. They do not need to contain a
length prefix to be correctly interpreted, but are also processed correctly if the
length prefix is present.

Variable-length and fixed-length files
Variable-length files might use a length prefix, which means they contain a prefix
that identifies the length of the record in the file. Each record contains a field that
gives the length of the record. If the record contains a length, that length must be a
prefix for each record and it must be a 16-bit binary number that includes the
length of the 2-byte length prefix. Use the fileformat=record keyword and value to
identify files with length prefixes.

Variable-length files might use either a separator or a delimiter to indicate the end
of a record, instead of using a length prefix. All of the bytes up to, but not
including, the delimiter are considered part of the record. For compatibility with
other systems, the default record separator for the line2afp command is X’0A’.

InfoPrint Manager reads the first six bytes and tests for all ASCII characters (code
points from X’00’ to X’7F’) to determine if a file is encoded in ASCII or EBCDIC. If
no non-ASCII characters are found, the line-data transform program assumes that
the file uses the ASCII newline character, X’0A’. Otherwise, the transform assumes
the file uses the EBCDIC newline character, X’25’. Because an input file can
misguide the line-data transform, a set of rules has been established to determine
how the transform processes the file.

Data Type Newline Character

All EBCDIC EBCDIC X’25’

All EBCDIC ASCII X’0D0A’ or X’0A’ 1

All ASCII EBCDIC X’25’ 1

All ASCII ASCII X’0D0A’ or X’0A’

1: These combinations are possible only if a file contains a prefix with a string that
indicates a different code set than actually exists.

v For EBCDIC data with ASCII newlines, use X’0320202020200A’as the first seven bytes of
the file.

v For ASCII data with EBCDIC newlines, use X’03404040404025’as the first seven bytes of
the file.

Fixed-length files
Fixed-length files contain records that are all the same length. No other separators
or prefixes or self-identifying information exists that indicates the record length.
You must know the record length and use the fileformat=record, nnn keyword and
value, where nnn represents the length of each record.

How does the imageout keyword affect processing?
The line-data transform converts image formats (IM1) in the input file, in overlays,
and in page segments to uncompressed IOCA format, if line2afp imageout=ioca
keyword and value is specified (the default). An uncompressed IOCA image might
use a significantly higher number of bytes than an IM1 image and might take more
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processing time to convert, especially for shaded or patterned areas. Although
IOCA is the MO:DCA-P standard for image data, and some data stream receivers
might require it, all products cannot accept IOCA data. All software products from
the InfoPrint Solutions Company do, however, accept IOCA data as well as IM1
image data.

If you are using non-InfoPrint products, you might want to specify imageout=asis.

Customizing the line data transform
InfoPrint Manager provides several sample programming exits to assist you in
customizing the line-data transform. Use of the programming exits is optional. You
specify the names of the exit programs with the inpexit, outexit, and resexit
keywords. Each of these keywords is described in the InfoPrint Manager: Reference.

InfoPrint Manager provides these sample exits:

install_path\exits\acif\apkinp.c
Input record exit

install_path\exits\acif\apkout.c
Output record exit

install_path\exits\acif\apkres.c
Resource exit

In addition, InfoPrint Manager provides these user input record exits to translate
line-data data streams:

install_path\exits\acif\apka2e.c
Converts the ASCII stream data into the EBCDIC2 stream data.

install_path\exits\acif\asciinp.c
Converts unformatted ASCII data that contains carriage returns and form
feeds into a record format that contains ANSI carriage control characters.
This exit encodes the ANSI carriage control character in byte 0 of every
record.

install_path\exits\acif\asciinpe.c
Converts unformatted ASCII data into a record format as does asciinp.c,
and then converts the ASCII stream data into EBCDIC2 stream data.

install_path\exits\acif\dbblank
Processes EBCDIC double-byte line data downloaded from the z/OS spool
by adding an extra blank to the end of the input record if:
1. The last byte in the record is a blank (x’40’ in EBCIDIC).
2. The second to the last byte is not a blank.
3. The input record is line data; that is, it is not a structured field.

This exit also updates the record length by 1 if the blank is added. The exit
has no way of determining if the data is DBCS or not, so this will happen
to every input record that ends in a single blank. The exit assumes that the
input data is EBCIDIC, and that the output data is also EBCIDIC. In other
words, the exit does not do any code page translation, but it simply adds
an extra blank if needed.

Notes:

2. The default conversion is from code page 850 to code page 037. You can override the defaults with the inpccsid and outccsid
parameters.
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1. This exit is only intended to be used if the spool file consists of
double-byte or mixed single- or double-byte data that has blank
truncation. Adding a blank to other types of data files could cause
formatting errors, depending on how the page definition is coded.

2. This exit only checks for a single trailing blank, so if a different
number of odd blanks is present in the data, it is up to the user to
make sure the data is formatted with the correct font.

The C language header file for all line-data transform exit programs is provided in
the install_path\exits\acif\apkexits.h directory, and the build rules for the line-data
transform user exits reside in install_path\exits\acif\exit_program.

The source code for the sample exits is provided in install_path\exits\acif. You can
modify these source files or create your own. You must have the Microsoft Visual
Studio 2005, installed on your InfoPrint Windows server to compile and build
user-exit programs. Be sure to apply the latest service available. Sample project
files for Microsoft Visual for each exit program are also installed in the same
directory.

For more information about compiling user exit programs, see “Configuring
transforms” on page 211.

Working with the transform for double byte text streams

InfoPrint Manager includes the db2afp transform, a program that transforms both
double-byte character set (DBCS) ASCII and Extended UNIX Code (EUC) files into
the Advanced Function Presentation (AFP) data stream.

This section describes:
v “What are DBCS ASCII and EUC?”
v “What font resources are needed to print DBCS ASCII and EUC?” on page 196
v “Determining what code page your print jobs use and setting the correct

environment variable” on page 196

What are DBCS ASCII and EUC?
In ideographic languages like Japanese, Chinese, and Korean, there are thousands
of characters. All of these characters cannot be represented with a single byte of
information because a single byte only accomodates 256 characters. Therefore, at
least one more byte of information is required.

In DBCS ASCII files, each ideographic character is exactly two bytes. In EUC files,
each ideographic character can be two, three, or four bytes, depending on the EUC
implementation and language. Single-byte ASCII characters can be mixed in with
DBCS and EUC characters.

InfoPrint Manager for Windows supports printing DBCS ASCII files in the
Japanese and Traditional Chinese languages, which can contain formatting controls
for the IBM 5577 or 5587 printers. InfoPrint Manager for Windows also supports
printing EUC files in the Japanese, Traditional Chinese, and Korean languages, but
you must submit those jobs from a UNIX or AIX workstation. EUC files cannot
contain any formatting control characters.
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What font resources are needed to print DBCS ASCII and
EUC?

You can use the db2afp command to transform DBCS ASCII and EUC files that
use these code pages:
v 932 (Japanese PC)
v 950 (Traditional Chinese PC)
v 33722 or eucJP (Japanese EUC)
v 964 or eucTW (Traditional Chinese EUC)
v 970 or eucKR (Traditional Korean EUC)

Note: Code page 938 (Traditional Chinese PC) is not supported on Windows 2000.
If your files use code page 938, you cannot use InfoPrint Manager for Windows on
a Windows 2000 operating system to print them.

Your InfoPrint Manager server must be able to access the appropriate DBCS fonts
when you print the transformed files. DBCS fonts are available for the MVS, VM,
Windows 2000, and AIX operating systems as separately orderable licensed
programs. To make the fonts available on your InfoPrint Windows 2000 system,
you must make sure that you have installed the fonts on your system and then
make the double-byte fonts known to InfoPrint Manager for Windows.

For more information about setting up font resources to print DBCS fonts, see
“Fonts for printing DBCS ASCII and EUC” on page 234.

Determining what code page your print jobs use and setting
the correct environment variable

Before you transform a print job, you need to determine what code page it uses,
then set the PSFDBLANG environment variable to that code page. If the job was
created on an AIX or a Windows workstation, you can determine the code page
that the job uses by finding out what code page is active on that system. On the
system that the job was created on, open a Command Prompt window and type:
chcp

then press Enter. The system responds with
Active code page: xxx

where xxx represents a three- to five-digit number. Use this number to set the
PSFDBLANG environment variable with these steps.
1. On your InfoPrint Manager server system, click the Windows Start button and

select Settings –>Control Panel.

Note: If you have more than one InfoPrint Manager server system, you need to
set this environment variable on all of the servers that contain actual
destinations that will use the db2afp transform.

2. In the Control Panel window, double-click System.
3. In the System Properties dialog, click Environment.
4. In the Variable field, type PSFDBLANG.
5. In Table 23 on page 197, locate the Code Page Value that you got from your

system above.
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Table 23. Code pages and their associated PSFDBLANG values

Code Page Value PSFDBLANG Value Language

932 J Japanese PC

950 T Traditional Chinese PC

33722 or eucJP JE Japanese EUC

964 or eucTW CE Traditional Chinese EUC

970 or eucKR KE Traditional Korean EUC

6. Find the PSFDBLANG Value that corresponds to that code page and type it in
the Value field of the System Properties dialog.

Note: The PSFDBLANG Value is case-sensitive. Be sure to type it in all caps.
7. Click OK.

The db2afp command assumes that all jobs use this code page as long as you do
not specify either the -i flag or the -e flag when running the command from a
Command Prompt window.

Working with the InfoPrint PPML transform program
InfoPrint Manager for Windows Version 2.2 provides a transform program to
convert Personalized Print Markup Language (PPML) data streams into the
Advanced Function Presentation (AFP) format. PPML is an emerging XML-based
print data stream that is divided into subsets. InfoPrint Manager for Windows
supports the Graphic Arts Conformance Subset for processing objects in the data
stream that can consist of PostScript, PDF, TIFF, and JPEG objects. Sample files that
demonstrate the power of this transform are provided in the default directory of
install_path\ppml2afp with the names samplePS.ppml, samplePDF.ppml,
sampleJPEG.ppml, and sampleTIFF.ppml.

Users can submit PPML jobs to InfoPrint through these methods:
v Hot folder interfaces from PC or Macintosh systems.
v Use of the pdpr command from the Windows command line.

For more information about how to submit PPML jobs to InfoPrint Manager, see
InfoPrint Manager: Reference.

When a PPML print job is submitted to print on a PSF physical printer, InfoPrint
automatically invokes the transform. You can also run the transforms from the
command line without printing the generated output. You might find this useful if
you intend to print the job later. Jobs print more quickly if they have already been
transformed.

The PPML transform has options that you can use to specify processing
information. For a list of the options or options and values for each transform,
refer to the InfoPrint Manager: Reference. Configuration files, environment variables,
and user-exit programs allow you to specify processing information for InfoPrint to
use when it invokes the transform automatically. You can also use configuration
files and environment variables instead of typing options on the command line
whenever you run a transform.
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Customizing the PPML transform
You can customize the transform for PPML data by specifying values in the
transform configuration files. Table 24 the default configuration files that InfoPrint
provides. You can either modify these files or create your own.

Table 24. Default PPML transform configuration file

Data Stream Transform Configuration File

PPML ppml2afp install_path\ppml2afp\ppml2afp.cfg

Sample PPML configuration file
Figure 12 shows an example of a configuration file for the PPML transform.

The configuration file uses keyword equivalents of the transform options. See
InfoPrint Manager: Reference for the keywords and values that you can specify in the
configuration file.

Hierarchy of PPML transform options
InfoPrint assigns a hierarchy to its use of options and configuration-file
information when it runs the PPML transform program. This lists the order in
which InfoPrint uses options and information specified in configuration files:
1. Any values you specify on the command line, including values in the

configuration file you specify with the -C option.
InfoPrint commands process options from left to right. If you enter the same
option more than once, InfoPrint uses the last occurrence of the option to
determine the value to use. For example, if you specify this command:

# default ppml2afp configuration file
#

# directory where PPML2AFP can create and maintain other files
ppml_work_directory = AFP_Support_Path\\ppml2afp

# port number of the server running the PS2AFP transform
ps_server_port = 8251

# server name of the server running the PS2AFP transform
ps_server_name = ipm_server

# resolution of the AFP being created; only supported values are 240, 300, 480
# and 600
ppml_resolution = 600

# output type format; only supported values are FS45 (color), FS10 (monochrome)
# or IO1_G4(monochrome)
ppml_outdatatype = FS45

# page height (measurement units: i (inches), c (centimeters), m (milimeters))
page_height = 11i

# page width (measurement units: i (inches), c (centimeters), m (milimeters))
page_width = 8.5i

# ignore all relative paths from the zip file and store all the resources under
# a single directory
ignore_path = true

# enable tracing
trace = off

Figure 12. Sample PPML configuration file
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ppml2afp -C config.file -r240 -r300 myfile.ps

The ppml2afp command transforms the file using 300-pel resolution. InfoPrint
ignores the resolution value specified in the configuration file config.file and
the first -r240 option and value.

2. Values are specified in the default transform command configuration file, which
is install_path\ppml2afp\ppml2afp.cfg. InfoPrint ignores values in the default
transform command configuration file if you invoke the transform command
indirectly by submitting a job to print.

3. Default values that are built into InfoPrint. These are the same as the transform
defaults.

Working with the XML transforms
XML provides a standard method for the exchange and processing of data across
different computing platforms. XML data is structured according to standards from
the World Wide Web Consortium (W3C). Specifically designed for Web
applications, XML differs from HTML in that, while HTML contains information
about how data is formatted for presentation on Web pages, XML contains data
with no presentation information. A W3C standard stylesheet language, called
Extensible Stylesheet Language (XSL), uses formatting objects to describe how
XML data is presented. XML data containing XSL formatting objects is called
XSL-FO. XSL-FO describes document presentation details, such as pagination,
layout, and styling information.

Using the XML transforms with InfoPrint Manager
XML has become the key standard in the deployment of new technologies for Web
services, data interchange, messaging, and application integration. Support for
XML is found in several InfoPrint products, including XML Extender and Print
Services Facility (PSF) for z/OS.

The XML transforms are the preferred method for printing highly-dynamic XML
data on AFP printers because the transforms can efficiently process data that
changes from job to job. The XML transforms are also an efficient, cost-effective
alternative to paper-based communication because it can transform XML data to
PDF documents for electronic delivery to customers.

Other benefits of using xml2afp and xml2pdf to transform XML data to AFP or
PDF include:
v You can use your existing AFP output system to print or view your XML data

without worrying about compatibility issues.
v The XML transforms provide you with significant formatting flexibility for your

XML documents.
v Print delivery is guaranteed when you transform your XML data to AFP and

then print to an AFP printer.
v Once XML data is transformed, you can use different tools to:

– Print to an AFP printer or transform AFP data to PostScript (PS) or printer
control language (PCL) for printing on a PS or PCL printer.

– Send PDF data to an electronic destination.
– View or archive AFP or PDF data.

The XML transforms let you take advantage of XML for data interchange and
content management while using AFP’s print and presentation technology and
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PDF’s electronic document exchange. Figure 13 shows what you can do with XML
data when you use the XML transforms.

The InfoPrint products you can use with the AFP or PDF output include:

AFP view/browse
AFP Viewer plug-in or Content Manager OnDemand

PDF view/browse
Content Manager OnDemand

Distributed AFP print
InfoPrint Manager and PSF for z/OS

Distributed PS/PCL print
InfoPrint Manager, Infoprint Server, and Infoprint Server Transforms

E-mail IP PrintWay™ component of Infoprint Server

Archive
Content Manager OnDemand

How do the XML transforms work?
You use the xml2afp and xml2pdf to transform XML data to an AFP or a PDF data
stream. To do this, you must supply one of these to the XML transforms::
v XML files (or data sets), which do not contain data placement and presentation

information, and an accompanying XSL style sheet
v XSL-FO files (or data sets), which contain XML data with XSL formatting objects

To transform XML data to AFP or PDF, the XML transforms use the data you
supply and do one of these:
v Uses the XSL style sheet to transform the XML files into XSL-FO and then

completes the transformation to AFP or PDF
v Directly transforms your supplied XSL-FO files to AFP or PDF

Figure 14 on page 201 shows how the XML transforms process data from XML to
AFP or PDF data.

Figure 13. Scenarios for using XML data that has been transformed to AFP or PDF
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Running the XML transforms
You can run the XML transforms as:
v A standalone transform
v A transform managed by InfoPrint Manager

Capabilities and limitations
The XML transforms have these capabilities and limitations, depending on how
data is being transformed:
v Capabilities and limitations for transforming all data
v Capabilities and limitations for transforming data to AFP
v Capabilities for transforming data to PDF

General capabilities and limitations for transforming all data
Output document size

Output document size is dependent on the amount of memory available;
however, no checking is done between document size and available
memory. If the output document is too big for the available memory, you
receive an out of memory error and the transform stops processing.

XSL support
The transforms support most, but not all, formatting objects, properties,
and features of the XSL Version 1.0 standards as documented by the W3C
(http://www.w3.org/TR/xsl/). See Appendix C, “Supported formatting
objects,” on page 335 for the formatting objects that the supports.

Style sheets embedded and referenced in XML files are not supported.

Capabilities and limitations for transforming data to AFP
Bar code support

The transform does not support bar codes.

Font support
The first font in the font index with properties that most closely match the
desired characteristics is used. Condensed and expanded fonts are usually

Figure 14. Process for transforming XML data to AFP or PDF
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only used when the font-stretch property is selected. Italic and oblique
fonts are considered the same and are used interchangeably.

The XML transforms support converting double-byte character set (DBCS)
fonts from one code page to another.

The XML transforms work with the OpenType fonts from the command
line. For more information about OpenType Fonts, see Using OpenType
Fonts in an AFP System.

To use the xml2afp transform, you must install the appropriate font
features for either Infoprint Fonts, Version 1.1.0, or AFP Font Collection,
Version 2.1.0.

Graphic support
You can specify graphic data in one of these AFP resources:

Overlay
An overlay contains a collection of constant image data (such as
lines, shading, boxes, or logos) that can be merged with variable
data during printing. The AFP output file references the name of
an overlay, which is located in a resource directory. Because the
overlay is not included but is only referenced in the output file,
you must specify the image size in the XSL external-graphic
formatting object. For example:
<fo:external-graphic src="overlay:corplogo" content-height="4in"
content-width="2in"/>

Page segment
A page segment contains image data (such as bar codes, signatures,
logos, or graphics in image format) that can be merged with
variable data during printing. The AFP output file references the
name of a page segment, which is located in a resource directory.
Because the page segment is not included but is only referenced in
the output file, you must specify the image size in the XSL
external-graphic formatting object. For example:
<fo:external-graphic src="pageseg:corpsign" content-height="4in"
content-width="2in"/>

IOCA object
An Image Object Content Architecture (IOCA) object contains a
series of picture elements (pels) arranged in rows and columns,
and specifies where the image is placed on a page. The XML
transforms access the first IOCA object in a specified MO:DCA-P
file and place it inline in the AFP output file (only MO:DCA-P
image data is supported). The transforms obtain the actual size
from the image; therefore, you do not need to specify the size in
the XSL external-graphic formatting object. If you do specify the
size with the external-graphic formatting object, the transforms
crop the image to make it the specified size or add whitespace to
the bottom-right corner, so the image appears in the upper-left
portion of the allotted space. Here is an example of the formatting
object you specify for an IOCA object:
<fo:external-graphic src="myfile/image.afp"/>

MO:DCA-P output
Output from the transform conforms to the MO:DCA Interchange Set 1
(IS/1) architecture (refer to Mixed Object Document Content Architecture
Reference, SC31-6802).
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Capabilities for transforming data to PDF
PDF output

The transform converts XML data to PDF 1.1 data streams.

Customizing the XML transforms
The system administrator can customize the XML transforms as standalone
transforms or as transforms managed by InfoPrint Manager. If you have InfoPrint
Manager installed, we recommend you to use it to manage the XML transforms.

This section details the common, standalone, and InfoPrint Manager customization
tasks the administrator must perform before the job submitter can run the XML
transforms. The administrator performs the common customization tasks and
either the standalone or InfoPrint Manager customization tasks, depending on
whether the XML transforms are run as a standalone transform or managed by
InfoPrint Manager.

Common customization tasks
The common customization tasks you perform depend on whether you are using
the XML to AFP transform or the XML to PDF transform.

Tasks for using the XML to AFP transform:

The sample xml2afp configuration file is provided in /usr/lpp/psf/xmltransform/
xml2afp.cfg on AIX and install_path\xmltransform\xml2afp.cfg on Windows.
These items are set in the file and can be modified:
1. The default location of the AFP fonts.
2. The default paper size.

Additionally, defaults for all the xml2afp options can be set in the configuration
file.

The syntax of the configuration file is exactly the same as the command line syntax
with these additional rules:
1. Blank lines are ignored.
2. All data on a line after a pound sign is ignored. The pound sign might occur

anywhere on a line.
3. To include a pound sign in parameter data, it must be escaped; that is, it must

be preceded by a backwards slash.
4. White space before and after parameter data is removed.
5. Parameter data on successive lines is concatenated with a single space between

them.
6. Parameters might span lines as long as they follow rules 1 through 5.

Customizing the xml2afp.cfg file: You can either create a new configuration file or
modify the sample that is provided:
1. Create a new xml2afp configuration file, xml2afp.cfg, which lets you configure

the xmp2afp transform.
To create the file on Windows, copy the sample configuration file,
install_path\xmltransform\xml2afp.cfg, to a temporary location.

Note: To modify the sample configuration file, you still need to copy it.
2. Edit the file using your preferred editor, such as vi or notepad.
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3. Add -C xml2afp.cfg to other-transform-options for your XML transform. You
can also add -C xml2afp.cfg to the IVD to apply the xml2afp transform to all
the jobs on the associated logical destination.

Customizing the font index file for xml2afp: The sample font index file for xml2afp is
provided in /usr/lpp/psf/xmltransform on AIX and install_path\xmltransform
on Windows. The samples include a outline_font_index and a raster_font_index
that you use to map XML font names to both outline FOCA fonts and raster fonts
in the font path.

Note: If you are using OpenType fonts, the font index files are not necessary.

A font is referenced in XSL-FLO using these attributes:
family
size
style
weight

Font index files describe AFP fonts using these attributes. In addition, a map is
defined that maps unicode code points to AFP code points.

The font index file consists of a sequence of key and value pairs, separated by
whitespace (such as a space, tab, or a newline). Comments can be inserted
anywhere between the delimiters /* and */. You can also use // to indicate that
the remainder of the current line is a comment.

The keys and their meanings are:

Key Meaning

map Select the named character map, creating it if it does not exist. A character
map is used to map unicode code points to AFP code page names and
code points. The default is default.

codepage
Set the code page to use for subsequent character mappings.

to End a range of mapped unicode code points. The value must be an integer
representing a valid unicode code point, and it must be greater than the
beginning value of the range given by the closest preceding value for the
char keyword. The value must be a valid unicode code point.

at Creates a mapping using the closed range given by a preceding char value
and an optional to value. The unicode characters from begin to end are
mapped to the AFP code point range from the at value to the at value +
end - begin, inclusive, using the closest preceding codepage value. This
value must be an integer from 0 to 65535.

family Establish the current font family name. The value must be a string
containing no whitespace characters.

size A font size, expressed as a floating point value giving the vertical size of
the font, in points (1/72nds inches). Size must be omitted when defining
outline technology fonts, since they can take any size.

style A font style. The value must be one of these keywords:
normal
italic
oblique
backslant
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The default is normal.

weight
A font weight. The value can be one of these keywords:

normal
bold

The value might also be one of the values between 100 and 900 inclusive,
in increments of 100. The keyword normal is equivalent to 400, and the
keyword bold is equivalent to 700. The default value is normal (400).

charset
Define a font with the preceding values given for the font properties
(family, size, style, and weight), or default values if no preceding property
values have been established. The currently selected character map is
associated with the font, and it is used for mapping unicode code points
when the font is selected. If modifications are made to the map later in the
file, those changes do not affect the defined font.

alias Establish a font family alias for the current family.

Of the keywords listed, only two are active: at and charset. The other
keywords collect values used when an active keyword is found. This
allows for a variety of possible arrangements for a font index. For example:
family courier
alias monospace
size 7
weight normal
style normal
charset C04200070
style italic
charset C0430070

weight bold
style normal
charset C0440070
style italic
charset C0450070

Defines the same set of fonts as:
family courier size 7 weight normal style normal charset C0420070
family courier size 7 weight normal style italic charset C0430070
family courier size 7 weight bold style normal charset C0440070
family courier size 7 weight bold style italic charset C0450070
alias monospace

But can be considered more difficult to read.

Tasks for using the XML to PDF transform: The sample xml2pdf configuration
file is provided in /usr/lpp/psf/xmltransform/xml2pdf.cfg on AIX and
install_path\xmltransform\xml2pdf.cfg on Windows. The default paper size can
be modified. Additionally, defaults for all the xml2pdf options can be set in the
configuration file.

The syntax of the configuration file is exactly the same as the command line syntax
with these additional rules:
1. Blank lines are ignored.
2. All data on a line after a pound sign is ignored. The pound sign can occur

anywhere on a line.
3. To include a pound sign in parameter data, it must be escaped; that is, it must

be preceded by a backwards slash.
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4. White space before and after parameter data is removed.
5. Parameter data on successive lines is concatenated with a single space between

them.
6. Parameters can span lines as long as they follow rules 1 through 5.

These are the common tasks you must do when using the XML to PDF transform:
1. Create the XML Extender configuration file, xml2pdf.cfg, which lets you

configure XML Extender. To create the file:
v Use Windows commands to copy the sample configuration file,

install_path|xmltransform\samples\xml2pdf.cfg, to install_path\
xmltransform\xml2pdf.cfg:
copy install_path\xml2afp\samples\xml2pdf.cfg install_path\xml2afp\xml2pdf.cfg

Note: To modify the sample configuration file, you still need to copy it.
2. Edit the file using your preferred editor.

Color management resource transform support
InfoPrint Manager enables these transforms to do color management:
v ps2afp
v jpeg2afp
v tiff2afp
v gif2afp

Note: The PCL and SAP transform do not support color management.

Transforms capable of color management allows the specification of color resource
information at job submission time and the implementation of color management
at the transform level within InfoPrint Manager. This support will provide color
fidelity with better printer performance.

Submitting job using transforms for color management

Before you use transforms to do color management, make sure that you have
installed the ICC Profiles using the Resource Installer into the Resource library as
Color Management Resources (CMRs). For more information, see cac_CMRs.dita
and cac_ResInst.dita.

Notes:

v You can specify the ICC Profile directly in a pure PS/PDF transform.
v Only audit color conversion, instruction color conversion, and link color

conversion CMRs are supported.

To submit a job:
1. Select your destination printer.
2. Right-click and select Job and Document Defaults.
3. Click Modify.
4. Click Document AFP Color. If this tab is not visible, click Show more and

then select Document AFP Color.
5. Enter one or more input color management resources in Input color

management resources.
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6. Next, enter an output color management resource in Output color
management resource.

7. From Color rendering indent, select one option.
8. Then, select the output color resource tagging from Tag output CMR.
9. In the Place CMR inline option, click Yes to inline the color resource

information in the FS45. Default is No.
10. Click Submit.

For more information about the values that you can specify, see InfoPrint Manager:
Reference.
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Chapter 25. Understanding transforms and the configurable
transform subsystem

Transforms are InfoPrint objects (like queues and destinations) that you create and
configure in InfoPrint Manager. Transforms receive data in a particular format or
formats, process the data in some way, and output the changed data. When you
create a transform, you have complete control over what data format or formats it
operates on and what type of processing it does. The processing that the transform
performs can be anything from simply copying the data to a different place on
disk, to filtering the data stream that the transform receives (for example, to
remove a particular PostScript order), to transforming the data to a completely
different format (for example, converting PCL to AFP).

When you create a transform, you specify several things, including:
v Input data format

The data stream that is sent to the transform. The input data format is what the
transform uses to determine whether it has any work to do. If you send a
PostScript job through a transform that has its input data stream set only to
PCL, the job will bypass the transform without being changed at all. You can set
the transform to accept multiple input data formats.

v Transform options

The program or command that actually does the work of the transform; what
happens during the processing stage. The transform options can be system
commands (such as copy), programs provided with InfoPrint Manager (such as
ps2afp), or your own custom transform programs (for example, mypclfixup).
When you create a transform, you specify the complete command line needed to
invoke this program or command. In this command line, you can also specify
various substitution variables, place holders which InfoPrint Manager replaces
with a value when InfoPrint Manager runs the transform. For example, if you
include %i in the line, InfoPrint Manager will replace it with the name of the file
that the transform receives; if you include %o, it will be replaced with the name
of the file that the transform needs to put the changed data into.

v Output data format

The data stream that results from the transform. You can only specify one output
data format.

In addition, you can specify whether you want the file that the transform produces
to be printed. If the transform doesn’t return the file to be printed (for example, if
the transform completes its processing and saves the file to a different location), it
is called a terminating transform. In addition to the terminating transform, you can
also create a conditionally-terminating transform. To create this, define a unique
return code to indicate the transform was successful but does not return data to
print.

Transforms do not do anything by themselves. They remain inactive until you
associate them with an actual destination as a transform sequence. A transform
sequence is an attribute of an actual destination that contains an ordered list of
transforms. Every job that is submitted to that actual destination is sent through
that list of transforms in the order specified before it is printed.
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InfoPrint Manager lets you create a sequence for transforming print data before the
system sends it to a printer. This provides users with a feature similar to the
configurable transform sequences that you could create in PSF/2 using the
XFMFLTR utility. For more information about creating transform sequences, see
“Defining a transform sequence.”

Notes:

1. If you include a terminating transform in a transform sequence, it must be the
last transform in the sequence.

2. If you invoke a terminating transform for a document in a job, the entire job
ends after all the documents in that job finish processing. It does not matter
whether any other documents in the job use the terminating transform.

Defining a transform sequence

A transform sequence lets you string together a series of transform objects to
perform a series of tasks. This section provides an example of a transform
sequence, followed by the specific procedure you can use to create a sequence of
transform objects.

You want to define an actual destination that will copy AFP versions of all print
jobs sent to it into a directory on your InfoPrint Manager server system. This
directory is used as an archive of AFP versions of print jobs that might need to be
viewed later.

To accomplish this, you use the InfoPrint Manager Administration GUI to create
these three transforms:
1. transps

You set the input data format to PostScript, the Transform options to use
ps2afp, and the output data format to MODCA-P (Mixed Object Document
Content Architecture™).

2. transpcl

You set the input data format to PCL, the Transform options to use pcl2afp,
and the output data format to MODCA-P.

3. saveafp

You set the input data format to AFP, the Transform options to issue a copy
command, and the output data format to MODCA-P. In addition, you make
this a terminating transform by selecting Transform only in the Create
Transform dialog.

Then, create an actual destination that you want to perform the transform
sequence. When the Printer Creation wizard asks to change the configuration for
the printer, select yes, then click Configuration to define the transform sequence as
follows:
1. transps
2. transpcl
3. saveafp

Note: If you already have the destination created, open the properties notebook for
that actual destination and click Configuration to define the transform sequence.

Now, when you send a job to this actual destination, this sequence of actions
occurs:
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1. transps checks to see if the incoming data is PostScript. If it is
PostScript,transps transforms the data to AFP using ps2afp. If it is not
PostScript, transps does nothing.

2. transpcl checks to see if the incoming data is PCL. If it is PCL, transpcl
transforms it to AFP using pcl2afp. If it is not PCL, transpcl does nothing.

3. saveafp copies the AFP file produced by either of the above steps into a
specific directory.

4. Since saveafp is a terminating transform, the job is not printed but is marked
complete at this point.

To create a transform sequence, use this procedure from the InfoPrint Manager
Administration GUI:
1. Select the printer that you want to send the job to.
2. Click Printer → Properties to open the Printer Properties notebook for the

selected printer.
3. In the Printer Properties notebook, click Configuration. The data stream

transforms that this printer can use are listed in the Transforms to use field.

Note: If you can’t see the Transforms to use field, click Show more.
4. Use the Add and Remove buttons to specify the transforms in the sequence

that they should be run in the Values field.
For example, you might want to create the three-step transform sequence that
runs the tranps , transppcl, and saveafp transforms in sequence as described
above. To accomplish this task, the Values field would contain these:

5. When you have entered the transforms in the correct sequence, click Apply to
associate this transform sequence with the selected printer.

Configuring transforms

To configure a transform, you must do these tasks:
1. “Creating transforms.”
2. “Associating a transform with an actual destination” on page 215.

Creating transforms

You can create a transform sequence through the InfoPrint Manager
Administration GUI (for more specific information, see the online help topic in
this GUI entitled ″Server transform tasks″).

To create a transform using the InfoPrint Manager Administration GUI, an
InfoPrint Manager system administrator must set these values on the Create
Transform window. You can access this window by clicking Server, and select
Transform → Create.
1. Start the InfoPrint Manager Administration GUI.
2. Click Server → Transform → Create.
3. Fill in these values:

Name Type a meaningful name for the transform.

InfoPrint Manager references the transform name in transform
sequences that are associated with actual destinations.
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Server If not filled in, either type or select the InfoPrint Manager server in
which you want to create the transform.

Transforms can only be associated with actual destinations in the same
server. If the InfoPrint Manager Administration GUI is only monitoring
one server, this field contains that server name.

Format of output file
Select a format for the output file produced from this transform.

Description
Type a description of this transform that will appear whenever you
show this transform through the InfoPrint Manager Administration
GUI.

Transform options
Type the command-line transform and its options, including any
InfoPrint Manager substitution variables.

How to process jobs
Select how to process jobs. The options are:
a. A transform that returns the transformed data to InfoPrint Manager

for printing (Transform and print radio button with the
Conditional terminating return code field left blank).

b. A terminating transform that completes without returning data to
InfoPrint Manager to print (Transform only radio button).

c. A conditionally terminating transform that might or might not print
the data after it has been transformed (Transform and print radio
button with the Conditional terminating return code field set to a
value that tells InfoPrint Manager not to print the data if the
transform returns that return code value).

Document formats allowed
Add a format for the input file or file(s) that are being transformed as
Values in the Document formats allowed field.

Note: You can specify either one or multiple document formats as
Values. The format of the input file determines whether this transform
is called for a job sent to this actual destination.

Use server locale
Decide whether InfoPrint Manager should pass the values of attributes
specified in the %% substitution variables in the Transform options
field in the language of the InfoPrint Manager server or in English, by
using the Use server locale radio button. By default, this radio button
passes information in the language of the server (Yes).

The transform examples that follow demonstrate common uses of transform
objects, using the substitution values shown in Table 25 on page 213. Some of these
examples presume that an application programmer has created a program with the
name specified at the start of the Transform options field.

Notes:

1. If you are specifying any substitutions for which the passed values might
contain a blank space, such as job name, be sure to put quotes around the
substitution so it is passed correctly. Note that this only applies to single %
substitution variables. Do not put quotes around any %% substitution variables.
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2. The examples that follow presume that the PATH environment variable has
been set to the appropriate path so you do not have to specify the fully
qualified path name in the Transform options field.

Table 25. Transform substitution variables

Transform options substitution variables Meaning

%i The name of the input file to transform.

%o The name of the file in which to store the
output of the transform.
Note: If this is a non-terminating transform,
data must be stored in the file named by %o.

%e The name of the file in which to store any
transform information or error messages. If
anything is written to this file, it is logged in
the InfoPrint Manager server log.
Note:

1. If the transform exits with an exit code of
0 or the value set in the Conditional
terminating return code field, the error
messages from the transform are logged
as debug severity.

2. If the transform exits with a non-zero
return code, but not with the value set in
the Conditional terminating return code
field transform attribute, the error
messages from the transform are logged
as error severity.

3. InfoPrint Manager writes transform error
messages to either the file specified
through this substitution variable, or to
standard error (stderr). You should not
mix output to %e and stderr in a single
run of the exit program. You should use
either one or the other in any given run.

%u The name of the file for updating the
pages-completed and job-page-count job
attributes.
Note: This file should only be accessed
through the transform_update utility.

%j The name of the original print file, minus
the path (from the document-file-name
attribute).
Note: This should only be used to construct
another name, such as a temporary file.

%n The name of the original print file, minus
the path and minus the extension (from the
document-file-name attribute).
Note: This should only be used to construct
another name, such as a temporary file.
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Table 25. Transform substitution variables (continued)

Transform options substitution variables Meaning

%d A text string that represents the document
format of the input file. This value might be:

v ASCII for ASCII line data.

v AFPDS for Advanced Function
Presentation data

v PCL for Printer Control Language data

v PS for PostScript data

Note: You can also acquire document format
through the %%Ddocument-format
substitution value.

%p The value of the document’s
destination-pass-through attribute.
Note: This value is passed to all subsequent
transforms and the actual destination.

%q The actual destination that is processing the
job.

%s The document-sequence-number for the
document.

%t The value of the document’s
other-transform-options attribute.
Note: To write one transform, but use it
differently for different actual destinations or
jobs, you can pass values into the transform
with this parameter.

%g The global job identifier for the job.

%# The job-identifier (10 digits maximum).

%%Aad_attribute%% The value of the InfoPrint Manager actual
destination attribute specified. For example,
if %%Aresource-context%%, InfoPrint Manager
passes the actual destination’s
resource-context attribute value.
Note: See the ″Considerations when using
the %%Nattributename substitution control
sequences″ topic under the ″Usage
guidelines″ for the other-transform-options
attribute in the InfoPrint Manager: Reference
before using this substitution variable.

%%Ddoc_attribute%% The value of the InfoPrint Manager
document attribute specified. For example, if
you use %%Ddepartment-text%%, InfoPrint
Manager passes the document’s
department-text attribute value.
Note: See the ″Considerations when using
the %%Nattributename substitution control
sequences″ topic under the ″Usage
guidelines″ for the other-transform-options
attribute in the InfoPrint Manager: Reference
before using this substitution variable.
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Table 25. Transform substitution variables (continued)

Transform options substitution variables Meaning

%%Jjob_attribute%% The value of the InfoPrint Manager job
attribute specified. For example, if you use
%%Jjob-owner%%, InfoPrint Manager passes
the job-owner attribute value of the job that
owns the document being transformed.
Note: See the ″Considerations when using
the %%Nattributename substitution control
sequences″ topic under the ″Usage
guidelines″ for the other-transform-options
attribute in the InfoPrint Manager: Reference
before using this substitution variable.

Associating a transform with an actual destination

Now that you have created a transform object, you must associate it with an actual
destination before you can use it.

To associate a data stream transform with an actual destination from the InfoPrint
Manager Administration GUI, use this procedure:
1. Select the printer that you want to send the job to.
2. Click Printer → Properties to open the Printer Properties notebook for the

selected printer.
3. In the Printer Properties notebook, click Configuration.

The data stream transforms that this printer can use are listed in the
Transforms to use field.

Note: If you can’t see the Transforms to use field, click Show more.
4. Use the Add and Remove buttons to specify the transform in the Values field

(the equivalent of setting the transforms-sequence actual destination attribute
from the command line).

Note: You can string multiple transforms together to do a sequence of tasks.
For more information about this feature, see “Defining a transform sequence”
on page 210.

5. When you have entered the transforms in the correct sequence, click Apply to
associate this transform sequence with the selected printer.

If you prefer to use the command line, you can use these InfoPrint commands
from either an AIX command line or an MS/DOS window with transform objects:
v pdcreate

v pddelete

v pdset

v pdls

For more information about the attributes in creating transform sequences, see the
Attributes for Transforms topic in the ″InfoPrint Object Attributes″ chapter of the
InfoPrint Manager: Reference.
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Examples of creating transform objects

These show three specific examples (from simple to more advanced) for creating
transform objects. The second and third examples require additional programming
to create the programs that are called from the Transform options field. This
section should suggest how you can use transform objects to customize your
InfoPrint Manager installation.

Creating a transform object to copy to a file without printing

To define a data stream transform object from the InfoPrint Manager
Administration GUI that takes an AFP input file and copies it to a file location on
the hard drive without printing the output, use this procedure:
1. Start the InfoPrint Manager Administration GUI.
2. Click Server, and select Transform → Create.
3. In the Create Transform dialog, fill in the fields as shown in either Figure 15 on

page 217 or Figure 16 on page 218, depending upon your operating system.
These values create a transform that copies AFP input data to an \afp folder on
a specific drive on Windows or a /usr/samp file system on AIX. Also, it names
the transformed file with the name of the original file name because of the %n
substitution variable.

4. Since you do not want the job to be printed, click Transform only to indicate
that this transform is a terminating transform.
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Figure 15. Create Transform dialog: Define a transform that copies an AFP file to a folder without printing on Windows
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5. Click OK.
InfoPrint Manager creates a transform object under the name you provided in
the Name field so that you can see its values by selecting Transform →
Properties from the Servers menu.

Creating a transform object to convert data and print only
smaller files

If your transform might want to terminate the processing of the job in some cases
but return data to be printed in other cases, you can create a conditionally
terminating transform. For example, you might want to transform and store some
documents but transform and return for printing other documents. You can define
a return code that your transform can return to indicate when it has completed its
task successfully, but is not returning any data for printing.

In the example below, the actual destination activates the pics2gif transform when
incoming JPEG and TIFF jobs enter the system. These jobs are transformed into
GIF format and then uploaded to the Internet by an application outside of
InfoPrint Manager. When the transformed GIF files are smaller than 3 KB, they are
returned to InfoPrint Manager for printing on a proof printer. To observe
cost-cutting mandates across the installation, transformed GIF files that are larger

Figure 16. Create Transform dialog: Define a transform that copies an AFP file to a directory without printing on AIX
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than 3 KB are not printed. The transform checks the size of the transformed file
and sends a return code of 5 if the job is too big to be printed.

To define a data stream transform object from the InfoPrint Manager
Administration GUI as a conditionally-terminating transform, use this procedure:
1. Start the InfoPrint Manager Administration GUI.
2. Click Server, and select Transform → Create.
3. In the Create Transform dialog, fill in the fields as shown in Figure 17. These

values create a transform that transforms both JPEG and TIFF input data into
GIF output and then provides a return code of 5 if the transform has completed
successfully without returning to InfoPrint Manager for printing.
In the Transform options field, you can use a series of substitution variables to
provide special options for the transform sequences. In this example, besides
the standard input (%i) and output (%o), this transform object also uses the %q
flag so the InfoPrint server passes the name of the actual destination processing
the job.

4. Click OK.
InfoPrint Manager saves the transform under the name you provided in the
Name field so that you can see its values by selecting Transform → Properties
from the Servers menu.

Figure 17. Create Transform dialog: Define a conditionally terminating transform
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Creating a transform object that updates the job’s page count

By default, InfoPrint Manager has no knowledge of the number of pages in a
transformed job. However, if you have a transform that knows how many pages
are in the job, you can create a transform object that can update InfoPrint Manager
with this information. InfoPrint Manager can pass transform objects an update_file
with the %u option. This update_file can be updated with how many pages are in
the transformed job, and InfoPrint Manager then updates the job with this
information. To modify the update_file, the user supplied transform needs to call
the transform_update utility that is supplied with InfoPrint Manager. For the
syntax of the transform_update utility, see“Using the transform_update utility” on
page 221.

To define a data stream transform object from the InfoPrint Manager
Administration GUI, use this procedure:
1. Start the InfoPrint Manager Administration GUI.
2. Click Server, and select Transform → Create.
3. In the Create Transform dialog, fill in the fields as shown in Figure 18 on page

221.
For this example, the passvals program that is called by the PASSVALUES
transform object gets passed both the resource-context document attribute and
the job-owner job attribute, as well as an update file. You should change the
passvals program to your transform program that knows how many pages are
in the job, and then change the parameters in ″Transform options″ to what your
program expects with the ″%u″ being the update_file that will be passed to the
transform_update utility when your transform calls it. Other attributes, like
resource-context and job-owner, can be included or omitted as required by the
needs of your transform.
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4. Click OK.
InfoPrint Manager saves the transform under the name you provided in the
Name field so that you can see its values by selecting Transform → Properties
from the Servers menu.

Using the transform_update utility
Use the transform_update utility to update InfoPrint Manager about the job page
count or number of pages completed.

You can use the %u transform option to access an update file that lets you update
the document page count or the job’s pages-completed attribute. Never access the
file identified with %u directly. The transform should only use the
transform_update utility. InfoPrint Manager only checks for updates while the
transform is running and immediately after it completes. The transform_update
utility can be called either once or multiple times while the transform is running.
Once the transform returns, InfoPrint Manager deletes the update file.

The transform_update utility provides these return codes:

1 An English message for basic problems, including:
v Invalid option specified.

v No option or option value specified.

Figure 18. Create Transform dialog: Define a transform to pass job attributes
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v No status file name specified.

v Cannot open status file named ____.

v Cannot read status file named ____.

0 A successful update

-1 The update of the status file was not successful.

transform_update [-t delta_pages_transformed]
[-d delta_pages_delivered]
update_file

-t Specifies the number of additional pages since the last update in the
transformed document file. InfoPrint Manager uses this information to
recalculate the job’s job-page-count attribute. The total of values that this
option passes cannot exceed 2,147,483,647.

-d Specifies the number of additional pages delivered by the transform since
the last update. InfoPrint Manager uses this information to update the job’s
pages-completed attribute. The total of values that this option passes
cannot exceed 2,147,483,647.

Often, it is unnecessary for transforms to update the pages-completed
attribute because it indicates how many pages have actually printed or
stacked for the job, and this attribute is updated by the print backend in
InfoPrint Manager with the number of pages that were printed. Any pages
referenced here should have been removed from any file returned to
InfoPrint Manager for further processing.

update_file
The file passed to the transform through the %u option.

Notes:

1. If a transform calls the transform_update utility more than once, each call
should pass a value for the change since the last call, not a cumulative value.

2. If InfoPrint Manager can neither open nor read the file, it logs an error and
continues processing.

3. If you use a transform to update the job-page-count attribute, you must
provide a page-count for the document. This page-count information provided
by the transform should be the pages in the transformed document for a single
copy of that document.

4. If a transform updates the pages-completed attribute and returns a job for
printing, the pages the actual destination completes are added to the pages the
transform reported it had completed.

Netware.exe
Netware.exe is one of the transform programs that is included with InfoPrint
Manager. This program extracts the user ID and job information from the header of
PostScript print jobs that are submitted from a Netware server, then strips that
header off the job and creates an new header that prints correctly from InfoPrint
Manager. Netware.exe is a terminating transform, but not because it stores its
output in another file. It is a terminating transform because the last step of the
program is to issue a pdpr command, which submits the job to a logical
destination to be printed.
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Note to users: Netware.exe provides the same function that was available through
netware.cmd in PSF for OS/2.

Using the Netware print program

From a Command Prompt window on an InfoPrint Manager server, you can
submit Netware Version 4 Release 1 jobs to an InfoPrint Manager printer. The
command removes the Netware-generated Postscript header and submits the job
for printing by using the JobName and JobOwner parameter values from the
original header.

To submit a Netware-generated job, type this in a Command Prompt window,
substituting the italicized terms with the appropriate values as described below.

netware input_name output_file_name log_dest_name

input_file
The fully qualified name of the file from Netware 4.1 with a PostScript
header.

output_file
The fully qualified name of the file from Netware 4.1 without the PotScript
header (after the transform has run).

log_dest_name
The name of the InfoPrint Manager logical destination that the job is
submitted to after the PostScript header has been removed.

This example submits a PostScript file from Netware (%i) to be transformed into
file without the PostScript header (%o), which is then submitted to a logical
destination called happyprinter1.

netware %i %o happyprinter1
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Chapter 26. Enabling capture for CMRs

If the jobs that run through your system use the same CMRs, you might want to
enable your actual destination to capture inline CMRs.

These inline CMRs must have an object identified (OID) so can capture them.

From the Administration GUI:
1. Click on the actual destination and select Printer → Properties.
2. From the actual destination’s Printer Properties notebook, click the Tuning tab.
3. Find the Capture inline CMR resources radio button. If you can’t see the

Capture inline CMR resources radio button, click Show more.
4. Scroll to the bottom of the screen and click the Yes radio button for the Capture

inline CMR resources setting.
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Chapter 27. Working with fonts

This section describes the fonts required for printing different data formats. It also
describes what you must do so that InfoPrint can use them. This material covers
these font topics:
v “Fonts for printing transformed PostScript and PDF data”
v “Fonts for printing DBCS ASCII and EUC” on page 234
v “Fonts for printing line data” on page 235

Fonts for printing transformed PostScript and PDF data
The InfoPrint PostScript transform program uses Type 1 outline fonts when
transforming PostScript and PDF files. InfoPrint includes the Type 1 outline fonts
and these fonts are installed in the install_path \ps\fonts path during installation.
If you have other Type 1 outline fonts, you can also use them with the transform
program.

install_path indicates the path where you have installed InfoPrint Manager. You can
view that path from the Management Console for InfoPrint Manager Server by
clicking on the Edit → Service Configuration path and checking the Install path
field.

Note: When InfoPrint runs the PostScript transform program during job
submission, it can search other directories for fonts.

The following section contains these topics:
v “Font mapping files”
v “Specifying font substitution through initialization files” on page 229

Font mapping files
A font-mapping file identifies the file names of the Type 1 outline fonts on the
Windows operating system. The InfoPrint PostScript transform program requires at
least one font-mapping file. InfoPrint installs the default font-mapping file,
fonts.map in the install_path\ps path during installation. If you have other Type 1
outline fonts installed on your system, you can create additional font-mapping files
to define their names.

Creating a PostScript font mapping file
When you create your own font-mapping files, consider that:
v You can create more than one font-mapping file.
v At least one font-mapping file must contain the Courier font. The PostScript

transform program substitutes Courier for any missing fonts.
v Fonts cannot span network file systems.

Use the InfoPrint mkfntmap command to create a font-mapping file for use with
the InfoPrint PostScript transform program. You specify one or more input files
containing Type 1 outline fonts and a name for the font-mapping file.

For example, to use the input file FontFile and create a font-mapping file named
font.map, enter:
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mkfntmap FontFile >font.map

Using font-mapping files with the ps2afp or pdf2afp command

By default, InfoPrint uses the fonts.map font-mapping file when you enter the
ps2afp or the pdf2afp command; you do not have to specify the name of the
default font-mapping file with the command.

To use font-mapping files that you have created when you issue the ps2afp
command, you must:
v Enter the path and name of the font-mapping file as the value of the

ps_font_map_files keyword in the transform daemon configuration file, which
is named ps2afpd.cfg and located in the install_path\ps2afp\ folder. For
performance reasons, this is the recommended method. You can specify more
than one font-mapping file, if necessary. Separate the font-mapping files with
colons.
For example, to specify the font-mapping files font1.map and font2.map, enter:
ps_font_map_files=c:\path\font1.map; c:\path\font2.map

v Enter the path and name of the font-mapping file as the value of the
ps_font_map_files transform command configuration file. Use the same syntax
as described for entering the value in the transform daemon configuration file.
Using this method can result in significant performance degradation.

v Specify the font-mapping file, including its path name, from the command line
using the -F flag of the ps2afp or the pdf2afp command. You can specify
multiple files using multiple -F flags; InfoPrint concatenates them from
left-to-right (first entered to last entered) in that order:
ps2afp -F c:\path\font.map -F C:\path2\font2.map

This method can also result in degraded performance.
v If the path to the font mapping file contains blanks, you must surround the

qualified pathname in double-quotes:
ps2afp -F"D:\Program Files\ps\fonts.map"

Do not enclose a path that contains spaces in quotes(″″); the transform will fail
with incorrect font mapping file errors.

v To specify two mapping files in a command, you must make sure that each file’s
full pathname is specified, as in these examples:
ps2afp -F"D:\Program Files\ps\font1.map; D:\Program Files\ps\font2.map"

ps2afp -F"D:\Program Files\ps\font1.map" -F"D:\Program
Files\ps\font2.map"

v If you do not specify a drive letter, but expect the transform to find a mapping
file using a relative path, the default drive is based on the install_path because
that is where the ps2afp executables reside.
If your file is on the D: drive, the command line is on the C: drive, and the
product is installed on the E: drive, InfoPrint attempts to use the E:\samp1.map
font mapping file:
C:\> ps2afp -oout.afp -F\samp1.map d:\incoming.ps

However, if your specify this command, InfoPrint attempts to use the
C:\ps\files\samp1.map font mapping file:
C:\ps\files> ps2afp -oout.afp -F\samp1.map d:\incoming.ps

If you create your own font mapping file -- either by using the mkfntmap
command or manually -- and the path to the fonts contains blanks, the font
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mapping file needs to double-quote the paths as well. For example, if your fonts
reside in E:\Program Files\ps\fonts , the font-mapping file could have any of
these variations:

PATH:

"E:\Program Files\ps\fonts"

FONT:

AvantGarde-Book AvantGarde-Book

FONT

AvantGarde-Book "E:\Program Files\ps\fonts\AvantGarde-Book"

Note: You can use either the ps2afp -F or the pdf2afp -F command flag or the
ps_font_map_files keyword in the transform command configuration file to
specify a font-mapping file. If the value from those three sources is different than
that specified in the transform daemon configuration file, the transform daemon
restarts the PostScript interpreter so that the new value for the font-mapping file
takes effect for that one job. However, restarting the PostScript interpreter
decreases performance, because the interpreter is restarted again with the
font-mapping file in the configuration file for the very next PostScript job.

Specifying font substitution through initialization files
You can issue specific PostScript commands to specify whether printers substitute
fonts for those defined in job tickets that are neither inline with the job nor
resident on the printer. To do this task, modify the UserInit file that is located in
the install_path\ps file system.

To make sure that fonts not inline with the job or resident on your printer
substitute Courier fonts to allow the job to print, specify this in the UserInit file:

%!

turnFontSubstitutionOn

To make sure that fonts not inline with the job or resident on your printer do not
print, specify this in the UserInit file:

%!

turnFontSubstitutionOff

Using OpenType Fonts
This section describes what you need to use OpenType Fonts for printing with
InfoPrint Manager.

These fonts offer many benefits over printing with standard font resources. They
provide users with these benefits:
v A wide range of non-Latin typefaces from which to choose
v A multilingual presentation environment through the support of Unicode
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v A migration path towards a single font technology across all presentation
environments

OpenType Fonts have these three characteristics in the font file:
1. A Microsoft Unicode version of Version 3 Release 1.
2. Microsoft Unicode Full Font Names
3. A Unicode character map (CMAP)

A CMAP defines the mapping of code points to glyph indices, which are used
to index the actual character shape information.

If your fonts do not contain all these elements, they cannot be used with InfoPrint
Manager. If the InfoPrint AFP Resource Installer (Program Number 5639-EE2) does
not install a font, that font does not meet this criteria.

Note: You can use the standard AFP code pages you use for other font resources
with OpenType fonts. For more information about doing this task, see Using
OpenType Fonts in an AFP System.

Using the Resource Installer to install OpenType fonts

If you have OpenType fonts, you must install them using the InfoPrint AFP
Resource Installer (Program Number 5639-EE2). If you create a new library or
subdirectory for these fonts, you must also update the global search path on your
InfoPrint Manager server. If you place them in an existing subdirectory, InfoPrint
Manager should already have this location in its global search path.

Each time you either add new OpenType fonts or modify existing ones, you must
reinstall them with the Resource Installer to make sure that InfoPrint Manager can
access them correctly. The search order of directories for a data object font
resources is the same as the search order for AFP font resources. Make sure that
the path where you install the OpenType Fonts is in the font search order that
InfoPrint Manager uses. For more information about how the font search order is
defined see “The search order for AFP resources” on page 62.

An administrator installs the OpenType fonts in a particular directory on each
system. On an AIX server, the default path for installing these fonts is the
/usr/lpp/ipfonts directory. On a Windows server, the default path is set up by the
administrator who configured the system.

Once the OpenType fonts have been installed through the IBM Infoprint Fonts for
Multiplatforms product, you must run the Resource Installer to create the Resource
Access Table (IBM_DataObjectFont.rat) and store it in the same directory where
the fonts reside. The Resource Installer does not prompt you to do this task
because the Resource Installer is not aware of changes to the directory. As a result,
the system administrator who installed the new fonts must do this task whenever
fonts are either added or removed from the directory.

The Resource Access Table contains an entry for each installed font so that
InfoPrint Manager can access it.

For more information about how to use the Resource Installer of Infoprint Fonts,
either access the online help system of the Resource Installer or see Using OpenType
Fonts in an AFP System.
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Using font capture with OpenType fonts

Font capture allows a printer to capture a downloaded font and treat it as if it
were a printer-resident font. Treating a downloaded font as a printer-resident font
improves performance for future jobs that use the same fonts. Printers retain
captured fonts across job boundaries and power cycles. Captured fonts can be
deleted from the printer when additional space is required. Because OpenType
fonts are large, you might want to make sure that your InfoPrint printer is set to
support font capture.

If you want to capture OpenType fonts that reside in a library on a particular
drive, click the Font Installer’s Capture check box. (far right column of the Top
pane) for each font that you want to capture. For more information, consult the
Resource Installer online help system.

Note: Do not capture sensitive fonts, such as signatures, because an unauthorized
person could access the captured font, even from another system.

Enabling font capture for inline fonts

If the jobs that you run through your system use the same fonts, you might want
to enable your actual destination to capture inline font resources. These inline fonts
must have an object identifier (OID) so InfoPrint can capture them.

Note: For many systems, this procedure is not recommended because captured
inline fonts can be deleted when your printer needs more storage. If InfoPrint
Manager cannot access these fonts, the jobs can either fail or print incorrectly.

From the InfoPrint Manager Administration GUI:
1. Click the actual destination and select Printer → Properties.
2. From the actual destination’s Printer Properties notebook, click Tuning.
3. Find the Capture inline OTF resources radio button. If you can’t see it, click

Show more.
4. Scroll to the bottom of the screen and select the Yes radio button for the

Capture inline OTF resources setting.

Using multiple fonts with limited printer memory

When you are using the OpenType fonts and you receive the Out of memory error
message, you can decrease the Maximum fonts to keep configuration item for
InfoPrint Manager or increase the size of the character cache from the Printer
console.

To decrease the number of Maximum fonts to keep, complete these steps:
1. Right-click the actual destination in the InfoPrint Manager GUI and click

Properties.
2. Click Tuning.
3. Find and change the Maximum fonts to keep value to a smaller number, such

as 5.

To increase the character cache size from the Printer’s console, complete these
steps:
1. Click Printer Definition.
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2. Click Printer.
3. Click Resource Utilization.
4. Increase Font Usage to the highest setting.

Using Unicode extended code pages
Unicode Extended Code Pages (ECP) are code pages with additional information
used by OpenType and TrueType fonts. This is a introduction for using extended
code pages:
v If OpenType and TrueType fonts are used without ECP, Unicode scalars must be

defined in the hardcoded GUM (GCGID-to-Unicode-Mapping, where GCGID
stands for Graphic Character Global IDentifier) table resident in the printer or
code points will be undefined. While the use of predetermined mappings might
meet many needs, if customization of GCGID to Unicode mappings is required,
an extended code page must be used.

v The extended code pages can be used on printers that do not support the
extensions. However, the extensions will be stripped out of the code page as it is
downloaded to the printer appearing as if an unextended code page was used.

v The extended code pages are files on disk just like unextended code pages. The
search order defined in the InfoPrint Manager: Reference in the description of the
resource-context-font attribute still applies. However, a new file extension of
.ECP is supported for all code pages. Inside the same directory, a code page with
the .ECP file extension will be selected before any other code page with a
matching name but a different file extension.

v File extensions are secondary search criteria. The search order of directories is
the primary search criterion when searching for any code page resource,
including Unicode extended code pages. The first possible match on the resource
name is used. For example, there might be two code pages called T1USV500.ECP
and T1USV500. The T1USV500.ECP code page is located in a directory only
specified by resource-context. The T1USV500 code page is located in a directory
specified in resource-context-font. In this case, the T1USV500 code page is used.
Conversely, if T1USV500.ECP and T1USV500 are located in the same directory,
the T1USV500.ECP code page is used.

v Code pages created or modified by the AFP Resource Installer will always have
an .ECP file extension. Use installation software to manage the installation of
this new kind of resource.

v To force a code page to be downloaded instead of using a printer resident code
page and to prevent run-time substitution of code pages, follow this procedure
“Using the ’no resident’ version of the sample grid files” on page 246.

Updating the global search path on an InfoPrint Manager
Windows server

To update the global search path on an InfoPrint Manager Windows server, follow
these steps.

Note: If you do not update the global search path, you must update each actual
destination that you use to print OpenType fonts.
1. To start the InfoPrint Manager Management Console, click the Windows Start

button and select Programs → InfoPrint Manager → Management Console.
2. Stop the InfoPrint Manager server by selecting File → Stop Server.

232 InfoPrint Manager for Windows: Procedures



Note: If you are not able to stop the server because you are not authorized for
that action, check the InfoPrint Manager Access Control List (ACL) for the
Shutdown operation. Log off and log back on as a user who is on the access
control list.

3. Select Edit → Service Configuration.
4. Update both the Default Font Search Path field and the Default Resources

Search Path fields with the directory where the OpenType fonts reside.

Using OpenType fonts with line data
When printing line data with OpenType fonts through InfoPrint Manager, you
need to specify the appropriate parameters on the line2afp command. To define
the location of the OpenType fonts to the line2afp command, you can either use
the InfoPrint Manager global search path (using “Updating the global search path
on an InfoPrint Manager Windows server” on page 232) or use the appropriate
values on the line2afp command. For more information about these values, see
either Using OpenType Fonts in an AFP System or ACIF: User’s Guide.

For more information about either creating or modifying page definitions for line
data jobs to print with OpenType fonts, see Page Printer Formatting Aid: User’s
Guide.

Limitations when printing line data with OpenType fonts
Before you can print this data, you must transform it to Unicode Transformational
Format (UTF-16), with big-endian byte order. Big-endian byte order means that in
a two-byte UTF-16 code point the high-order byte is specified first, followed by the
low-order bytes. You can transform it through the uconv utility, or any other
application that transforms ASCII to Unicode. For more information about the
uconv utility see the AIX operating system documentation.

Line data using OpenType fonts supports using the Byte Order
Mark (BOM) and little endian data
InfoPrint Manager can process the Unicode Byte Order Mark (BOM) when printing
line data with OpenType fonts. (For UTF8 or UTF16-BE data, the BOM is skipped
and not printed. For UTF16-LE, the data is reversed to BE before it is printed, and
the BOM is not printed.) In addition, InfoPrint Manager can now recognize
multi-byte carriage return and line feed characters when parsing Unicode line data.

This support lets you process UTF8 and UTF16 line data in either little-endian or
big-endian order using a traditional line data or record-format page definition. As
many Windows and AIX editors default to UTF8 or UTF16LE encodings and
automatically insert a BOM at the beginning of the file, you can now print
documents created with these editors using Unicode-enabled Open Type Fonts.

Mixed mode data is line data mixed with MODCA structured fields. You can use
mixed mode data with UTF8, UTF16LE, and UTF16BE with a BOM as long as the
BOM is the first bytes (following any cc or trc bytes) of the first line of data.

To mix UTF8 or UTF16BE data with other data encodings, you can do that if there
is no BOM. In this case, the font selected for the data tells InfoPrint Manager the
data encoding. You can’t do this with UTF16LE data because it always requires a
BOM.

This support includes a -o newlineencoding flag for the -o flag, a
stream,(newline=characters,encoding) value for the fileformat parameter on the
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line2afp transform, and a new-line-option-data-encoding document/default
document attribute. For more information about this support, see InfoPrint
Manager: Reference.

Fonts for printing DBCS ASCII and EUC
In ideographic languages, like Japanese, Chinese, and Korean, there are thousands
of characters. A single byte of information cannot represent all of these characters
because a single byte only accommodates 256 characters. Therefore, at least one
more byte of information is required.

For DBCS ASCII files, each ideographic character is either one byte or two bytes
for each character. For Extended UNIX Code (EUC) files, each ideographic
character can be two, three, or four bytes, depending on the EUC implementation
and language. Single-byte ASCII characters can be mixed in with DBCS ASCII and
EUC characters.

InfoPrint supports printing DBCS ASCII and EUC files in these formats:
v DBCS ASCII files in the Japanese and Traditional Chinese languages, which can

contain formatting controls for the InfoPrint 5577 or 5587 printers.
v EUC files in the Japanese, Traditional Chinese, and Korean languages. EUC files

cannot contain any formatting control characters.

The following section contains these topics on printing with DBCS Fonts:
v Fonts required to print a double-byte transformed file
v Installing DBCS fonts on Windows 2000
v Setting up font resources for DBCS ASCII and EUC printing
v Printing Japanese DBCS messages at the end of a job

Fonts required to print a double-byte transformed file

You can use the db2afp transform command to transform input files that use these
code pages:
v Japanese PC (code page IBM-932)
v Japanese EUC (code page IBM-eucJP)
v Traditional Chinese PC (code page IBM-950)
v Traditional Chinese EUC (code page IBM-eucTW)
v Korean EUC (code page IBM-eucKR)

The transformed files contain font references to the double-byte character set. You
set the character set and code page you want by either setting the PSFDBLANG
environment variable or using the default-character-mapping default document
attribute defined in the InfoPrint Manager: Reference. When using the
default-character-mapping default document attribute, you must also specify
document-format=debs-ascii for each applicable document or default document.

To set the PSFDBLANG environment variable, see the Determining what code
page your print jobs use and setting the correct environment variable section in
Chapter 24, “Working with transforms,” on page 179.

After you have used the db2afp command to transform DBCS ASCII and EUC files
to AFP data stream files, you must have access to DBCS fonts when you print the
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transformed files. The DBCS fonts for Japanese, Traditional Chinese, and Korean
are available with Infoprint Fonts, which is a separately orderable feature of
InfoPrint Manager.

Installing DBCS fonts on Windows
To make the fonts available to InfoPrint on your system once you have the licensed
programs, you can use the Windows licensed programs to install the fonts, or copy
the fonts to a particular directory on your Windows system.

Setting up font resources for DBCS ASCII and EUC printing

To print the transformed files that contain font references to the double-byte
character set, you must make the double-byte fonts known to InfoPrint through
one of these methods:
v Create a resource-context object that identifies the location of the double-byte

fonts and associate the resource-context object with a default-document object
and an InfoPrint logical destination. Using this method makes the fonts known
to InfoPrint for any job submitted to the logical destination associated with the
default-document object.

v Add the drives and specific folders to the search path for actual destinations
using this procedure from the InfoPrint Administration GUI:

1. From the InfoPrint Administration GUI main window, highlight the actual
destination.

2. From the main menu, select the Printer → Properties path to open the selected
printers’ Printer Properties window.

3. From the Printer Properties window, click AFP Resources.
4. From AFP Resources, you can specify the fully qualified path where the

double-byte fonts are in the Location of Resources field.

This makes the fonts known to InfoPrint for any job processed by this actual
destination.

Printing Japanese DBCS fonts at the end of a job
You can have DBCS messages print in Japanese at the end of each DBCS print job.
As with printing any DBCS jobs, you must have already installed the appropriate
DBCS fonts on your system, and your printer must be DBCS-enabled. Also, you
must have installed the font from the AFP Font Collection – Japanese Fonts CD-ROM
to support printing the Japanese DBCS message page. If you have installed this
prerequisite and can print DBCS output in Japanese, this support is enabled and
messages print in Japanese automatically.

Please note that if you do not install the appropriate fonts, InfoPrint Manager
defaults to printing the appropriate message in English.

Fonts for printing line data
When you specify a coded font name with the chars keyword of the line2afp
command or with the chars document attribute, the font name is limited to four
characters, excluding the two-character prefix.

This table provides a list of the IBM Expanded Core Fonts for use with
unformatted ASCII input data. InfoPrint stores these coded fonts in the
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install_path\fontlib path. There are copies of the eight-character names that
correspond to the six-character names that reside in the same location.

For the names of other coded fonts, see IBM AFP Fonts: Font Summary.

Table 26. IBM Expanded Core Fonts

Type Family Point Size Coded Font Name Short Name (for
chars keyword)

Courier 7 X0423072 X04272

Courier 8 X0423082 X04282

Courier 10 X0423002 X04202

Courier 12 X04230B2 X042B2

Courier 14 X04230D2 X042D2

Courier 20 X04230J2 X042J2

Helvetica 6 X0H23062 X0H262

Helvetica 7 X0H23072 X0H272

Helvetica 8 X0H23082 X0H282

Helvetica 10 X0H23002 X0H202

Helvetica 11 X0H230A2 X0H2A2

Helvetica 12 X0H230B2 X0H2B2

Helvetica 14 X0H230D2 X0H2D2

Helvetica 16 X0H230F2 X0H2F2

Helvetica 18 X0H230H2 X0H2H2

Helvetica 20 X0N230J2 X0N2J2

Helvetica 24 X0N230N2 X0N2N2

Helvetica 30 X0H230T2 X0H2T2

Helvetica 36 X0H230Z2 X0H2Z2

Times New Roman 6 X0N23062 X0N262

Times New Roman 7 X0N23072 X0N272

Times New Roman 8 X0N23082 X0N282

Times New Roman 9 X0N23092 X0N292

Times New Roman 10 X0N23002 X0N202

Times New Roman 11 X0N230A2 X0N2A2

Times New Roman 12 X0N230B2 X0N2B2

Times New Roman 14 X0N230D2 X0N2D2

Times New Roman 16 X0N230F2 X0N2F2

Times New Roman 18 X0N230H2 X0N2H2

Times New Roman 20 X0N230J2 X0N2J2

Times New Roman 24 X0N230N2 X0N2N2

Times New Roman 30 X0N230T2 X0N2T2

Times New Roman 36 X0N230Z2 X0N2Z2
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Printing with the DBCS Simulation Fonts with the font metric
adjustment triplet

PTF UO00352 includes support for printing the DBCS Simulation Fonts (available
with Infoprint Fonts for Multiplatforms, Version 1 Release 1 Modification 0,
Program Number 5648-E77) with the font metric adjustment triplet. The DBCS
Simulation Fonts are available on the AIX and Windows operating systems.

Note: When you use the DBCS Simulation Fonts, set the requested-font-resolution
appropriately or use the NORES grid files.
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Chapter 28. Working with global resource identifiers

InfoPrint can identify the fonts required for a job, access AFP font files that are
installed on or NFS-mounted to your Windows system, and download the
appropriate fonts to an InfoPrint-managed printer device. However, some InfoPrint
printers can use fonts that are resident in the printer, which saves the time it takes
to download these fonts. Because the font files on the Windows system do not
share the same names as the printer-resident fonts, InfoPrint uses global resource
identifiers (GRIDs) to map the system-resident fonts to the printer-resident fonts.

Uses of GRID files
GRID files contain preassigned mappings that you can modify to map
system-resident font file names to printer-resident font identifiers. These
preassigned mappings include both single-byte character set (SBCS) and
double-byte characters set (DBCS) outline fonts.

If you have a printer that supports outline fonts, you can use the GRID files to
map raster character-set names to outline font global identifiers.

GRID files also support Mixed Object Document Content Architecture for
Presentation (MO:DCA-P) files that specify fonts using GRIDs rather than
character-set names. You can customize the GRID files to define which fonts
InfoPrint uses when the data stream of the job specifies GRIDs.

Note: If a data stream specifies only GRID parts instead of specific names, the
fgid.grd table is used to find the name of the font to download or the outline font
to activate. In this case, the data stream must specify a specific width value

GRID files that come with InfoPrint Manager
InfoPrint Manager provides four GRID files that you can customize to use with the
types of printer devices that you have and the types of jobs that you print. These
files are charset.grd.sample, codepage.grd.sample, cpgid.grd.sample, and
fgid.grd.sample, and they are installed in the <install path>\grd directory.

Note: You can either shut down and restart the InfoPrint server (pdserver process)
or shut down and restart all your printers to make sure that .grd file changes are
applied.
Descriptions of each file are provided below.

charset.grd.sample
Specifies which printer-resident fonts are activated for the character-set names
found in the data stream of the job.

This file maps the font character-set name to a:
v Font global identifier (fgid)
v Graphic character set global identifier (gcsgid)
v Font width
v Vertical size value
v Set of font attributes (bold, italic, and doublewide)
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Figure 19 shows an example of the format of a line in the character set sample
file.

codepage.grd.sample
Specifies which printer-resident fonts are activated for the code page names
found in the data stream of the job.

This file maps a code page to the:
v Code page global identifier (cpgid)
v Graphic character set global identifier (gcsgid)

Figure 20 shows an example of the format of a line in the code page sample
file.

fgid.grd.sample
Specifies which font character set InfoPrint should download when
substituting for a global resource identifier that it finds in the data stream of
the job.

This file maps these to a font character set (FCS) name:
v A font global identifier (fgid)
v A graphic character set global identifier (gcsgid)
v A font width
v A vertical size value

Figure 21 shows an example of the format of a line in the font global identifier
sample file.

cpgid.grd.sample
Specifies which code page InfoPrint should download when substituting for a
global resource identifier that it finds in the data stream of the job.

This file maps a code page global identifier and a graphic character set global
identifier to a code page name. Figure 22 shows an example of the format of a
line in the code page identifier sample file.

# FCS name -> fgid gcsgid width vsize attr #
#----------------------------------------------------------------------#

C0L00GSC 398 - 96 120 - # GOTHIC CONDENSED 1

Figure 19. Sample File for a Character Set

# code page name -> cpgid gcsgid #
#----------------------------------------------------------------------#

T1000038 38 123 # US-ASCII Character Set 1

Figure 20. Sample File for a Code Page

# fgid gcsgid width vsize -> FCS name #
#----------------------------------------------------------------------#

3 0 144 240 C0E0DE10 # DELEGATE 12 POINT 1

Figure 21. Sample File for a Global Identifier

# cpgid gcsgid -> code page name #
#----------------------------------------------------------------------#

29 0 T1V10871 # OLD ICELANDIC 1

Figure 22. Sample File for a Code Page Identifier

240 InfoPrint Manager for Windows: Procedures



For a detailed explanation of how the different types of identifiers combine to
produce fonts, see AFP Fonts: Font Summary.

If you have a job that specifies a font that is not resident on your printer, you can
use the GRID files to map the missing font to one with the same point size that
does reside on your printer. To understand what resident fonts your printer device
has, consult both your printer documentation and Advanced Function Presentation:
Printer Information.

InfoPrint search order for GRID files

InfoPrint searches these directories, in the order shown, for GRID files:
1. An internal list that matches the charset.grd.sample file.
2. <install path>\grd

3. <install path>\var\psf\printername, where PrinterName is the name of a valid
InfoPrint actual destination.

Note: When the same mapping is found in one of these files, InfoPrint uses the
last one.

When you install InfoPrint Manager, sample GRID files are installed in the <install
path>\grd directory. You can maintain a central location for new or modified
GRID files for specific printers by storing files in the <install path>\var\psf\
PrinterName directory.

If you are mapping raster fonts to outline fonts, you can map multiple names to
the same GRID part so that different sized fonts can apply to your print job.

Notes:

1. The new or modified GRID files you create have the same names as the sample
files except that you delete .sample from each file name.

2. After creating or modifying GRID files, you must shut down and restart the
physical printer represented by PrinterName for the changes in the file to take
effect.

Understanding the general syntax rules and allowable values for GRID
files

To tailor the InfoPrint-supplied GRID files for your own system needs, you need to
understand the general syntax rules for the four GRID files and the allowable
values for the fields in the files.

Syntax rules that apply to all types of GRID files
GRID files are simple ASCII text files that you can modify using any standard text
editor. These rules apply to all of the GRID files.
v No line in the file can contain more than 255 characters
v Fields in a line must be separated with one or more delimiters (spaces)
v The pound sign (#) indicates the start of a comment, which causes InfoPrint to

ignore the remainder of that line
v A dash (–), indicates the absence of a particular value, for which InfoPrint

substitutes a zero (0)
v An asterisk (*) indicates that a wildcard value (any numeric decimal) is accepted.
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v InfoPrint ignores blank lines and extraneous fields

Allowable values for the charset.grd file
You can specify these values for fields in the GRID file for a character set for a
font:

fgid
Identifies the character set identifier for the font. Specify a numeric value from
1 to 65534 or enter a dash (–) to disable the mapping of this character set to
GRID values.

gcsgid
Identifies a global identifier for the font. Specify a numeric value from 0 to
65534 or enter a dash (–) to specify no gcsgid. If you specify an asterisk (*),
InfoPrint issues an error message.

width
Identifies the width specified in the character set. Specify a numeric value from
0 to 65534 or enter a dash (–) to specify no width. If you specify an asterisk (*),
InfoPrint issues an error message.

vertical_size
Identifies the vertical size specified in the character set. Specify a numeric
value from 0 to 65534 or enter a dash (–) to specify no vertical size. If you
specify an asterisk (*), InfoPrint issues an error message.

attribute_field
Indicates the attributes of the character set. Specify a lowercase b (bold), i
(italic), d (doublewide), or enter a dash (–) to specify no attribute.

Allowable values for the codepage.grd file
You can specify these values for fields in the GRID file for a code page for a font:

cpgid
Identifies the code page identifier for the font. Specify a numeric value from 1
to 65534 or enter a dash (–) to disable the mapping of this character set to
GRID values.

gcsgid
Identifies a global identifier for the code page. Specify a numeric value from 0
to 65534 or enter a dash (–) to specify no gcsgid. If you specify an asterisk (*),
InfoPrint issues an error message.

Allowable values for the fgid.grd file
You can specify these values for fields in the GRID file for a font global identifier:

fgid
Identifies the global identifier for the font. Specify a numeric value from 1 to
65534 or enter an asterisk (*) to indicate a wildcard value. If you specify a dash
(–), InfoPrint issues an error message.

gcsgid
Identifies the global identifier for the font. Specify a numeric value from 0 to
65534 or enter an asterisk (*) to indicate a wildcard value. If you specify a dash
(–), InfoPrint issues an error message.

width
Identifies the number of characters per horizontal inch. Specify a numeric
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value from 1 to 65534 or enter an asterisk (*) to indicate a wildcard value. If
you specify a dash (–), InfoPrint issues an error message.

vertical_size
Identifies the vertical size of the font. Specify a numeric value from 1 to 65534
or enter an asterisk (*) to indicate a wildcard value. If you specify a dash (–),
InfoPrint issues an error message.

Allowable values for the cpgid.grd file
You can specify these values for fields in the GRID file for a code page global
identifier:

cpgid
Identifies code page identifier for the font. Specify a numeric value from 1 to
65534.

gcsgid
Identifies the global identifier for the font. Specify a numeric value from 0 to
65534 or enter an asterisk (*) to indicate a wildcard value. If you specify a dash
(–), InfoPrint issues an error message.

Modifying GRID files
The following section describes the two ways you can modify GRID files to
support the printer devices and types of jobs in your production printing
environment.

Note: If you are using InfoPrint Manager to print from either the 6400 and 6500
series in both native and 4234 emulation mode, you must modify both the
charset.64xx.grd and the codepage.64xx.grd files as described in “Modifying the
charset and codepage GRID files” and “Modifying the FGID and CPGID GRID
files” on page 244.

Modifying the charset and codepage GRID files

You can avoid having InfoPrint download fonts by adding font entries that map
the font character set or code page that is most referenced in jobs to a global
identifier for a resident font.

For example, if your jobs specify the Prestige 10-point font, which is character set
C0S0PR10, and that font is not available you can map the Prestige 10-point font to
a similar font that is either resident on your printer or available for InfoPrint to
download to your printer. In this procedure, you map the Prestige 10-point font to
Gothic 10-point font, character set C0D0GT10.

Do these steps:
1. Open the file <install path>\grd\charset.grd.sample in a text editor such as

Notepad.
2. Click File → Save as. Rename the file charset.grd and save it into the <install

path>\var\psf\PrinterName directory, where PrinterName is the name of the
InfoPrint actual destination representing the actual device.

3. Edit the charset.grd file you just created. Copy this line for the Gothic 10 point
printer-resident font:
C0D0GT10 40 - 144 240 # GOTHIC TEXT 10
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4. Change the first entry in the copied line (in the FCS name column) to the
character set identifier of the Prestige 10 point font that you want to map to the
Gothic 10 point font. You can change the comment at the end of the copied line
to identify the mapping change you are making.
C0S0PR10 40 - 144 240 # PRESTIGE 10 mapped to GOTHIC TEXT 10

5. Search the remainder of the charset.grd file to make sure that it contains no
other C0S0PR10 entries. A later entry of the same character set would replace
the entry you just made.

6. Save your changes and close the file.

If you want to print jobs that specify the personal computer ASCII codepage for
Iceland, T1000861, but that codepage is not available, you can map codepage
T1000861 to the personal computer multilingual codepage for ASCII data,
T1000850.

Do these steps:
1. Open the file <install path>\grd\codepage.grd.sample in a text editor such as

Notepad.
2. Click File → Save as. Rename the file codepage.grd and save it into the <install

path>\var\psf\PrinterName directory, where PrinterName is the name of the
InfoPrint actual destination representing the actual device.

3. Edit the codepage.grd file you just created and copy this line for the personal
computer multilingual codepage for ASCII data:
T1000850 850 980 # PC MULTILINGUAL

4. Change the first entry in the copied line (in the code page name column) to the
codepage identifier of the personal computer ASCII codepage for Iceland that
you want to map to the multilingual codepage. You can change the comment at
the end of the copied line to identify the mapping change you are making.
T1000860 850 980 # ICELAND MAPPED TO MULTILINGUAL

5. Search the remainder of the codepage.grd file to make sure that it contains no
other T1000860 entries. A later entry of the same character set would replace
the entry you just made.

6. Save your changes and close the file.

Modifying the FGID and CPGID GRID files

You can add new entries to map your GRID data to the resident fonts in your
printer by modifying either the fgid.grd.sample file or the cpgid.grd.sample file. If
you have a printer that does not support the outline font technology (such as the
InfoPrint 3835 Advanced Function Printer), we recommend that you map all the
CZnnnn entries to raster font character-set names. If you do not create this
mapping, InfoPrint issues an error message and does not print the job.

For example, to map the Times New Roman Latin 1 character set to the raster
version, follow these steps.
1. Open the file <install path>\grd\fgid.grd.sample in a text editor such as

Notepad.
2. Click File → Save as. Rename the file fgid.grd and save it into the <install

path>\var\psf\PrinterName directory, where PrinterName is the name of the
InfoPrint actual destination representing the printer device.

3. Edit the file that you just created and copy this line:
2308 2039 * * CZN200 # Times New Roman Latin1
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4. Change the entry in the FCS name column to CON20000.
2308 2039 * * CON20000 # Raster version of TNR Latin 1

5. Save your changes and close the file.

After this substitution, InfoPrint prints jobs that specify the font character-set name
CZN200 and that processed on the physical printer for which you made the change
using the raster version of the font. The CZN200 character set now maps to:
v An FGID of 2308
v A GCSGID of 2039
v A vertical size of 65535
v A width of 0

Note: For more information about the different values available for font character
sets and code pages, see ″IBM Font Interchange Information″ in InfoPrint Data
Stream and Object Architectures Mixed Object Document Content Architecture Reference.

Because the InfoPrint 3835 Advanced Function Printer does not support any
resident outline fonts, the fgid.grd.sample file maps the FGID and the GCSGID
back to the C0N20000 character set. Then, InfoPrint searches the resource library
search path to locate the C0N20000 character set for downloading with the job.

To modify the cpgid file so that the personal computer ASCII codepage for Iceland
maps to the multilingual codepage for ASCII data as described in “Modifying the
charset and codepage GRID files” on page 243, do these steps:
1. Open the file <install path>\grd\fgid.grd.sample in a text editor such as

Notepad.
2. Click File → Save as. Rename the file cpgid.grd and save it into the <install

path>\var\psf\PrinterName directory, where PrinterName is the name of the
InfoPrint actual destination representing the printer device.

3. Edit the cpgid.grd file you just created and copy this line for the personal
computer multilingual codepage for ASCII data:
850 980 T1000850 # PC MULTILINGUAL

4. Change the first entry in the copied line, in the cpgid column, to the codepage
identifier of the personal computer ASCII codepage for Iceland font that you
want to map to the multilingual codepage. You can change the comment at the
end of the copied line to identify the mapping change you are making.
861 980 T1000850 # ICELAND MAPPED TO MULTILINGUAL

5. Search the remainder of the cpgid.grd file to ensure that it contains no other
861 entries. A later entry of the same character set would replace the entry you
just made.

6. Save your changes and close the file.

Verifying the GRID files
During physical printer initialization, InfoPrint examines the contents of the GRID
files. If InfoPrint detects any syntax errors, it reports an error condition and fails to
enable the physical printer. To correct these errors, you must edit the GRID files
that fail. For information about what files, lines, or fields are in error, you must
access the GRID error.log file for the physical printer, which is located in <install
path>\var\psf\PrinterName.
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Preventing InfoPrint from using GRID files

If you have a 300-pel printer but you print 240-pel jobs, the printer-resident fonts
might have different line spacings and endings in the printed output. For some
types of billing statements, these line endings are inappropriate. You can solve this
problem by preventing InfoPrint from using the GRID files, which in turn keeps
InfoPrint from using printer-resident fonts.
1. Rename your customized GRID files. For example, open Windows Explorer and

navigate to the <install path>\var\psf\PrinterName directory, where
PrinterName is the InfoPrint actual destination that you don’t want to use
GRID files with. Find the charset.grd file and right-click it. From the pop-up
menu, select Rename and change the name to charset.grd.bak.

2. Open the file <install path>\grd\charset.grd.sample in a text editor such as
Notepad.

3. Click File → Save as. Rename the file charset.grd and save it into the same
<install path>\var\psf\PrinterName directory that you were working with in
step 1.

4. Edit the charset.grd file and place a dash (–) in the fgid column.
5. Save your changes and close the file.
6. Open the file <install path>\grd\codepage.grd.sample in a text editor such as

Notepad.
7. Click File → Save as. Rename the file codepage.grd and save it into the same

<install path>\var\psf\PrinterName directory that you were working with in
step 1.

8. Edit the copied codepage.grd file and place a dash (–) in the cpgid column.
9. Save your changes and close the file.

Using the ’no resident’ version of the sample grid files

There can be situations when you do not want InfoPrint Manager to use
printer-resident fonts.

If you do not have customized GRID files and want to use the ’no resident’ version
of the sample grid files shipped with InfoPrint Manager, complete this procedure:
1. From a DOS prompt:

cd <install path>\var\psf\PrinterName

Where PrinterName is the name of the InfoPrint physical printer that represents
the actual printer device.

2. Create the charset.grd file from the charset.grd.nores file:
copy <install path>\lpp\psf\grd\charset.grd.nores charset.grd

3. Create the codepage.grd file from the codepage.grd.nores file:
copy <install path>\lpp\psf\grd\codepage.grd.nores codepage.grd
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Chapter 29. Generating and submitting color mapping table
source and output files

A color mapping table is a printer resource object that defines a translation from
certain MO:DCA structured fields to new color structured fields used by newer
printers. Color mapping tables are used to provide highlight color attachments to
black-and-white printers, such as using the InfoPrint 4005 attachment with the
InfoPrint 4000 printer. You can also use a color mapping table to map highlight
colors into richer colors on a color printer like the InfoPrint Color 130 Plus printer
or the InfoPrint 4100 when printing with highlight colors. To apply color to black
and white documents, you must use the following procedure to create Color
Mapping Table Source (.src) and Output Files. See ″InfoPrint administrative
utilities″ in ″ InfoPrint Manager Tools″ chapter of the InfoPrint Manager: Reference
for information about the cmt utility. You can define translations from non-color
fields to color, old color fields to new color fields, and from new color fields to
different new color fields. Therefore, you can use existing applications and
documents with new color fields without having to change the documents or
applications. Also, you can use various color mappings with a single document to
print the document using color in different ways without changing the original
document.

The sample configuration file named cmt.cfg file should be available in the
install_path\config directory and the cmt utility should be available in the
install_path\bin directory on your Infoprint Server. Using the AFP architectural
reference, you can apply color to existing black and white documents.

Note: A MOD:CA sample color mapping table produces from the sample cmt.cfg
file is provided in install_path\config\cmtsampl.

The cmt utility lets you create color mappings in a variety of different color modes
that are defined through the ColorSpace parameter. For example, the Highlight
value can be used when printing to an InfoPrint 4000 printer with an Highlight
Color Model HC2 Post-Processor (HCPP). For more information about HCPP, see
the InfoPrint Hi-Lite Color Printer: Library Catalog at the URL
http://www.infoprint.com.

Parts of a color mapping table
A color mapping table consists of a base part, a set of source groups, and a set of
target groups. The base part identifies the color mapping table with a type of
either reset or normal.

The simplest possible color mapping table is a reset color mapping table that tells
the printer to do no transformations on the color information found in the
document. A reset color mapping table has no source or target groups; all other
color mapping tables have at least one source and one target group.

Using source groups
Each source group has an identification (ID) number that is used to match the
source group with a corresponding target group. You can have unique ID numbers;
however, if you create the color mapping table without the cmt utility and want to
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map several source groups to a single target group, you can use the same ID
number on multiple source groups. Valid ID values are 1–127.

Note: The cmt utility generates pairs of sources and targets, then assigns
increasing, sequential IDs to each pair. For more information about the cmt utility,
see the InfoPrint Manager: Reference.

Each source group must be classified as one of these color spaces:

Highlight color
Highlight color is used when your existing documents describe color in
terms of the percent to be covered and the percent to be shaded for a color
number. The colors are device dependent. For example, you might have a
printer that allows the use of three colors for highlighting. You could
specify percent coverage and percent shading for colors 1, 2, or 3. Your
printer setup would determine the actual colors.

Standard Object Content Architecture (OCA)
Standard OCA uses defined combinations of red, green, and blue to create:
blue, red, pink, magenta, green, turquoise/cyan, and yellow. Standard
OCA also defines several defaults such as white on a black medium, black
on a white medium, and the same color as the medium. The medium
could be, for example, paper or a display.

GOCA pattern fill
GOCA pattern fill defines patterns for filling areas that you might want to
map to colors with a color mapping table.

For detailed explanations about these color spaces, see Mixed Object Document
Content Architecture Reference.

You can use a color mapping table to pick specific object types to map, such as:
v Object area
v IM image data
v PTOCA data
v Page presentation space
v GOCA data
v Overlay presentation space
v BCOCA data
v IOCA data (bi-level, FS10)
v All PTOCA, GOCA, BCOCA, IOCA, FS10, and IM object data
v All objects, object areas, and presentation spaces

After you pick the color spaces and object types you want to map, you can specify
exact values for the fields you want to map.

Using target groups
If you create the color mapping table without the cmt utility, you must specify a
target group ID number to match the source groups for a target. Valid ID values
are 1–127.

Note: The cmt utility generates pairs of sources and targets, then assigns
increasing, sequential IDs to each pair. For more information about the cmt utility,
see the InfoPrint Manager: Reference.
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Each target group must be classified as a color space that is the kind of color you
want as output. The color spaces defined in the matching source groups are
transformed to this color space. The color mapping table allows RGB CMYK,
highlight, and CIELAB, but your actual hardware determines your available
choices. For example, if your printer supports only highlight color, your target
group must use highlight color.

You can specify exact values for output colors. For example, if your printer
supports three highlight colors, you can specify colors 1, 2, or 3 with coverage and
shading percentages that are supported by your printer.

Other publications that have helpful references regarding color devices include:
v InfoPrint 4005 Hi-Lite Color Application Design Reference, available from your

InfoPrint Solutions Company marketing representative.
v InfoPrint Hi-Lite Color Introduction and Planning Guide for 4005.

Creating a color mapping table

In the procedure described below, we create a color mapping table to print an
Advanced Function Presentation (AFP) file that contains pie charts in the color
green.

For our AFP files, this pie chart appears as a series of horizontal lines. By
reviewing the chapter on ″Graphic primitives and attributes″ in the Graphics Objects
Content Architecture for Advanced Function Presentation Reference manual, we can see
that these horizontal lines are created by a Pattern Output Primitive with a
hexadecimal value of '0B'(11).

To turn these horizontal lines into a shade of green when using a ColorSpace
source group of GOCA to map to a target group value of RGB, make sure that you
specify a low value for red (12), a high value for green (252), and a value under 50
for blue (42) to provide a clear contrast.

You must do these tasks from the Windows command line:
1. From the install_path\config directory, specify:

copy cmt.cfg piel.cfg

This copies the Color Mapping Table configuration file into a file you can
customize for your own purposes (in this case, pie1.cfg)

2. Specify notepad piel.cfg.

This lets you edit the configuration file and insert the applicable values to
create the appropriate color mapping (whether GOCA to RGB or OCA to
CIELAB) table. See the sample cmt.cfg configuration file below:
# -------------------------------------------------------
# Required, starts a Color Mapping Definition.
# One definition for each Source to Target mapping.
# -------------------------------------------------------
# -------------------------------------------------------
# BeginSourceDef:
# Required, starts the Source Parameters
# -------------------------------------------------------
BeginSourceDef:
# -------------------------------------------------------
# ColorSpace:
# Required, values= OCA | Highlight | GOCA
# -------------------------------------------------------
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ColorSpace: GOCA
# -------------------------------------------------------
# ColorValue:
# Required, values depend on Color Space
# -------------------------------------------------------
ColorValue: 11
# -------------------------------------------------------
# ObjectType:
# Optional, values= ObjArea | ImageData | PTOCData |
# GOCAData | BCOCAData | AllOCA | Page | Overlay |
# ObjsAll
# default= ObjsAll
# -------------------------------------------------------
ObjectType: GOCAData

# -------------------------------------------------------
# PercentShading:
# Optional, only valid for SourceColorSapce: Highlight,
# values= 0 .. 100, 255 (all percentages),
# default= 100
# -------------------------------------------------------
# PercentShading:
# -------------------------------------------------------
# PercentCoverage:
# Optional, only valid for SourceColorSpace: Highlight,
# values= 0 .. 100, 255 (all percentages),
# default= 100
# -------------------------------------------------------
# PercentCoverage:
# -------------------------------------------------------
# EndSourceDef:
# Required, ends the Source Parameters
# -------------------------------------------------------
EndSourceDef:
# -------------------------------------------------------
# BeginTargetDef:
# Required, starts the Target Parameters
# -------------------------------------------------------
BeginTargetDef:
# -------------------------------------------------------
# ColorSpace:
# Required, values= RGB | CMYK | Highlight | CIELAB
# -------------------------------------------------------
ColorSpace: RGB
# -------------------------------------------------------
# ColorValue:
# Required, values depend on Color Space
# -------------------------------------------------------
ColorValue: 12 252 42
# -------------------------------------------------------
# PercentShading:
# Optional, only valid for TargetColorSpace: Highlight,
# values= 0 .. 100, default= 100
# -------------------------------------------------------
# PercentShading:
# -------------------------------------------------------
# PercentCoverage:
# Optional, only valid for TargetColorSpace: Highlight,
# values= 0 .. 100, default= 100
# -------------------------------------------------------
# PercentCoverage:
# -------------------------------------------------------
# EndTargetDef:
# Required, ends the Target Parameters
# -------------------------------------------------------
EndTargetDef:
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# -------------------------------------------------------
# Required, ends a Color Mapping Definition.
# -------------------------------------------------------
# EndMappingDef:

3. Once you have finished editing the pie1.cfg file, save the file.
4. To create the Color Mapping Table object (MOD:CA) file that will be used

when you submit the job for printing, run the cmt utility as the input file (-i
flag):
cmt -i pie1.cfg -o pie1.out

This command produces a pie1.out output file.

Submitting jobs using a Color Mapping Table
To submit a job using the color mapping tables for spot color, you must make sure
that you also specify a resource-context attribute so that the server knows the
location of the color mapping table. Once you have configured a Color Mapping
Table, you must have defined a logical destination (named prt1 for this example)
to which you can send the job.

Submitting jobs through the Windows command line

Once the logical destination has been defined, you can submit a job to an InfoPrint
Manager printer by specifying this from the command line:

Command Values Meaning

pdpr -d prt1 Print Command with logical destination
name.

-x job-name=gocajob Name of the AFP file you submit for
printing.

-x resource-context=/usr/lpp/psf/cmt/ Explicit path name for the Color
Mapping Table object files.

-x color-mapping-table=pie1.out Color Mapping Table that you created in
“Creating a color mapping table” on
page 249 for printing this file.

install_path\psf\cmt\goca.afp Explicit pathname where the print file is
located in.

Configuring an actual destination with the InfoPrint Manager
Administration GUI
To configure an actual destination to use the appropriate Color Mapping Table:
1. From the InfoPrint Administration Servers main window, enable the

appropriate actual destination (in this case, NewP, as shown below) by
right-clicking the actual destination and then selecting Enable.
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2. Make sure that the Color mapping table (pie1.out) has been specified on the
AFP Color tab of the Printer Properties notebook and that the Location of
resources (install_path\config) has been specified on the AFP Resources tab:

Figure 23. InfoPrint Administration Servers main window
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3. Submit your job to InfoPrint Manager, using either the command line or the
InfoPrint Select client.

Using the InfoPrint Select client with Color Mapping Tables
In InfoPrint Select, specify the name of the Color Mapping Table as the job or
document default as appropriate.

Figure 24. Printer Properties notebook
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Chapter 30. Configuring the Halftone Management System

The Print on Demand feature offers the Halftone Management System (HMS). The
HMS supports printer calibration on devices such as the InfoPrint 20 and the
InfoPrint 4000 series. The Halftone Management System gives you the ability to
calibrate halftones for each screen frequency on most Intelligent Printer Data
Stream (IPDS) printers. The result is consistent grayscale for each appearance
selection. For a complete list of supported printers, see the calibd.src file located in
the /usr/lpp/pd/ipcal/server directory.

With the Halftone Management System, you can run multiple InfoPrint 4000 and
4100 printers and calibrate each system. For two-engine duplex print systems, the
Halftone Management System also lets you calibrate each print engine separately,
so that whatever document you print , the various levels of gray (grayscale) used
to print the document will look the same on both engines. Note that this applies to
input file types of TIFF, GIF, JPEG, PostScript, and Portable Document Format
(PDF).

From the smallest network printer to the largest production printer, you can either
use the halftone provided with InfoPrint Manager or create your own. You can
calibrate for different paper types to account for differences between supplies.
InfoPrint Manager will save and manage these calibrations, allowing you to select
them on a job-by-job basis.

The Halftone Management System consists of two parts that are only installed with
the Print-on-Demand feature:
1. A client process that can be run from any InfoPrint for AIX server.
2. A server process that runs on all InfoPrint for AIX servers.

You can calibrate printers on any InfoPrint AIX server by using the client from
another InfoPrint AIX server. For example, if you have installed InfoPrint servers
A, B and C, you can calibrate printers on A using the client on either A, B or C.
The daemon must be running on server A.

This section describes the procedures that you should make sure have been
completed before attempting to use the Halftone Management System:
1. “Starting the Halftone Management System” on page 257
2. “Calibrating a densitometer” on page 257

Using the correct halftones for the installed toner version

Multiple versions of toner are available for the InfoPrint 4000 and InfoPrint 4100
printers. For some printer models, InfoPrint Manager ships different halftone
curves for different toners, and provides scripts to replace or install the correct
ones. Make sure you have the correct halftone installed for your toner to achieve
the best print quality.

The toner characteristics can require changes in the halftone resources. When the
toner in the printer is replaced with a different version of toner, you must run the
associated Windows bat file from the command line.

© Copyright InfoPrint Solutions Company 1999, 2009 255



Notes:

v When you apply InfoPrint Manager PTFs, the appropriate Windows bat file
must be run again, because the PTF replaces the existing halftone files with the
standard halftone files.

v Some versions of toner do not require different halftones. Therefore, a Windows
bat file might not be available.

The bat files are installed in install_path\config

v IP4000-ID5-6.Std
v IP4000-ID5-6.V2toner
v IP4000-ID5-6.V3toner
v IP4000-IR1-2.Std
v IP4000-IR1-2.V2toner
v IP4000-IR1-2.V3toner
v IP4000-IR3-4.Std
v IP4000-IR3-4.V2toner
v IP4000-IR3-4.V3toner
v IP4100-HD3-HD4.RTtoner
v IP4100-HD3-HD4.Stdtoner
v IP4100-HD3-HD4.V3toner
v IP4100-HD3-HD4.V5toner
v IP4100-MD1-2.Stdtoner
v IP4100-MD1-2.V2toner
v IP4100-MD1-2.V2_PQItoner
v IP4100-PD1-2.Std
v IP4100-PD1-2V3toner

Each bat file changes the InfoPrint Manager system to use the relevant toner; Std
or Stdtoner is the default.

Limitations of actual screen frequencies and angles on InfoPrint 4000
and 4100 printers

If you change the version of toner used with your printer, you should recalibrate
all customized calibration curves to make sure that they print correctly. The screen
frequencies shown in this section presume the use of a 600 dots per inch (DPI)
printer. Frequencies at other DPI are proportionally lower. For example, an 85 lines
per inch (LPI) screen used on a 300 DPI printer will be 43 LPI. Screen frequencies
match the requested screen frequency as closely as possible, based on constraints of
the halftone design.

For the actual screen frequencies and angles for both InfoPrint 4000 and InfoPrint
4100 printers, see Table 27, Table 28 on page 257, and Table 29 on page 257.

Table 27. Screen Frequencies for InfoPrint 4000 IR3/IR4 and ID5/ID6 and InfoPrint 4100
HD3/HD4 and HS2 printers with Version 3 Toner

Submit Screen Frequency (LPI) 71 85 106 141

Actual screen frequency (LPI) 74 85 96 117

Actual Screen Angle (Default °
Set)

35.5° 45° 51.3 ° 59°
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Table 27. Screen Frequencies for InfoPrint 4000 IR3/IR4 and ID5/ID6 and InfoPrint 4100
HD3/HD4 and HS2 printers with Version 3 Toner (continued)

Actual Screen Angle (90° Set) 54.5° 45° 38.7° 31°

Table 28. Screen Frequencies for InfoPrint 4000 IR3/IR4 and ID5/ID6 and InfoPrint 4100
HD1/HD2, HD5/HD6, PD1/PD2, HS1, HS3, and PS1 printers with Version 2 (enhanced
printing toner) or Standard Toner

Submit Screen Frequency (LPI) 71 85 106 141

Actual screen frequency (LPI) 71 85 103 141

Actual Screen Angle 45° 45° 31° 45°

Table 29. Screen Frequencies for InfoPrint 4000 IR1/IR2 Printers with Version 2, 3, or
Standard Toner

Submit Screen Frequency (LPI) 71 85 106 141

Actual screen frequency (LPI) 71 83 106 141

Actual Screen Angle 45° 34° 45° 45°

Starting the Halftone Management System

The Halftone Management System that is included with the InfoPrint Manager
POD feature is not started with an icon or shortcut on InfoPrint Manager for
Windows.

Use these steps to start the Halftone Management System:
1. Go to the Start menu.
2. Go to Programs.
3. Go to InfoPrint Manager.
4. Select Start Halftone Management Server.
5. Repeat steps 1 through 3, and then select Start Halftone Management Client.

If the InfoPrint Manager Server has already been defined in the Halftone
Management System and the Halftone Management System client is started when
the Halftone Management System Server is not running, InfoPrint Manager issues
this message: Error in connecting to host yourhostname - Connection refused.
When this happens, start the Halftone Management System server.

Calibrating a densitometer

The reflection densitometer must be calibrated to provide accurate density
readings. Before using, you must follow the instructions that are provided by the
manufacturer to calibrate the densitometer. The densitometer used must comply to
the spectral responses defined by ANSI PH2.18 - 1985 and ISO 5/3 - 1984. The
densitometer should not have a polarizing filter. The Greytag Macbeth model
D19C has a polarizing filter and should not be used. Densitometers which are
appropriate to use include the X-Rite Model 504, 508, or 400B.

The densitometer should be used in Absolute Density mode for measurements.
This procedure describes how to calibrate the X-RITE 400B (1060) densitometer,
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using the Reflection Reference Card (part number 400-62). Since the X-RITE 400B is
now obsolete, this information is provided as reference.

The Reflection Reference is the card you use to calibrate the densitometer. You will
use only the circular patches labeled 1 (white reference) and 3 (black reference).
The densitometer should be calibrated periodically, or whenever the instrument
displays RECAL. You should store the Reflection Reference Card in its envelope.
1. Press the FUNCTION and ENTER keys in sequence, then release.

After the version and copyright notices appear, the display will show N cal O
Y.

2. Press the ZERO key and release.
After the version and copyright notices appear, the display will show N qcal Y.

3. Press the FUNCTION key and release.
SET LO is displayed momentarily, followed by X.XX, where X.XX should be the
white patch ORTHO value from the Reflection Reference card.

4. If X.XX matches the white patch ORTHO value for your reflection reference,
press the ENTER key. If X.XX does not match, hold down the ZERO key and
press either the FUNCTION or the ENTER key. Decrease (FUNCTION) or
increase (ENTER) the value until the correct number is displayed. When
finished, release the keys and press Enter.
SET HI is displayed momentarily, followed by Y.YYH , where the Y.YY part of
the value should be the black patch ORTHO value from the Reflection
Reference card.

5. If Y.YY matches the black patch ORTHO value for your reflection reference,
press the ENTER key. If Y.YY does not match, hold down the ZERO key and
press either the FUNCTION or the ENTER key. Decrease (FUNCTION) or
increase (ENTER) the value until the correct number is displayed. When
finished, release the keys and press Enter.

6. When you see READ WHT displayed, center the circle on the base of the
densitometer over the white patch (the one labeled ″1″) on the Reflection
Reference. Push the head down and then release it to establish the white patch
Optical Density.
If INVALID displays, repeat the measurement.

7. When you see READ BLK displayed, center the circle on the base of the
densitometer over the white patch (the one labeled ″3″) on the Reflection
Reference. Push the head down and then release it to establish the black patch
Optical Density.
If INVALID displays, repeat the measurement.

Verify the calibration by measuring the black, gray, and white patches. If they
agree within 0.02 OD to the reflection reference values on the card, density is
accurately calibrated. If not, repeat this process until the measurements are
accurate.

To find out how you can calibrate and set output appearances, see “Calibrating a
printer using the Halftone Management System” on page 259.
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Calibrating a printer using the Halftone Management System
The Halftone Management System lets you calibrate each of your printers to
achieve a consistent tone curve for a set of generic halftone screens. The system
also lets you define additional calibrations for specific paper types. When
calibrated the dot gain for a fifty percent dot will be nominally zero percent for
Standard appearance, fourteen percent for Highlight Midtone appearance, and
thirty-four percent for Dark appearance.

To use this tool to calibrate your printers, do these procedures in sequence:
1. “Defining InfoPrint Manager servers to the Halftone Management System

client”
2. “Defining custom patch sets”
3. “Calibrating a halftone” on page 260
4. “Measuring optical density with a densitometer” on page 263

Defining InfoPrint Manager servers to the Halftone
Management System client

The first time you start the Halftone Management System client, you will see an
empty window. You must connect to the InfoPrint AIX server to see a list of the
printers that are available for calibration:
1. From the Halftone Management System (or Main) window, select the Edit →

Servers option.
2. From the Servers window, select the File → Add Server option.
3. In the Server Properties window, fill in the Server Name field with the

symbolic server name, and the Hostname field with either the explicit name of
the server or the server’s dotted decimal notation IP address.
For example, the Server Name field value could be sage, while the Hostname
field value could be either sage.penn.boulder.ibm.com or 9.99.43.73 .

4. Return to the Main window and either use left mouse button to double-click
on each printer or highlight the printer and press enter to display its output
screens. The Main window displays all printers defined to the InfoPrint server
to which you are connected, but only the IPDS printers contain screens that can
be calibrated.

Defining custom patch sets

A patch set is a step wedge file that has patches with different shades of gray. One
patch set has been defined (patches11 ). It has eleven uniformly-stepped grays.

To define additional patch sets, use this procedure:
1. From the Halftone Management System window, select the Edit → Patch Sets

option.
2. From the Patch Sets window, click a patch set (such as patches11) and select

the Edit → Properties option.
3. From the Patch Set name window (where name indicates the patch set

highlighted in the previous step), use the left mouse button to select the
patches that you would like to modify.
The screen shows 99 squares representing from 1-to-99 percent dot at one
percent increments. Squares which are dark will be printed. To change a patch
selection, point to the patch desired and left-click. Each click selects or deselects
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a patch. 0 percent and 100 percent dot patches are always included in each
patch set. The example displayed below will print 0, 10, 20, 30, 40, 50, 60, 70,
80, 90, and 100 percent dot patches.

4. Once you have defined the patch set, select the File → Save as option and save
your patch set with a unique name.
The shipped patch set patches11 cannot be modified. However, a user-created
patch set can be modified through the Save option.

Calibrating a halftone

Once you have either selected an existing patch set or created your own
customized patch set, you must print it out, use a densitometer to measure the
density of each gray patch. Then you must enter the calibration values in the
Halftone Calibration Management System to create a calibration curve for the
printer.

Note: Make sure that you use the Halftone Management System to both add and
delete patch files and Calibration files.

Use this procedure to accomplish these tasks:
1. If desired, define a custom patch set to print from the Halftone Management

System window from the menu bar by selecting EDIT → PATCH SETS, then
selecting the patch from the list and ACTIONS → SELECT AS CURRENT,
FILE → CLOSE.

2. From the Halftone Management System window, select a printer and a
halftone screen supported by that printer.

3. From the Halftone Management System window, select the Actions → Print
Patches option.

4. If the actual destination you chose has a logical-destination-assigned
attribute, the patch set will be sent to that logical printer. Otherwise, you will
be prompted for a logical printer.

5. From the pop-up window, click OK.
6. Once you retrieve your output from the printer, use the densitometer to

measure the patches. Because the Halftone Management System is designed to
take multiple measurements of each patch and use the average, you could
take three measurements of each patch.

7. Select the same actual destination (printer) and screen that you selected before
you printed the patch set (in 2).
The printed patch set identifies the screen, patch set, and printer, along with a
date/time stamp.

8. From the Halftone Management System window, select the Actions →
Calibrate option.

9. From the Enter calibration values window (shown below), set The number of
entries to average field (it defaults to 3) to the number of measurements you
took for each patch.

10. If this is a custom calibration and you want it to replace the default calibration
provided by InfoPrint Manager, allow it to retain the default value in the
Calibration name field. To retain the original default, but have this custom
calibration as a second option, type a name for the calibration in the
Calibration name field.
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11. To enter your densitometer readings, begin with the 0% field. Enter your first
0% value and press Enter. The statistics of your values will be displayed
under the columns Average, Min, and Max.
If you specified more than 1 in the number of entries to average field, the
cursor will remain in the field for your next reading. Otherwise, it will move
on to the next patch field. Continue until all your readings have been entered.
The display below shows a sample customized Calibration named first_run.
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12. Once you have filled in your calibration values, press the OK button. Your
calibration is saved in the /usr/lpp/psf/config/custom directory and ready for
use.

Figure 25. First_run calibration
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Measuring optical density with a densitometer

This procedure describes how you can measure optical density using the XRITE
400B Densitometer. While you can use other densitometers, this procedure has
been verified with this particular make and model. Make sure that the density
readings are absolute, not paper reference.
1. Press the FUNCTION key until DEN appears. If DEN-R appears, press the

ZERO key and try again.
2. Center the circle on the base of the densitometer over the area to be measured.
3. Push the head down and release it to measure the Optical Density (OD).

The density reading will appear as X.XXD.
4. Record the X.XX value as it is displayed.

Several measurements should be taken at different representative locations on
each gray patch and averaged to obtain an accurate OD value. Alternately, you
can enter individual measurements into the calibration value screen and have
the averaging performed automatically.

Specifying a halftone for printing on the InfoPrint AIX server

You can use a particular halftone for printing a grayscale file through either
“Printing from InfoPrint Submit Express” interface or the “Printing from the AIX
command line.”

Note: The Halftone Management System does not need to be running when you
print the job.

Printing from InfoPrint Submit Express
You can print using a particular halftone for printing a grayscale file from a job
ticket (name.jtk file) in InfoPrint Submit Express. Begin by selecting a value in the
Halftone field of the Look tab. Note that all halftones shipped with the product
have the term ’ibm’ prepended to their identifier. If you are accessing this interface
for the first time, all of your previous default calibrations will have ’ibm’ attached
to the name.

InfoPrint Manager lets you determine output appearance on a job-by-job basis by
setting a default halftone in a default document or job object.

Note: InfoPrint Submit Express is part of the InfoPrint Manager Print-on-Demand
feature.

Printing from the AIX command line
You can submit a halftone calibration from the AIX command line by using some
variation of the pdpr Command:
pdpr -p sip20-sage -x halftone=ibm106lpi:highlight-midtones grayscale.ps

where the -x value is the customized calibration file and grayscale.ps is the file to
be printed.

Note: When submitting a pdpr command from the AIX command line, you can
specify the halftone attribute. The actual halftone name for this example
(ibm106lpi:highlight-midtones) can be found either by using the InfoPrint
Manager Administration Interface to look up the halftones supported for the
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actual destination, or enter this at the command line: pdls -cp -r
halftones-supported ActualDestination name.
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Chapter 31. Submitting specialized print jobs

This chapter describes these specialized print job:
v “Submitting PSF printer input to a PCL or PPDS printer”
v “Printing PCL or PostScript to PSF destinations: specifying which paper bin to

use” on page 267
v “Sending print jobs to InfoPrint Manager for Windows from an AIX system” on

page 275
v “Printing from ERP applications” on page 277

Submitting PSF printer input to a PCL or PPDS printer
In addition to AFP printing, InfoPrint Manager allows you to submit PSF printer
input data to PCL and PPDS printers as well.

When you use the Create Printer wizard in the InfoPrint Manager Administration
GUI to create a printer object that will send jobs to a PCL or PPDS printer, you
must specify the path for the command in the Printer command field. For
example, by default the lpr command is located at c:\winnt40\system32\lpr.exe.
Because InfoPrint Manager does not search the PATH environment variable for the
command, you must either add that directory to the PATH for that system or
specify the entire path of the command, as in this example:
c:\winnt40\system32\lpr -P printername -S servername

To specify a file name in the command in a location other than at the end of the
command, you must include the text-string -IPMF- in the command string. The
temporary file name used to store either the PCL or PPDS data generated by
InfoPrint Manager is substituted into the command wherever the -IPMF-
text-string is located.

Note: The dashes (-) on either side of the -IPMF- text-string are part of the syntax
and cannot be omitted.

You can only specify one -IPMF- text-string in a print command, as in the example
below:
e:\usrapp\copyit -IPMF- /b e:\tmp

where copyit represents a user-written application for moving either the PCL or
PPDS file that InfoPrint Manager generated to the specified directory (in this case,
\tmp on the e drive), and giving it a unique name.

Setting up PCL tray mappings

To map the input trays requested in the AFP data stream to the input trays on
your PCL printer, follow this procedure:
1. Determine the AFP bin number and PCL bin number for each input tray.

Table 30 on page 266 shows the default bin numbers associated with some
standard names for input trays.

Note: You can use any tray names you wish, but these names are defined by
the PCL data stream and are the most common names. For more information
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about the limitations of trays and paper with a PSF other-driver or PSF
command DSS see the psf-tray-characteristics attribute in the InfoPrint Manager:
Reference.

Table 30. Default bin mappings

Input tray name AFP bin number PCL bin number

alternate 3 5

bottom 2 4

envelope 65 6

manual 100 2

top 1 1

If these mappings are not appropriate for your printer, reverse the process
described in “Determining bin mappings” on page 268. In this case, the AFP
bin number is the bin number in the data stream and the PCL tray number is
the bin number used by the printer. Note that AFP bin numbers must be
unique, but different AFP bin numbers can map to the same PCL tray number.

2. Open the InfoPrint Manager Administration GUI.
3. Select the printer that you want to set up trays on.
4. From the Media/Bins/Trays tab of the Actual Destination Properties notebook,

in the Media ready table, select Add to define a new tray or Modify to change
an existing one. You can define up to 15 trays.

5. Completethese fields:

Input bin number
This field specifies the AFP bin number.

Media ready
This field shows the medium loaded in the input tray. The drop-down
list lets you select from all media supported by the printer.

Input tray name
This field shows the name associated with the input tray. Standard
names for PCL input trays are:

alternate

envelope

lower

manual

upper

Formerly, these were the only names allowed. You can now use any
name you like, subject to these restrictions:
v Manual trays must have the string manual somewhere in the name,

in any combination of upper and lowercase, for example,
transparentMANUALa4. You can define multiple manual trays.

v Envelope trays must have the string envelope somewhere in the
name, in any combination of upper and lowercase, for example,
Number10Envelope. You can define multiple envelope trays.

Tray number
This field specifies the PCL bin number.
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Duplex
This field specifies whether two-sided printing is possible from this
input tray.

6. Click OK.

To make your changes take effect, you must now stop and restart PSF, the printer,
or both. Follow the steps corresponding to your job submission method.
v If you use DPF to submit jobs:

1. On your host system, stop PSF.
2. In the InfoPrint Manager GUI, left-click the printer, then select Printer →

Stop.

Note: If you don’t see Stop on the Printer menu, use Add/Remove Menu
Items to add it.

3. Open the Management Console and click the DPF Host Receivers item in the
left pane.

4. Click the DPF Host Receiver that feeds this printer to select it.
5. Click Actions→ Obtain Printer Characteristics.
6. Go back to the InfoPrint Manager GUI and start the printer again.
7. Restart the host PSF.

v If you use any other method to submit jobs:
1. In the InfoPrint Manager GUI, left-click the printer, then select Printer →

Stop.

Note: If you don’t see Stop on the Printer menu, use Add/Remove Menu
Items to add it.

2. In the Stop command dialog, select Shut down and click OK.
3. Select Printer → Enable to restart the printer.

Printing PCL or PostScript to PSF destinations: specifying which
paper bin to use

In general, when you submit a print job through a PCL or PostScript driver, you
can use the printer options to specify which input paper bin you want the printer
to use. For example, if you know that white 8.5 x 11 inch paper is always loaded in
bin one and letterhead is always in bin two, you can select bin one when you want
to print a draft and bin two when you’re ready to print a real letter.

When you send PCL or PostScript print jobs to a PSF Destination in InfoPrint
Manager, the data stream is transformed into Advanced Function Presentation
(AFP) before it is printed. By default, most PCL jobs that are transformed use
paper bin one, regardless of the bin you specify. Transformed PostScript jobs
default to letter-sized paper if no other options are specified, and look for a bin
that contains that size paper; they either print on paper from the first bin that
contains the right size or fail because they don’t find the right paper.

If you want the transform program to check for your bin selection and include it in
the AFP data that is sent to the printer, you must specify mappings between the
PCL and PostScript bins and the AFP bins. The transform will use your mappings
to convert the bin number it finds in the PCL or PostScript to an AFP bin number.
You can configure InfoPrint Manager so that you can specify up to 20 different
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input paper bins. For information about how to figure out which PCL and
PostScript bins map to which AFP bins, see “Determining bin mappings.”

After you have figured out the bin mappings, select the option below that most
resembles your situation and follow the related procedure.
v If you only have one printer with multiple paper bins OR if you can use the

same mappings for all of your printers, see “Editing configuration files” on page
274.

v If you have more than one printer with multiple paper bins AND you want to
use different mappings for all of them, see “Creating a transform with bin
mappings” on page 274.

You cannot specify bin mappings if you are printing booklets (with or without
integrated covers) or side-by-side copies (multiple copies of the same page on one
sheet of paper).

Determining bin mappings

PCL printing

When you submit a print job through a PCL print driver and select a paper bin to
print from, the driver generates a bin number and puts it into the data stream.
Unfortunately, different drivers generate different bin numbers for the same bin.
For example, one driver might make ″Tray 1″ equal to bin 4 and ″Auxiliary tray″
equal to bin 2, while another driver makes ″Tray 1″ equal to bin 1 and ″Auxiliary
tray″ equal to bin 8. To add more difficulty, the generated PCL bin numbers can
range from 0 to 59. While most drivers use low numbers (0 through 10), keep in
mind the other possibilities.

During the transformation from PCL to AFP, InfoPrint Manager takes the bin
number that the driver generated and compares it to the bin mappings you set.
The pcl2afp transform inserts the AFP bin number that you assigned and sends the
job to the destination you requested. The printer prints the job on paper from the
bin you chose. As a result, it is essential that all of the users who submit jobs to a
given InfoPrint Manager printer use the same driver. If they do not, the mappings
you set up will not work correctly for them.

The first challenge for you in setting up the mappings is determining what bin
number the PCL driver places in the data stream. For various InfoPrint printers,
the drivers actually generate the same bin numbers. If you are using the PCL5e
driver for an IBM Network Printer 12, Network Printer 17, Network Printer 24,
InfoPrint 20, InfoPrint 21, InfoPrint 32, or InfoPrint 40, the numbers listed in
Table 31 are placed in the data stream.

Table 31. IBM PCL5e Bin numbers

Tray (what you select in Device Settings) PCL bin number (what the driver puts in
data stream)

Automatically Select 0

Tray 1 1

Manual feed paper 2

Manual feed envelope 3

Auxiliary tray 4
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Table 31. IBM PCL5e Bin numbers (continued)

Tray (what you select in Device Settings) PCL bin number (what the driver puts in
data stream)

Tray 2 5

Envelope feeder or Envelope tray 6

Tray 3 7

Tray 4 8

Tray 5 or 2000 sheet input tray 9

If you are using a different driver, the documentation that came with your printer
might provide these numbers; look for a section on the PCL driver. Alternatively, if
you are able to capture the PCL data that is sent to a specific bin in your printer,
you can look for the bin number in the data stream. In some cases, however, it
might be just as easy to use trial and error to determine the correct mappings.
Again, keep in mind that PCL bin numbers can range from 0 to 59.

The second challenge is in determining the AFP bin numbers that correspond to
your printer. AFP bin numbers range from 1 to 255, and are not standard from
printer to printer. Some printers have hard-coded bin numbers; each bin on the
printer actually has a number written on it. In other cases, the AFP bin numbers
are more difficult to discover. In fact, the numbering scheme for some printers
changes completely when you add one of the optional paper bins. Still other
printers allow you to change the bin numbers yourself. As a result, it is difficult to
predict exactly what the AFP bin numbers for your printers are. However, there are
some guidelines that you can use.
v Most AFP paper bins use numbers 1 through 10, with 1 being the biggest,

topmost, or bottommost bin.
v Envelope feeders/bins start at number 65 and can go up to 69.
v The manual feed tray is usually number 100.

If you are printing to InfoPrint printers, the best place to find the default
numbering schemes for each printer is in the IPDS and SCS Technical Reference and
the IPDS Handbook for printers that use the AFCCU™, both of which are available
from the InfoPrint Solutions Company web site at http://www.infoprint.com.
(Under Get support, click Product publications => IPDS Technical Reference and
find the IPDS and SCS Technical Reference and IPDS Handbook for printers that use the
AFCCU in the list.

Important: If you find the AFP bin numbers for your printer in this
documentation, be aware that the number is written in hexadecimal notation. You
must convert the number to decimal before you put it in the mapping file. In
addition, the numbers that are listed are the machine numbers, not the numbers
the software requires (they are the IPDS bin numbers, not the AFP bin numbers).
After you convert the number to decimal, add 1 to it to get the number that you
should put in the mapping file.

For example, if you have a printer with three paper bins and a manual feed bin,
you could do this:
1. On the system that your InfoPrint Manager server runs on, install the PCL

driver that you plan to use. The easiest way to install the driver is by using
the Windows Add printer wizard to create a printer that uses that driver.
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2. Using the Management Console, create a Windows gateway printer that uses
the driver you just installed and has a PSF printer as its target destination.

3. Click the Windows Start button and select Settings → Printers to open the
Printers window.

4. Right-click the Windows gateway printer you just created and select
Properties from the pop-up menu.

5. Click Device Settings to show the printer options that are available for this
driver. For example, some drivers show a list of ″paper trays″ and allow you
to select a paper size for each one.

6. Make sure that all of the paper trays you plan to use are activated and have
the correct size paper selected.

7. Click OK to close the dialog and make the settings take effect.
8. Determine which method you will be using to map bins:
v If you only have one printer with multiple paper bins OR if you can use the

same mappings for all of your printers, see “Editing configuration files” on
page 274.

v If you have more than one printer with multiple paper bins AND you want
to use different mappings for all of them, see “Creating a transform with
bin mappings” on page 274.

9. Follow the appropriate procedure.
When you have to enter PCL and AFP bin numbers, start with the guidelines
above and create some logical mappings, such as the ones shown in table
Table 32 for an InfoPrint 20.

Table 32. Sample mapping table for an InfoPrint 20

Tray selection PCL bin number AFP bin number

Tray 1 1 1

Tray 2 5 2

Tray 3 7 3

Manual feed tray 2 100

Envelope tray 1 6 60

Envelope tray 2 4 61

Complete the procedure.
10. Load each paper bin (including the manual feed bin) with a different kind,

color, or specially marked paper.
11. Submit a test job to each bin and see which paper it prints on. Keep track of

your results and use them to change the mappings to meet your configuration.
12. Once you have the mappings worked out correctly, tell your users this

information:
v How to create a connection to this Windows gateway printer from their

workstations.
v What options to set in the device settings.
v What kind of paper is in each bin.
v How to print to each bin.

PostScript printing

PostScript drivers use different methods to determine what paper bin to print a job
on. Some drivers allow you to select which paper tray you want the paper to come
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from. When you submit a job, the driver sends a number to the printer to ask for
the corresponding tray. Other drivers allow you to select different paper options
(such as size, color, or weight). When you submit a print job, these options are sent
with the print job and are used to determine which paper bin to use (paper size is
the only option that you have to set for this function to work).

When you configure InfoPrint Manager correctly, it will work with either type of
driver. There are three steps involved in performing this configuration:
1. “Gathering paper tray information”
2. “Identifying paper trays to InfoPrint Manager” on page 272
3. “Testing tray mappings” on page 272

Gathering paper tray information: The first step in configuring InfoPrint
Manager is to figure out:
v How many paper trays does your printer have?
v What is the AFP bin number for each tray?

Guidelines for figuring out the bin numbers are provided below.
v What kind of paper will you be loading into each tray?

At a minimum, you should know what size paper will go in each tray. You can
also specify a color or weight of the paper.

Use this chart to record your data.

Table 33. Paper bin information

AFP bin number (in decimal
notation)

Paper tray on printer Paper loaded

100 Manual feed tray

There is trial and error work involved in figuring out the correct bin numbers. AFP
bin numbers range from 1 to 255, and are not standard from printer to printer.
Some printers have hard-coded bin numbers; each bin on the printer actually has a
number written on it. In other cases, the AFP bin numbers are more difficult to
discover. In fact, the numbering scheme for some printers changes completely
when you add one of the optional paper bins. Still other printers allow you to
change the bin numbers yourself. As a result, it is nearly impossible to predict
exactly what the AFP bin numbers for your printers are. However, there are some
guidelines that you can use.
v Most AFP paper bins use numbers 1 through 10, with 1 being the biggest,

topmost, or bottommost bin.
v Envelope feeders/bins start at number 65 and can go up to 69.
v The manual feed tray is usually number 100.
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If you are printing to InfoPrint printers, the best place to find the default
numbering schemes for each printer is in the IPDS and SCS Technical Reference and
the IPDS Handbook for printers that use the AFCCU, both of which are available from
the InfoPrint Solutions Company web site at http://www.infoprint.com. (Under
Get support, click Product publications => IPDS Technical Reference and find
the IPDS and SCS Technical Reference and IPDS Handbook for printers that use the
AFCCU in the list.

Important: If you find the AFP bin numbers for your printer in this
documentation, be aware that the number is written in hexadecimal notation. You
must convert the number to decimal before you put it in the mapping file. In
addition, the numbers that are listed are the machine numbers, not the numbers
the software requires (they are the IPDS bin numbers, not the AFP bin numbers).
After you convert the number to decimal, add 1 to it to get the number that you
should put in the mapping file.

Identifying paper trays to InfoPrint Manager:

Once you have the chart filled in with your first try at mappings, you can move to
the second step: identifying all of the bins to InfoPrint Manager.

By default, InfoPrint Manager assumes that all PostScript printers have only one
paper tray. When you identify the trays, you let InfoPrint Manager know how
many there really are. Then, when you submit a job, you can choose any one of
them.

You identify the paper bins to InfoPrint Manager either in the configuration file or
in the transform you create. In this step, you will determine the syntax that you
will be able to use in either place. The general syntax of the identification
statement is:
inputX=(size,type=xxx,weight=xxx,color=xxx),inputX=(size,
type=xxx,weight=xxx,color=xxx)

Where these conditions apply:
v Each inputX corresponds to a different paper tray. You should have as many

inputX entries as you have paper trays. Separate them with commas, no spaces.
v The X in each inputX is replaced with the AFP bin number from Table 33 on

page 271 for each tray.
v Size is the only required paper attribute. Replace the word size with the size of

the paper that will be in the tray, such as letter, legal, 8.5ix11i, or A4.
v Other paper attributes can be specified or left out entirely.

All of these are valid identification statements:
input1=(letter),input2=(legal),input100=(letter)

input1=(8.5ix11i,color=blue),input2=(8.5ix11i,color=yellow),
input3=(11ix17i),input100=(8.5ix11i)

input1=(A4,color=white),input2=(A4,color=blue),input3=(A4,color=yellow),
input65=(C5),input100=(A4,type=letterhead)

Write out your identification statement before moving on to the next step.

Testing tray mappings:
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Once you have your identification statement created, you can test your mappings
to make sure they are correct. This procedure explains one way to verify the
mappings.
1. On the system that your InfoPrint Manager server runs on, install the

PostScript driver that corresponds to your printer. The easiest way to install
the driver is by using the Windows Add printer wizard to create a printer
that uses that driver. After you create the printer, you can delete it; the driver
will still be installed.

2. Using the Management Console, create a Windows gateway printer that uses
the driver you just installed and has a PSF printer as its target destination.

3. Click the Windows Start button and select Settings → Printers to open the
Printers window.

4. Right-click the Windows gateway printer you just created and select
Properties from the pop-up menu.

5. Click Device Settings to show the trays and options that are available.
6. If your driver lists the paper trays that are available, activate them and select

paper sizes for each one. Set the options to match your identification
statement.

7. Click OK to close the dialog and make the settings take effect.
8. Determine which method you will be using to map bins:
v If you only have one printer with multiple paper bins OR if you can use the

same mappings for all of your printers, see “Editing configuration files” on
page 274.

v If you have more than one printer with multiple paper bins AND you want
to use different mappings for all of them, see “Creating a transform with
bin mappings” on page 274.

9. Follow the appropriate procedure.
When you have to change the configuration file or enter the command that
your transform will use, replace the inputX=... statement with your
identification statement from “Identifying paper trays to InfoPrint Manager”
on page 272, and complete the procedure.When you have to enter PostScript
options and AFP bin numbers, select an input bin number and enter the
options that you want to assign to that bin. For example, if you want AFP bin
1 (on the printer) to hold letter-sized paper, AFP bin 2 to hold legal paper, and
the manual feed tray to hold 11x17 inch paper, the mapping portion of your
command would read:
input1=(letter),input2=(legal),input100=(11ix17i)

10. Load each paper bin (including the manual feed bin) with a different kind,
color, or specially marked paper.

11. Test your settings by submitting print jobs to each bin of the Windows
gateway printer and making sure that it prints on the correct paper. If a job
does not print on the correct paper, adjust your AFP bin numbers and input
numbers as necessary.

12. Tell your users this information.
v How to create a connection to this Windows gateway printer from their

workstations.
v What options to set in the device settings.
v What kind of paper is in each bin.
v How to print to each bin.
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Editing configuration files

There are five configuration files that come with the InfoPrint Manager PCL to
AFP and PostScript to AFP transforms. For the PCL transform, they are: pcl2afp.cfg
and pcl2afpd.cfg. For the PostScript transform they are: ps2afp.cfg, ps2afpd.cfg
(used with InfoPrint 3000 and InfoPrint 4000 printers), and 3160d.cfg (used with all
other IPDS printers). You only need to edit one of these files per data stream,
depending on the printer you send your jobs to and these considerations.
v Edit pcl2afpd.cfg, ps2afpd.cfg, or 3160d.cfg if you want everyone to use the

same mappings. This method is recommended.
v Edit pcl2afp.cfg or ps2afp.cfg if different people have to use different mappings.

To edit the appropriate file:
1. On the system that your InfoPrint Manager server is installed on, locate the file.

It should be in the <install path>\pcl2afp or the <install path>\ps2afp
directory.

2. Open the file in a text editor such as Notepad.
At the bottom of the file, you will see blocks of instructions and sample
commands.

3. Modify the file according to the instructions in the file.
Choose one of the options and uncomment that line, then enter your mapping
numbers. If you are using the ps2afp transform, replace the inputX=... portion
of the device_controls line with your identification statement from
“Identifying paper trays to InfoPrint Manager” on page 272.

4. Save the file.

Note: It is recommended that you save a copy of your changes in a directory
outside of the InfoPrint Manager install path so that you have a copy in case
you ever have to re-install or apply service to InfoPrint Manager.

5. Close the file.
6. Restart the computer to have the new settings take effect.
7. Tell your users what kind of paper is in each bin and how to print to each of

them.

Creating a transform with bin mappings

You can use the InfoPrint Manager transforms to process print jobs with different
options, including which paper bins to use. First, you create a transform using the
InfoPrint Manager Administration GUI, specifying an input data stream and an
output data stream. Then, you associate it with one or more printers. When you
send a print job to that printer, your transform checks to see if the file is the data
stream that needs to be transformed. If it does, the transform converts the file as
you specified; if it is not, the transform passes the file to the logical destination. As
a result, if you don’t want to use the same bin mappings for all of your printers,
you can create several different transforms, all with different mappings. Then,
associate each transform with whichever printer or printers you want.

Note: If you will be sending both PCL and PostScript jobs to the same printer, you
can create two transform objects (one that accepts PCL and one that accepts
PostScript) and associate them both with that printer.

To create a transform that maps PCL/PostScript bins to AFP bins:
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1. In the InfoPrint Manager Administration GUI, click Server and select
Transform → Create.

2. In the Create transform dialog, fill in the fields:
v Name: Type a name for the transform.
v Server: Choose the correct InfoPrint Manager server.
v Format of output file: Select MODCA-P.
v Description: Type a description that will help you remember which printer

uses this transform.
v Transform options: The command line that will execute when the transform

runs.
If this transform accepts PCL, type:
pcl2afp -o ″%o″ ″%i″ –device ’plex,inputX=(pcl_bin=Z),inputX=(pcl_bin=Z)’
Replacing the Xs with the number of the AFP bin (on the printer) and Zs
with the number of the PCL bin. You can specify up to 20 mappings.
If this transform accepts PostScript, type:
ps2afp -o ″%o″ ″%i″ –device
’plex,inputX=(size,type=xxx,color=xxx,weight=nnn),
inputX=(size,type=xxx,color=xxx,weight=nnn)’
Replace the inputX=... portion of the command with your identification
statement from “Identifying paper trays to InfoPrint Manager” on page 272.

v Select Transform and print.
v Document formats allowed: The data stream that your transform accepts.

Select PCL or PostScript and add it to the allowed values.
v Click OK.

3. Select the printer that you want to associate this transform with and open its
properties notebook.

4. Click Configuration.
5. Find the Transforms to use field.
6. Select the transform you just created in the Possible values box and add it to

the Values box.
7. Click Apply.
8. Click Document.
9. Find the Formats allowed section.and look in the Values box. Make sure that

modca-p and either pcl or PostScript are listed.
10. Click OK.
11. Tell your users what kind of paper is in each bin and how to print to each of

them.

Sending print jobs to InfoPrint Manager for Windows from an AIX
system

To send print jobs from an AIX system to InfoPrint Manager for Windows, you
need to set up an appropriate Line Printer client (LPR) on the AIX system and an
appropriate Line Printer Daemon (LPD) on the Windows system. To use the
advanced printing options (such as formdef and pagedefs) that InfoPrint Manager
provides, you must use lprafp on your AIX system and the InfoPrint Manager LPD
on your Windows system.
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lprafp is a version of LPR that lets you use –o options to specify advanced print
options when you submit jobs to InfoPrint Manager. You can download an lprafp
sample code package (including a compiled version of the code that can be used
on AIX version 4.3.3 and later) from the InfoPrint Solutions Company Web site at
http://www.infoprint.com/. InfoPrint Solutions Company does not provide
support for the package.

The InfoPrint Manager LPD is installed and activated with your InfoPrint Manager
for Windows server. It is the only LPD that properly processes the –o options that
lprafp submits. If you use a different LPD (such as TCP/IP Print Services, the LPD
that is shipped with the Windows operating system), the –o options that you send
will be lost.

Note: The LPD supplied with the Windows operating system (TCP/IP Print
Services) does support a –o option, but it is not the same. This –o option specifies
the binary option.

If you use the InfoPrint Manager LPD, you will only be able to LPR print jobs to
InfoPrint Manager destinations, not to Windows printers. If you use a different
LPD, you will only be able to LPR to Windows printers. To submit a job to
InfoPrint Manager, you will have to set up a Windows gateway printer.

If you cannot use lprafp and/or the InfoPrint Manager LPD, you can use the
standard LPR and a different LPD to submit jobs from an AIX system to your
InfoPrint Manager for Windows system. However, you will not be able to use
advanced print options.

Important:

1. Do not use this procedure if you have InfoPrint Manager for AIX installed on
your AIX system. If you have InfoPrint Manager for AIX installed, you should
use the InfoPrint Manager AIX Client to submit print jobs from AIX systems to
your InfoPrint Manager servers. In addition, you should consider setting up an
interoperating environment so your InfoPrint Manager servers can work
together.
For additional information about interoperability, refer to “Configuring for
interoperability between an InfoPrint AIX server and an InfoPrint Windows
server” on page 138.

2. When you enter the lpr command, you must specify the option that designates
binary or already-formatted data. For example, on AIX you must use the -l
(lowercase ″L″) option on the lpr.

To submit jobs from an AIX system to your InfoPrint Manager for Windows
system, you must complete these tasks:
v “Verify that the InfoPrint Manager LPD is running”
v “Install and configure lprafp” on page 277

Verify that the InfoPrint Manager LPD is running
1. On the system that your InfoPrint Manager server runs on, open the InfoPrint

Manager Management Console.
2. Click Edit → Service Configuration.
3. In the Service Configuration dialog, find Run InfoPrint Manager LPD service

check box.
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v If the box is checked, the InfoPrint Manager LPD is already running. Click
Cancel to dismiss the dialog.

v If the box is not checked, click Cancel and continue with step 4.
4. In the Management Console, click File → Stop Server.
5. After the InfoPrint Manager server has stopped, click Edit → Service

Configuration again.
6. Click Run InfoPrint Manager LPD service to select it.
7. Click OK.
8. Click File → Start Server to restart the InfoPrint Manager server.

Install and configure lprafp

The lprafp sample code package is available for free download at
http://www.ibm.com.

Note: The compiled version of lprafp for AIX will only run on AIX 4.3.3 and later.
If you have an earlier version, you must use a different LPR client and will not be
able to use advanced printing options.

Printing from ERP applications

For information about the use of SAP R/3 with InfoPrint Manager, see the InfoPrint
Manager: SAP R/3 Configuration and Printing Tasks publication, which can be found
on the Internet in the manual and publication page for InfoPrint Manager for
Windows or InfoPrint Manager for AIX at http://www.infoprint.com.

You can send PostScript or PCL output from your ERP software to InfoPrint
Manager to be printed. If your ERP software is installed on a Windows system,
you should submit the jobs through a Windows gateway printer. If your ERP
software is installed on an AIX system and you do not have InfoPrint Manager for
AIX installed, you should use the lprafp Line Printer Client (LPR) and the
InfoPrint Manager Line Printer Daemon (LPD).

Submitting ERP print jobs from a Windows system

Defining the Windows gateway printer

Your ERP print jobs will be submitted to a Windows gateway printer that is
associated with the appropriate PostScript or PCL driver for your printer. To define
your Windows gateway printer:
1. Create or select an InfoPrint actual destination that will accept the data stream

that you will be sending to the printer (PostScript, PCL, or AFP).
This actual destination can be almost any type of InfoPrint printer
(Passthrough, BSD, IPP, PSF) that you can create using the InfoPrint Manager
Administration GUI. If you don’t want to use the default queue and logical
destination, create them and associate the actual destination with them.

2. Install the appropriate PostScript or PCL printer driver on the system that your
InfoPrint Manager server is located on.
v If you will be sending PostScript data to an AFP printer, you can use the

IBM Network Printer 17 driver, which you can download from the InfoPrint
Solutions Company Web site.

v Otherwise, you can install and use the driver that came with your printer.
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To install the driver on your system:
a. Insert the CD or disk containing the driver into the correct drive.
b. Start the Windows Add Printer wizard and create a local printer. When you

have to select a port, select FILE:.
c. When the wizard gives you a list of manufacturers and printers, select

either the IBM Network Printer 17 or the driver that came with your printer.
d. Finish the wizard without printing a test page or making this printer the

default.
Once you finish the wizard, you can delete this printer; the driver will still be
installed.

3. Open the Management Console and create a Windows gateway printer.
In the Target destination field, select the destination that you created or chose
in 1 on page 277. In the Windows driver name field, select the driver that you
installed in 2 on page 277. Remember the Share name that you choose; you
will need it later. Refer to the Management Console online help for additional
information.

Adding the Windows gateway printer to the system you want to
print from

Once the Windows gateway printer is created, you can add it to the desktop of the
system that you want to print from. Then you will be able to submit your print
jobs directly to it. Follow this procedure to add the Windows gateway printer to
the desktop.
1. Use the Add Printer wizard to add the Windows gateway printer to your

desktop as a network printer. When you are prompted for the name of the
printer to connect to, find or enter the Share name of the Windows gateway
printer you created. Finish the wizard.

2. Once the connection to the Windows gateway printer is created, you can print
to it just as you would to any other printer.
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Chapter 32. Configuring InfoPrint Manager for Windows to
support the InfoPrint 5000 printer Models CS1 and CD1/2

The InfoPrint 5000 printer Models CS1 and CD1/2 are set up so that PDF and
PostScript Level 3 jobs are submitted by dropping them into printer hot folders.
The printer controller uses Microsoft Shared Folders as hot folders to receive the
print jobs. From a print submission workstation or server, you can map the
top-level hot folder directory to your local system and copy files to the individual
hot folder to get the jobs to the printer. Hot folders can be configured with unique
job attributes.

Note: All hot folders must be created from the InfoPrint 5000 printer operator
panel.

The InfoPrint 5000 printer features a simple 2-up function that can be used for
slit-merge finishing applications. Any other changes to document format and
layout might require additional processing with impositioning software before a
file is submitted for printing. InfoPrint Manager attributes are not passed to the
InfoPrint 5000 printer. For each hot folder that is defined by the printer operator, a
corresponding logical/actual destination pair needs to be defined on InfoPrint
Manager. The InfoPrint 5000 printer requires a 1:1 relationship for logical to actual
destinations.

To configure the InfoPrint Manager for Windows to support the InfoPrint 5000
printer Models CS1 and CD1/2, follow these steps:
1. (Optional) If you do not need to support the AFP or line data input data types,

please ignore this step.
To support the AFP or line data input data types, install the afp2pdf PRPQ for
InfoPrint Manager or afp2pdf PRPQ for InfoPrint Transform Manager.
See the related documents in PRPQ offerings for detailed instructions.

2. Map a network drive from the local machine to the printer’s hot folder named
SV-110 HotFolder. SV-110 HotFolder is the required name. Ask your Customer
Support Specialist for the InfoPrint 5000 printer’s userid and password. You can
have up to 100 hot folders under SV-110 HotFolder. See “Mapping the Hot
Folder for InfoPrint 5000” on page 281 for more information.

3. Run the scripts to create a new BSD DSS printer and the custom transforms to
be assembled into the transforms list of the BSD DSS printer. Depending on
your workflow, you might need to run the scripts many times: once to
reference each PostScript shared folder on the InfoPrint 5000, and again to
reference each PDF shared folder on the InfoPrint 5000.
You need a unique hot folder subdirectory under the SV-110 HotFolder for each
type of PDF and PostScript that you send to the InfoPrint 5000, and you also
need a unique actual destination/logical destination pair for each type of PDF
and PostScript. Let’s say you have two types of PDF and three types of
PostScript, see Table 34 on page 280 for sample names.
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Table 34. Suggested naming convention for InfoPrint 5000 hot folders

Type of PDF or
PostScript

Actual Destination
name (limited to 8
characters)

Logical Destination
name

Hot Folder
subdirectory name

PDF letter 5K-PDF1 5k-pdf1-ld-letter PDF letter

PDF tabloid 5K-PDF2 5k-pdf2-ld-tabloid PDF tabloid

PostScript letter size 5K-PS1 5k-ps1-ld-letter PS letter

PostScript tabloid size 5K-PS2 5k-ps2-ld-tabloid PS tabloid

PostScript ABC
Statement size

5K-PS3 5k-ps3-ld-abc PS ABC Statement

See “Running scripts” on page 281 for detailed instructions.
4. InfoPrint Manager for Windows uses a default user name called LocalSystem

for its activities. LocalSystem does not have the ability to write to a network
drive, even if the Administrator on the workstation can write to that same
network drive:
a. You must add the user name and password provided to access shared

network drives on the InfoPrint 5000 printer to the InfoPrint Manager for
Windows server by using Control Panel–�Users and Passwords. The user
must be a member of the Administrator’s group. You must also set the
password to never expire.

b. Give the user access to these Administrative Tool policies:
1) Go to Control Panel–�Administrative Tools–�Local Security Policy.

You see the Local Security Settings window.
2) From the Local Security Settings window on the left pane, open the

Local Policies folder and then open the User Rights Assignment folder,
and then select these assignments on the right pane:
v Act as part of the operating system
v Create permanent shared objects
v Log on as a service

c. Open the InfoPrint Manager for Windows Management Console. Stop the
InfoPrint Manager for Windows server. Use Edit–�Service Account/Domain
and replace LocalSystem with the InfoPrint 5000 user name and password
that you received from the Customer Support Specialist.

5. Restart the InfoPrint Manager for Windows server.
6. After a PDF or PostScript print job is copied to the appropriate InfoPrint 5000

hot folder, the print job is no longer available on InfoPrint Manager unless the
job-retain-until or job-retention-period job attributes are specified for the job.

Notes:

1. Only the Customer Support Specialist can change the user name and the
password from the InfoPrint 5000 printer control panel. Work with your
Customer Support Specialist to have them change the user name and password.

2. If you use interoperating InfoPrint Manager for Windows servers in your
environment, make sure that the hot folder share userid is the same as the
domain account userid that was used for the interoperating systems.
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Mapping the Hot Folder for InfoPrint 5000

You should map or mount the Hot Folder provided by the InfoPrint 5000 printer
onto your local system.

To do this mapping in the Windows operating system, follow these steps:
1. On the desktop, right-click My Computer or My Network Places. Then a

pop-up menu displays.
2. From the pop-up menu, select Map Network Drive. You see the Map Network

Drive window.
3. On the Map Network Drive window:

a. In the Drive combination box, click the local drive letter that you want the
remote folder to be mapped to.

b. In the Folder combination box, type the path to the remote folder (such as
\\IPC01\SV-110 Hotfolder or the IP address) or press the Browse button to
select the remote folder from the Local Area Network.

c. Click Connect using a different user name.
d. You see the Connect As window. Enter the supplied userid and password

from your Customer Support Specialist.
4. Click Finish. Now you have successfully mapped the Hot Folder onto your

local system.

Running scripts
When you need to enable the InfoPrint 5000 support, some scripts should be run
on the InfoPrint Manager server, to create a new BSD DSS printer (together with a
new logical destination and a new or existing queue), to create the custom
transforms that allows the InfoPrint Manager product to convert the input data to
the corresponding output data format, and to assemble the list of transform objects
previously created into the BSD DSS printer. To run these scripts, you can execute
a Windows command run_customization_1.cmd, with administrative rights both
on the Windows system and on the InfoPrint Manager server.

The run_customization_1.cmd command syntax:
run_customization_1.cmd nameOfServer nameOfAD nameOfQueue nameOfLD nameOfSharedIP5000NetworkDrive

where:

nameOfServer
Specify the name of the InfoPrint Manager server where to create the
destination.

nameOfAD
Specify the name of the new actual destination that will be created.

nameOfQueue
Specify the name of an existing queue or a new one that will be created, if
there is no queue named nameOfQueue.

nameOfLD
Specify the name of the new logical destination that will be created.

nameOfSharedIP5000NetworkDrive
Specify the path to the Hot Folder provided by the InfoPrint 5000 printer.

For example:
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run_customization_1.cmd ipmwin 5K-PS1 color-q 5k-ps1-ld-ledger "\\ipc01\SV-110 Hotfolder\PS Letter"

Note: After running the run_customization_1.cmd script, check the results that the
command returns and make sure that a new actual destination and logical
destination were created. You can specify an existing queue in the script’s
parameters, so this might be reflected in the results that the command returns.
Specify the path to the Hot Folder provided by the InfoPrint 5000 printer.

Limitations of InfoPrint 5000 printer support
This support has these limitations:
1. The afp2pdf transform does not support n-up.
2. The afp2pdf transform supports black and white text, color text and GOCA.
3. The afp2pdf transform does not support CMR.
4. The number of copies is limited to 1.
5. Input data streams are limited to line-data, AFP, PDF, and PS data types.
6. There are limitations for output print fidelity of the afp2pdf transform.
7. The accounting information is available only when the pdaccount

administrative command is used.
8. No accurate job completion status is available. Only the page count is

provided as feedback.
9. Any attributes relevant to PS and PDF input files are not supported, because

these files will be simply passed through.
10. InfoPrint Manager submission clients Submit Express and InfoPrint

JobTicketer are not supported.
11. The input AFP files together with the formdef are the only formatting controls

of the input job. Other formatting controls such as output format (booklet,
reverse order) are not supported.
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Chapter 33. Configuring the InfoPrint 5000 Models AS1 and
AD1/2 to print PDF and PostScript

Printing PDF and PostScript files on the InfoPrint 5000 printer Models
AS1 and AD1/2 with hot folders from InfoPrint Manager for Windows

To print PDF and PostScript files on the InfoPrint 5000 printer Models AS1 and
AD1/2 with InfoPrint Manager for Windows, you can use hot folders.

When you use hot folders, you must complete minor configuration tasks.

Running scripts before printing PDF and PostScript files
All hot folders must be created from the InfoPrint 5000 printer operator panel. The
hot folders can have different job attributes, such as the actual destination to print
the job (actual-destination-requested job/default job attribute) or the combination
of start, end, or separator sheets to use with a job (auxiliary-sheet-selection
job/default job attribute).

To enable InfoPrint 5000 hot folder support, run scripts on the InfoPrint Manager
server to create a new BSD DSS printer (together with a new logical destination
and a new or existing queue), to create the custom transforms that allows InfoPrint
Manager to convert the input data to the corresponding output data format, and to
assemble the list of transform objects previously created on the BSD DSS printer.

To configure the InfoPrint Manager server to enable hot folder support on the
InfoPrint 5000 printer:
1. Log on to your InfoPrint Manager server.
2. Locate the scripts provided by InfoPrint Manager: install_path\bin
3. Type one of these commands:
v For Model AS1, run_customization_1.cmd nameOfServer nameOfAD

nameOfQueue nameOfLD \\printerIPAddress\Simplex\yourhotfolder

v For Models AD1/2, run_customization_1.cmd nameOfServer nameOfAD
nameOfQueue nameOfLD \\printerIPAddress\Duplex\yourhotfolder

nameOfServer
Specify the name of the InfoPrint Manager server on which to create
the destination.

nameOfAD
Specify the name of the new actual destination that will be created.

nameOfQueue
Specify the name of the existing queue or a new queue.

nameOfLD
Specify the name of the new logical destination that will be created.

PrinterIPAddress
Specify the IP address for the InfoPrint 5000.

Simplex or Duplex
Specify the parent directory for your hot folder. With Model AS1,
specify Simplex. With Models AD1/2, specify Duplex.

yourhotfolder
Specify the name of the hot folder created at the InfoPrint 5000 printer
console.

© Copyright InfoPrint Solutions Company 1999, 2009 283



4. Verify that a new actual destination and logical destination were created by
checking the InfoPrint Manager Administration GUI.

5. Submit a PDF or PostScript test job to the InfoPrint 5000.

Example scripts
v For Model AS1:

run_customization_1.cmd ipwin 5k-short color-q 5k-short-ld
\\9.16.72.105\Simplex\shortcolorjobs

v For Models AD1/2:
run_customization_1.cmd ipwin 5k-long color-q 5k-long-ld
\\9.27.83.207\Duplex\longcolorjobs

284 InfoPrint Manager for Windows: Procedures



Part 5. Operator and User Procedures
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Chapter 34. Setting up finishing options for specific printers

This chapter describes finishing options for these printers:
v “Setting up finishing options for IPDS-only printers”
v “Setting up finishing options for PS/PCL printers” on page 294

Setting up finishing options for IPDS-only printers

Depending on the printer model, you can set up several finishing options.
InfoPrint Manager can be set up to support many of these possibilities, including
edge stitching (stapling one edge of the print job to create a booklet), saddle stitch
(stapling in the middle of the page to create a folded booklet), and corner stapling.
These sections describe how to set up finishing options for IPDS printers, including
the InfoPrint 45, InfoPrint 60, and InfoPrint 2000.

Telling InfoPrint Manager what options the finisher supports

The first step in enabling the finishing options is to let InfoPrint Manager know
what options the finisher supports. To set the appropriate values:

Note: If you will only be submitting print jobs that specify a form definition to
this printer, you do not have to complete this procedure. You can proceed to
“Setting up InfoPrint Manager and clients to use finishing options” on page 295.
1. Start the InfoPrint Manager Administration GUI.
2. Find or create the PSF printer (actual destination) that sends jobs to the printer

you are setting up.
3. Right-click the printer and select Properties from the pop-up menu.
4. In the Printer Properties notebook, click Job.
5. Find the Finishing options allowed field.

Note: If you don’t see the Finishing options allowed field, click Show More.
6. Select all of the finishing options that your finisher supports in the Possible

values list and add them to the Values list.
7. Click OK.

Setting up InfoPrint Manager and clients to use finishing
options

How you set up to use finishing options varies depending upon what kind of print
jobs you create and how you submit them. There are several categories; find the
one that most resembles your situation.

Using the pdpr command
When you submit print jobs from the command line with the pdpr command, you
can use the job-finishing attribute on the –x flag to specify finishing options. For
example:
pdpr -d printername -x"job-finishing=staple-top-left" printfilename

You can also use the form-definition attribute on the –x flag to specify finishing
options. For example:
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pdpr -d printername -x"form-definition=F1name" printfilename

For a list of allowed values, proper syntax, and usage guidelines for the
job-finishing and form-definition attributes, see InfoPrint Manager: Reference.

Using a form definition
If you submit your print jobs using a form definition (either by specifying a certain
one or by using a default form definition), you can identify the finishing options
that you want to apply in the form definition. When you specify printing and
finishing options this way, no InfoPrint finishing attributes are necessary to request
the finishing options. The print job is sent to the printer and the options are read
out of the formdef. If the finisher supports the options chosen, the job should print
correctly without any more configuration on your part.

Note: InfoPrint Manager does not check the finishing options you specify in the
formdef against the options you set in “Telling InfoPrint Manager what options the
finisher supports” on page 294. As a result, if the finisher doesn’t support the
options, the job will fail.

Using InfoPrint Submit Express
When you submit a job using InfoPrint Submit Express, you can select a variety of
options, including finishing. Build your job ticket as you usually would, and
specify the finishing options that you want to use in the Finishing field on the
appropriate tab.

Using InfoPrint Select
The enhanced InfoPrint Select client lets you specify job-finishing attribute values
or a form definition when submitting a job to the server. For more information
about using the job-finishing attribute, see the InfoPrint Manager: Reference. For
instructions on setting attribute values in Select, consult the help system.

Using the InfoPrint AFP driver: If you are interested in using the powerful
features of AFP in a wide range of environments, you might want to install and
use the InfoPrint AFP driver with InfoPrint Select. To install and set up the
InfoPrint AFP driver, see ″Setting up the AFP driver″ in InfoPrint Manager for
Windows: Getting Started. To specify the AFP driver for your printer, follow the
directions in ″Creating InfoPrint Select printers″ in the InfoPrint Manager for
Windows: Getting Started, and specify one of these drivers depending on your
printer model:
1. For the InfoPrint 45 printer, specify the InfoPrint AFP 4345 driver.
2. For the InfoPrint 60 printer, specify the InfoPrint AFP 3160 driver.
3. For the InfoPrint 2000 printer, specify the InfoPrint AFP 2710 driver.

Once installed, click Printing Preferences on Windows 2000 systems from the Print
window, and then use the AFP driver to specify inline form definitions with
finishing options, or make use of other AFP features.

PSF printer:

To use InfoPrint Select to submit print jobs with finishing options to a PSF printer,
you must create a Select printer that uses the specific printer driver for your
printer shown here. The driver is installed on your system when you install
InfoPrint Select. Use the procedure that is described in the InfoPrint Manager for
Windows: Getting Started for creating a Select printer, modifying it as described
here.
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1. Follow the procedure through creating a port and selecting an InfoPrint
destination.

2. When the Add Printer wizard asks you to choose a manufacturer and a printer
model, don’t select anything, just click Have Disk.

3. In the Install from Disk dialog, click Browse and navigate to the directory that
you installed InfoPrint Select in. The default directory is c:\Infoprint.

Note: Because this dialog assumes the the driver is actually on a floppy disk or
CD-ROM, you might receive an error that the drive is not ready. In the error
box, click Cancel. A Windows Open dialog should then open. Use that dialog
to navigate to the correct directory.

4. Select the Ibmprint.inf file and click Open.
5. Select the appropriate driver based on your printer model and click OK.
v For the InfoPrint 45 printer, specify the InfoPrint AFP 4345 driver.
v For the InfoPrint 60 printer, specify the InfoPrint AFP 3160 driver.
v For the InfoPrint 2000 printer, specify the InfoPrint AFP 2710 driver.

6. In the Install from Disk dialog, click Next.
7. Complete the wizard as usual.

When you submit jobs to this printer, you can choose the finishing option you
want to use.

Note: The InfoPrint 60 with Finisher driver only supports four finishing options:
top corner, bottom corner, 2 edge stitch (two staples in one side of the paper), and
3 edge stitch (three staples on one side of the paper). To use other finishing
options, you have to use a different submission method.

Using a Windows gateway printer or the IPP gateway
You cannot select finishing options when you submit a print job using any of these
methods, therefore it is recommended that you choose a different submission
method to specify finishing options.

If you cannot use a different submission method, the only way to submit print jobs
through one of these methods and request finishing options is to use default jobs.
A default job is a list of attributes that is applied to every job that a particular
logical destination receives. You can use the InfoPrint Manager Administration GUI
to modify the default job for the logical destination that InfoPrint Select sends jobs
to so that it requests the appropriate finishing options.

If you use default jobs, you will need a different logical destination for each
finishing option. Every job that you send to a particular logical destination will be
finished the same way. For example, if you set the Finishing options attribute of
the default job to staple-top-left, every job that is submitted to that printer will
have a staple in the top left corner, even if the job is only one page long. In
addition, a logical destination can only have one default job, and a default job can
only have one finishing option set.

Using MVS Download
MVS Download is an optional feature of PSF for OS/390® that uses TCP/IP to
automatically send data sets from the JES spool, without formatting them, directly
to InfoPrint Manager for AIX or InfoPrint Manager for Windows. InfoPrint
Manager receives the data sets into files, formats them, and sends them to the
printer. When you submit a print job with MVS Download, do one of these:
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v Specify a mapping from a JCL keyword to a finishing attribute in the Windows
destination control file. The selected JCL parameter you specify in OS/390 maps
to the InfoPrint Manager pdpr finishing attribute.

v Use the existing form definition JCL keyword to form definition attribute
mapping. The JCL FORMDEF parameter you specify in OS/390 maps to the
InfoPrint Manager pdpr form definition attribute.

v Specify a default form definition or finishing attribute so all jobs have the same
finishing option.

Using InfoPrint Manager hot folders
An InfoPrint Manager hot folder is a directory that is associated with a logical
destination. When you copy or move a file to the hot folder, InfoPrint Manager
automatically submits the file to that logical destination. The default job and
document finishing attributes that are set for the logical destination are applied to
jobs submitted through the hot folder. You can also specify other finishing
attributes or use different values for existing attributes. For instructions on using
hot folders, see “Submitting jobs through InfoPrint Manager hot folders” on page
306.

Using InfoPrint Manager LPD and an LPR client
The InfoPrint Manager Line Printer Daemon (LPD) is a utility that lets you submit
print jobs from other operating systems using a Line Printer (LPR) client. To
submit print jobs with finishing to the InfoPrint Manager LPD, you must use an
LPR client, such as lprafp, that lets you use –o options to specify advanced
printing options (for example, form definitions and page definitions) when you
submit jobs to InfoPrint Manager. You can either specify finishing attributes on the
submission command or use a default job.

On a Windows server, the InfoPrint Manager LPD is the only LPD that properly
processes the –o options that lprafp submits. If you use a different LPD (such as
TCP/IP Print Services, the LPD supplied with the Windows operating system), the
–o options that you send will be lost. You can download an lprafp sample code
package from the InfoPrint Solutions Company Web site at http://
www.infoprint.com. The package includes executable forms of the lprafp client for
the Windows and AIX (Version 4.3.3 Build Level 9 and later) platforms. You can
also compile this code to use it on other platforms. InfoPrint Solutions Company
does not provide support for the package.

Selecting the correct finishing options
In InfoPrint Manager, the finishing options have very descriptive names so that it
is easy to select the one you want for your job. However, the names of those
options are based on print jobs that use the ″portrait″ orientation, and as a result
are misleading for jobs that printed in the ″landscape″ orientation. In addition,
some of the options are valid if the paper is fed through the printer long edge first
(LEF) and not valid if the paper is fed short edge first (SEF), and vice versa. As a
result, choosing the correct finishing option can be confusing. These tables can help
you determine which option to select for the InfoPrint 45, InfoPrint 60, and
InfoPrint 70, based on how you want your job to be finished.
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Paper fed LEF
Table 35. Options to set for paper fed LEF on the InfoPrint 45

Desired output Select this value for
″portrait″ jobs

Select this value for
″landscape″ jobs

One staple in the upper left
corner

staple top left staple bottom left

One staple in the upper right
corner

Not supported staple top left

One staple in the bottom left
corner

staple bottom left Not supported

More than one staple on the
left edge of the paper

edge stitch, OR edge stitch
left

Not supported

More than one staple on the
top edge of the paper

Not supported edge stitch OR edge stitch
left

Table 36. Options to set for paper fed LEF on the InfoPrint 60

Desired output Select this value for
″portrait″ jobs

Select this value for
″landscape″ jobs

One staple in the upper left
corner

staple top left staple bottom left

One staple in the upper right
corner

staple top right staple top left

One staple in the bottom left
corner

staple bottom left staple bottom right

One staple in the bottom
right corner

staple bottom right staple top right

More than one staple on the
left edge of the paper (uses
the default number of staples
that is set for the finisher)

edge stitch OR edge stitch
left

Not supported

Two staples on the left edge
of the paper

edge stitch 2 Not supported

Three staples on the left edge
of the paper

edge stitch 3 Not supported

More than one staple on the
top edge of the paper (uses
the default number of staples
that is set for the finisher)

Not supported edge stitch OR edge stitch
left

Two staples on the top edge
of the paper

Not supported edge stitch 2

Three staples on the top edge
of the paper

Not supported edge stitch 3

More than one staple on the
right edge of the paper

edge stitch right Not supported

More than one staple on the
bottom edge of the paper

Not supported edge stitch right
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Table 37. Options to set for paper fed LEF on the InfoPrint 2000

Desired output Select this value for
″portrait″ jobs

Select this value for
″landscape″ jobs

One staple in the upper left
corner

staple top left staple bottom left

One staple in the upper right
corner

staple top right staple top left

One staple in the bottom left
corner

staple bottom left staple bottom right¹

One staple in the bottom
right corner

staple bottom right¹ staple top right

Two staples on the left edge
of the paper

edge stitch, edge stitch left,
OR edge stitch 2

Not supported

Two staples on the top edge
of the paper

Not supported edge stitch, edge stitch left,
OR edge stitch 2

Two staples on the right
edge of the paper

edge stitch right Not supported

Two staples on the bottom
edge of the paper

Not supported edge stitch right

¹ Some printers support this option via 180-degree image rotation, some do not.
See printer documentation for more details.

Note: For the InfoPrint 2000, paper must be pulled from the paper tray
long-edge-first (LEF) for finishing options to be applied. Because ledger and A3
paper are both pulled from the paper tray short edge first (SEF), the InfoPrint 2000
does not support finishing options for those paper sizes.

Paper fed SEF
Table 38. Options to set for paper fed SEF on the InfoPrint 45

Desired output Select this value for
″portrait″ jobs

Select this value for
″landscape″ jobs

One staple in the upper left
corner

staple top left Not supported

One staple in the upper right
corner

staple top right staple top left

One staple in the bottom
right corner

Not supported staple top right

More than one staple on the
right edge of the paper

Not supported edge stitch OR edge stitch
top

More than one staple on the
top edge of the paper

edge stitch OR edge stitch
top

Not supported

Table 39. Options to set for paper fed SEF on the InfoPrint 60

Desired output Select this value for
″portrait″ jobs

Select this value for
″landscape″ jobs

One staple in the upper left
corner

staple top left staple bottom left
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Table 39. Options to set for paper fed SEF on the InfoPrint 60 (continued)

Desired output Select this value for
″portrait″ jobs

Select this value for
″landscape″ jobs

One staple in the upper right
corner

staple top right staple top left

One staple in the bottom left
corner

staple bottom left staple bottom right

One staple in the bottom
right corner

staple bottom right staple top right

More than one staple on the
top edge of the paper (uses
the default number of staples
that is set for the finisher)

edge stitch OR edge stitch
top

Not supported

Two staples on the top edge
of the paper

edge stitch 2 Not supported

Three staples on the top edge
of the paper

edge stitch 3 Not supported

More than one staple on the
right edge of the paper (uses
the default number of staples
that is set for the finisher)

Not supported edge stitch OR edge stitch
top

Two staples on the right
edge of the paper

Not supported edge stitch 2

Three staples on the right
edge of the paper

Not supported edge stitch 3

More than one staple on the
left edge of the paper

Not supported edge stitch bottom

More than one staple on the
bottom edge of the paper

edge stitch bottom Not supported

Default number of staples in
the center of the sheet

saddle stitch saddle stitch

Staple positions for InfoPrint 2060ES, InfoPrint 2075ES,
InfoPrint 2090ES, InfoPrint 2190, InfoPrint 2210, and InfoPrint
2235

Table 40. Staple positions for InfoPrint 2060ES, InfoPrint 2075ES, and InfoPrint 2090ES
mapped to InfoPrint Manager values

InfoPrint Manager value Staple Position

Portrait Landscape

staple-top-left top left top right

staple-bottom-left bottom left top left

staple-top-right not supported not supported

staple-bottom-right not supported not supported

edge-stitch left edge top edge

edge-stitch-2 not supported not supported

edge-stitch-3 not supported not supported

edge-stitch-left left edge top edge
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Table 40. Staple positions for InfoPrint 2060ES, InfoPrint 2075ES, and InfoPrint 2090ES
mapped to InfoPrint Manager values (continued)

edge-stitch-right not supported not supported

edge-stitch-top not supported not supported

edge-stitch-bottom not supported not supported

saddle-stitch not supported center

Note: The InfoPrint Manager value saddle-stitch means staple down the center. With
the InfoPrint 2060ES, InfoPrint 2075ES, and InfoPrint 2090ES, printers, saddle-stitch
is only supported for sheets in the landscape orientation, and if this is specified
along with bin 3, the sheets are sent to the BookletMaker.

Staple positions for InfoPrint 2105ES
Table 41. Staple positions for InfoPrint 2105ES mapped to InfoPrint Manager values

InfoPrint Manager value Staple Position

Portrait Landscape

staple-top-left top left top right

staple-bottom-left bottom left top left

staple-top-right not supported not supported

staple-bottom-right not supported not supported

edge-stitch left edge top edge

edge-stitch-2 not supported not supported

edge-stitch-3 not supported not supported

edge-stitch-left left edge top edge

edge-stitch-right not supported not supported

edge-stitch-top not supported not supported

edge-stitch-bottom not supported not supported

Setting up finishing options for PS/PCL printers
Depending on the printer model, you can set up several finishing options.
InfoPrint Manager can be set up to support many of these possibilities, including
edge stitching (stapling one edge of the print job to create a booklet), saddle stitch
(stapling in the middle of the page to create a folded booklet), and corner stapling.
These sections describe how to set up finishing options for printers that can be
sent PostScript and PCL, including the InfoPrint 70, InfoPrint 2085, and InfoPrint
2105.

Telling InfoPrint Manager what options the finisher supports

The first step in enabling the finishing options is to let InfoPrint Manager know
what options the finisher supports. To set the appropriate values:

Notes:

1. For the InfoPrint 70, InfoPrint 2060ES, InfoPrint 2075ES, InfoPrint 2085,
InfoPrint 2090ES, InfoPrint 2105, and InfoPrint 2105ES, the PSF DSS will set
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default values for the job-finishings-supported attribute, so you do not need to
do this setup process for the actual destination. These are the default settings:

InfoPrint 70
staple-top-left, staple-bottom-left, staple-top-right, edge-stitch

InfoPrint 2085, InfoPrint 2105
staple-top-left, staple-bottom-left, staple-top-right, edge-stitch,
edge-stitch-left

InfoPrint 2060ES, InfoPrint 2075ES, and InfoPrint 2090ES
staple-top-left, staple-bottom-left, edge-stitch, edge-stitch-left,
saddle-stitch

InfoPrint 2105ES
staple-top-left, staple-bottom-left, edge-stitch, edge-stitch-left

2. If you will be submitting only print jobs that specify a form definition to this
printer or if, you do not have to complete this procedure. You can proceed to
“Setting up InfoPrint Manager and clients to use finishing options.”

1. Start the InfoPrint Manager Administration GUI.
2. Find or create the PSF printer (actual destination) that sends jobs to the printer

you are setting up.
3. Right-click the printer and select Properties from the pop-up menu.
4. In the Printer Properties notebook, click Job.
5. Find the Finishing options allowed field.

Note: If you don’t see the Finishing options allowed field, click Show More.
6. Select all of the finishing options that your finisher supports in the Possible

values list and add them to the Values list.
7. Click OK.

Setting up InfoPrint Manager and clients to use finishing
options

How you set up to use finishing options varies depending upon what kind of print
jobs you create and how you submit them. There are several categories; find the
one that most resembles your situation.

Using the pdpr command
When you submit print jobs from the command line with the pdpr command, you
can use the job-finishing attribute on the –x flag to specify finishing options. For
example:
pdpr -d printername -x"job-finishing=staple-top-left" printfilename

You can also use the form-definition attribute on the –x flag to specify finishing
options. For example:
pdpr -d printername -x"form-definition=F1name" printfilename

For a list of allowed values, proper syntax, and usage guidelines for the
job-finishing and form-definition attributes, see InfoPrint Manager: Reference.

Using a form definition
If you submit your print jobs using a form definition (either by specifying a certain
one or by using a default form definition), you can identify the finishing options
that you want to apply in the form definition. When you specify printing and
finishing options this way, no InfoPrint finishing attributes are necessary to request
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the finishing options. The print job is sent to the printer and the options are read
out of the formdef. If the finisher supports the options chosen, the job should print
correctly without any more configuration on your part.

Note: InfoPrint Manager does not check the finishing options you specify in the
formdef against the options you set in “Telling InfoPrint Manager what options the
finisher supports” on page 294. As a result, if the finisher doesn’t support the
options, the job will fail.

Using InfoPrint Submit Express
When you submit a job using InfoPrint Submit Express, you can select a variety of
options, including finishing. Build your job ticket as you usually would, and
specify the finishing options that you want to use in the Finishing field on the
appropriate tab.

Using InfoPrint Select
The InfoPrint Select client lets you specify job-finishing attribute values or a form
definition when submitting a job to the server. For more information about using
the job-finishing attribute, see the InfoPrint Manager: Reference. For instructions on
setting attribute values in Select, consult the help system provided with InfoPrint
Select.

The automatic data stream transforms that PSF printers use do not support
finishing (stapling), so in general, to use InfoPrint Select to submit PCL or
PostScript jobs to a PSF printer (destination), you cannot specify finishing options
when you submit a job, even if the print driver you use supports those options.
However, there are other submission methods that will let you submit jobs with
finishing options using Select.

Using the InfoPrint AFP driver:

If you are interested in using the powerful features of AFP in a wide range of
environments, you might want to install and use the InfoPrint AFP driver with
InfoPrint Select. To install and set up the InfoPrint AFP driver, see ″Setting up the
AFP driver″ in InfoPrint Manager for Windows: Getting Started. To specify the AFP
driver for your printer, follow the directions in ″Creating InfoPrint Select printers″
in InfoPrint Manager for Windows: Getting Started and specify one of these printer
drivers depending on your printer model:
1. For the InfoPrint 70 printer, specify the InfoPrint AFP 2770 driver.
2. For the InfoPrint 2085 printer, specify the InfoPrint AFP 2785 driver.
3. For the InfoPrint 2105 printer, specify the InfoPrint AFP 2705 driver.

Once installed, you can click either Printing Preferences on Windows 2000 systems
and then use the AFP driver to specify inline form definitions with finishing
options, or make use of other AFP features.

Using a PSF other-driver printer: You can use the document-formats-ripped-at-
destination actual destination attribute to prevent the automatic data stream
transform from occurring. Refer to the InfoPrint Manager: Reference for details.

Using a Passthrough printer: A Passthrough printer allows InfoPrint Manager for
Windows to bridge to the Windows print-spooling subsystem, and it does not
transform the data stream. This type of destination uses fewer processing resources
but provides less functions.
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Any other destination type: To use InfoPrint Select to submit print jobs to a
different destination type (such as a BSD or IPP printer), the only way to request
finishing options on PCL and PostScript jobs is to use default jobs. A default job is a
list of attributes that is applied to every job that a particular logical destination
receives. You can use the InfoPrint Manager Administration GUI to modify the
default job for the logical destination that InfoPrint Select sends jobs to so that it
requests the appropriate finishing options.

If you use default jobs, you will need a different logical destination for each
finishing option. Every job that you send to a particular logical destination will be
finished the same way. For example, if you set the Finishing options attribute of
the default job to staple-top-left, every job that is submitted to that printer will
have a staple in the top left corner. In addition, a logical destination can only have
one default job, and a default job can only have one finishing option set.

Using a Windows gateway printer or the IPP gateway
You cannot select finishing options when you submit a print job using any of these
methods, therefore it is recommended that you choose a different submission
method to specify finishing options.

If you cannot use a different submission method, the only way to submit print jobs
through one of these methods and request finishing options is to use default jobs.
A default job is a list of attributes that is applied to every job that a particular
logical destination receives. You can use the InfoPrint Manager Administration GUI
to modify the default job for the logical destination so that it requests the
appropriate finishing options.

If you use default jobs, you will need a different logical destination for each
finishing option. Every job that you send to a particular logical destination will be
finished the same way. For example, if you set the Finishing options attribute of
the default job to staple-top-left, every job that is submitted to that printer will
have a staple in the top left corner. In addition, a logical destination can only have
one default job, and a default job can only have one finishing option set.

Using MVS Download
MVS Download is an optional feature of PSF for OS/390 that uses TCP/IP to
automatically send data sets from the JES spool, without formatting them, directly
to InfoPrint Manager for AIX or InfoPrint Manager for Windows. InfoPrint
Manager receives the data sets into files, formats them, and sends them to the
printer. When you submit a print job with MVS Download, do one of these:
v Specify a mapping from a JCL keyword to a finishing attribute in the Windows

destination control file. The selected JCL parameter you specify in OS/390 maps
to the InfoPrint Manager pdpr finishing attribute.

v Use the existing form definition JCL keyword to form definition attribute
mapping. The JCL FORMDEF parameter you specify in OS/390 maps to the
InfoPrint Manager pdpr form definition attribute.

v Specify a default form definition or finishing attribute so all jobs have the same
finishing option.

Using InfoPrint Manager hot folders

An InfoPrint Manager hot folder is a directory that is associated with a logical
destination. When you copy or move a file to the hot folder, InfoPrint Manager
automatically submits the file to that logical destination. The default job and
document finishing attributes that are set for the logical destination are applied to
jobs submitted through the hot folder. You can also specify other finishing
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attributes or use different values for existing attributes. For instructions on using
hot folders refer to “Submitting jobs through InfoPrint Manager hot folders” on
page 306.

Using InfoPrint Manager LPD and an LPR client
The InfoPrint Manager Line Printer Daemon (LPD) is a utility that lets you submit
print jobs from other operating systems using a Line Printer (LPR) client. To
submit print jobs with finishing to the InfoPrint Manager LPD, you must use an
LPR client, such as lprafp, that lets you use –o options to specify advanced
printing options (for example, form definitions and page definitions) when you
submit jobs to InfoPrint Manager. You can either specify finishing attributes on the
submission command or use a default job.

On a Windows server, the InfoPrint Manager LPD is the only LPD that properly
processes the –o options that lprafp submits. If you use a different LPD (such as
TCP/IP Print Services, the LPD supplied with the Windows operating system), the
–o options that you send will be lost. You can download an lprafp sample code
package from the InfoPrint Solutions Company Web site at http://
www.infoprint.com. The package includes executable forms of the lprafp client for
the Windows and AIX (Version 4.3.3 Build Level 9 and later) platforms. You can
also compile this code to use it on other platforms. InfoPrint Solutions Company
does not provide support for the package.

Selecting the correct finishing options
In InfoPrint Manager, the finishing options have very descriptive names so that it
is easy to choose the one you want for your job. However, the names of those
options are based on print jobs that use the ″portrait″ orientation, and as a result
are misleading for jobs that printed in the ″landscape″ orientation. In addition,
some of the options are valid if the paper is fed through the printer long edge first
(LEF) and not valid if the paper is fed short edge first (SEF), and vice versa. As a
result, choosing the correct finishing option can be confusing. These tables can help
you determine which option to choose based on how you want your job to be
finished.

Paper fed LEF
Table 42. Options to set for paper fed LEF for the InfoPrint 70

Desired output Select this value for ″portrait″ jobs Select this value for ″landscape″
jobs

One staple in the upper left corner staple top left staple bottom left

One staple in the upper right corner Not supported staple top left

One staple in the bottom left corner staple bottom left Not supported

More than one staple on the left edge
of the paper

edge stitch, OR edge stitch left Not supported

More than one staple on the top edge
of the paper

Not supported edge stitch OR edge stitch left

Paper fed SEF
Table 43. Options to set for paper fed SEF for the InfoPrint 70

Desired output Select this value for ″portrait″ jobs Select this value for ″landscape″
jobs

One staple in the upper left corner staple top left Not supported
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Table 43. Options to set for paper fed SEF for the InfoPrint 70 (continued)

Desired output Select this value for ″portrait″ jobs Select this value for ″landscape″
jobs

One staple in the upper right corner staple top right staple top left

One staple in the bottom right corner Not supported staple top right

More than one staple on the right
edge of the paper

Not supported edge stitch OR edge stitch top

More than one staple on the top edge
of the paper

edge stitch OR edge stitch top Not supported

Staple positions for InfoPrint 2085 and InfoPrint 2105
Table 44. Staple positions for InfoPrint 2085 and InfoPrint 2105 mapped to InfoPrint
Manager values

InfoPrint Manager value Staple Position

Portrait Landscape

staple-top-left top left top right

staple-bottom-left bottom left top left

staple-top-right not supported not supported

staple-bottom-right not supported not supported

edge-stitch left edge top edge

edge-stitch-2 not supported not supported

edge-stitch-3 not supported not supported

edge-stitch-left left edge top edge

edge-stitch-right not supported not supported

edge-stitch-top not supported not supported

edge-stitch-bottom not supported not supported

saddle-stitch not supported not supported

Staple positions for InfoPrint 2060ES, InfoPrint 2075ES, and
InfoPrint 2090ES
Table 45. Staple positions for InfoPrint 2060ES, InfoPrint 2075ES, and InfoPrint 2090ES
mapped to InfoPrint Manager values

InfoPrint Manager value Staple Position

Portrait Landscape

staple-top-left top left top right

staple-bottom-left bottom left top left

staple-top-right not supported not supported

staple-bottom-right not supported not supported

edge-stitch left edge top edge

edge-stitch-2 not supported not supported

edge-stitch-3 not supported not supported

edge-stitch-left left edge top edge

edge-stitch-right not supported not supported
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Table 45. Staple positions for InfoPrint 2060ES, InfoPrint 2075ES, and InfoPrint 2090ES
mapped to InfoPrint Manager values (continued)

edge-stitch-top not supported not supported

edge-stitch-bottom not supported not supported

saddle-stitch not supported center

Note: The InfoPrint Manager value saddle-stitch means staple down the center. With
the InfoPrint 2060ES, InfoPrint 2075ES, and InfoPrint 2090ES, printers, saddle-stitch
is only supported for sheets in the landscape orientation, and if this is specified
along with bin 3, the sheets are sent to the BookletMaker.

Staple positions for InfoPrint 2105ES
Table 46. Staple positions for InfoPrint 2105ES mapped to InfoPrint Manager values

InfoPrint Manager value Staple Position

Portrait Landscape

staple-top-left top left top right

staple-bottom-left bottom left top left

staple-top-right not supported not supported

staple-bottom-right not supported not supported

edge-stitch left edge top edge

edge-stitch-2 not supported not supported

edge-stitch-3 not supported not supported

edge-stitch-left left edge top edge

edge-stitch-right not supported not supported

edge-stitch-top not supported not supported

edge-stitch-bottom not supported not supported

saddle-stitch not supported not supported
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Chapter 35. Setting up high speed printers for spacing

In InfoPrint Manager, moving from page to page in a job is called spacing:
v Forward spacing is moving to a point later in the job (such as skipping from page

10 to page 15).
v Backspacing is moving to a point earlier in the job (such as backing up from page

40 to page 20).

For spacing to work effectively on the InfoPrint 2000 for AFP printing, InfoPrint
3000, InfoPrint 4000, and InfoPrint 4100, you must first enable the printer to work
with the Simple Network Management Protocol (SNMP) and allow SNMP to
configure the printer. These settings allow you to use the InfoPrint Manager GUI to
stop a printer very quickly (in ten seconds or less) when you need to, instead of
having to wait for all of the pages of a job that have been buffered to print.

Enabling SNMP on an InfoPrint 2000 for AFP printing
1. On the display/touch screen on the touch screen/printer console, open the

Printer definition pull-down menu.
2. Select Remote Access.
3. On the SNMP tab:
v Select the Enable SNMP Agent and Allow SNMP to configure the printer

check boxes.
v In the Communities list, touch the name of the community you will be using

to access the printer and verify the settings. Make sure that the community
has Write access to the printer.

4. Touch OK to close the window.
5. On the main screen of the console, make sure that the attachment type you will

be using is enabled.
6. If you changed the Enable SNMP Agent or the Allow SNMP to configure the

printer setting, shutdown and restart the printer to make the changes take
effect.

7. Disable the printer and enable it again to refresh the printer configuration
information in the server.
a. Start the InfoPrint Manager Administration GUI.
b. In the GUI, find the InfoPrint Manager printer (actual destination) that

corresponds to this printer and select it.
c. Use the GUI to disable the printer.
d. Use the GUI to enable the printer again.

Enabling SNMP on an InfoPrint 3000 or an InfoPrint 4000 printer that
uses the operator console

The Operator console is the standard console for the InfoPrint 3000 and the
InfoPrint 4000.
1. On the display/touch screen on the Operator console, open the Configure

pull-down menu.
2. Select Remote Access.
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3. Under Select a Remote Access, select SNMP.
4. Under Enabled, select Yes.
5. Under Allow to Configure, select Yes.
6. Touch OK to close the window.
7. You will be prompted to restart the printer so that these settings can take effect.

Restart the printer, and wait for it to power back up before you continue.
8. Disable the printer and enable it again to refresh the printer configuration

information in the server.
a. Start the InfoPrint Manager Administration GUI.
b. In the GUI, find the InfoPrint Manager printer (actual destination) that

corresponds to this printer and select it.
c. Use the GUI to disable the printer.
d. Use the GUI to enable the printer again.

Enabling SNMP on a printer that uses the Enhanced Operator Console

The Enhanced Operator Console is the standard console for the InfoPrint 4100 and
is available as an upgrade for the InfoPrint 4000.
1. On the Enhanced Operator Console, touch Printer definition at the top of the

screen.
2. On the left side of the screen, touch Remote Access.
3. In the Communities list, select the name of the community you will be using to

access the printer and verify the settings. Make sure that the community has
Write access to the printer.

4. Select the SNMP Agent Enabled and Allow SNMP to Configure Printer
checkboxes, so they both say Yes.

5. Touch OK to save the settings.
6. You might be prompted to restart the printer so that these settings can take

effect. Restart the printer, and wait for it to power back up before you continue.
7. Disable the printer and enable it again to refresh the printer configuration

information in the server.
a. Start the InfoPrint Manager Administration GUI.
b. In the GUI, find the InfoPrint Manager printer (actual destination) that

corresponds to this printer and select it.
c. Use the GUI to disable the printer.
d. Use the GUI to enable the printer again.
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Chapter 36. General Operator and User Procedures

This chapter describes these procedures:
v “Turning duplexing on and off for the InfoPrint 45 and InfoPrint 70”
v “Deleting orphan files and resubmitting jobs to MVS Download” on page 304
v “Using a Windows gateway printer” on page 305
v “Adding an Internet Printing Protocol (IPP) gateway printer to your desktop” on

page 306
v “Submitting jobs through InfoPrint Manager hot folders” on page 306
v “Submitting print jobs through the InfoPrint Manager LPD” on page 308
v “Checking job status” on page 310
v “Interrupting and restarting a job that is currently printing on an InfoPrint

4000/4100” on page 310
v “Stopping, restarting, or pausing a job that is currently printing” on page 311
v “Pausing a job that’s printing” on page 314
v “Moving backward or forward in a job that is currently printing” on page 316
v “Stopping a printer to perform scheduled maintenance” on page 317
v “Fixing a printer problem and starting to print again” on page 318

Turning duplexing on and off for the InfoPrint 45 and InfoPrint 70

If your printer has the capability to duplex and has an option on the console to
turn it on and off, you should understand the hierarchy of duplex processing
options based on your selections.

The InfoPrint 45 and InfoPrint 70 can produce either simplex (single-sided) or
duplex (double-sided) output. You can turn the duplex option ON or OFF at the
printer console, depending upon what type of output you need. However, you can
also turn duplexing on and off using the sides attribute in InfoPrint Manager. If
you use InfoPrint Manager to turn duplexing on or off, the InfoPrint Manager
setting will override the setting on the printer.

You can set the sides attribute on a document, default document, or an actual
destination. You can also specify duplex or simplex in a form definition (formdef).
If you set the attribute in a document, that setting overrides the value in the
formdef. The formdef overrides the setting on the default document, which
overrides the setting on the actual destination. All of these settings override the
setting on the printer console.

Important: The default value of the sides attribute on all three objects (document,
default document, and actual destination) is Use default. When InfoPrint Manager
encounters that value, it considers the attribute ″not set″ and looks to the next item
in the priority list to see if sides is set there. InfoPrint Manager keeps going down
the list until it finds a value to use.

Some examples of this behavior include:
v You turn duplexing OFF at the console of your InfoPrint 45. Then, you submit a

job to your InfoPrint 45 through InfoPrint Manager. The job uses a formdef that
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requests duplex printing. The sides attributes on the document, default
document, and actual destination are set to Use printer default.
InfoPrint Manager looks at the sides attribute on the document, and considers it
″not set,″ so it looks at the formdef. The job prints duplex.

v You turn duplexing OFF at the console of your InfoPrint 70. Then, you use
InfoPrint Submit Express to send a job with Sides set to duplex, and don’t use a
formdef. The sides attributes on the default document is set to Use printer
default and on the actual destination is set to 1.
InfoPrint Manager looks at the sides attribute on the document, and sees that
InfoPrint Submit Express sets it to 2. InfoPrint Manager ignores all of the other
values and the job prints duplex.

For additional information about the sides attribute, see the ″Attributes for
documents and default documents″ section in the ″InfoPrint object attributes″
chapter of the InfoPrint Manager: Reference.

Deleting orphan files and resubmitting jobs to MVS Download
Orphaned files are old files left in the Windows file system because you specified
the Keep CMD file for Resubmitting Jobs check box when you started the MVS
Download receiver to submit the jobs, and errors prevented InfoPrint from
processing these print jobs. Their file names follow the MVS Download Destination
Control file naming format:
MVS_system_name.job_name.dataset_name.forms_name.yyddd.hhmmsstABCD.PRD

Because orphan files can cause performance problems, you should either correct
the problem that prevented the job from processing and then resubmit the job to
MVS Download, or delete the orphan files from the system.

Deleting orphaned files from the system

Orphan files should only occur when there’s an error. If you do not want to
identify and correct errors, delete all files that are older than some site-determined
period, such as three days.

To manually delete individual files:
1. In the Management Console, double-click the MVS Download receiver that

you want to clean out.
2. In the Viewing: Receiver xxx dialog, find the View Job Data field and click

Browse. The orphan and .CMD files that remain on the InfoPrint Manager
server are listed in the MVS Download Receiver Data dialog that opens.

3. Highlight the job to be deleted and right-click it, then select Delete from the
menu that appears.

Resubmitting jobs

Use this procedure to resubmit jobs through MVS Download:
1. In the Management Console, double-click the MVS Download receiver that

received the failed print job.
2. In the Viewing: Receiver xxx dialog, find the View Job Data field and click

Browse. The orphan and .CMD files that remain on the InfoPrint Manager
server are listed in the MVS Download Receiver Data dialog that opens.

3. Right-click the .CMD file that failed.
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4. Click Edit from the menu that appears to open the .CMD file as a text file.
5. Edit the file as you need to and save it.
6. Close the text editor.
7. Back in the MVS Download Receiver Data dialog, select and right-click the

.CMD file again.
8. Click Open from the menu that appears to run the file.
9. In the MVS Download Receiver Data dialog, click Cancel.

10. In the Viewing: Receiver xxx dialog, click Cancel.

If you identify and correct print errors, re-submission of the file to MVS Download
should delete the file once it is successful.

Using a Windows gateway printer
A Windows gateway printer is a Windows shared printer that you create on your
InfoPrint Manager server system. This lets users anywhere in the network to
submit print jobs through InfoPrint Manager. InfoPrint Manager organizes
everyone’s print jobs by putting them in a print queue in the order that it receives
them, then sends them all to the correct printers. In addition, if you have InfoPrint
Manager notifications running on your workstation, InfoPrint manager sends you
messages about the status of your print job.

Users must follow the instructions in “Adding a Windows gateway printer to a
workstation” to add the Windows gateway printer to their desktops.
Administrator’s can use the Management Console to create and administer a
Windows gateway printer. The Management Console help includes instructions.

Note: When InfoPrint Manager is uninstalled, all Windows Gateway printers are
deleted. Therefore, you must have your users manually delete the Windows
Gateway printer from their desktops after the uninstall.

Adding a Windows gateway printer to a workstation

To add a Windows gateway printer to a workstation, instruct your users to follow
the steps below. This procedure assumes that you have already created the
Windows gateway printer on the InfoPrint Manager server system.
1. Locate the share name of the Windows gateway printer.
2. Follow the standard procedure for adding a network printer to your desktop.

This procedure depends on the operating system that you use. For example, on
Windows systems, use the Add Printer Wizard to create a printer that will be
managed by network print server. When you are prompted for the name of the
printer to connect to, enter the share name of the Windows gateway printer.

3. Once the connection to the Windows gateway printer is created, you can print
to it just as you would print to any other printer.

Notes:

1. When the InfoPrint Manager server is uninstalled, any Windows gateway
printers that exist on the server are deleted. However, connections to those
Windows gateway printers that have been added to workstations are still
present; they are still displayed in the Printers window, and you can still try to
print to them from applications. Because the Windows gateway printer on the
InfoPrint Manager server no longer exists, those print jobs will fail. If you try
to print to one of these Windows gateway printer, you will get an
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application-dependent message that does not identify this problem. To resolve
this problem, delete the Windows gateway printer from your desktop and
create a new one once your print system administrator has created a new one.

2. In certain situations, the system might try to use drivers that you have not
intended to be used.
To avoid this situation, load print drivers for each client OS on the InfoPrint
Manager server system so that they can be automatically installed onto client
machines over the network (if they are not already on the client system).

Adding an Internet Printing Protocol (IPP) gateway printer to your
desktop

The Internet Printing Protocol (IPP) is a data transport protocol that lets you print
your documents to any IPP-enabled printer whose IP address you know. You can
use IPP to send print data over both LANs and the Internet, so you can send print
jobs to a network printer from your desk, your home office, or anywhere that you
find an Internet connection. Not all printers are currently enabled to work with
IPP. However, InfoPrint Manager provides an IPP gateway (a mechanism that lets
you use IPP) even if your printers are not IPP-enabled.

Note: You must work with your InfoPrint Manager Administrator to have the IPP
gateway enabled through the Management Console.

An Internet Printing Protocol (IPP) gateway printer is a printer that you create on
a client workstation using IPP client software, such as the Windows 2000 IPP
client. Users submit print jobs to that printer, and they are sent to InfoPrint
Manager through the InfoPrint IPP gateway. The IPP gateway can then send the
job on to any InfoPrint printer, even those that are not IPP-enabled.

To be able to print through an IPP gateway, you must first have IPP client software
installed on your workstation or laptop. IPP client software is available from
various printer vendors; check with your printing system administrator to see
which IPP client your company is using. Once you have the IPP client software
installed, to set up to print through the IPP gateway:
1. Ask your printing system administrator for the address of the printer that you

want to print to.
2. Follow the instructions provided with your IPP client software for adding a

printer to your desktop. When you are asked for the address of the printer,
enter the address that you got in step 1.

3. Once the printer is added, you can print to it just as you would any other
printer.

Submitting jobs through InfoPrint Manager hot folders

Mapping a network drive
On the end user system, use the standard Windows method to map a network
drive (available in Windows Explorer) to the InfoPrint Manager hot folder. If there
are multiple hot folders in the same directory, you only have to map one network
drive to the parent directory; you will be able to access all of the subdirectories
through it.
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Submitting jobs through a hot folder

To submit a job through a hot folder, simply copy or move the print file to the hot
folder.

Note: If you experience problems with hot folders submitting incomplete jobs to
the InfoPrint Manager server, use the method described in “Staging jobs.”

Attention: To save the file, copy it. Files are deleted from the hot folder after
submission.

Specifying job attributes

By default, jobs submitted through a hot folder use the attribute values in the
default document and default job associated with the logical destination; and also
by default, hot folder jobs are submitted to InfoPrint Manager with job
notifications turned off. To receive notifications about jobs that you submit through
hot folders, you must specify a notification-profile with an explicit
delivery-address in the .att file. To specify other attributes or use different values
for existing attributes, complete these steps.
1. Either on your system or in the hot folder itself, create a text file to use as your

attributes file. Name the attributes file filename.att, where filename is the same as
the file name of the print file. For example, if the print file is report.pdf, the
attributes file is report.pdf.att.

2. In the attributes file, specify the InfoPrint attributes and values that you want
to use for this job. For example, to print three single-sided copies of
report.pdf, report.pdf.att looks like this:
copy-count = 3
sides = 1

Note: The attributes file is in the same format as a –X file passed to a pdpr
command.
For information about job and document attributes, see InfoPrint Manager:
Reference.

3. If you created the attributes file on your system, copy or move the file to the
hot folder. The InfoPrint Manager logical destination recognizes the .att file
extension as an attributes file and knows not to try to print it.

4. Copy or move the print file to the hot folder. The InfoPrint Manager logical
destination sees the print file and looks for an attributes file with the same file
name. Both of the files are taken and your attributes are used.

Staging jobs

You can stage jobs to InfoPrint Manager with this procedure:
1. Make a copy of the print file on your local system.

You will end up with 2 files: report.pdf and copy of report.pdf.
2. Rename the copy of the print file so that it has the same name as the original

print file and the extension .stg.
Rename copy of report.pdf to report.pdf.stg.

3. Copy the new file to the hot folder.
Copy report.pdf.stg and paste it in the hot folder.

Note: The InfoPrint Manager logical destination ignores files with the .stg
extension.
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4. Change the extension back to the original extension when you want the job to
print.
Rename report.pdf.stg back to report.pdf. InfoPrint Manager will pick up the
renamed file and send it to print.

Submitting multiple-document jobs

You can use staging to print jobs that contain multiple documents. In this case, you
stage an entire directory. The InfoPrint Manager logical destination prints the
documents as one job, in the order that you copied the files into the directory.
1. Navigate to the hot folder (using Windows Explorer, for example).
2. In the hot folder directory, create a new folder named jobname.stg, where

jobname is any name you choose.

Note: The InfoPrint Manager logical destination ignores directories with the
.stg extension.

3. Copy the documents you want to print into the subdirectory in the same order
that you want to print them.

Note: If you copy multiple files in a single operation, they might not be copied
in the same order that you selected them. If the print order matters, copy the
files one at a time.

4. To override the default attributes, create an attributes file called jobname.att,
where jobname is the same as the subdirectory name, and copy it into the hot
folder.

5. Rename the subdirectory from jobname.stg to jobname. The InfoPrint Manager
logical destination then accepts all of the files in the subdirectory as a single
job.

Submitting print jobs through the InfoPrint Manager LPD
The InfoPrint Manager Line Printer Daemon (LPD) is a utility that lets you submit
print jobs from other operating systems using a Line Printer (LPR) client. The
InfoPrint Manager LPD replaces the LPD that is supplied with the Windows
operating system (TCP/IP Print Services), however, it submits the files it receives
directly to an InfoPrint destination, not to a Windows printer. It also supports the
-o options that are available with some LPR clients (-o options let you specify
advanced InfoPrint print options such as formdefs and pagedefs).

Only one LPD can run on your InfoPrint Manager server system at a time. If you
have TCP/IP Print Services installed, InfoPrint Manager disables it and enables the
InfoPrint Manager LPD. If you would prefer to use TCP/IP Print Services, use the
Management Console to change the service configuration. See the Management
Console help for further instructions.

Important: If you have a different LPD installed, InfoPrint Manager does not
disable it, but installs and starts the InfoPrint Manager LPD. You must stop one of
the LPDs before you try to submit a print job using an LPR client.

To submit print jobs to the InfoPrint Manager LPD, you can use any LPR client.
However, to be able to specify advanced InfoPrint options on the –o flag, you
should use the lprafp sample code package. lprafp is an LPR client that is
available as a free download from the InfoPrint Solutions Company Web site. The
package includes executable forms of the lprafp client for the Windows and AIX
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(version 5.1 and later) platforms. You can compile this code to use it on other
platforms as well. InfoPrint Solutions Company does not provide support for the
package.

Note: The Microsoft LPR client supports a –o flag, but it is not the same as the
InfoPrint –o. Any values you pass to InfoPrint Manager using the Microsoft –o flag
will be lost. In addition, some LPR clients provide print control functions, such as
landscape print. The InfoPrint Manager LPD does not support these options.

Install and configure lprafp for Windows from the Web

For Windows operating system clients, the lprafp sample code package is available
for free download from the InfoPrint Solutions Company Web site at
http://www.infoprint.com. Use this procedure to locate and install the package:
1. Navigate to http://www.infoprint.com in your Web browser.
2. Click Support and maintenance.
3. Select InfoPrint Manager for Windows in the Software Support list.
4. On the InfoPrint Manager for Windows Home page, click Downloads.
5. On the Downloads page, click InfoPrint Manager for Windows NT and

Windows 2000 downloads.
6. Click lprafp - LPR sample code package and click FTP.
7. Save the lprafp.zip file to your machine.
8. Use a zip utility to unzip the package.
9. Open the readme.txt file and follow the instructions for installing the package

on a Windows system.

Preparing to submit print jobs

When you submit jobs to the InfoPrint Manager LPD, it uses a mapping file to
match the keywords you specify on the -o option with InfoPrint attributes. A
sample mapping file comes with InfoPrint Manager for Windows; before you
submit any print jobs to the InfoPrint Manager LPD, you should modify this file to
meet your needs.

To modify the mapping file do this:
1. Open the file <install path>\var\pd\lpd\lpdmap.txt (where <install path> is

the directory where InfoPrint Manager is installed) in a text editor such as
Notepad.

2. Read all of the instructions in the mapping file before you make any changes.
3. Edit the mappings as necessary and save the file using the same name.

Because all LPR clients use different keywords, it is impossible to list them all. The
mappings listed are ″best guess″ mappings and might not generate the results you
need. The best way to see what values you need to add or change is to
uncomment the line that reads:

* DEBUG

and save the file. (To uncomment the line, delete the *.) Submit a print job through
the LPD and check the output. If the job fails or if it prints incorrectly, check the
error messages in the server log in the Management Console. Use them to help
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determine which keywords are missing or mapped incorrectly. When you are
finished, be sure to open the mapping file and comment the DEBUG line out
again.

Submitting print jobs
When you submit print jobs using the LPR client, all you need to specify is the
InfoPrint Manager server and the name of an InfoPrint destination (logical or
actual). The InfoPrint Manager LPD submits the job to the InfoPrint print spool.

Checking job status

This section describes some ways you can find out the status of print jobs that you
submit through InfoPrint Manager.

Checking status using notifications

The easiest way to find out the status of print jobs that you submit is to have
InfoPrint Manager send you messages about them. You can use the InfoPrint
Manager Notifications client, or if you submitted the job using Select, you can use
Select notifications. Installing and setting up the Notifications client is described in
the InfoPrint Manager for Windows: Planning and Installation Guide book. In addition,
see Chapter 7, “Using InfoPrint Manager notifications,” on page 19 and “Working
with Select notifications” on page 22 for more detailed instructions about using the
Notifications client and Select notifications.

Checking status from the Printers window

If you cannot or choose not to use InfoPrint Manager notifications, you might be
able to check the status of your jobs manually. If you submit jobs to a Windows
gateway printer or to a Select printer, follow these steps:
1. Click the Windows Start button, and select Settings → Printers to open the

Printers window.
2. In the Printers window, double-click the printer that you sent your job to. The

job window for that printer will open.
3. Find your job in the list of documents. If the job isn’t in the list, it might be

finished printing.

Note: For Windows gateway printers, print jobs will appear in this list only if
the gateway was configured to report accurate job status back to workstations.

Interrupting and restarting a job that is currently printing on an
InfoPrint 4000/4100

Use this procedure:
v To interrupt the job that is currently printing and start printing it again
v To interrupt the job that is currently printing, print another job, and then start

the job that you interrupted.
v To interrupt the job that is currently printing, move the job to a different printer,

and start printing the job again.

This procedure does NOT stop the printer; it only stops the job that is currently
printing. Other jobs continue to print on this printer.
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Once the job is stopped, the next job in the queue will start to print. To stop the
printer (for example, to replace toner), use the procedure “Stopping a printer to
perform scheduled maintenance” on page 317.

Note: Refer to the online help in the InfoPrint Manager GUI if you need
instructions on completing any of these steps.

When you use the “Interrupting a job that is currently printing” procedure, the job
fills a physical sheet, stops, and prints a message after the last page indicating the
number of the last (AFP) page printed. The job shows on the GUI as Paused.
When the job restarts, it starts on the next page of the job in the next logical
partition. InfoPrint Manager prints a message at the end of the restarted section of
the job indicating the page on which the printing started. You might want to use
this procedure if you are printing a very long job, and you need to print another,
more urgent job immediately.

Interrupting a job that is currently printing
1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager

Administration GUI.
2. In the GUI, find the printer where the currently printing job is, and select it.
3. Right-click on the printer, and select Interrupt Printing Job or left-click on the

printer and then left-click on the icon on the toolbar.

Note: If the Interrupt Printing Job action does not appear on the Printer menu
or toolbar, use the Customize dialog to add the action.

4. Select from these options:
v Click Now to interrupt the job as soon as possible
v Click After current copy to interrupt the job after the current copy has

finished printing.
5. Click OK.

The job that is currently printing stops printing, its icon changes to black, and
the job is listed in the job window of the main InfoPrint Manager GUI window.
Other jobs continue to print on this printer.

Restarting the interrupted job
To restart the interrupted print job:
v In the GUI, right-click on the interrupted job and select Resume.
v Select the job and left-click on the

icon on the toolbar.

Stopping, restarting, or pausing a job that is currently printing

Use this procedure to stop printing a job and start printing it again or to stop
printing a job, move it to a different printer, and start printing again. If you are
printing an AFP print job, you can also use this procedure to stop printing a job
and start it again from any page in the job, not just from the beginning.

This procedure does NOT stop the printer; it only stops the job you select.
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Once the job is stopped, the next job in the queue will start to print. To stop the
printer (for example, to replace toner), use the procedure “Stopping a printer to
perform scheduled maintenance” on page 317.

Note: If you need instructions on completing any of these steps, see the online
help in the InfoPrint Manager GUI.

When you use the “Stopping the job” procedure, InfoPrint Manager considers the
job cancelled and does not collect any checkpoint information about the job. Unless
the operator changes the page range before releasing the job to print again, the job
restarts printing at page 1. Be sure to remember any n-upping associated with the
job when selecting the page range so that the pages are placed into the correct
partition in relation to each other. You might want to use this procedure when you
realize that a job has started to print on the wrong form.

Stopping the job
1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager

Administration GUI.
2. In the GUI, find the job that you want to stop and select it.
3. Click Job → Hold.

Note: If the Hold item doesn’t appear in the Job menu, use Add/Remove
Menu Items to add it.

4. Click OK.
The job stops printing, the icon changes to black, and the job is listed in the job
window of the main InfoPrint Manager GUI window.

Restarting the job

Use this procedure to do one of these:
v Print the entire job on the same printer it was printing on before.
v Print the entire job on a different printer.
v Print part of the job (such as page one to page fifty, or page twelve to the end).

Important:

– When you use Job → Hold, the job information resets to the beginning of the
job. Checkpoint information is not stored.

– You can only start printing in the middle of the job if the job is transformed
to AFP before it gets printed. You cannot print part of an ASCII, KGL,
metacode, or LCDS job; you have to print the whole job.

– You can only start printing in the middle of the job if the job has only one
printable document. If it has more than one printable document, you either
have to print the whole job or use spacing to skip a section of the job. See the
“Moving backward or forward in a job that is currently printing” on page 316
for instructions on spacing.
If you submitted this job using DPF from a host system, you can start
printing from any page in the job, but InfoPrint Manager ignores any value
you enter for the end page. You will always print to the end of the job.

Note: Spacing will only work if you send the job to a PSF DSS printer.

To restart the print job:
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1. To print the entire job on the same printer it was printing on before, select the
job in the job window and click Job → Release. The job will start printing from
the first page.

2. To print the entire job on a different printer, skip to Before you Continue
between steps 8 and 9 below.

3. To print part of the job, figure out what page you want to start printing from.

Important: If you don’t want to start printing from the first page of the job,
be careful when you choose which page to start with. Duplex and n-up jobs
can be confusing because you have to start printing with the first page on the
front side of the sheet of paper. If you don’t choose the correct start page, the
job will print, but the sequence will probably be wrong.

For example, if you are printing a 2–up duplex job, each sheet of paper
actually has four pages printed on it, like this:

Table 47. 2–up duplex print job: front and back views

Front of sheet Back of sheet

Sheet one

page 1 page 3 page 4 page 2

Sheet two

page 5 page 7 page 8 page 6

Last sheet

page n-3 page n-1 page n page n-2

Since you have to start printing this job at the first page on the front side, you
can choose page one or page five (or any other page that would fall in that
position). If you choose a different page, the sequence of pages will be wrong,
and the job won’t print correctly.

4. Figure out what page you want to stop printing on (if you don’t want to print
all the way to the end of the job).
You don’t have to be as precise on the last page to print; the last page can be
in any location on the sheet of paper.

5. Select the job you want to print.
6. With the job selected, click Job → Change Page Range to Process.

If you don’t see the Change Page Range to Process item in the Job menu, use
Add/Remove Menu Items to add it.
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7. In the Change Page Range to Process dialog, select Range of Pages and type
the start page and end page you decided.

Note: If you submitted this job using Distributed Print Facility (DPF),
InfoPrint Manager ignores the end page that you specify. DPF jobs always
print from the start page you specify to the end of the job.

8. Click OK.
Before you continue:

You should only move a job to an InfoPrint printer that uses the same
destination support system (DSS) as the one the job was originally submitted
to. If you move the job to a printer that uses a different DSS and the new
printer doesn’t support all of the attributes of the job, the job will fail to print.
To check which DSS your InfoPrint printer uses:
a. Select the printer in the tree view of the Main window of the InfoPrint

Manager GUI.
b. See if the Type column appears in the details view. The Type column

displays the DSS that the InfoPrint printer uses.
c. If you don’t see the Type column, use Add/Remove menu items to add it.

Continue with step 9.
9. Select the job again and click Job → Move job.

10. In the Move Jobs dialog, select the printer to print the job on. You can choose
the same printer it was printing on before or a different one.
When you release the job in step 12 below, if the job is accepted it will go
back into the queue and wait to be printed. Depending on how many jobs are
ahead of it in the queue, it might take a while for the job to print. To print the
job right away, you can either move it to the top of the queue (so it prints
next) or you can change its priority (so it prints sooner, but not necessarily
next).

11. To move the job to the top of the queue, select the job in the InfoPrint
Manager GUI and use the Make Job First task. To change the priority of the
job, use the Change Priority task.

12. Select the job in the job window and click Job → Release.

Note: If the task you want to use doesn’t appear in the menu, use
Add/Remove menu items to add it.

Pausing a job that’s printing
1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager

Administration GUI.
2. Find the job that you want to pause and select it.
3. Click either Job → Pause → Now or Job → Pause → After current copy.

Note: If the Pause item doesn’t appear in the Job menu, use Add/Remove
Menu Items to add it.

4. Click OK.
The job will stop printing, the icon will change to black, and the job will be
listed in the job window of the main InfoPrint Manager GUI window.

5. To resume the printing of this job, click Job → Resume.
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Pausing a job that’s printing

When you use the use this procedure, InfoPrint Manager stops the job, checks to
see if the paused job is indeed the job currently printing, and collects checkpoint
information about the job if it is. The job shows on the GUI as Paused. Assuming
that the operator does not take actions that invalidate the checkpoint information
when the job is resumed, it should restart at the checkpoint boundary. If the
checkpoint information is invalidated, the job restarts at page 1 unless the operator
changes the page range before resuming the job. Changing the job attributes so
that the job would have to be re-ripped before printed is an example of an action
that would invalidate the checkpoint information.
1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager

Administration GUI.
2. Find the job that you want to pause and select it.
3. Click either Job → Pause → Now or Job → Pause → After current copy.

Note: If the Pause item doesn’t appear in the Job menu, use Add/Remove
Menu Items to add it.

4. Click OK

The job will stop printing, the icon will change to black, and the job will be
listed in the job window of the main InfoPrint Manager GUI window.

5. To resume the printing of this job, click Job → Resume.

Pausing and restarting an actual destination

Use these procedures to pause and restart an actual destination. You might want to
pause an actual destination when you are printing a long job, so that you can
perform maintenance on the printer.

Pausing an actual destination
1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager

Administration GUI.
2. In the GUI, find the actual destination you want to pause.
3. Right-click on the actual destination, and select Stop or left-click on the actual

destination and then left-click on the icon on the toolbar.

Note: If the Stop action does not appear on the menu or toolbar, use the
Customize dialog to add the action.

4. Select from these options:
v Click Now to pause the actual destination
v Click After current copy to pause the actual destination after the current

copy has finished printing.
v Click After current job to pause the actual destination after the current job

has finished printing.
5. Click OK.

The actual destination stops printing, and the jobs processing on the actual
destination stay in the same state until the actual destination starts again.
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Resuming the actual destination
To resume the actual destination:
v In the GUI, right-click on the actual destination and select Resume.

v Select the actual destination and left-click on the icon on the toolbar.

Moving backward or forward in a job that is currently printing
In InfoPrint Manager, moving from page to page in a job is called spacing the
printer:
v Forward spacing is moving to a point later in the job (such as skipping from page

10 to page 15).
v Backspacing is moving to a point earlier in the job (such as backing up from page

40 to page 20).

Spacing a printer

Things to remember:

v You can only space a printer that uses the PSF Destination Support System
(DSS) and one of these attachment types:

– PSF TCP/IP
– PSF BSD
– PSF Other
To see what DSS your printer uses, do this:
1. Select the printer in the tree view of the Main window of the InfoPrint

Manager GUI.
2. See if the Type column appears in the details view. The Type column

displays the DSS that the InfoPrint printer uses.
3. If you don’t see the Type column, use Add/Remove menu items to add it.

v You can only space a printer after a job has already started to print.

If you only want to print a section of a job (such as page 11 to page 20) or to
start printing from a page other than the first page of the job, use the Change
Page Range to Process task in the InfoPrint Manager GUI.

v Spacing works better on high-speed printers than on low speed printers.

While spacing is supported on all printers that you print to using the PSF DSS,
it is very difficult to space printers that print 40 pages per minute (ppm) or less.
Spacing works adequately on printers that print between 60 and 100 ppm, and
works very well with high-speed InfoPrint printers that are configured correctly.

v The InfoPrint 2000, InfoPrint 3000, InfoPrint 4000, and InfoPrint 4100 printers
require additional configuration for spacing to work efficiently.

See the Setting up high speed printers for spacing topic for instructions on
configuring your printer.

v Page numbers refer to pages of the print job, not necessarily to any page
numbers in your document.

For example, in a book, the first page of chapter one is usually ″page 1.″
However, it might be page 15 of the print job, because of the title page, credits,
and table of contents.

v You cannot space to the back side of a sheet of paper.

If you are printing a duplex job, you will always print both the front and back
sides of the sheet of paper that you space to.

316 InfoPrint Manager for Windows: Procedures



To space a printer, do this:
1. Start the InfoPrint Manager GUI.
2. In the GUI, find the InfoPrint printer that you need to space.
3. Select the InfoPrint printer by clicking on it, then click Printer → Stop.

Note: If you don’t see Stop in the menu, useAdd/Remove menu items to add
it.

4. In the Stop printer_name dialog, select Pause and Now, and click OK.
Even though you selected Now, the printer will keep printing for a while
because it has to get to a point in the job where it can stop. For InfoPrint 2000,
InfoPrint 3000, and InfoPrint 4000 printers that are configured correctly, you
shouldn’t have to wait more than 10 seconds. For other printers, you might
have to wait longer.

5. Once the printer has stopped printing, look at the last sheet that printed.
Write down the number of that sheet of the job.

6. Figure out what sheet of paper in the job you want to space to. Write down
the number of that sheet of the job.

7. Figure out the number of sheets of paper you need to space.
v To forward space the printer:

Subtract the number of the sheet that printed last (from step 5) from the
number of the sheet that you want to skip to (from step 6), and then
subtract one. Like this:
(number from step 6) – (number from step 5) – 1 = number of sheets to skip

v To backspace the printer:
Subtract the number of the sheet that you want to go back to (from step 6)
from the page that printed last (from step 5), and add one (for the current
page). Like this:
(number from step 5) – (number from step 6) + 1 = number of sheets to
back up

8. Determine the number of ″sides″ to space the printer.
v If you are printing a simplex job, the number of sides is the same as the

number of sheet from step 7.
v If you are printing a duplex job, multiply the number from step 7 by two to

get the number of sides. (number from step 7 x 2 = number of sides)
9. In the InfoPrint Manager GUI, find the printer you want to space and select it.

10. With the printer selected, click Printer → Space.
11. In the Space printer_name dialog, select Backspace or Forward space and type

the number of sides you found in step 8.
12. Click OK.
13. Make sure the printer is still selected and click Printer → Resume to start the

printer again.

Stopping a printer to perform scheduled maintenance

Use this procedure to stop a printer so you can perform routine maintenance, such
as updating the microcode, changing paper, or cleaning the printer. While you
have the printer stopped, InfoPrint Manager will not be able to send or schedule
jobs to it. This procedure will work for printers that use any DSS.
1. Open the InfoPrint Manager Operations GUI or the InfoPrint Manager

Administration GUI.
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2. In the GUI, find the printer that you want to stop and select it.
3. Use Printer—>Disable to disable the printer.

The InfoPrint printer will stop accepting jobs, but the printer will not stop
printing immediately. All of the jobs that were in the processing state before
you disabled the printer will print before it stops.

4. After the printer stops printing, you can perform whatever maintenance you
need to.

5. When you are finished and the printer is ready to receive jobs again, go back to
the InfoPrint Manager GUI.

6. Find the printer in the GUI and select it.
7. Use the GUI to enable the printer again.

The printer will be available to accept and print jobs again.

Fixing a printer problem and starting to print again

Use this procedure when the printer stops printing because of a paper jam, ″out of
paper″ error, or for some other reason.

Note: Refer to the online help in the InfoPrint Manager GUI if you need
instructions on completing any of these steps.

Try this first

″Out of paper″ errors and some paper jams are easy to recover from. Most of the
time, you don’t have to do anything to InfoPrint Manager to fix them; InfoPrint
Manager just waits until the printer is ready to print again. While it is waiting,
InfoPrint Manager continues to accept jobs and schedule them to the printer.

If the printer stops printing because of a problem, first try this.
1. Check the printer.
v If a lot of pages of the job are ruined and need to be reprinted, stop here.

Don’t finish this procedure. Use the “Fixing more complicated problems”
procedure below instead.

v Otherwise, load paper if the bins are empty or clear paper jams as the printer
console indicates. Once everything is clear, the printer should reset itself and
continue sending jobs. InfoPrint Manager should pick up where it left off.

2. Find the printer in the InfoPrint Manager GUI. Make sure that its status is
ready. If it is not, select the printer and use the GUI to enable it.

3. If just a few pages of the print job need to be printed again, the easiest thing to
do is to resubmit the job and print just those pages. You can only print part of
the job if you are using the PSF DSS and if the job will be transformed to AFP
before it is printed.

Fixing more complicated problems

Use this procedure when the problem is more difficult to fix or if you have to
reprint numerous pages of a job.
1. Open the InfoPrint Manager GUI.
2. Find the InfoPrint Manager printer (also called an actual destination) that

sends jobs to that printer and select it.
3. Use the GUI to disable the printer.
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The printer won’t be able to accept any print jobs until you enable it again.
4. If the printer stopped printing in the middle of a job, find that job in the GUI

and select it.
5. With the job selected, click Job → Hold.

Note: If the Hold item doesn’t appear in the Job menu, use Add/Remove
Menu Items to add it.

6. Click OK.
The job will stop printing, the icon will change to black, and the job will be
listed in the job window of the main InfoPrint Manager GUI window.

7. Decide what you want to do with any other jobs that are in the queue waiting
for this printer. Some of the options are:
v Leave them in the queue, so they print when you enable the printer again.

If you can fix the problem quickly, this option is the easiest one. In addition,
if your printers are pooled, the other printers will take care of all of the jobs
until this one is ready.

v Move them to a different printer so they can be scheduled to print while
you are working on this one.

v Delete them. You should only consider this option if it is easier to resubmit
the jobs than to use other methods to recover them.

8. Fix the problem at the printer.
Once the problem is fixed, the printer might start to print again, just to clear
the pages that were in the buffer before you disabled it and deleted the job. If
any other jobs were in processing state when you disabled the printer, they
will print as well.

9. Go back to the InfoPrint Manager GUI, find the InfoPrint printer again, and
select it.

10. Use the GUI to enable the printer.
The printer will be available to accept jobs again. If you left jobs in the queue,
the printer should start accepting and printing them.

Restarting the job that was printing when the problem
occurred

You can either:
v Start the job from the beginning.
v Start the job from a point before the problem occurred (so the ruined pages get

printed).
Important:

– You can only start printing in the middle of the job if the job is transformed
to AFP before it gets printed. You cannot print part of an ASCII, KGL,
metacode, or LCDS job; you have to print the whole job.

– You can only start printing in the middle of the job if the job has only one
printable document. If it has more than one printable document, you either
have to print the whole job or use spacing to skip a section of the job. Refer
to the Moving backward or forward in a print job that’s already printing
topic for instructions on spacing.

Note: Spacing will only work if you send the job to a PSF DSS printer.
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1. To print the entire job on the same printer it was printing on before, select the
job in the job window and click Job → Release. The job will start printing from
the first page.

2. To print the entire job on a different printer, skip to Before you Continue
between steps 8 and 9 below.

3. To print only part of the job, figure out what page you want to start printing
from.

Important: If you don’t want to start printing from the first page of the job,
be careful when you choose which page to start with. Duplex and n-up jobs
can be confusing because you have to start printing with the first page on the
front side of the sheet of paper. If you don’t choose the correct start page, the
job will print, but the sequence will probably be wrong.

For example, if you are printing a 2–up duplex job, each sheet of paper
actually has four pages printed on it, like this:

Table 48. 2–up duplex print job: front and back views

Front of sheet Back of sheet

Sheet one

page 1 page 3 page 4 page 2

Sheet two

page 5 page 7 page 8 page 6

Last sheet

page n-3 page n-1 page n page n-2

Since you have to start printing this job at the first page on the front side, you
can choose page one or page five (or any other page that would fall in that
position). If you choose a different page, the sequence of pages will be wrong,
and the job won’t print correctly.

4. Decide what page you want to stop printing on (if you don’t want to print all
the way to the end of the job).
You don’t have to be as precise on the last page to print; the last page can be
in any location on the sheet of paper.

5. Select the job you want to print.
6. With the job selected, click Job → Change Page Range to Process.
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If you don’t see the Change Page Range to Process item in the Job menu, use
Add/Remove Menu Items to add it.

7. In the Change Page Range to Process dialog, select Range of Pages and type
the start page and end page you decided above.

Note: If you submitted this job using Distributed Print Facility (DPF),
InfoPrint Manager ignores the end page that you specify. DPF jobs always
print from the start page you specify to the end of the job.

8. Click OK.
Before you continue:

You should only move a job to an InfoPrint printer that uses the same
destination support system (DSS) as the one the job was originally submitted
to. If you move the job to a printer that uses a different DSS and the new
printer doesn’t support all of the attributes of the job, the job will fail to print.
To check which DSS your InfoPrint printer uses:
a. Select the printer in the tree view of the Main window of the InfoPrint

Manager GUI.
b. See if the Type column appears in the details view. The Type column

displays the DSS that the InfoPrint printer uses.
c. If you don’t see the Type column, use Add/Remove menu items to add it.

Continue with step 9.
9. Select the job again and click Job → Move job.

10. In the Move Jobs dialog, select the printer that you want to print the job on.
You can select the same printer it was printing on before or a different one.
When you release the job in step 12 below, if the job is accepted it will go
back into the queue and wait to be printed. Depending on how many jobs are
ahead of it in the queue, it might take a while for the job to print. If you want
the job to print right away, you can either move it to the top of the queue (so
it prints next) or you can change its priority (so it prints sooner, but not
necessarily next).

11. To move the job to the top of the queue, select the job in the InfoPrint
Manager GUI and use the Make Job First task. To change the priority of the
job, use the Change Priority task.

12. Select the job in the job window and click Job → Release.

Note: If the task you want to use doesn’t appear in the menu, use
Add/Remove menu items to add it.
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Part 6. Appendixes
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Appendix A. IPDS print operator commands

InfoPrint Manager offers a comprehensive set of operator commands that can be
used to manage printing on IPDS printers. These commands can be used to help
manage printing priorities and also help by providing the operator with functions
that are useful when dealing with problems that might occur in the printing
system. This table describes several of the most commonly used operator tasks,
and their corresponding commands. For more information, see the .

Task Description InfoPrint Manager Command
Syntax

1 Disable
Stop a printer from receiving
new jobs.

pddisable -cd dest where dest
specifies either a logical or an
actual destination (printer) object.

2 Enable
Allow a printer to receive
new jobs.

pdenable -cd dest where dest
specifies either a logical or an
actual destination (printer) object.

3 Query active job

Query which job is actively
printing on a printer
Note: The query response is
based on the last set of
station counters obtained
from the printer, which is
printing pages continuously.
To get an absolutely accurate
query you must:

v Pause the printer (7)

v Enter the query

v Resume the printer (11).

pdls -f ″destination-name-
requested==ldest &&
current-job-state==printing″
server: where server specifies the
InfoPrint AIX server to which the
job was submitted, and
destspecifies the actual destination
(physical printer).

4
Query page
number

Query the page number of
the currently printing page.
See Note after (3).

pdls -cj -r current-page-printing
jobid where jobid specifies the
job-identifier attribute. IBM
recommends using the global ID,
which follows the convention
server:0123456789 where server
specifies the name of the InfoPrint
AIX server to which this job was
submitted and 0123456789
indicates a 10-digit numeric value
assigned by the InfoPrint spooler.
You can determine the
job-identifier attribute value by
specifying: pdls -cj server:

5
Query job
details

Query the number of copies,
sheets and pages stacked for
a job. See Note after (3).

pdls -cj -r ″job-copies-completed
media-sheets-completed
pages-completed″ jobid where
jobid specifies the job-identifier
attribute.

6 Clean
Remove all jobs from a
printer.

pdclean ldest where ldest specifies
the logical destination (logical
printer).
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Task Description InfoPrint Manager Command
Syntax

7 Pause printer Pause a printer immediately.
pdpause -cd dest where dest
specifies the actual destination
(physical printer).

8 Pause printer
Pause a printer after the
current copy completes.

pdpause -cd -w after-current-copy
dest where dest specifies the
actual destination (physical
printer).

9 Pause printer
Pause a printer after the
current job completes.

pdpause -cd -w after-current-job
dest where dest specifies the
actual destination (physical
printer).

10 Resume printer
Resume a printer that had
been paused.

pdresume -cd dest where dest
specifies the actual destination
(physical printer).

11 Cancel job Cancel a specific job.
pdrm jobid where jobid specifies
the job-identifier attribute.

12 Pause job
Pause a specific job after the
current copy completes.

pdpause -cj -w after-current-copy
jobid where jobid specifies the
job-identifier attribute.

13 Pause job
Pause a specific job
immediately.

pdpause -cj jobid where jobid
specifies the job-identifier
attribute.

14 Pause job
Pause the job that is
currently printing
immediately.

pdpause -cd -j dest where dest
specifies the actual destination
(physical printer).

15 Pause job
Pause the job that is
currently printing after the
current copy.

pdpause -cd -j -w
after-current-copy dest where dest
specifies the actual destination
(physical printer).

16 Resume job
Resume a job that was
paused.

pdresume -cj jobid where jobid
specifies the job-identifier
attribute.

17 Back space
Back space (reprint a specific
number of sides) the job that
is printing.

pdspace -cd -b sidecount dest
where dest specifies the actual
destination (physical printer).

18 Reprint
Reprint the job that is
printing from the beginning.

pdspace -cd -b -1 dest where dest
specifies the actual destination
(physical printer).

19 Forward space
Forward space (skip a
specific number of sides) the
job that is printing.

pdspace -cd -f sidecount dest
where dest specifies the actual
destination (physical printer).

If one of these commands is received and it affects a job that has been sent or is in
the process of being sent to the printer, InfoPrint Manager immediately stops
sending data to the printer and sends the printer a command to stop printing (this
applies to commands 7, 9, 10, 12-15).

For printers that support , like the InfoPrint 4000, the printer will stop in a few
seconds. For printers without this support, some pages will likely print before the
printer stops.
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The number of pages that print before the printer stops will vary depending on the
number, size, and complexity of jobs that are in process as well as the speed and
type of printer involved. Once the printer has stopped, InfoPrint Manager
performs the steps necessary to execute the requested operator command.
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Appendix B. IPDS error recovery

When driving an IPDS printer, InfoPrint Manager sends page and resource data to
the printer. The printer reports status and errors back to InfoPrint Manager. The
printer status information is in the form of station counters representing progress
of pages sent to the device through the printer microcode and the physical printing
mechanism. Station counters report the number of pages and the number of copies
of pages proceeding through each point in the printer.

InfoPrint Manager requests printer status information (an acknowledgement
request) after sending each job. The acknowledgement response contains the latest
values of all the printer station counters. Once all pending jobs have been
processed, InfoPrint Manager polls the printer periodically until all the pages of
each job have been stacked.

The actual destination object ack-interval attribute is configurable and defines how
often InfoPrint Manager requests updated station counters from the printer while
processing a particular job. The value for this attribute is specified in terms of
pages and can be from 1 to 9999; the default value is 100 pages. For a 360 page job,
an ack-interval setting of 100 pages means that InfoPrint Manager will send an
acknowledgement request to the printer after sending pages 100, 200, 300, and 360.

The printer responds to an acknowledgement request and returns station counters
when all of the pages up to that point have been processed. This does not
necessarily mean that all of those pages have printed or are stacked. The
acknowledgement response from the printer after the 100th page will show that
100 pages have been processed (received). The printer might report, however, that
only 10 pages have stacked.

The ack-interval value affects printing performance and the currency of job status
information. A small ack-interval value causes increased communication and
processing and can cause a reduction in printer throughput. A small ack-interval
value will, however, increase the frequency that job attributes such as
current-page-printing, job-copies-completed, media-sheets-completed, and
pages-completed are updated. A small ack-interval value will also enable the
InfoPrint Manager software to have more recent station counters than it would
with a large ack-interval value.

Errors reported from the printer can be grouped into these categories:
v “IPDS error recovery: Data stream errors”
v “IPDS error recovery: Insufficient memory in the printer” on page 331
v “IPDS error recovery: Intervention required conditions” on page 332
v “IPDS error recovery: Unrecoverable problems” on page 333

IPDS error recovery: Data stream errors

For data stream errors, the job might continue printing or the job might be
terminated, depending on the severity of the error. There are hundreds of specific
data stream errors. If one data stream error is defined for the error, InfoPrint
Manager directs the printer to continue processing the page and take an alternate
exception action.
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When a data stream error occurs, messages are produced describing the problem
and the recovery actions performed. The messages report details about the error
and include the page number where the error occurred. After InfoPrint Manager
receives a data stream error from the printer and produces a message, it uses
station counters returned from the printer to continue printing without skipping or
reprinting any pages.

Reporting of some data stream errors (using undefined code points in a font or
printing outside of the valid printable area) can be controlled with job attributes.
This allows the job submitter to decide whether error messages or printer error
marks should be generated when the these type of errors are encountered:
v “Data stream error example 1 (job continues printing):”
v “Data stream error example 2 (job is terminated, no pages print):”
v “Data stream error example 3 (job is terminated; some pages print):” on page

331

Data stream error example 1 (job continues printing):

If page 3 of a 10–page document attempts to print outside the valid printable area
(an error) and the submitter specified (data-fidelity-problem-reported=all), this
occurs:
1. Pages 1-2 and 4-10 in the document print normally.
2. For page 3, the printer prints only the data that is inside the valid printable

area. In addition, a printer error marker (PEM) is printed on the page where
the print data extends outside the valid printable area.

3. After all 10 pages have printed, a set of messages is printed:

0420-094: The following messages were generated for file /info/afp/baddata with
Job ID 123. This file printed on the InfoPrint destination ip60, which is a
3160 destination.

0420-484: The destination reported that an attempt was made to print outside of the
valid printable area.

0420-249: InfoPrint received IPDS exception X’08C1..00’, action code X’01’ from the
destination.

0420-098: The error occurred while printing page 3 of copy 1 of this print job.

0420-254: The destination reported an error that caused InfoPrint to stop processing
the page.

Data stream error example 2 (job is terminated, no pages
print):

If a document is submitted and it requests a specific form definition which does
not exist, this occurs:
1. The document does not print. However, auxiliary sheets such as the start sheet

(header) and end sheet (trailer) page, if requested, do print.
2. A message page will print with these messages:

0420-094: The following messages were generated for file /info/afp/testfdef with
Job ID 456. This file printed on the InfoPrint destination ip60, which is a
3160 destination.
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0420-128: ERROR: InfoPrint cannot find or cannot access the FORMDEF resource
named F1BAD.

0420-060: The error occurred with the object type page with token name PAGE0001.

0420-060: The error occurred with the object type document with token name ASCII.

0420-098: The error occurred while printing page 1 of copy 1 of this print job.

Data stream error example 3 (job is terminated; some pages
print):

If page 5 of a 10–page document requests a font (C0D0GT15) which cannot be
located, this occurs:
1. Pages one through four print; page five does not print. Printing of the

document ends; pages 6 through 10 also do not print.
2. A message page will print with these messages:

0420-094: The following messages were generated for file /info/afp/long.list3820
with Job ID 167. This file printed on the InfoPrint destination psf4317,
which is a 4317 destination.

0423-284: InfoPrint mapped the FGID, GCSGID, width, vertical size combination:
230, 0, 96, 160 to the FCS name C0D0GT15. The FGID.GRD mapping file
specified that this mapping be performed.

0423-291: Map Coded Font (MCF) structured field could not be processed because
InfoPrint could not locate the font character set C0D0GT15. Attempted
resolution/type(s): 300-pel Font Fidelity for this job was CONTINUE.
Destination supported resolution/type(s): 300-pel.

0420-060: The error occurred with the object type Active Environment Group with
token name 1.

0420-060: The error occurred with the object type page with token name 1.

0420-060: The error occurred with the object type document with token name
LONG.

0420-098: The error occurred while printing page 1 of copy 1 of this print job.

0423-302: The font reference in the MCF1 structured field, repeating group number
1, with sequence number 1, at file offset 118, could not be processed
successfully. Additional error and diagnostic messages follow.

0420-729: The error occurred in file /info/afp/long.list3820. The structured field in
error was structured field EAG with code X’D3A9C9’ and sequence
number 1 located at file offset 250.

IPDS error recovery: Insufficient memory in the printer

In some cases, a printer might not have sufficient storage to process the data or
resources required for a page. When this occurs, InfoPrint Manager responds by
deleting resources in the printer which are not required for the page and then tries
to print the page again. Frequently, this recovery will allow the page to print
successfully. If the printer still reports that there is insufficient storage to process
the page, the job is terminated and a message is produced indicating that the page
and its associated resources are too complex.
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Insufficient memory in the printer exmple:

A 30 page document is submitted. Each page of the document references several
complex page segments.
1. InfoPrint Manager sends pages for the document to the printer.
v Before each page is sent, InfoPrint Manager downloads page segments that

are required by the page.
2. The printer reports an insufficient memory error to InfoPrint Manager (for page

23).
v InfoPrint Manager deletes all the page segments (and any other resources)

previously downloaded to the printer. All of the printer memory available
for resources should now be free. InfoPrint Manager then attempts to load
only the page segments required for page 23. Because unnecessary page
segments have been removed from printer memory, all of the page segments
for page 23 can be successfully downloaded into the printer. No messages
are reported to the server and no message pages are printed.

3. All 30 pages of the job print successfully.

IPDS error recovery: Intervention required conditions

A printer might experience intervention required conditions that are not related to
the data stream or complexity of the data. These conditions cause printing to stop.
Some intervention required conditions are handled directly by some printers and
are not reported back to InfoPrint Manager. In these cases, InfoPrint Manager
continues to send data to the printer.

Example:
1. As soon as the paper jam occurs, printing stops and the destination (printer)

object changes to red.
v A message is sent to the operator:

– 0420-466: The destination reported a paper jam; clear the jam.

2. The actual destination (printer) object’s destination-state changes to ″needs key
operator.″
v InfoPrint Manager waits until the paper jam has been cleared.

3. The operator then clears the paper jam, according to the printer jam recovery
procedure. Some damaged pages are usually discarded as part of this
procedure.

4. Once the printer jam is cleared, the destination (printer) object is no longer red.
Using station counters from the printer, InfoPrint Manager repositions to the
correct page and continues printing the document.

5. At the end of the document, a message page is printed which contains these:
v 0420-094: The following messages were generated for file /info/paperjam

with Job ID 787. This file printed on the InfoPrint destination ip32, which is a
4332 destination.

v 0420-467: A paper jam occurred in the destination while printing this job.
Inspect the output to determine if it is complete and that all printed pages
are acceptable.
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IPDS error recovery: Unrecoverable problems

Unrecoverable problems cause the InfoPrint Manager software or printer software
to stop functioning or prevent them from communicating with each other.
Examples of unrecoverable errors include: server system crash, software core
dump, printer abort, power failure, or severe network problems.

These errors prevent the InfoPrint Manager software from obtaining current station
counter status information from the printer. In these cases, InfoPrint Manager
cannot determine how many pages and which jobs printed since the last set of
valid station counters were received. InfoPrint Manager considers a job complete
only when all pages are reported by the printer as stacked. In most cases, some
pages for one or more jobs will print between the time InfoPrint Manager last
received a printer acknowledgment and the time the unrecoverable error occurs.

Those jobs, because they are considered incomplete, will normally start printing
from the beginning when the problem is resolved and both the InfoPrint Manager
software and the printer are operating and communicating again.

However, if the submitter or operator does not want the job to start printing from
the beginning, there is a way to modify where printing starts for the documents in
these jobs. The document object page-select attribute can be modified before the
job is processed again. This attribute allows the submitter to specify a page range
(first to last) for each document in a job. This way, the submitter or operator can
control which pages are printed after the problem is resolved.

Depending on the type of error and the network configuration, some errors might
not be reported to InfoPrint Manager immediately. In these cases, an operator can
issue a pdshutdown command to the actual destination object. This command
works without any attempts to communicate with the printer. InfoPrint Manager
will checkpoint the job that was partially stacked at the printer and use the station
counters from the last valid acknowledgment to determine which page of which
job to checkpoint. A small ack-interval value will make it possible to checkpoint
using a more recent set of station counters than would be available with a large
ack-interval value. The job can be resumed later from that checkpoint.

Some unrecoverable errors are reported immediately to the InfoPrint Manager
software and the actual destination object (printer) is disabled. When this occurs,
the pdshutdown command cannot be issued and therefore no checkpoint can be
taken. InfoPrint Manager does not perform automatic checkpointing.

Unrecoverable problem example:
1. The destination (printer) object becomes disabled and the icon changes to

black.
2. The job object changes to the pending state.
3. Later, the printer power is restored.
4. The operator must enable the destination (printer) object.
5. Jobs start printing on the printer in the order they have been scheduled.

All 300 pages of the job that were printing during the power failure print again.
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Appendix C. Supported formatting objects

Table 49 lists the XSL formatting objects (XSL-FO) and properties that XML
Extender supports. For more information about XSL formatting objects and XSL
style sheets, see http://www.w3.org/TR/XSL/ and http://www.w3.org/Style/
XSL/.

Attention:

v The XML transforms do not support XSL shorthand properties and XSL
functions.

v For the common properties listed in the table, most of their properties are
supported.

Table 49. Supported XSL formatting objects. The order of the formatting objects is based on the order listed in the
XSL Standard on W3C.

Formatting object Category Property

root declaration-pagination-layout

page-sequence declaration-pagination-layout initial-page-number

master-reference

page-sequence-master declaration-pagination-layout master-name

single-page-master-reference declaration-pagination-layout master-reference

repeatable-page-master-reference declaration-pagination-layout master-reference

maximum-repeats

repeatable-page-master-alternatives declaration-pagination-layout maximum-repeats

layout-master-set declaration-pagination-layout

simple-page-master declaration-pagination-layout Common Margin Properties–Block

master-name

page-height

page-width

reference-orientation

region-body declaration-pagination-layout Common Border, Padding, and Background
Properties

Common Margin Properties–Block

clip

region-name

reference-orientation

region-before declaration-pagination-layout Common Border, Padding, and Background
Properties

extent

precedence

region-name

reference-orientation
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Table 49. Supported XSL formatting objects (continued). The order of the formatting objects is based on the order
listed in the XSL Standard on W3C.

Formatting object Category Property

region-after declaration-pagination-layout Common Border, Padding, and Background
Properties

extent

precedence

region-name

reference-orientation

region-start declaration-pagination-layout Common Border, Padding, and Background
Properties

extent

region-name

reference-orientation

region-end declaration-pagination-layout Common Border, Padding, and Background
Properties

extent

region-name

reference-orientation

flow declaration-pagination-layout flow-name

static-content declaration-pagination-layout flow-name

block block Common Border, Padding, and Background
Properties

Common Font Properties

Common Margin Properties–Block

absolute-position

color

linefeed-treatment

line-stacking-strategy

text-align

visibility

text-indent

white-space-collapse

white-space-treatment

wrap-option

block-container block Common Border, Padding, and Background
Properties

Common Margin Properties–Block

block-progression-dimension

height

inline-progression-dimension

reference-orientation

width
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Table 49. Supported XSL formatting objects (continued). The order of the formatting objects is based on the order
listed in the XSL Standard on W3C.

Formatting object Category Property

character inline Common Border, Padding, and Background
Properties

Common Font Properties

Common Margin Properties–Inline

character

color

initial-property-set inline Common Border, Padding, and Background
Properties

Common Font Properties

color

external-graphic inline Common Border, Padding, and Background
Properties

Common Margin Properties–Inline

block-progression-dimension

content-height

content-width

inline-progression-dimension

src

text-align

inline inline Common Border, Padding, and Background
Properties

Common Font Properties

Common Margin Properties–Inline

block-progression-dimension

color

height

inline-progression-dimension

width

wrap-option

inline-container inline Common Border, Padding, and Background
Properties

Common Margin Properties–Inline

block-progression-dimension

height

inline-progression-dimension

reference-orientation

width
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Table 49. Supported XSL formatting objects (continued). The order of the formatting objects is based on the order
listed in the XSL Standard on W3C.

Formatting object Category Property

page-number inline Common Border, Padding, and Background
Properties

Common Font Properties

Common Margin Properties–Inline

wrap-option

table-and-caption table Common Border, Padding, and Background
Properties

Common Margin Properties–Block

caption-side

text-align

table table Common Border, Padding, and Background
Properties

Common Margin Properties–Block

block-progression-dimension

inline-progression-dimension

height

table-layout

width

table-column table column-width

number-columns-spanned

table-caption table Common Border, Padding, and Background
Properties

block-progression-dimension

height

inline-progression-dimension

width

table-header table Common Border, Padding, and Background
Properties

table-footer table Common Border, Padding, and Background
Properties

table-body table Common Border, Padding, and Background
Properties

table-row table Common Border, Padding, and Background
Properties

height
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Table 49. Supported XSL formatting objects (continued). The order of the formatting objects is based on the order
listed in the XSL Standard on W3C.

Formatting object Category Property

table-cell table Common Border, Padding, and Background
Properties

block-progression-dimension

empty-cells

ends-row

height

inline-progression-dimension

number-columns-spanned

number-rows-spanned

starts-row

width

list-block list Common Border, Padding, and Background
Properties

list-item list Common Border, Padding, and Background
Properties

list-item-body list

list-item-label list
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Appendix D. Accessibility

Accessibility features help a user who has a physical disability, such as restricted
mobility or limited vision, use software products successfully. The major
accessibility features in the InfoPrint Manager for Windows let users:
v Use assistive technologies such as screen-readers and screen magnifier software.
v Operate specific or equivalent features using only the keyboard.
v Customize display attributes such as color, contrast, and font size.

Using assistive technologies

Assistive technology products, such as screen-readers, function with the user
interfaces found in the InfoPrint Manager for Windows. Consult the assistive
technology documentation for specific information when using it to access the
InfoPrint Manager for Windows.

Keyboard navigation of the user interface

The InfoPrint Manager for Windows user interface complies with the accessibility
guidelines for HTML. Users can use keyboard shortcuts or function keys (PF keys)
to access the InfoPrint Manager for Windows user interface. For example,
Alt+Shift+F2 lets you skip to the main content. see your browser documentation
for keyboard shortcuts and default settings for the PF keys and for explanations
about how to modify their functions.
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Notices

This information was developed for products and services offered in the U.S.A.

InfoPrint Solutions Company may not offer the products, services, or features
discussed in this document in other countries. Consult your local InfoPrint
Solutions Company representative for information on the products and services
currently available in your area. Any reference to an InfoPrint Solutions Company
product, program, or service is not intended to state or imply that only that
InfoPrint Solutions Company product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe any
InfoPrint Solutions Company intellectual property rights may be used instead.
However, it is the user’s responsibility to evaluate and verify the operation of any
non-InfoPrint Solutions Company product, program, or service.

References in this document to InfoPrint Solutions Company products, product
features, programs or services do not imply that InfoPrint Solutions Company
intends to make such products, product features, programs or services available in
all countries in which InfoPrint Solutions Company operates or does business.

InfoPrint Solutions Company may have patents or pending patent applications
covering subject matter described in this document. The furnishing of this
document does not give you any license to these patents. You can send license
inquiries, in writing, to:

InfoPrint Solutions Company, LLC
6300 Diagonal Hwy 002J
Boulder, CO 80301-9270
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the
InfoPrint Solutions Company Intellectual Property Department in your country or
send inquiries, in writing, to:

InfoPrint Solutions Company, LLC
6300 Diagonal Hwy 002J
Boulder, CO 80301-9270
U.S.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INFOPRINT
SOLUTIONS COMPANY PROVIDES THIS PUBLICATION ″AS IS″ WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states
do not allow disclaimer of express or implied warranties in certain transactions,
therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. InfoPrint Solutions Company may
make improvements and/or changes in the product(s) described in this publication
at any time without notice.
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Any references in this information to non-InfoPrint Solutions Company Web sites
are provided for convenience only and do not in any manner serve as an
endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this InfoPrint Solutions Company product and use of those Web
sites is at your own risk.

InfoPrint Solutions Company may use or distribute any of the information you
supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

InfoPrint Solutions Company, LLC
6300 Diagonal Hwy 002J
Boulder, CO 80301-9270
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by InfoPrint Solutions Company under terms of the
InfoPrint Solutions Company Customer Agreement, InfoPrint Solutions Company
International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-InfoPrint Solutions Company products was obtained
from the suppliers of those products, their published announcements or other
publicly available sources. InfoPrint Solutions Company has not tested those
products and cannot confirm the accuracy of performance, compatibility or any
other claims related to non-InfoPrint Solutions Company products. Questions on
the capabilities of non-InfoPrint Solutions Company products should be addressed
to the suppliers of those products.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
These terms are trademarks or registered trademarks of Ricoh Co., Ltd., in the
United States, other countries, or both:
v Advanced Function Presentation
v Advanced Function Printing
v AFCCU
v AFP
v Bar Code Object Content Architecture
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v BCOCA
v Intelligent Printer Data Stream
v IPDS
v InfoPrint
v Infoprint
v Mixed Object Document Content Architecture
v MO:DCA
v Ricoh

These terms are trademarks or registered trademarks of International Business
Machines Corporation in the United States, other countries, or both:
v AIX
v DFS
v HACMP
v IBM
v IP Printway
v MVS
v OS/2
v OS/390
v POWER
v Print Services Facility
v z/OS

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States
and/or other countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the U.S. and other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, or service names may be trademarks or service marks of
others.
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Glossary

This glossary defines technical terms and abbreviations used in InfoPrint Manager.

Special Characters

.Guidefaults file
A file created by InfoPrint in the home
directory of a person using the InfoPrint
GUI. InfoPrint uses this file to save and
reference information about the servers
you are monitoring and the windows you
are working in.

A

Access Control List (ACL)
In computer security, a collection of all
access rights for one object.

ACL Access Control List.

acl editor
A command line interface that lets you
view, add, update, and delete access
authorization records in an ACL.

action In the InfoPrint GUI, an icon that
represents an operation that you can
perform on an InfoPrint object. You drag
and drop the action onto an object to
initiate the operation for that object. For
example, using the Enable action to
enable a disabled actual destination.

actual destination
In InfoPrint, an object that represents the
output device that performs the printing
or transmission function. See email
destination, fax destination; see also physical
printer, printer device; contrast with logical
destination.

additive color system
A system that reproduces an image by
mixing (adding) appropriate quantities of
red, green, and blue light (the additive
primary colors) to create all other colors
of light, either direct or transmitted.
When the additive primaries are
superimposed on one another, they create
white light. Contrast with subtractive color
system.

administrator
In InfoPrint, the person who creates and
manages one or more components of a

printing system, such as servers and
actual destinations. By default, InfoPrint
gives administrators authorization to
perform some InfoPrint operations and to
access certain information that is not
available to the operators or job
submitters.

Adobe® Acrobat
An Adobe software program that
provides instant access to documents in
their original format, independent of
computer platform. With the Adobe
Reader, you can view, navigate, print, and
present any Portable Document Format
(.pdf) file.

Adobe PageMaker
A desktop publishing program that
produces PostScript documents.

Adobe PostScript Raster to Image Transform
(RIP) See raster image processor (RIP).

ADSM/6000
Advanced Distributed Storage Manager.

Advanced Distributed Storage Manager
(ADSM/6000)

A program that provides storage
management for archived files.

Advanced Function Common Control Unit
(AFCCU)

An IBM RISC-based control unit with
code common to all printers that use the
AFCCU.

Advanced Function Presentation (AFP)
A set of licensed programs, together with
user applications, that use the
all-points-addressable concept to print
data on a wide variety of printers or to
display data on a wide variety of display
devices. AFP includes creating,
formatting, archiving, retrieving, viewing,
distributing, and printing information.

Advanced Function Presentation data stream
(AFP data stream)

The printer data stream used for printing
AFP data. The AFP data stream includes
composed text, page segments, electronic
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overlays, form definitions, and fonts
downloaded from the operating system to
the printer.

A presentation data stream that is
processed in AFP environments. The AFP
data stream includes MO:DCA-P-based
data streams.

Advanced Interactive Executive (AIX)
An operating system used with RS/6000
computers. The AIX operating system is
IBM’s implementation of the UNIX
operating system.

AFCCU
Advanced Function Common Control
Unit.

AFP Advanced Function Presentation.

AFP data stream
Advanced Function Presentation data
stream.

ainbe The printer input/output backend
program used by the PSF DSS to send
jobs to printer devices. Depending on the
incoming data stream of the job, the PSF
DSS might have transformed the data
stream of the job before the backend
program sending it to the printer device.

AIX Advanced Interactive Executive.

AIX-attached printer
A printer device, attached to an RS/6000
computer through the network or through
a serial or parallel port that receives jobs
from an AIX print queue.

In InfoPrint, a PSF physical printer that
represents an AIX-attached printer device.
See also direct-attached printer,
TCP/IP-attached printer,
upload-TCP/IP-attached printer.

AIX destination support system
In InfoPrint, the destination support
system that communicates with the
standard AIX print backend (piobe), or
with certain variations of the rembak
print backend, to print jobs.

AIX physical printer
In InfoPrint, the object representing a
printer device that uses the AIX
destination support system.

aliasing
In a digitized image, the creation of
diagonal lines by combining short

horizontal and vertical line segments that
approximate the path of the desired line.

all-points-addressability (APA)
The capability to address, reference, and
position text, overlays, and images at any
defined point of the printable area of the
paper or display medium.

alphameric
Synonym for alphanumeric.

alphanumeric
Pertaining to a character set containing
letters, digits, and other symbols such as
punctuation marks. Synonymous with
alphameric.

AMPV
Average monthly print volume.

analog
Pertaining to a continuous variable
sampling of information between two
points that achieves an even, smooth
transition of photographic material.

analog color proof
An off-press color proof made from
separation films.

anti-aliasing
The rendering of hard-edged objects so
that they blend smoothly into the
background. PhotoShop offers
anti-aliasing when rasterizing an EPS file.

Removing the jagged “stairstep” quality
in diagonal lines produced on a computer
screen by aliasing. This removal is
effected by creating less densely shaded
fields parallel to the diagonal line.

APA All-points-addressability.

API Application Program Interface.

Application Program Interface (API)
The call interface between a client
program and the procedures that
implement the printing system, as defined
by the specification. Clients use the API to
access servers. (P)

architecture
The set of rules and conventions that
govern the creation and control of data
types such as text, image, graphics, font,
fax, color, audio, bar code, and
multimedia.
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archiving
The transfer of digital information from
an online system onto floppy disk,
compact disc, or other media for offline
storage. The original copy is deleted from
the online system. See also retrieval.

array inkjet
An ordered collection of multiple print
heads used in an inkjet printer.

ASCII American National Standard Code for
Information Exchange. The standard code,
using a coded character set consisting of
7–bit coded characters (8 bits including a
parity check). The ASCII code is used for
information exchange among data
processing systems, data communications
systems, and associated equipment. The
ASCII character set includes control
charactes and graphic characters.

asynchronous
Pertaining to two or more processes that
do not depend upon the occurrence of
specific events, such as common timing
signals. (T)

In InfoPrint, occurring without a regular
or predictable time relationship to a
specified action. Contrast with
synchronous.

attachment type
Defines the method by which a printer
device is attached to the AIX system from
which it receives data. See AIX-attached
printer, direct-attached printer,
TCP/IP-attached printer, and
upload-TCP/IP-attached printer.

attribute
A defined characteristic of an object, such
as the number of copies required of a job,
or the document formats accepted by an
actual destination.

attribute name
A string that identifies an attribute.
Typically, in InfoPrint attribute names
consist of two or more words separated
by hyphens.

attribute value
The element of an attribute that specifies
the characteristics relating to the attribute.

authorization
In computer security, verification of the
eligibility of a user to access an object.

authorized user
A person with the appropriate
permissions to access an object or to issue
a command.

automatic recovery
A function of printer logic that permits
the printer to reprint a job if the job is
misprinted or damaged or if a component
has failed.

auxiliary sheet
In InfoPrint, an object that represents a
particular sheet of paper, blank or
otherwise, that can precede a job, separate
documents in a job, or follow a job.

auxiliary-sheet selections
A particular combination of start,
separator, and end sheets that print with
jobs on a particular printer device.

B

backend
In AIX, the program that is invoked by
the qdaemon process to run a print or
batch job. Synonymous with backend
program.

backend program
Synonym for backend.

backlog
In InfoPrint, the amount of time
calculated by InfoPrint that is required to
print all of the jobs currently in a queue.

backspace
In InfoPrint, the action used to back up
and reprint pages in a job.

bar code
A code representing characters by sets of
parallel bars of varying thickness and
separation that are read optically by
transverse scanning.

An array of parallel rectangular bars and
spaces that together represent data
elements or characters in a particular
symbology. The bars and spaces are
arranged in a predetermined pattern
following unambiguous rules defined by
the symbology.

BCOCA
Bar Code Object Content Architecture™.

Bezier curves
A method of defining curves using anchor
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points, control handles, and tangent lines.
The PostScript path passes through
anchor points. Its approach direction is
along the tangent lines that are controlled
by the control handles. Many personal
computer programs use this drawing
method. Type 1 PostScript fonts are
defined using Bezier curves.

binding
The cover and materials that hold a book
together. See edition binding, perfect
binding, spiral binding, wire-o binding.

The process of applying the binding to a
book.

In InfoPrint, assigning a job to an actual
destination. See early binding, late binding.

bitmapped
Pertaining to an image formed by a
rectangular grid of pixels. Each pixel is
assigned a value to denote its color.
One-bit images are black and white; 8–bit
images have 256 colors (or grays); 24–bit
images have full color. CMYK images
have 32–bits per pixel to encode 256
levels in each of four channels. Bitmapped
images are also called raster images.

bleed An extra amount of printed image that
extends beyond the trim edge of the
sheet. Bleed ensures that no white gap
appears at the edge of the sheet.

boot To prepare a computer for operating by
loading an operating system.

BSD Berkeley Software Distribution.

BSD destination support system
In InfoPrint, the destination support
system that generates a print command
string that the shell runs to print jobs.

BSD physical printer
In InfoPrint, the object representing a
printer device that uses the BSD
destination support system.

burn In platemaking, an exposure. Burn is
named because of the extremely bright
ultraviolet lamps used to transfer images
from film to plate.

In photography, to lengthen the final
exposure time to increase the final density
of print.

C

cathode ray tube (CRT)
A vacuum tube in which a beam of
electrons can be moved to draw lines or
form characters or symbols on its
luminescent (phosphor-coated) screen.
CRTs are the heart of all modern
computer display screens. Black and
white displays have only one phosphor
scanned by one electron beam, while
color displays have RGB phosphors
scanned by three beams.

CDE Common Desktop Environment.

child See parent/child relationship.

choke In color printing, an area whose
dimensions have been reduced to avoid
overlapping another color. Contrast with
spread.

class Synonym for object class.

clean In InfoPrint, an action used to remove all
the jobs from specified servers, actual
destinations, or queues, or to remove all
the jobs submitted to specified logical
destinations.

CLI Command Line Interface.

client In InfoPrint, the component of the print
system that assembles a print request and
submits the request to a server. The client
generates the local ID numbers for each
job, submits the jobs to the servers, and
keeps track of where each user’s jobs
have been submitted.

CMR Color Management Resource.

CMY Cyan, magenta, yellow.

CMYK
Cyan, magenta, yellow, black.

collator
In some printers a special-purpose hard
drive disk array used to store RIPped files
and later transfer them to the LED print
heads for imaging.

color balance
The relative levels of cyan, magenta, and
yellow channels in an image to produce
accurate color rendition of an original
image.

color correction
The adjustment of the color balance in an
image to produce accurate color rendition
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of an original image. Color correction is
used for two- or three-spot-color jobs.

color key
A color proof similar to Cromalin, but
typically not laminated and not
necessarily accurate in color. Color keys
are used to verify that breaks or color
assignments and traps have been made
accurately.

Color management resource
Color management resource (CMR) is an
architected resource that is used to carry
all of the color management information
required to render a print file, document,
group of pages or sheets, page, or data
object with color fidelity.

Command Line Interface (CLI)
A type of user interface where commands
are specified on the command line.
Contrast with Graphical User Interface.

Common Desktop Environment (CDE)
A graphical user interface running on a
UNIX operating system.

complex attribute
In InfoPrint, an attribute that can have
multiple values with each value
containing multiple components.

constant data
Data that does not change between copies
of a document and that is merged with
variable data to produce personalized
documents. For example, a form letter
(constant data) can be merged with a
customer’s name and address (variable
data).

contextual help
A type of online help that provides
specific information about each selectable
object, menu choice, notebook tab, field,
control, and pushbutton in a window.

control strip
A strip of information that can be
attached to a print job and used to
measure registration and density.

Cromalin
The Dupont color proofing system. Four
layers (CMYK) of light-sensitive material
are exposed through final halftone
negative films, then laminated together on
an opaque backing to produce a color-
and trap-accurate final proof showing

actual halftone dot structure. Cromalin is
sometimes called an analog proof.

crop To remove unwanted areas of an image,
usually indicated by crop marks on the
original.

CRT Cathode ray tube.

CTS Cutter-trimmer-stacker.

cutter-trimmer-stacker (CTS)
A post-processing device attached to a
printer device and used for paper
handling.

cyan, magenta, yellow (CMY)
The subtractive primary colors.

cyan, magenta, yellow, black (CMYK)
The four basic colors used in offset
printing, as opposed to the three basic
colors of light: red, green, and blue.
Magenta, yellow, and cyan are the
subtractive primaries. Black is added to
provide better density and to produce a
true black.

D

daemon
A program that runs unattended to
perform a standard service. Some
daemons are triggered automatically to
perform their tasks; others operate
periodically. Daemon processes generally
provide a service that must be available at
all times to more than one task or user,
such as sending data to a printer.

DAT Digital audio tape.

data stream
All information (data and control
commands) sent over a data link.

A continuous stream of data that has a
defined format.

In InfoPrint, pertaining to the incoming
format of the job and the output format
required by the printer device. InfoPrint
transforms the incoming format into the
output format, as required. See also
document format.

DB2*/6000
DataBase 2/6000.

deadline
In InfoPrint, a queuing technique where
the next job assigned to the first position
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in the queue is the one whose deadline is
closest. Contrast with FIFO
(first-in-first-out), job-priority,
longest-job-first, and shortest-job-first.

default document
In InfoPrint, an object that represents
default attribute values for a document in
a job. Synonymous with initial value
document.

default job
In InfoPrint, an object that represents
default attribute values for a job.
Synonymous with initial value job.

default object
In InfoPrint, a general term that refers
either to a default document or a default job.
Synonymous with initial value object.

default value
A value stored in the system that is used
when no other value is specified.

delete In InfoPrint, an action used to delete
default objects, jobs, logical destinations,
actual destinations, or queues from the
server.

desktop publishing
Performing print-related activities on a
personal computer, including but not
limited to layout, design, photo
manipulation, creating fonts, editing text,
color separation, scanning, and animation.

destination
See actual destination, logical destination.

destination support system (DSS)
In InfoPrint, the programs that an actual
destination uses to communicate with the
output device. Synonymous with device
support system. See AIX destination support
system, BSD destination support system,
email destination support system, Generalized
Fax destination support system, and PSF
destination support system.

device An individual piece of equipment
(hardware) that attaches to a computer,
such as a printer device.

device address
The identification of an input or output
device by its channel and unit number.

device driver
A file that communicates with a specific
device such as a printer, disk drive, or

display. An application that sends output
to a device controls the actions of the
device through the device driver. See
printer driver.

device support system (DSS)
Synonym for destination support system.

DFS™ Distributed File Service.

digital Pertaining to data represented by digits,
sometimes with special characters and the
space character.

digital audio tape (DAT)
A high-capacity, low-cost bulk storage
system used for archiving, copying (for
backup purposes), and transferring large
files. Typical DAT units store 1.3 GB on
inexpensive cassette tapes.

digital color proof
An off-press color proof made from a
color printer attached to a computer.

digital printing
A filmless and plateless printing process
in which digital data for each page is
transferred directly to a light-sensitive
drum and then to paper for a final image.

direct-attached printer
A printer device, attached to an RS/6000
computer through the network or through
a serial or parallel port.

In InfoPrint, a PSF physical printer that
represents a direct-attached printer device.
See also AIX-attached printer,
TCP/IP-attached printer, and
upload-TCP/IP-attached printer.

disable
In InfoPrint, an action used to stop the
acceptance of jobs on destinations,
queues, or servers, or to stop writing
information to logs.

distributed print system
A computer system with the ability to
interchange print data and controls
among different computing environments
with the intent of printing the data on a
different system from the one where the
print request was generated. For example,
in host-to-LAN distributed printing, data
that is located on the host is printed on
printers attached to a local area network.

dithering
A technique of filling the gap between
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two pixels with another pixel having an
average value of the two to minimize the
difference or to add detail to smooth the
result.

document
In InfoPrint, an object representing a
grouping of data in a job. A job can
contain one or more documents. The
documents in a job can differ from each
other in some ways. For example, they
can contain different data and can have
different document formats. A document
in a job can contain printable data or a
resource that is not printable by itself. See
file-reference document, printable document,
and resource document.

document element
A portion of a document at least a single
page in size.

document format
In InfoPrint, a document format describes
the type of the data and control characters
in the document, such as line data or
PostScript. The format of the data
determines which printer devices are
capable of printing the document and
whether InfoPrint must transform the
format.

document identifier
A string that identifies a document in a
job. It consists of a job ID followed by a
period (.) and a document sequence
number. For example, 12.2. Document
sequence numbers are integers starting at
1.

Document Printing Application (DPA)
An ISO/IEC 10175 standard that
addresses those aspects of document
processing that enable users in a
distributed open systems environment to
send electronic documents to shared,
possibly geographically-dispersed
printers. InfoPrint supports the DPA
standard.

document transfer method
In InfoPrint, the transfer method describes
how documents are transferred to, or
acquired by, servers. See pipe-pull and
with-request.

document type
In InfoPrint, the document type describes
the kind of data in the document. A

printable document can only contain
printable data. A resource document can
only contain data such as fonts or form
definitions that are not printable. A file
reference document can only contain names
of files entered on separate lines.

dot The individual elements of a halftone.

dot gain
An increase in the size of a halftone dot
during printing, caused by ink spreading.
Generally, this value is known precisely,
and the scanning and filming production
process is calibrated to compensate for it.
The Cromalin proofing system simulates
this effect.

dots per inch (dpi)
A measure of data density per unit
distance. Typical values for desktop
publishing range from 200 to 300 dpi.

DPA Document Printing Application.

DPF Distributed Print Facility.

dpi Dots per inch.

drag and drop
In graphical user interfaces, a procedure
by which you perform actions and tasks.
Using the mouse, you drag (move) an
action or object icon to a new position
where you want the action or task to
occur.

DSS Destination support system.

dummy
A rough paste-up or hand-drawn
representation of the anticipated finished
product. A dummy is used for basic
design and pagination.

duplex printing
Printing on both sides of the paper.
Contrast with simplex printing (1).

Printing on both sides of the paper,
placing output images on the media in a
head-to-head format, so that the top of
one image is at the same edge as the top
of the next image. Contrast with tumble
duplex printing; see also simplex printing
(2).

E

early binding
In InfoPrint, assigning a job to an actual
destination as soon as it is accepted. Early
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binding permits InfoPrint to estimate the
time when the job will be completed.
Contrast with late binding.

edition binding
A type of book binding in which printed
sheets are folded into 16- or 32-page
signatures. Four-page endleaves are
pasted on the outside of the first and last
signature. The signatures are then collated
by machine and sewn together using
special sewing machines. Contrast with
perfect binding, spiral binding, and wire-o
binding.

electronic document
A document stored in a computer instead
of printed on paper.

electronic mail
Correspondence in the form of messages
sent between workstations over a
network. Synonymous with email.

electrophotographic
Pertaining to a type of printer technology
that creates an image on paper by
uniformly charging the photoconductor,
creating an electrostatic image on the
photoconductor, attracting negatively
charged toner to the discharged areas of
the photoconductor, and transferring and
fusing the toner to paper.

em In composition, a unit of measurement
exactly as wide and as high as the point
size of the font being set. The name is
derived from the fact that the letter M in
early typefaces was usually cast on a
square body.

email Electronic mail.

email destination
In InfoPrint, an actual destination
representing an electronic mailing system.

email destination support system
In InfoPrint, the destination support
system that supports email destinations.

embellishments
Variable data added to all copies of
assembled pages to make the unit appear
like a whole; for example, headers,
footers, a table of contents, and chapter
separations.

en In composition, exactly one-half an em.

enable
In InfoPrint, the action that makes a
destination, queue, or server able to
accept jobs, or a log able to accept
information.

end sheet
The sheet of paper, blank or otherwise,
that can follow a job. See also auxiliary
sheet.

Enhanced X-Windows
A tool designed to permit multiple
application processes to operate in
multiple windows displayed on a virtual
terminal. See X-Windows.

environment variable
Any one of a number of variables that
describe the way an operating system
runs and the devices it recognizes.

error log
A data set or file in a product or system
where error information is stored for later
access.

estimate
The professional cost analysis made by a
print shop in response to a customer’s
request for a price quotation on a print
job.

event In InfoPrint, an occurrence in the printing
system during an operation; for example,
the completion of a command.

event log
In InfoPrint, a collection of messages
about events that have occurred.

event notification
The notification that is sent by InfoPrint
for an event.

F

fax destination
In InfoPrint, an actual destination
representing a fax device.

FIFO (first-in-first-out)
In InfoPrint, a queuing technique where
the next job assigned to the first position
in the queue is the job that has been in
the queue for the longest time. InfoPrint
processes jobs in the order in which they
are received. Contrast with deadline,
job-priority, longest-job-first, and
shortest-job-first.
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file-reference document
In InfoPrint, a file containing the names
of other files, each entered on a separate
line. Job submitters can specify this file
for printing when they specify a
document type of file-reference; InfoPrint
prints each file listed in the reference
document.

File Transfer Protocol (FTP)
In TCP/IP, the application protocol that
makes it possible to transfer data to and
from host computers and to use foreign
hosts indirectly.

finisher
A hardware device attached to a printer
that performs such operations as folding
or stapling the printed pages.

finishing
In a print shop, the final operations on a
printed product, such as stapling,
trimming, drilling, folding, embossing,
varnishing, gluing, shrink wrapping,
perforating, laminating, collating, and so
on.

flag A modifier of a command that specifies
the action of the command. A dash
usually precedes a flag. Synonymous with
option. See also keyword.

FOCA Font object content architecture.

folder In the InfoPrint GUI, an object that
represents a container for a collection of
similar objects. For example, the Retained
Jobs folder contains retained jobs.

font A family of characters of a given size and
style; for example, 9-point Helvetica.

One size and one typeface in a particular
type family, including letters, numerals,
punctuation marks, special characters,
and ligatures.

A paired character set and code page that
can be used together for printing a string
of text characters. A double-byte font can
consist of multiple pairs of character sets
and code pages.

form definition
A resource object used by InfoPrint that
defines the characteristics of the form or
printed media, which include: overlays to
be used, the paper source (for cut-sheet
printers), duplex printing, text

suppression, and the position of
composed-text data on the form.

forward space
In InfoPrint, the action used to move
ahead and skip the printing of a specified
number of pages in a job.

FPO Low-quality (sometimes photographic)
images placed in a dummy to represent
final images. Desktop publishing software
produces images as display-screen
resolution FPOs.

front panel
In the CDE, a workspace area containing
controls that represent various tasks you
can perform and workspace switches.

FTP File Transfer Protocol.

G

GCR Gray component replacement.

Generalized Fax destination support system
In InfoPrint, the destination support
system that supports generalized fax
destinations.

GIF Graphics Interchange Format.

global change
In the InfoPrint GUI, an action used to
make changes to one or more attributes of
several objects at once. You can also
perform the same action on several
objects of the same object class at the
same time; for example, disabling two or
more actual destinations at the same time.

global character
A character or set of characters used to
specify an unknown number or set of
characters in a search string. In InfoPrint,
a global character is represented by an
asterisk (*).

global ID
Global job identifier.

global job identifier
An unambiguous job identifier. In
InfoPrint, it is represented as the name of
the server managing the job followed by a
colon (:) and a generated integer. This ID
uniquely identifies the job in the InfoPrint
server.

glyph An image, usually of a character, in a
font.
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GOCA
Graphics object content architecture.

graphic character
A visual representation of a character,
other than a control character, that is
normally produced by writing, printing,
or displaying.

Graphical User Interface (GUI)
A type of user interface that takes
advantage of a high-resolution monitor
and includes a combination of graphics to
implement an object-action paradigm, the
use of pointing devices, menu bars,
overlapping windows, and icons. Contrast
with Command Line Interface.

Graphics Interchange Format (GIF)
A compressed graphics format widely
used on the Internet.

gray component replacement (GCR)
Synonym for under color removal (UCR).

gray scale
A strip of standard gray tones, ranging
from white to black, placed at the side of
the original copy during photography to
measure the tonal range and contrast
obtained.

GUI Graphical User Interface.

gutter The blank area or inner margin from the
printing area to the binding.

H

halftone
A printing method that simulates
continuous-tone shading using dots of
varying sizes laid out on a rectangular
grid. Larger dots simulate darker tones
and smaller dots simulate lighter tones.
Typical grid spacings are 85 lines per inch
(lpi) (newspaper), 133 lpi (low end), 150
lpi (midrange), and 175+ lpi (high
quality).

help In the InfoPrint GUI, an action used to
display the online help for a specific
template, object, action, button, control, or
area in an application window.

The name of a button used to access the
online help.

hold An indication determined by the job-hold

attribute that is used to keep a job in the
queue and prevent InfoPrint from
scheduling it.

hostname
The name given to an AIX system.

hot folder
A workstation directory where users copy
jobs to submit them to print.

hypertext
A way of presenting information online
with connections between one piece of
information and another. These
connections are called hypertext links. See
also hypertext link.

hypertext link
A connection between one piece of
information and another. Selecting a link
displays the target piece of information.

I

icon A graphic symbol displayed on a screen
that a user can click to invoke a function
or software application.

image Toned and untoned pels arranged in a
pattern.

image data
Rectangular arrays of raster information
that define an image.

imagesetter
A high resolution (1270–3600+ dpi)
printer that uses an Argon (green) laser to
write to film using digital imput.
Imagesetting is the step before Cromalin
proofing and platemaking.

imposition
The process of arranging pages on a press
sheet to ensure the correct order during
final cutting, folding, and binding.
Electronic imposition builds press sheets
automatically during the RIP and outputs
film formatted for immediate use in
platemaking.

InfoPrint
A solution of software and hardware
products that can supplement or replace
the offset presses and copiers in print
shops with high-quality, non-impact,
black and white or process color printers.
InfoPrint takes documents from creation
to the published, kitted, and shipped
product.
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In InfoPrint software publications,
InfoPrint Manager for AIX or any of its
components.

InfoPrint Manager for AIX
The software component of InfoPrint.
InfoPrint Manager for AIX handles the
scheduling, archiving, retrieving, and
assembly of a print job and its related
resource files. It also tracks the finishing
and packaging of the printed product.

InfoPrint Manager for AIX is based on
Palladium technology developed at
MIT/Project Athena. It conforms to the
ISO DPA and POSIX standards.

InfoPrint Network
The local area network running TCP/IP
protocol that InfoPrint uses to
communicate among servers, clients, and
output devices.

InfoPrint Select
The component of InfoPrint Manager for
AIX that lets you submit jobs from an
OS/2® or Windows workstation.

InfoPrint Submit Express
The component of InfoPrint Manager that
lets you submit jobs with a job ticket from
a Windows or Macintosh workstation.

InfoPrint 20
A black and white, large-format, cut-sheet,
workgroup laser printer with optional
duplexing and 600-dpi resolution.

InfoPrint 60
A duplex, black and white, cut-sheet
printer with 600-dpi resolution.

InfoPrint 62
A non-impact, continuous-forms printer
that runs at a maximum of 62
impressions-per-minute (depending on
forms size), and is factory set to run at
either 240 or 300 dpi on a maximum
paper size of 370.8 mm (14.6 in.).

InfoPrint 4000
A duplex, black and white,
continuous-forms printer with 600-dpi
resolution.

initial value document
Synonym for default document.

initial value job
Synonym for default job.

initial value object
Synonym for default object.

initially settable attribute
An attribute whose value can be
established when an object is created but
cannot be subsequently set or modified.
See also resettable attribute; contrast with
non-settable attribute.

input focus
The area of a window where user
interaction is possible from either the
keyboard or the mouse.

input tray
For a printer device, the container that
holds the medium upon which the printer
prints its output.

Intelligent Printer Data Stream (IPDS)
An all-points-addressable data stream that
enables users to position text, images, and
graphics at any defined point on a
printed page.

Information that the host sends to IPDS
printers. This information generally
contains basic formatting, error recovery,
and character data and enables the
printers to make decisions.

An architected host-to-printer data stream
that contains both data (text, image,
graphics, and bar codes) and controls
defining how the data is to be presented.
IPDS provides a device-independent
interface for controlling and managing
all-points-addressable (APA) printers.

International Organization for Standardization
(ISO) An organization of national standards

bodies from various countries established
to promote development standards to
facilitate international exchange of goods
and services, and develop cooperation in
intellectual, scientific, technological, and
economic activity.

Internet
A wide area network connecting
thousands of disparate networks in
industry, education, government, and
research. The Internet network uses
TCP/IP as the protocol for sending
information.

Internet Protocol
The set of rules that determines how to
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route data from its source to its
destination in an internet environment.

intervening jobs
In InfoPrint, the number of jobs in a
queue that are scheduled to print before
the job in question.

IOCA Image object content architecture.

IP address
The Internet Protocol address of the
server in a dotted decimal format where
each node is an integer. (For example,
9.99.9.143).

IPDS Intelligent Printer Data Stream.

ISO International Organization for
Standardization.

J

job In InfoPrint, an object that represents a
request to print or send one or more
documents together in a single session. A
job includes the data to be printed or sent
and resources such as fonts, images, and
overlays. Depending on how it was
submitted, it can also include a job ticket.
Synonymous with job bundle and print job.

job bundle
Synonym for job.

job data
The page descriptions, merge data, and
embellishments that compose a document
in a job, either directly or by reference.

job ID
A local or a global identifier that
identifies a job to a job submitter,
administrator, operator, or InfoPrint. See
local job identifier, global job identifier.

job-priority
In InfoPrint, a queuing technique where
the next job assigned to the first position
in the queue is the one with the highest
priority. Contrast with deadline, FIFO
(first-in-first-out), longest-job-first, and
shortest-job-first.

job submitter
In InfoPrint, the person who submits jobs
for printing. Often, this person is an
application programmer who maintains
applications that generate data to be
printed.

job ticket
The customer’s hardcopy or electronic
instructions listing all the variables
describing a print job, either directly or
by reference. The print shop can add
specifications to the job ticket and can
print the job ticket.

Joint Photographic Experts Group (JPEG)
A compressed graphics format widely
used on the Internet.

JPEG Joint Photographic Experts Group.

K

kerning
In typesetting, adjusting the relative
spacing of two characters to improve their
appearance and readability. Kerning pairs
are specific sets of characters with built-in
relative spacing. Some typefaces have as
many as 100 kerning pairs.

keyword
A name or symbol that identifies a
parameter.

Part of a command operand that consists
of a specific character string, such as
DSNAME=.

kitting
In a print shop, packaging the completed
published work with attendant binders,
tabs, diskettes, and other equipment or
information, before shipping the finished
product.

L

LAN Local Area Network.

laser (light amplification by stimulated emission
of radiation)

In InfoPrint printers, a device that emits a
beam of coherent light that forms the
image on the photoconductor that is
subsequently transferred to the paper.

late binding
In InfoPrint, waiting to assign a job to an
actual destination until it is about to be
processed. Late binding permits InfoPrint
to route a job to the first suitable actual
destination that becomes available.
Contrast with early binding.

LED Light-emitting diode.
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light-emitting diode (LED)
The imaging device element for
electrophotographic print units.

lines per inch (lpi)
A measure of the density of the grid used
to space halftone dots. Typical grid
spacings are 85 lpi (newspaper), 133 lpi
(low end), 150 lpi (midrange), and 175+
lpi (high quality).

Local Area Network (LAN)
A computer network at one location that
consisting of devices connected to one
another and communicating. This
network can also be connected to a larger
network.

local ID
Local job identifier.

local job identifier
In InfoPrint, a job identifier automatically
generated by the server, identifying the
job to the person who submitted it.
InfoPrint maps a local job ID to a global
job ID.

locale The human language and character set of
information presented to a user.

In InfoPrint, the language InfoPrint uses
when sending notification and error
messages or displaying the InfoPrint
graphical user interfaces.

log A collection of messages or message
segments added to a file for accounting or
data collection purposes.

To record messages in a file.

logical destination
In InfoPrint, an object to which users
submit their jobs. The logical destination
routes jobs to one or more actual
destinations representing output devices
such as printers, electronic mail systems,
or fax machines. See also logical printer;
contrast with actual destination.

logical printer
In InfoPrint, a type of logical destination.
The logical printer routes jobs to one or
more physical printers representing
printing devices.

logical unit (LU)
A type of network accessible unit that

enables end users to gain access to
network resources and communicate with
each other.

logical unit (LU) 6.2
A type of logical unit that supports
general communication between
programs in a distributed processing
environment. LU 6.2 is characterized by
(a) a peer relationship between session
partners, (b) efficient utilization of a
session for multiple transactions, (c)
comprehensive end-to-end error
processing, and (d) a generic application
program interface (API) consisting of
structured verbs that are mapped into a
product implementation.

longest-job-first
In InfoPrint, a queuing technique where
the next job assigned to the first position
in the queue is the longest job in the
queue. Contrast with deadline, FIFO
(first-in-first-out), job-priority, and
shortest-job-first.

lpi Lines per inch.

LU Logical unit.

M

magnetic ink character recognition (MICR)
Identification of characters printed with
ink that contains particles of magnetic
material.

mainframe processor
A functional unit that interprets and
executes instructions in a large computer
to which other computers are connected
so that they can share the facilities the
mainframe provides.

makeready
All the setup work involved in preparing
a press for a print run.

manage
In the InfoPrint GUI, the action used to
put an object into a mode where its icon
reflects changes of status.

mechanical
A camera-ready layout. The mechanical
can consist of multiple sheets or overlays
for each spot or process color used. Final
images, if not stripped in later, should be
at final size, cropped and screened to the
correct line frequency.
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medium
In InfoPrint, an object representing the
physical material upon which a job is
printed.

merge data
Data that is unique to each copy of a
document and that customizes the
document; for example, serial numbers or
mailing information. Merge data is
typically a small percentage of the total
data in the document.

message catalog
A file of all the possible messages than
can display during the processing of an
application.

MICR Magnetic ink character recognition.

Mixed Object Document Content Architecture
(MO:DCA)

An architected, device-independent data
stream for interchanging documents.

MO:DCA-P
Mixed Object Document Content
Architecture Presentation.

modify
In InfoPrint, an action used to modify the
values of attributes in the object attributes
notebook.

moire Undesirable interference patterns caused
by two overprinting halftone screens with
incorrect halftone dot angles.

monospaced
In typesetting, pertaining to a typeface in
which all the characters have equal
widths. Monospaced typefaces are useful
for tabulating figures.

Multiple Virtual Storage (MVS)
An operating system developed by IBM.
The design of MVS incorporates an
addressing architecture that provides a
unique address space to each job in the
system.

MVS Multiple Virtual Storage.

N

N_UP Pertaining to the number of forms placed
together in a layout. Typical layouts are
2_UP, 4_UP, 8_UP, 16_UP, and so on.
N_UP printing is done to use the
maximum area of the print sheet.

namespace
A global name repository available to all
utilities and API procedures. The
namespace contains mappings of object
names to other related objects. For
example, the namespace provides the
mapping of a logical destination to the
server in which it is located.

Network File System (NFS)
A protocol developed by Sun
Microsystems that uses Internet Protocol
to allow a set of cooperating computers to
access each other’s file systems as if they
were local.

newline options
The different ways in which the printer
determines how lines are delimited in a
document data stream.

NFS Network File System.

non-process-runout (NPRO)
A printer function that moves the last
printed sheet to the stacker of the printer
device.

non-settable attribute
An attribute that is neither initially
settable nor resettable. The values for
these attributes are controlled by
InfoPrint. Contrast with initially settable
attribute and resettable attribute.

notification
The act of reporting the occurrence of
events.

In InfoPrint, notification of events appears
as messages in event logs or messages
sent to administrators, operators, and job
submitters. In the InfoPrint GUI,
notification of events also appears as
changes to the appearance of icons.

notification-profile
In InfoPrint, an attribute associated with
an object that contains information
designating the people to whom InfoPrint
sends notification about events for that
object, which event information it sends,
and how it sends the information.

NPRO Non-process-runout.

O

object A collection of attributes that represent a
physical or logical entity in the print
system. For example, a specific printer
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device is represented by an actual
destination (physical printer) object. An
object is identified by its object name.
Objects are grouped into classes. See also
object class.

object class
A group of objects that share a common
definition and therefore share common
properties, operations, and behavior as
defined by their attributes. For example,
all InfoPrint queue objects are in the same
object class and each queue has the same
set of queue attributes. However, the
values for those attributes can differ for
each queue in the queue object class.

Object Identifier (OID)
In architecture, a notation that assigns a
globally unambiguous identifier to an
object or a document component. The
notation is defined in international
standard ISO.IEC 8824(E).

object name
The alphanumeric term that identifies an
object.

object state
The state of an object indicates its
availability and readiness for performing
its functions. An object can be in one of a
number of states such as ready, busy, or
unknown.

OCR Optical character recognition.

octet A byte that consists of eight binary digits
(bits).

offset stacking
In certain printer devices, a function that
allows the printer to offset the printed
output pages for easy separation of the
jobs.

OID Object Identifier.

open destinations window
In the InfoPrint GUI, the action used to
open a new application window
displaying the logical and actual
destinations associated with a queue.

Open Prepress Interface (OPI)
An industry standard for replacing
low-resolution images in review
documents with high-resolution images
needed for high-quality final output.

Open Software Foundation (OSF)
A nonprofit research and development
organization created by a consortium of
companies that work together to develop
software in the open systems market.

OpenType font (OTF)
An extension of the TrueType font format
that adds:
v Support for PostScript outlines
v Better support for international

character sets
v Broader support for advanced

typographic control

open window
In the InfoPrint GUI, the action used to
open a new application window
representing one or more objects
displayed in the currently open
application window.

operation
An action performed on one or more data
items.

operator
In InfoPrint, the person responsible for
printer devices. Also, this person
performs a subset of tasks for InfoPrint
queues and actual destinations and
performs some job-related tasks.

OPI Open Prepress Interface.

optical character recognition (OCR)
Conversion of scanned text to editable
ASCII characters.

option A modifier of a command that specifies
the action of the command. A dash
usually precedes an option. Synonymous
with flag. See also keyword.

orphan logical destination
In the InfoPrint GUI, an object that
represents a logical destination that is not
associated with an existing queue.

orphan logical printer
In the InfoPrint GUI, an object that
represents a logical printer that is not
associated with an existing queue.

OSF Open Software Foundation.

overlay
A collection of constant data, such as
lines, shading, text, boxes, or logos, that is
electronically composed in the host
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processor and stored in a library, and that
can be merged with variable data during
printing.

OTF OpenType font.

P

PAC Privilege Attribute Certificate.

page definition
A resource that contains the formatting
controls for line data.

In InfoPrint, a resource that defines the
rules of transforming line data into
composed pages and text controls.

page segment
A resource that contains composed text
and images, which are prepared before
formatting and included during printing.

Palladium
A distributed print system developed at
MIT/Project Athena with participation
from Digital Equipment Corporation
(DEC), International Business Machines
(IBM), and Hewlett-Packard (HP). It is a
reference implementation for the OSI
Document Printing Architecture (DPA)
standard, ISO/IEC 10175.

pane In the Work Area of the InfoPrint
Manager Administration GUI, an area
containing a group of objects of a specific
type, such as an actual destinations pane.

parent/child relationship
In InfoPrint, servers, queues, and
destinations are related to one another in
a parent/child relationship. For example,
a server is the parent of all the queues
that reside in that server, and these
queues are its children.

pass through
In InfoPrint, referring to options
submitted with a job that are used by the
device driver, but not InfoPrint. InfoPrint
does not process or validate this
information; it passes it along to the
device driver. See printer driver.

path The route used to locate files; the storage
location of a file. A fully qualified path
lists the drive identifier (if any), directory
name, subdirectory name (if any), and file
name with the associated extension.

pause In InfoPrint, the action used to

temporarily halt the printing or
transmission of jobs on actual destinations
or the distribution of jobs from servers or
queues.

pdcreate
In InfoPrint, the command used to create
a new object and set its attributes to
specified values.

PDF Portable Document Format.

Printer description file.

pdmsg
In InfoPrint, a utility used to display
information about a message.

pdpr In InfoPrint, the command used to create
and submit a job, consisting of one or
more documents, to a server for printing
or transmission.

perfect binding
A type of book binding in which the
pages are held together with flexible
adhesive. Contrast with edition binding,
spiral binding, and wire-o binding.

permissions
In AIX, codes that determine who can
access a file and what operations they can
perform on the file.

physical printer
In InfoPrint, a type of actual destination
that represents a printer device. See also
printer device.

piobe The standard printer input/output
backend program used by AIX for
printing. See also ainbe.

pipe-pull
In InfoPrint, a document transfer method
where InfoPrint saves the documents in a
file and transfers the address of the file to
the server. InfoPrint transfers the file to
the server upon the request from the
server. This is an efficient transfer method
for large jobs and is the default transfer
method at job submission. Contrast with
with-request.

plex A document or actual destination
attribute used to define the placement of
output images on the page. See the plex
values simplex and tumble.

Portable Document Format (PDF)
An Adobe PostScript data format that can
be viewed or printed.
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Portable Operating System Interface for
Computer Environments (POSIX)

An Institute of Electrical and Electronics
Engineers (IEEE) standard for computer
operating systems.

POSIX
Portable Operating System Interface for
Computer Environments.

PostScript
Adobe’s page description language.
PostScript has become a standard for
graphic design and layout software.
PostScript files can contain both vector
and raster data. Fonts are described using
PostScript coding. Many desktop
publishing systems produce PostScript
data as their output data stream.

PostScript printer description (PPD)
A file that contains options for printing
PostScript data on various printer devices.

PPD PostScript printer description.

preflight
To assess all resources for a job before the
actual print run.

prepress
Work done in the print shop before
printing a job, such as preparing data and
art, page imposition, color retouching,
electronic editing, and page layout.

print database
The set of files on disk that provide a
permanent repository for the attributes of
all print objects, such as logical
destinations, queues, and actual
destinations.

print job
Synonym for job.

Print Quality Enhancement (PQE)
A printer facility that provides edge
smoothing along diagonal lines, fine
fidelity protection, and independent
boldness control.

Print Services Facility (PSF)
Any of several programs, including PSF
for AIX, PSF/MVS, PSF/VM, and
PSF/VSE, that produce printer commands
from the data sent to them.

print system
A group of one or more print servers and
one or more printing devices, which

might or might not be located in the same
geographical area. The components of a
print system are assumed to be
interconnected in some manner, providing
at least one network interface to print
clients, and acting synergistically to
supply the defined document print
service. (D)

printable document
In InfoPrint, an object that represents text
or data to be printed by a job. Contrast
with resource document.

printer description file (PDF)
A file that contains options for printing
PostScript data on a specific printer
device.

printer device
The physical output device that performs
the printing function. See also physical
printer.

printer driver
A file that describes the physical
characteristics of a printer or other
peripheral device. This file is used to
convert graphics and text into
device-specific data at the time of printing
or plotting. Synonymous with device
driver.

priority
In InfoPrint, a number assigned to a job
that determines its precedence in being
printed. Jobs with higher priority
numbers are handled before jobs with
lower priority numbers.

process color
Color made up of CMYK links simulating
a specified color. This is the traditional
method of reproducing continuous tone
color images (color separations). Because
of the nature of color inks, certain inks do
not reproduce well.

processor
In a computer, a functional unit that
interprets and executes instructions. A
processor consists of at least an
instruction control unit and an arithmetic
and logic unit. (T)

promote
In InfoPrint, the action used to move a job
to the beginning of the queue so that it
will print on the next available printer
that can handle that job.
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protocol
A set of semantic and syntactic rules that
determines the behavior of functional
units in achieving communication.

PSF Print Services Facility.

PSF destination support system
In InfoPrint, the destination support
system that communicates with PSF for
AIX to print jobs.

PSF physical printer
In InfoPrint, the object representing a
printer device that uses the PSF
destination support system.

Q

QuarkXpress
A desktop publishing system produced by
Quark, Incorporated.

queue In InfoPrint, an object that manages a
collection of jobs that are waiting to print.
A queue receives jobs from one or more
logical destinations and sends jobs to one
or more actual destinations.

A line or list formed by items waiting for
processing.

R

raster A pattern of dots defined at varying data
depths. Black and white images are
one-bit (on/off); grayscale images are
8-bit (256 levels); RGB images are 24-bit;
CMYK images are 32-bit.

raster image processor (RIP)
A processor in which a PostScript data
stream is converted into dot patterns that
are transferred to the final print medium.
InfoPrint uses an Adobe RIP to convert
PostScript to IPDS for such printers as the
InfoPrint 4000 and InfoPrint 60.

rc.pd In InfoPrint, a utility used to start the
InfoPrint servers listed in the
/etc/pd.servers file.

read-only
In InfoPrint, describes an attribute value
that cannot be set by the user but can
change based on other activity.

ready A state in which an object is ready and
able to perform tasks.

An available resource, such as a value of
the media-ready attribute. Contrast with
supported.

red, green, blue (RGB)
The colors of CRT display phosphors.
RGB images are for screen display only.
They must be converted to CMYK images
before printing.

registration
The accuracy of printing on paper relative
to the edges of the paper.

The accuracy of printing a single color
(cyan, magenta, or yellow) relative to
black.

The accuracy of printing on one side of a
page relative to printing on the reverse
side of the page.

reprographics
The process of copying or duplicating
documents or information.

requested
In InfoPrint, pertaining to the specific
values of attributes requested by a job
when it is submitted. The requested
attribute values of a job are validated
against supported attribute values for an
actual destination to determine if the
printer can handle that job. Contrast with
supported.

resettable attribute
An attribute whose value can be set or
modified after an object has been created,
assuming the object is in an appropriate
state to be modified. See also initially
settable attribute; contrast with non-settable
attribute.

resource
In AFP, a file containing a collection of
printing instructions used when printing
a job. Resources include fonts, overlays,
form definitions, page definitions, and
page segments.

resource context
In InfoPrint, an object that contains
directory path information that helps the
print system locate resources needed for
printing a job. The resources include
fonts, overlays, form definitions, page
definitions, and page segments.

resource document
In InfoPrint, an object that represents a
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resource, such as graphics or fonts, used
by a job to print a printable document.
Contrast with printable document.

resubmit
In InfoPrint, an action used to reroute
pending or retained jobs to a different
logical destination than the one through
which the job was originally submitted.

resume
In InfoPrint, the action used to resume the
printing of paused jobs or resume the
distribution of jobs from paused servers
or queues.

retained job
In InfoPrint, an object that represents a
job that is being stored in the print
system for a specified amount of time,
normally after the completion of printing
the job. A retained job does not reside in a
queue.

retention
The process of storing data after
completion of a process for a certain
length of time.

retrieval
The process of bringing digital archived
data out of storage and into online
memory for reuse. See also archiving.

RGB Red, green, blue.

RIP Raster image processor.

To convert data to dot patterns using a
raster image processor.

root user
In the AIX environment, the system user
with the most authority who can log in
and execute restricted commands, shut
down the system, and edit or delete
protected files. Synonymous with
superuser.

RPC Remote Procedure Call.

RS/6000
A family of workstations and servers
based on IBM’s POWER® architecture.
They are primarily designed for running
multi-user numerical computing
applications that use the AIX operating
system.

S

scanner
A device that converts hardcopy source
data into digital format (halftone dots) to
avoid retyping the data.

scheduler
In InfoPrint, the scheduling method that
the queue uses when assigning a job to an
actual destination.

separator sheet
The sheet of paper, blank or otherwise,
that separates documents in a job. See
also auxiliary sheet.

server In InfoPrint, the object that accepts
configuration, management, and printing
requests, performs the requested
operations, and sends responses back as a
result of the operation.

settable attribute
See initially settable attribute, resettable
attribute.

severity
An indication of how serious an error
condition is.

shell In the AIX operating system, a command
interpreter that acts as an interface
between the user and the operating
system. In InfoPrint documentation, all
shell examples use the Korn shell.

shift-out, shift-in code
Control characters used to indicate the
beginning and end of a string of
double-byte, ideographic characters.

shortest-job-first
In InfoPrint, a queuing technique where
the next job assigned to the first position
in the queue is the shortest job in the
queue. Contrast with deadline, FIFO
(first-in-first-out), job-priority, and
longest-job-first.

shut down
In InfoPrint, the action used to halt all
server or actual destination processes
without deleting the server or actual
destination.

signature
A group of pages that are printed, folded,
cut, and bound together. Manual
placement of pages in the signature is
determined using a folding dummy.
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simplex
In InfoPrint, the value of the document or
actual destination plex attribute indicating
that output images are placed on the
media in a head-to-head format, so that
the top of one image is at the same edge
as the top of the next image. Depending
on the value of the document or actual
destination sides attribute, the document
can be printed on one or both sides of the
paper. Contrast with tumble; see also
simplex printing and duplex printing.

simplex printing
Printing on only one side of the paper.
Contrast with duplex printing (1).

Printing on one or both sides of the
paper, placing output images on the
media in a head-to-head format, so that
the top of one image is at the same edge
as the top of the next image. Contrast
with tumble duplex printing; see also duplex
printing (2).

SMIT System Management Interface Tool.

SNA Systems Network Architecture.

spiral binding
A type of book binding in which wire or
plastic coils are threaded through a series
of holes or slots in the binding edge.
Contrast with edition binding, perfect
binding, and wire-o binding.

spot color
Individual colored inks formulated to
exactly match a specified color. Spot color
is used when CMYK process color cannot
produce a reasonable facsimile of the
color or when vivid color is needed. Spot
color is also used when fluorescent or
metallic colors are needed.

spread
In color printing, an area whose
dimensions have been enlarged to
eliminate white space between it and
another color. Contrast with choke.

start sheet
The sheet of paper, blank or otherwise,
that can precede a job. See also auxiliary
sheet.

state Synonym for object state.

stripping
The process of mechanically assembling

film into plate layouts. Page imposition
takes place during stripping.

subnet mask
A bit template indicating which part of an
IP address represents the network. A 1 in
the subnet mask means that the
corresponding bit in the IP address is part
of the network address; a 0 means that it
is not. For example, if the IP address is
9.99.12.137 and the subnet mask is
255.255.255.0, the network address is
9.99.12.0.

subnetwork
Any group of nodes that have a set of
common characteristics, such as the same
network ID.

In the AIX operating system, one of a
group of multiple logical divisions of
another network, such as can be created
by TCP/IP.

subtractive color system
A system that reproduces an image by
mixing (adding) appropriate quantities of
cyan, magenta, and yellow paints on
white paper. These paints reflect certain
colors and absorb—or subtract—others.
Contrast with additive color system.

superuser
Synonym for root user.

supported
In InfoPrint, pertaining to the specific job
attribute values that the actual destination
can accept during job validation. InfoPrint
validates the requested attribute values of
the job against the supported attribute
values of the actual destination to
determine whether the actual destination
can handle that job. Contrast with
requested.

synchronous
Occurring with a regular or predictable
time relationship to a specified action.
Contrast with asynchronous.

system administrator
Synonym for administrator.

System Management Interface Tool (SMIT)
In the AIX operating system, an interface
tool for installation, maintenance,
configuration, and diagnostic tasks. SMIT
lets you perform tasks without entering
any commands.

366 InfoPrint Manager for Windows: Procedures



Systems Network Architecture (SNA)
The description of IBM’s logical structure,
formats, protocols, and operational
sequences for sending units through, and
controlling the configuration and
operation of, networks.

T

table reference character (TRC)
An optional control character in a print
data set. The TRC identifies the font used
to print the record and can be used to
select a font during printing.

Tagged Image File Format (TIFF)
A digital format for storing scanned
images. TIFF files are also referred to as
raster format files (as opposed to vector
format files). When used in desktop
publishing, TIFF files produce only a
low-resolution FPO image; the
high-resolution data remains on the hard
disk.

task help
A type of online help that provides a list
of tasks that can be completed with a
selected object. When you select a task,
the help provides step-by-step
information about how to complete the
task.

TCP/IP
Transmission Control Protocol/Internet
Protocol.

TCP/IP-attached printer
A printer device attached to an RS/6000
computer through telecommunication
lines using the TCP/IP protocol.

In InfoPrint, a PSF physical printer that
represents a TCP/IP-attached printer
device. See also AIX-attached printer,
direct-attached printer, and
upload-TCP/IP-attached printer.

template
In the InfoPrint Manager Administration
GUI, an object that represents a set of
default attribute values that has been
defined for creating a particular type of
object, such as an actual destination.

ticket See job ticket.

TIFF Tagged Image File Format.

Transmission Control Protocol/Internet Protocol
(TCP/IP)

A set of communication rules used in the
Internet and in any network that follows
the U.S. Department of Defense standards
for inter-network protocol. TCP provides
a reliable host-to-host protocol between
hosts in packet-switched communications
networks and in interconnected systems
of such networks. It assumes that the
Internet Protocol (IP) is the underlying
protocol. See also Internet Protocol.

trapping
In desktop publishing, the amount of
overlap in overprinting colors. Trapping
prevents white paper showing through
gaps caused by normal errors in
registration. On sheet-fed presses,
trapping is usually 0.25 point. See also
choke and spread.

TRC Table Reference Character.

TrueType font (TTF)
A font format based on scalable outline
technology with flexible hinting. Glyph
shapes are based on quadratic curves. The
font is described with a set of tables
contained in a TrueType Font File.

TTF TrueType font.

tumble
In InfoPrint, the value of the document or
actual destination plex attribute indicating
that output images are placed on the
media in a head-to-toe format, so that the
top of one image is at the same edge as
the bottom of the next image. The
document must be printed on both sides
of the paper. Contrast with simplex.

tumble duplex printing
Printing on both sides of the paper,
placing output images on the media in a
head-to-toe format, so that the top of one
image is at the same edge as the bottom
of the next image. Contrast with simplex
printing (2), duplex printing (2).

U

UCR Under color removal.

under color removal (UCR)
Conversion of neutral color areas to black
ink that reduces use of CMY inks,
improves trapping, and reduces setup
time. Generally, UCR is performed during
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image scanning, but some RIPs perform it
during processing. Synonymous with gray
component replacement (GCR).

unmanage
In the InfoPrint Manager Administration
GUI, the action used to put an object into
a mode where its icon does not reflect the
changes of status for the object.

upload printer
See upload-TCP/IP-attached printer.

upload-TCP/IP-attached printer
In InfoPrint, a PSF physical printer that
represents a printer device attached
through an MVS system and managed by
PSF/MVS. InfoPrint communicates with
the MVS system through the TCP/IP
network. See also AIX-attached printer,
direct-attached printer, and TCP/IP-attached
printer.

V

validate
In InfoPrint, to compare the attribute
values requested by a job with the
supported attribute values of the actual
destinations in the system and to
determine whether there is an actual
destination capable of printing or sending
the job.

value A specific characteristic of an attribute.

variable
A name used to represent a data item
whose value can change while the
program is running.

variable data
Data that can be changed between copies
of a document. For example, a form letter
(constant data) can be merged with
variable data, such as a customer’s name
and address to produce personalized
documents.

varnish
A protective layer applied to a finished
sheet, usually for photos, but sometimes
used as a design element because of its
reflective qualities. Varnishes can be
tinted.

vector An absolute coordinate point and line in
space. PostScript files can contain vector
artwork. Vector files are converted to
rasters during the RIP process.

velox A black and white photographic print
made from a halftone negative, to be used
as a proof copy.

vignette
An image with soft, fade-away edges.

Virtual Machine (VM)
An IBM licensed product that manages
the resources of a single computer so that
multiple computing systems appear to
exist.

A virtual data processing system that
appears to be at the exclusive disposal of
a particular user, but whose functions are
accomplished by sharing the resources of
a real data processing system. (T)

Virtual Storage Extended (VSE)
An IBM licensed program whose full
name is the Virtual Storage
Extended/Advanced Function. It is a
software operating system controlling the
execution of programs.

Visual Systems Management (VSM)
In AIX, a type of graphical user interface
that allows system management through
the direct manipulation of objects.

VM Virtual Machine.

VSE Virtual Storage Extended.

VSM Visual Systems Management.

W

web A roll of paper used in web or rotary
printing.

well In the InfoPrint Manager Administration
GUI, an area in a pane that contains a
group of objects related to the objects in
the pane; for example, a queues well in a
servers pane.

what you see is what you get (WYSIWYG)
Refers to the fact that the composite
image displayed on the screen at a
computer workstation has the appearance
of the final printed image.

window
A rectangular area of the screen that you
can move about, place on top of, or pull
under other windows, or reduce to an
icon.

wire-o binding
A continuous double series of wire loops

368 InfoPrint Manager for Windows: Procedures



run through punched slots along the
binding side of a booklet. Contrast with
edition binding, perfect binding, and spiral
binding.

with-request
In InfoPrint, a document transfer method
where the client transfers the documents
directly to the server. Contrast with
pipe-pull.

workstation
A terminal or microcomputer, usually one
that is connected to a mainframe or to a
network, at which a user can use
applications.

write access
A level of authorization that grants the
ability to modify data.

WYSIWYG
What you see is what you get.

X

X-Windows
A network-transparent windowing system
developed by MIT. It is the basis for
Enhanced X-Windows, which runs on the
AIX Operating System.

xerography
A dry printing process using
corona-charged photoconductive surfaces
to hold latent images that are developed
with a dry toner and then transferred to
paper and fused with heat.

Xstation
A terminal that is connected through a
network to an RS/6000 computer, from
which a user can perform command-line
functions and run X-Windows based
applications.
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Special characters
<install path>\grd directory 239

A
access control list (ACL) 33, 35

interoperating environment 133, 135
types

destinations 36
operations 36
queues 36
servers 36

wildcarding 36
working with 36

accessibility 341
accounting

data 111, 119
data file 119
information 111, 116
PSF DSS user-exit 117
usage by DSS 114
user exit 71

accounting-exit
post-printing 116

accounting.log file 114
acif 190
acl_admin 35
actual destination 59

associating input data user-exit
program with 107

associating output data user-exit
program with 107

attributes 53
BSD printer 11
destination support systems (DSS) 11
IPP printer 11
Passthrough printer 11
pause 315
PSF printer 11
restarting 316
resuming 316
selecting 11

Add Printer Wizard 305
adding

Internet Printing Protocol (IPP)
gateway printer to desktop 306

users to a security group 35
administrative tasks

performing 43
Advanced Function Presentation 199
Advanced Function Presentation

(AFP) 179
data stream 190

AFP 199
bin numbers 269, 271
capabilities for transforming to 201
configuration file for 203
resources for graphic data 202
scenarios for using data 200

AFP Download Plus 169

AFP Resources
in MVS Download 166
remote 49

AFP resources, search order 62
AIX

submitting jobs from 275
AIX command line, printing from 263
ANSI carriage controls

definition 191
apka2e 87
appearance

dark 259
highlight midtone 259
standard 259

ASCII 179, 190
asciinp.c 87
asciinpe.c 87
associating

a transform with an actual
destination 215

attachment types
channel 13
command 13
other driver 13
TCP/IP 13

attribute
accounting-exit 116
ack-interval 329, 333
actual destination 53
current-page-printing 329
default-character-mapping 234
delivery-address 28
delivery-method 28
destination-tcpip-internet-address 57
document-formats-ripped-at-

destination 115
event-identifiers 28
events-supported 28
input-trays-medium 53
job-copies-completed 329
job-end-message 32
job-page-count 115, 116
job-start-message 32
job-start-wait 32
log-accounting-data 111
media-sheets-completed 329
media-supported 53
notification-profile 27, 307
notify-operator 31
output-bin-numbers 53
page-count 116
page-select 333
pages-completed 329
plexes-supported 53
printer-model 53
psf-exit-form-definition 105
psf-exit-page-mark 105
psf-exit-program-name 105
psf-tray-characteristics 53
resource-context 170
resource-context-font 170

attribute (continued)
resource-context-overlay 170
resource-context-page-definition 170
resource-context-page-segment 170
resource-coresource-context-form-

definition 170
snmp-community-name 57
snmp-discovery-during-startup 59
snmp-retry-count 58
snmp-timeout 58
snmp-write-community-name 57
transform-message-file-name 170
use-snmp 57

attributes
capture-inline-otf-resources 231
log-backup-number 37

audit
data 111, 119
information 116
PSF DSS user-exit 117
user exit 71

audit.log file 114
authority 35
automatic tasks during migration 125
auxiliary sheet 97

creating 97
examples of 100
managing 97
object 98, 105
preparing to work with 97
style 97
terms 97

auxiliary-sheet attribute
activating for post-print accounting

information 106
auxiliary-sheet object 97

activating for accounting or audit
information 106

associating with PSF printers 106
configuring 105
creating 105

using pdcreate command 105
default

accounting-log 98
blank 98
brief 98
full 98
job-ticket 98
none 98

name 97

B
back up 125
backspacing 301, 316, 317
bar code support 201
bin mapping 267

finishing 268
PCL 268
PostScript 270
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bin numbers
AFP 269, 271
PCL 268

BSD printer 11

C
calibrating

densitometer 257
halftone 260
printer 259

calibrating a printer using the halftone
management system 259

capabilities, XML Extender 201
capture-inline-cmr-resources 65
capture-inline-otf-resources attribute 231
changing

notification 26
changing Select notifications 22
CMRs

search order 64
cmt.cfg file 247
cmt.cfg file, sample 249
cmtsampl file 247
code page

determining 196
coded character sets

converting 94
color mapping table

parts of 247
specific object types to map 248

color mapping table,
submitting source and output files for

printing 251
color mapping table, creating 249
color space value

GOCA pattern fill 248
Highlight color 248
Standard Object Content Architecture

(OCA) 248
command

IPDS operator 325
pdaccount 111, 114
pdclean 325
pdcreate 105
pddisable 325
pdenable 325
pdls 325
pdpause 326
pdpr 149, 287, 295
pdresume 326
pdrm 326
pdset 112
pdshutdown 333
pdspace 326

commands
acif 190
line2afp 190
pdcreate 215
pddelete 215
pdls 215
pdpr 169
pdset 27, 215
uconv 94

common customization tasks 203
community

SNMP 57

conditionally- terminating
transform 209

conditionally- terminating transform
object

example 218
Configurable Transform Subsystem 209
configuration files 199

transform 274
xml2afp.cfg 203
xml2pdf.cfg 206

configuring
for receiving notifications with Select

on Windows 22
Halftone Management System 255
halftone support 255
transforms 211

control 156
converting coded character sets 94
Create IPP Printer Wizard 17
creating

a transform object that updates the
job’s page count 220

conditionally- terminating transform
object 218

terminating transform object 216
transform to convert data and print

only smaller files 218
transform to copy a file without

printing 216
transforms 211

creating a color mapping table 249
custom patch sets, defining 259
customization tasks 203

common 203
customizing

error logs in the server 37
img2afp transform 186
transform

Graphic interchange format
(GIF) 189

Joint photographic experts group
(JPEG) 189

line data 194
Portable document format

(PDF) 180
PostScript 180
Printer control language

(PCL) 180
Tag image file format (TIFF) 189

D
data objects

search order 64
data stream

AFPDS 12
ASCII 12, 190
DBCS ASCII 190
EBCDIC DBCS 190
error 329

job continues printing 330
job is terminated, no pages

print 330
job is terminated, some pages

print 331
IPDS 11, 12, 13
line data 12

data stream (continued)
MO:DCA-P 169
non-IPDS 11, 12
PCL 11, 12, 13, 267, 277
PDF 12
PostScript 11, 12, 267, 277
PPDS 11, 12, 13
transforms 209

db2afp 179
DBCS 179
DBCS ASCII 190

definition 195
font 234
font resources 196

DBCS EUC
definition 195
font 234
font resources 196

DBCS fonts
installing on Windows 235
transform 179

Default Gateway 9
default job 26
default notification profile 24
default-character-mapping 234
defining

custom patch sets 259
InfoPrint servers to the halftone

management system client 259
transform sequence 210

delete
and retain 319
orphaned files 304
users from a security group 35

delivery-address 28, 307
delivery-method 28
densitometer, calibrating 257
densitometer, measuring optical density

with 263
destination

interoperating environment 135
security 33

Destination Control File (DCF) 151
advanced editing 159
control statements 153
control statements, syntax 154
copying 157
debugging 159
editing 158

destination support system (DSS) 11,
111, 114, 116, 314, 316, 321

destination-MID-support-enabled
destination-MID-release-timer 15

destination-tcpip-internet-address 57
device_controls finishing option 182
device-specific actual destination

attributes
non-settable 55
settable 55

Direct download 173
Direct download method

performance 173
directories 239

/usr/lpp/psf/bin 247
/usr/lpp/psf/cmt/ 252
/usr/lpp/psf/config 247
<install path>\grd 239
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directories (continued)
<install path>\var\psf\

PrinterName 241
global resource identifiers

(GRIDS) 241
install_path\psf\config 249

directory locations
user-exit programs 103

disability 341
disk-space-low event 41
disks

monitored by InfoPrint Manager
for Windows 42

DNS 9
Double byte font 234
Double Byte font

transform 179
Double Byte text stream 179, 195
DSS (see also Destination support

system) 316

E
E-mail 26
EBCDIC DBCS 190
ecp 232
edge marks 98
Enable MID Support 15
enabling font capture

for OpenType fonts 231
environment variable

setting 196
environment variables

PSFPATH 63
ERP printing 277

Windows 278
error

IPDS
data stream errors 329
insufficient memory 331
intervention required

conditions 332
unrecoverable problems 333

messages 330, 331, 332
out of paper 318
paper jam 318

error logs
customizing 37
using the log-backup-number

attribute 37
event-identifiers 28
events

detecting 19
disk-space-low 41
messages about 19
out-of-disk-space 42

events-supported 28
examples

auxiliary sheets 100
img2afp transform 188
of creating transform objects 216

Exit Program
customizing 162
modifying 162
MVS Download 161
using 162

extended code pages 232

F
files 239

accounting.log 114
audit.log 114
charset.grd.sample 239
cmt.cfg 247
cmt.cfg sample 249
cmtsampl 247
codepage.grd.sample 240
cpgid.grd.file 240
fgid.grd.sample 240
notifyd_error.cfg 38
pie1.cfg 251
pie1.out 251, 252
prt1.accounting.log 114
Resource Access Table 230
spl_error.cfg 37

finishing
bin mapping 268
InfoPrint 45 287
InfoPrint 70 294
staple and punch options with

ps2afp 183
fixed-length files

defined 192
font 227

for DBCS ASCII 234
for DBCS EUC 234
for Double-Byte transformed file 234
for line data 235
for PDF data 227
for PostScript data 227
Japanese DBCS 235
mapping files 227
remote resources 49
resources for DBCS ASCII printing

setting up 235
resources for DBCS EUC printing

setting up 235
substitution 229

font capture
for fonts in a library 231
overview 231

font index files 199
font resources

DBCS ASCII 196
DBCS EUC 196

font support 201
fonts

global resource identifiers
(GRIDS) 239

printer-resident 239
resource-context object 61
using OpenType fonts 229

form definition 98
finishing 288, 295
remote resources 49

formatting objects 199
definition 199
supported 335

block 336
block-container 336
character 337
external-graphic 337
flow 336
initial-property-set 337

formatting objects (continued)
supported (continued)

inline-container 337
inlineinline 337
layout-master-set 335
list-block 339
list-item 339
list-item-body 339
list-item-label 339
page-number 338
page-sequence 335
page-sequence-master 335
region-after 336
region-before 335
region-body 335
region-end 336
region-start 336
repeatable-page-master-

alternatives 335
repeatable-page-master-

reference 335
root 335
simple-page-master 335
single-page-master-reference 335
static-content 336
table 338
table-and-caption 338
table-body 338
table-caption 338
table-cell 339
table-column 338
table-footer 338
table-header 338
table-row 338

forward spacing 301, 316, 317

G
gateways

Windows gateway printer
adding to desktop 305

gathering
accounting data 111
audit data 111

generating color mapping table source
and output files 247

GIF 179
global resource identifiers (GRIDS) 239

description 239
files that come with InfoPrint

Manager
charset.grd.sample 239
codepage.grd.sample 239
cpgid.grd.sample 239
fgid.grd.sample 239

global id example 244
location 241
modifying 243
preventing InfoPrint from using 246
resident font id example 243
searching for 241
specifying 245
specifying fonts 239
understanding syntax rules 241
uses of 239

GOCA pattern fill color space 248
Graphic interchange format (GIF) 179
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graphic support 202
group

identifying 36
name 35
security 35

groups
working with 36

H
halftone

calibrating 260
specifying for printing on InfoPrint

server 263
halftone management system

invoking 255
overview 255
starting 257

Halftone Management System
actual screen frequencies and

angles 256
starting

client 257
error message 257
server 257

using 255
Versions 2 or Standard Toner 257
Versions 2, 3, or Standard Toner 257
Versions 3 Toner 256

halftones
configuring printer devices for 255

header (start) page user exit 71
help for notification messages 31
Highlight color color space 248
host system 11
host systems

PC-based applications and 12
hostname

changing 45
non-namespace server 46

hot folder
job attributes 307
mapping 281
mounting 281
staging jobs 307

hot folders
submitting muliple-document

jobs 308
Hypertext Transfer Protocol (HTTP)

Internet Printing Protocol (IPP) 17

I
IBM TCP/IP Network Port Monitor 116
iconv command

replaced with uconv command 94
identifying

group 36
user 36

imageout keyword
affect on processing 193

img2afp transform 186
AIX printer halftone files 187
configuration files 186
customizing 186
examples 188

img2afp transform (continued)
limitations 188
thresh printer files 187

InfoPrint 2000 301
spacing 316, 317

InfoPrint 3000 301
spacing 316, 317

InfoPrint 4000 301
spacing 316, 317

InfoPrint 4000 printer
actual screen angles 256
actual screen frequencies 256

InfoPrint 4100 301
InfoPrint 4100 printer

actual screen angles 256
actual screen frequencies 256

InfoPrint 45
duplexing 303
finishing options 287
using 303

InfoPrint 5000
setting up

Model CS1 279
Models CD1/2 279

InfoPrint 70
finishing options 294
using 303

InfoPrint Manager 123, 124, 173
InfoPrint Manager accounting 114

actual destination name 112
completion time 112
data stream 112
from a BSD DSS 115
from a Passthrough DSS 116
from a PSF DSS with Command 115
from a PSF DSS with

Other-Driver 115
from a PSF DSS with TCP/IP 114
from an Internet Printing Protocol

DSS 115
global job-id 112
how different InfoPrint printers gather

data 114
job name 112
job owner 112
managing the logs 113
octets-completed 112
pages-completed 112
submission time 112

InfoPrint Manager Administration GUI
administrative tasks 43

InfoPrint Manager for AIX 135, 276
using with InfoPrint Manager for

Windows 133
InfoPrint Manager for Windows

interoperating environment 46
InfoPrint Manager line printer daemon

(LPD) 121, 276, 308
configuring 309

InfoPrint Manager Management Console
updating the global search path 232

InfoPrint Manager Notifications 19
using 310

InfoPrint Manager Security 33, 45
InfoPrint Select

finishing 288, 296
job status 310

InfoPrint servers, defining to the halftone
management system 259

Infoprint Submit Express
finishing 288

InfoPrint Submit Express
finishing 296

InfoPrint Submit Express, printing
from 263

InfoPrint System Migration utility 125
InfoPrint TCP/IP Network Port

Monitor 116
infoprint_attribute 156
infoprint_definition 156
InfoPrint70

duplexing 303
inpexit keyword 88
input data

user-exit programs
associating with actual

destination 107
input data format

PCL 209
PostScript 209

input data user exit 71
input record exit 88

apka2e 87
asciinp.c 87
asciinpe.c 87

input-trays-medium 53
input/output parameters

OUTDATA_EXITDATA 86
install_path\psf\config directory 249
installing

DBCS fonts on Windows 235
insufficient memory 331

example 332
Internet Printing Protocol (IPP)

adding an IPP gateway to the
desktop 306

auxiliary sheet 97
client software 15, 17
creating an IPP-enabled printer 17
IPP Gateway 15, 17
printer 11
printing to an IPP-enabled printer 17
using 17

interoperating environment 133, 135,
276

changing server hostname 45, 46
configuration example 136
example configurations 134
namespace 134
printer driver 135
reasons for setting up 133
security 134
with multiple Windows 2000

servers 135
interrupt job 311
Interrupt Message Pages 98
intervention required conditions 332

example 332
IOCA object support 202
IP address

changing 45, 47
class A 9
class B 9
secondary network 9
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IP Printway 11
IPDS

error recovery
data stream errors 329
insufficient memory 331
intervention required

conditions 332
unrecoverable problems 333

print operator commands 325
IPP (see also Internet Printing

Protocol) 17
IPP Gateway

finishing 289, 297
job status 310

ismu utility 123
ismu Utility

prerequisites 124

J
Japanese DBCS fonts
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